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Preface

Over the past few years, we have seen many changes in the 8-bit microcontroller market.
Motorola stopped new development on its popular 8-bit 68HC11 microcontroller, which was
one of the most taught microcontrollers in universities. Instead, Motorola developed the new 8-
bit 68HC908 to take over the low-end applications of the 68HC11 and introduced the 16-bit
68HC12 and HCS12 to take over the high-end applications of the 68HC11. Several new players
in the 8-bit microcontroller field have gained significant market share. Among them, Microchip
has overtaken Motorola to become the new market leader in this competitive 8-bit microcon-
troller market.

In the past few years, more and more universities and colleges became interested and
started to teach the Microchip PIC® microcontrollers. Microchip designs and manufactures sev-
eral families of 8-bit microcontrollers. Among them, the PIC16 family and the PIC18 family are
the two most important families. The PIC18 family was the latest development and has several
advantages over the PIC16 microcontroller family:

1. The PIC18 family supports much larger program memory space. The PIC18 family
supports 2 MB of program memory space, whereas the PIC16 family supports only
8 KB of program memory.

2. The PIC18 family supports external program memory. The PIC16 family does not.

3. The PIC18 family has much larger on-chip data memory to support the application.

4, The PIC18 family provides the access bank to minimize the data memory bank-
switching overhead.

5. The PIC18 family provides more instructions, which sometimes makes assembly
language programming a little easier.
6. The PIC18 family supports more peripheral functions than the PIC16 family does.
7. The PIC18 family devices can run at a higher clock rate and achieve better performance.
The PIC18 family provides a wide range of pin count from as few as 18 pins to as many as
80 pins at the time of this writing. In addition to the normal parallel I/O ports, the PIC18 fam-
ily provides a wide spectrum of peripheral functions to satisfy the needs of different applications:
1. Multiple serial interfaces. The PIC18 family supports industrial standard serial
interfaces, including the USART, SPI, I2C, and CAN bus. The SPI and I2C allow the
PIC18 microcontroller to interface with numerous peripheral devices with serial
interfaces, such as LED drivers, LCD drivers, A/D converters, D/A converters; real-
time clock chips, SRAM, EEPROM, and phase-locked loop. The CAN bus has been
widely used in automotive applications and factory automation and control.
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2. Sophisticated timer system. A PIC18 microcontroller may provide input-capture,
output-compare, pulse width modulation (PWM), real-time interrupt, and watchdog
timer functions. Some PIC18 members have their PWM modules enhanced to support
motor applications.

3. A/D converter. The PIC18 family provides a 10-bit resolution A/D converter.

4. In-system programming capability. Most PIC18 members provide on-chip flash
program memory and allow the software to be upgraded in the system.

5. In-circuit debug capability. The PIC18 family implements a background debug mode
and provides an in-circuit debug {ICD) interface, which allows the inexpensive in-
circuit debugger to be implemented.

These features appear to be most desired by the end user. With these features, the PIC18
microcontroller is very suitable for those who want to learn about modern microcontroller
interfacing and programming.

Intended Audience

This book is written for two groups of readers:

1. Students in electrical and computer engineering and technology who are taking an
introductory course of microprocessor interfacing and applications. For this group of
readers, this book provides a broad and systematic introduction to the
microcontrollers. The material of this book would be adequate for two semesters.

2. Senior electrical engineering and computer engineering students and working
engineers who want to learn about the PIC18 microcontroller and use it in a design
project. For this group of readers, this book provides numerous more complicated
examples to explore the functions and applications of the PIC18 microcontroller. For
those readers who have learned at least one assembly language before, they might
want to use C language to program their applications as much as possible to gain the
productivity advantage provided by the C language.

Prerequisites

This book has been written with the assumption that the reader has taken a course on dig-
ital logic design and has been exposed to high-level language programming. The knowledge in
digital logic will greatly facilitate the learning of the PIC18 microcontroller. The experience in
high-level language programming will enable the reader to quickly implement a program con-
struct using an appropriate assembly instruction sequence. The knowledge in assembly lan-
guage programming is not required because one of the writing goals of this book is to teach the
PIC18 assembly language programming.

Approach

Using a high-level language to program the application would be much more productive
than using an assembly language because a high-level language such as C allows the user to
work on the program logic at a much higher level. However, our experience shows that learn-
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ing the assembly language programming can give the learner much insight into the functioning
of hardware because the assembly instructions allow the user to have full control of the hard-
ware. Based on these two considerations, this text uses both the assembly and the C languages
to teach the programming of each peripheral function.

The main writing goal of this text is to facilitate the learning of the microcontroller inter-
facing and programming. Each subject is started with background issues and general concepts
followed by the specific implementation in the PIC18 microcontroller. Numerous examples are
used to illustrate the programming and interfacing of the PIC18 microcontroller.

Textbook Orga

Chapter 1 presents the basic concepts of computer hardware and software, microcontroller
applications, the PIC18 architecture and addressing modes, a subset of PIC18 instructions, and
a survey of the 8-bit microcontroller market.

Chapter 2 introduces the PIC18 instruction set, assembler directives, and the basic assem-
bly language programming skills.

Chapter 3 provides a review of the PIC18 software and hardware development tools pro-
vided by Microchip and Shuan-Shizu Enterprise. Microchip provides a full spectrum of hardware
and software development tools, whereas Shuan-Shizu developed several PIC18 demo boards for
learning the PIC18 microcontrollers. Several tutorials have been provided to demonstrate the
use of development tools and demo boards.

Chapter 4 is about more advanced topics in assembly language programming, including
writing subroutines and making subroutine calls. A salient feature of this chapter is the imple-
mentation of software stack data structure. The PIC18 does not support the stack structure in
hardware. This chapter puts forth great effort to illustrate how to use software techniques to
implement the stack data structure. The stack structure has been heavily used in passing
incoming parameters, returning computation result, and allocating local variables during sub-
routine calls.

Chapter 5 provides a tutorial on the C language and then examines the features of the
Microchip C compiler. A tutorial on the use of the Microchip C compiler is also given in this
chapter. A tutorial on using the Hi-Tech PICC-18 C compiler is given in Appendix C. The Hi-
Tech PICC-18 C compiler appears to be easy to use and user friendly.

Chapter 6 discusses the concept and programming of interrupts and resets. The debounced
key switches available on the demo boards from Shuan-Shizu Enterprise are especially suitable
for experimenting with the interrupt handling and interrupt-driven I/O.

Chapter 7 introduces the basic concept of parallel I/O. This chapter also covers the inter-
facing and programming of simple I/O devices, including DIP switches, keypad scanning and
debouncing, LEDs, LCDs, D/A converters, and the parallel slave port.

Chapter 8 explores the operation and applications of the timer system, including input cap-
ture, output compare, real-time interrupt, and pulse width modulation and the applications of
these functions on the measurement of pulse width, period, duty cycle, and frequency; the cre-
ation of time delays, sirens, and songs; and motor control.

Chapter 9 deals with the serial communication interface USART. This interface can oper-
ate in both the asynchronous and the synchronous mode. However, this interface is often used
to communicate with a PC using the EIA-232 interface.

Chapter 10 covers the synchronous serial interface SPI and the applications of this inter-
face, including parallel port expansion with shift registers, multidigit display with seven-
segment display driver chips, and time-of-day tracking.
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Chapter 11 introduces the characteristics of the interintegrated circuit {I*C) and the applica-
tions of this interface, including EEPROM interfacing and ambient temperature measurement.

Chapter 12 presents the topic of analog-to-digital conversion and its applications in tem-
perature, humidity, and barometric pressure measurement.

Chapter 13 presents the CAN 2.0 protocol and the PIC18 CAN module. Examples and pro-
gramming of CAN bus have been provided.

Chapter 14 describes the PIC18 internal SRAM, data EEPROM, and flash memory. The
issues related to external memory expansion are also explored: address space assignment,
decoder design, and timing verification.

Chapter 15 describes the system configuration issue and miscellaneous issues of the PIC18
microcontroller, including the configuration registers, watchdog timer, low-power mode, pro-
gram memory protection, data EEPROM protection, background debug mode, and in-circuit
serial programming,

Each chapter opens with a list of objectives. Every subject is presented in a step-by-step
manner. Background issues and general concepts are presented before the specifics related to
each PIC18 peripheral function are discussed. Numerous examples are then presented to
demonstrate the use of each PIC18 peripheral function. Algorithmic steps and flowcharts are
used to help the reader understand the program logic in most examples. Each chapter concludes
with a summary along with exercise problems and lab assignments. Many of the exercise prob-
lems can also be used as lab assignments. A separate lab manual is not needed to support the
learning of the PIC18 microcontroller.

Development tools are important in the learning of the PICI8 microcontroller. The
MPLAB® IDE from Microchip is an integrated development environment, which consists of a
context-sensitive text editor, cross assemblers for all Microchip microcontrollers, a linker, a
librarian, a simulator, and drivers for several in-circuit emulators and the in-circuit debugger
(ICD 2). The MPLAB IDE is updated several times each year and can be downloaded from the
Microchip Web site free of charge (www.microchip.com).

The ICD 2 is an inexpensive tool for the user to download programs (hex files) onto the
demo board for execution. This device also supports source-level debugging under the control
of MPLAB IDE. The user connects the ICD 2 to a PC using the USB port or serial communica-
tion port and plugs into the target demo board via a connector.

Chapter 3 examines three demo boards for learning the PIC18 microcontroller made by
Shuan-Shizu Enterprise (www.evb.com.tw). The SSE452 uses the PIC18F452 as its controller
and allows the user to experiment with different types of PIC18 devices by providing optional
28-pin and 40-pin DIP ZIF sockets. The SSE8720 uses the PIC18F8720, whereas the SSE8860
uses the PIC18F8680 as their controllers. The SSE8680 includes the CAN transceiver chip
MCP2551 and allows the user to experiment with CAN bus interfacing. All three demo boards
include a 2 x 20 LCD kit, digital waveform outputs with frequency ranging from 1 Hz up to
16 MHz, DIP switches, debounced key switches, LEDs, an EEPROM with serial interface, a
time-of-day chip, a temperature sensor, a rotary encoder, a connector for the speaker and the
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keypad, and connectors for accessing microcontroller signals. Microchip also produces several
PIC18 demo boards for learning the PIC18 microcontroller.

This text uses the PIC18 C compiler from Microchip to compile all the C programs. This
compiler does not have a student version. However, it has a demo version that can be run for a
month to allow the user to experiment with the supported C language features. The demo ver-
sion of the C compiler can be downloaded from the Microchip Web site. For those who are inter-
ested in the C compiler from Hi-Tech Inc., a tutorial is provided in Appendix C.

Complimentary CD

This text includes a complimentary CD that contains all appendices, including the source
code of all example programs in the text and also the PDF files of datasheets of the PIC18 micro-
controllers and peripheral chips discussed in the text.

Supplements

A CD dedicated to instructors who adopt this text is also available from the publisher. This
CD contains solutions to all exercise problems and the lecture notes in PowerPoint format.
Instructors are encouraged to modify the PowerPoint lecture notes to suit their teaching needs.

(ISBN #: 1401839681}
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2 Chapter 1 m Introduction to the PIC18 Microcontroller

1.2 What Is a Computer?

A computer is made up of hardware and software. The hardware of a computer consists of
four types of components:

m  Processor. The processor is responsible for performing all of the computational
operations and the coordination of the usage of resources of a computer. A
computer system may consist of one or multiple processors. A processor may
perform general-purpose computations or special-purpose computations, such as
graphical rendering, printing, or network processing.

®  nput devices. A computer is designed to execute programs that manipulate certain
data. Input devices are needed to enter the program to be executed and data to be
processed into the computer. There are a wide variety of input devices: keyboards,
keypads, scanners, bar code readers, sensors, and so on.

»  Qutput devices. No matter if the user uses the computer to do certain
computation or to find information from the Internet or a database, the end results
must be displayed or printed on paper so that the user can see them. There are
many media and devices that can be used to present the information: CRT
displays, flat-panel displays, seven-segment displays, printers, light-emitting
diodes (LEDs), and so on.

®  Memory devices. Programs to be executed and data to be processed must be stored
in memory devices so that the processor can readily access them.

1.2.1 The Processor

A processor is also called the central processing unit {CPU). The processor consists of at
least the following three eomponents:

Registers. A register is a storage location inside the CPU. It is used to hold data and/or
a memory address during the execution of an instruction. Because the register is very
close to the CPU, it can provide fast access to operands for program execution. The
number of registers varies greatly from processor to processor.

Arithmetic logic unit (ALU). The ALU performs all the numerical computations and
logical evaluations for the processor. The ALU receives data from the memory,
performs the operations, and, if necessary, writes the result back to the memory.
Today’s supercomputer can perform trillions of operations per second. The ALU and
registers together are referred to as the datapath of the processor.

Control unit. The control unit contains the hardware instruction logic. The control
unit decodes and monitors the execution of instructions. The control unit also acts
as an arbiter as various portions of the computer system compete for the resources
of the CPU. The activities of the CPU are synchronized by the system clock. The
clock rates of modern microprocessors have exceeded 3.0 GHz at the time of this
writing, where

1 GHz = 1 billion cycles per second

The period of a 1-GHz clock signal is 1 ns (10 second). The control unit also maintains a reg-
ister called the program counter (PC) that keeps track of the address of the next instruction to
be executed. During the execution of an instruction, the occurrence of an overflow, an addition
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carry, a subtraction borrow, and so forth are flagged by the system and stored in another regis-
ter called a status register. The resultant flags are then used by the programmer for program-
flow control and decision making.

1.2.2 The Microprocessor

The advancement of semiconductor technology allows the circuitry of a complete proces-
sor to be placed in one integrated circuit (also called a chip). A microprocessor is a processor
packaged in a single integrated circuit. A microcomputer is a computer that uses a micro-
processor as its CPU. A personal computer (PC) is a microcomputer. Early microcomputers
were very slow. However, many personal computers manufactured in 2003 run at a clock rate
higher than 3.0 GHz and are faster than some supercomputers of a few years ago.

Depending on the number of bits that a microprocessor can manipulate in one operation, a
microprocessor is referred to as 4-bit, 8-bit, 16-bit, 32-bit, or 64-bit. This number is the word
length (or datapath length) of the microprocessor. Currently, the most widely used micro-
processors are 8-bit.

Although the clock rate of the microprocessor has been increased dramatically, the
improvement in the access time {or simply called the speed) of the high-capacity memory chips
{especially the most widely used DRAM chips to be discussed in Section 1.2.4) has been mod-
erate at best. The microprocessor may complete one arithmetic operation in one clock cycle;
however, it may take many clock cycles to access data from the memory chip. This disparity in
speed makes the high clock rate of the microprocessor alone useless for achieving high through-
put. The solution to this issue is adding a small high-speed memory to the CPU chip. This on-
chip memory is called cache memory. The CPU can access data from the on-chip cache memory
in one or two clock cycles because it is very close to the ALU. The cache memory is effective
in improving the average memory access time because the CPU demonstrates locality in its
access behavior. Within a short period of time, the CPU tends to access a small area in the mem-
ory repeatedly. Once the program segment or data has been brought into the cache, it will be
referenced many times. This results in an average memory access time very close to that of the
access time of the cache memory.

Microprocessors and input/output (I/O) devices have different characteristics and speed. A
microprocessor is not designed to deal with I/O devices directly. Instead, peripheral chips {also
called interface chips) are needed to make up the difference between the microprocessor and the
I/O devices. For example, the Intel 18255 was designed to interface the 8-bit 8080 microproces-
sor from Intel, and the M6821 was designed to interface the 8-bit 6800 from Motorola with I/O
devices.

Microprocessors have been widely used in many applications since they were invented.
However, there are several limitations in the initial microprocessor designs that led to the
development of microcontrollers:

m  External memory chips are needed to hold programs and data because the early
microprocessors did not have on-chip memory.

®  Glue logic (such as address decoder and buffer chips) is required to interface with
the memory chips.

® Peripheral chips are needed to interface with 1/O devices.

Because of these limitations, a product designed with microprocessors cannot be made as com-
pact as might be desirable. The development of microcontrollers has not only eliminated most of
these problems but also enabled the design of many low-cost microprocessor-based products.



Chapter 1 m Introduction to the PIC18 Microcontroller

1.2.3 Microcontrollers

A microcontroller, or MCU, is a computer implemented on a single very large scale inte-
grated (VLSI) circuit. In addition to those components contained in a microprocessor, an MCU
also contains some of the following peripheral components:

= Memory

= Timers, including event counting, input capture, output compare, real-time interrupt,
and watchdog timer

® Pulse-width modulation (PWM)

®  Analog-to-digital converter (ADC)

® Digital-to-analog converter (DAC)

» Parallel I/O interface

= Asynchronous serial communication interface ([UART)

®  Synchronous serial communication interfaces (SPI, I>XC, and CAN)
» Direct memory access (DMA) controller

=  Memory component interface circuitry

m  Software debug support hardware

The discussion of the functions and applications of these components is the subject of this
text. Most of these functions are discussed in details in later chapters.

Since their introduction, MCUs have been used in almost every application that requires
certain amount of intelligence. They are used as controllers for displays, printers, keyboards,
modems, charge card phones, palm-top computers, and home appliances, such as refrigerators,
washing machines, and microwave ovens. They are also used to control the operation of engines
and machines in factories. One of the most important applications of MCUs is probably the
automobile control. Today, a luxurious car may use more than 100 MCUs. Today, most homes
have one or more MCU-controlled consumer electronics appliances. In these applications, peo-
ple care about only the functionality of the end product rather than the MCUs being used to
perform the control function. Products of this nature are often called embedded systems.

1.2.4 Memory

Programs and data are stored in memory in a computer system. A computer may contain
semiconductor, magnetic, and/or optical memories. Only semiconductor memory is discussed
in this text because magnetic and optical memories are seldom used in 8-bit MCU applications.
Semiconductor memory can be further classified into two major types: random-access memory
(RAM) and read-only memory (ROM).

Ranpom-Access MEmoRY

Random-access memory is volatile in the sense that it cannot retain data in the absence of
power. RAM is also called read/write memory because it allows the processor to read from and
write into it. Both read and write accesses to a RAM chip take roughly the same amount of time.
As long as the power is on, the microprocessor can write data into a location in the RAM chip
and read back the same contents later. Reading memory is nondestructive. When the micro-
processor writes data to memory, the old data is written over and destroyed.

There are two types of RAM technologies: static RAM (SRAM) and dynamic RAM (DRAM).
SRAM uses from four to six transistors to store one bit of information. As long as power is on,
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the information stored in the SRAM will not be degraded. Dynamic RAM uses one transistor
and one capacitor to store one bit of information. The information is stored in the capacitor in
the form of electric charge. The charge stored in the capacitor will leak away over time, so a
periodic refresh operation is required to maintain the contents of DRAM.

RAM is mainly used to store dynamic programs and data. A computer user often wants to
run different programs on the same computer, and these programs usually operate on different
sets of data. The programs and data must therefore be loaded into RAM from hard disk or other
secondary storage, and for this reason they are called dynamic.

READ-ONLY MEMORY

ROM is nonvolatile. If power is removed from ROM and then reapplied, the original data
will still be there. As its name implies, ROM data can only be read. This is not exactly true.
Most ROM technologies require special algorithm and voltage to write data into the chip.
Without using the special algorithm and voltage, any attempt to write to the ROM memory will
not be successful. There are many different kinds of ROM technologies in use today:

Masked-programmed read-only memory (MROM) is a type of ROM that is programmed
when it is manufactured. The semiconductor manufacturer places binary data in the memory
according to customer’s specification. To be cost effective, many thousands of MROM memory
chips, each containing a copy of the same data (or program), must be sold. Many people simply
call MROM as ROM.

Programmable read-only memory (PROM] is a type of read-only memory that can be pro-
grammed in the field (often by the end user) using a device called a PROM programmer or
PROM burner. Once a PROM has been programmed, its contents cannot be changed. PROMs
are fuse-based; that is, end users program the fuses to configure the contents of memory.

Erasable programmable read-only memory (EPROM) is a type of read-only memory that
can be erased by subjecting it to strong ultraviolet light. The circuit design of EPROM requires
the user to erase the contents of a location before a new value can be written into it. A quartz
window on top of the EPROM integrated circuit permits ultraviolet light to be shone directly
on the silicon chip inside. Once the chip is programmed, the window can be covered with dark
tape to prevent gradual erasure of the data. If no window is provided, the EPROM chip becomes
one-time programmable (OTP) only. EPROM is often used in prototype computers where the
software may be revised many times until it is perfected. EPROM does not allow erasure of the
contents of an individual location. The only way to make change is to erase the entire EPROM
chip and reprogram it. The programming of an EPROM chip is done electrically by using a
device called an EPROM programmer. Today, most programmers are universal in the sense that
they can program many different types of devices including EPROM, EEPROM, flash memory,
and programmable logic devices.

Electrically erasable programmable read-only memory (EEPROM) is a type of nonvolatile
memory that can be erased and reprogrammed by electrical signals. Like EPROM, the circuit
design of EEPROM also requires the user to erase the contents of a memory location before writ-
ing a new value into it. EEPROM allows each individual location to be erased and repro-
grammed. Unlike EPROM, EEPROM can be erased and programmed using the same
programmer. However, EEPROM pays the price for being so flexible in its erasability. The cost
of an EEPROM chip is much higher than that of an EPROM chip of comparable density.

Flash memory was invented to incorporate the advantages and avoid the disadvantages of
both EPROM and EEPROM technologies. Flash memory can be erased and reprogrammed in the
system without using a dedicated programmer. It achieves the density of EPROM, but it does
not require a window for erasure. Like EEPROM, flash memory can be programmed and erased
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electrically. However, it does not allow the erasure of an individual memory location—the user
can only erase a section or the entire chip. Today, more and more MCUs are incorporating on-
chip flash memory for storing programs and data. The flash-based PIC18 MCUs allow you to
erase one block of 64 bytes at a time.

Programs are known as software. A program is a set of instructions that the computer can
execute. The program is stored in the computer’s memory in the form of binary numbers called
machine instructions.

The length of a machine instruction of a computer may be fixed or variable. Fixing the
instruction length makes instruction decoding simpler and hence can simplify the design of the
processor. However, it has one potential drawback. The program length may be longer because
of the inefficiency of instruction encoding. Most of the PIC18 instructions are 16 bits, whereas
four of them are 32 bits. For example, the PIC18 machine instruction

0010 0100 0010 0000  (or 2420 in base 16)

adds the contents of the data register at the hexadecimal address 20 to the WREG register and
leaves the sum in WREG. The machine instruction

0110 1010 0000 0101 (or 6A05 in base 16)

clears the contents of the data register located at the address 5 to O.

When a machine instruction is fetched from the memory, it will be decoded in the con-
trol unit of the CPU. Appropriate control signals will then be generated to trigger the desired
operation.

1.3.1 Assembly Language
It is not difficult to conclude that software development in machine language is extremely hard:

1. Program entering. The programmer must use the binary patterns of every machine
instruction in order to enter a machine instruction. Before the user can memorize the
binary pattern of each instruction, he or she must consult a lookup table constantly.
In addition, the programmer must work on the program logic at a very low level,
which will hinder the programming productivity.

2. Program debugging. Whenever a program does not perform as expected, the
programmer will have a hard time to identify the instruction that caused the problem.
A programmer will need to identify each machine instruction and then think about
what operation is performed by that instruction. This is not an easy task.

3. Program maintenance. Most programs will need to be maintained in the long run. A
programmer who did not write the program will have a hard time reading the program
and figuring out the program logic.

Assembly language was invented to simplify the programming job. An assembly program
consists of assembly instructions. An assembly instruction is the mnemonic representation of
a machine instruction. For example, in the PIC18 MCU,

decf fp_cnt,F,A stands for “decrement the variable /p_cnt located at the access bank by 1”
addwf sum,F,A stands for “add the contents of the WREG register and the variable sum in the access bank and
leaves the result in sum.
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where the meaning of access bank is explained in Section 1.5.2.

With the invention of the assembly language, a programmer no longer needs to scan
through the sequence of 0s and 1s in order to identify what instructions are in the program. This
is a significant improvement over machine language programming.

The assembly program that the programmer enters is called source program or source code.
The user needs to invoke an assembler program to translate the source program into machine
language so that the computer can execute it. The output of an assembler is also called object
code. There are two types of assemblers: native assembler and cross assembler. A native assem-
bler runs on a computer and generates the machine code to be executed on the same computer
or a different computer having the same instruction set. A cross assembler runs on a computer
but generates machine code that will be executed by computers that have a different instruc-
tion set. The Microchip MPASM® is a cross assembler designed to run on a PC to translate
assembly programs for the PIC MCUs.

1.3.2 High-Level Languages
There are a few drawbacks for assembly language programming:

» The programmer must be familiar with the hardware architecture on which the
program is to bc cxecuted.

® A program (especially a long one) written in assembly language is difficult to
understand for anyone other than the author.

»  Programming productivity is not satisfactory for large programming projects
because the programmer needs to work on the program logic at a very low level.

For these reasons, high-level languages such as C, C++, and Java were invented to avoid the
problems of assembly language programming. High-level languages are close to plain English,
and hence a program written in a high-level language becomes easier to understand. A state-
ment in high-level language often needs to be implemented by tens or even hundreds of assem-
bly instructions. The programmer can now work on the program logic at a much higher level,
which makes the programming job much easier. A program written in a high-level language is
also called a source code, and it requires a software program called a compiler to translate it into
machine instructions. A compiler compiles a program into object code. Just as there are cross
assemblers, there are cross compilers that run on one machine but translate programs into
machine instructions to be executed on a computer with a different instruction set.

Some high-level languages are interpreted; that is, they use an interpreter to scan the user’s
source code and perform the operations specified. Interpreters do not generate object code.
Programming languages that use this approach include Basic, Lisp, and Prolog. The Java lan-
guage is partially compiled and partially interpreted. A program written in Java language is first
compiled into byte code and then interpreted. The design purpose of this language is “compiled
once, run everywhere.”

High-level languages are not perfect, either. One of the major problems with high-level lan-
guages is that the machine code compiled from a program written in a high-level language is
much longer and cannot run as fast as its equivalent in the assembly language. For this reason,
many time-critical programs are still written in assembly language.

C language has been used extensively in MCU programming in the industry, and most
MCU software tool developers provide cross C compilers. Both the C and the PIC18 assembly
languages will be used throughout this text. The C programs in this text are compiled by the
Microchip C cross compiler and tested on the PIC18 demo board.
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Microchip has introduced six different lines of 8-bit MCUs over the years:
1. PIC12XXX: 8-pin, 12- or 14-bit instruction format
2. PIC14000: 28-pin, 14-bit instruction format (same as PIC16XX)
3. PIC16C5X: 12-bit instruction format
4. PIC16CXX: 14-bit instruction format
5. PIC17: 16-bit instruction format
6. PIC18: 16-bit instruction format

Each line of the PIC MCUs support different number of instructions with slightly different
instruction formats and different design in their peripheral functions. This makes products
designed with a different family of PIC MCUs incompatible. The members of the PIC18 family
share the same instruction set and the same peripheral function design and provide from eight
to more than 80 signal pins. This makes it possible to upgrade the PIC18-based product with-
out changing the MCU family. One of the design goals of the PIC18 MCU is to eliminate the
design flaws of other earlier MCU families and provide a better upgrade path to other families
of MCUs. In terms of cost, the PIC18 MCUs are not more expensive than those in other fami-
lies with similar capability.

The PIC18 MCUs provide the following peripheral functions:

1. Parallel I/O ports

2. Timer functions, including counters, input capture, output compare, real-time
interrupt, and watchdog timer

Pulse width modulation (PWM)

SPI and I2C serial interface

Universal Synchronous/Asynchronous Receiver Transmitter (USART)
A/D converter with 10-bit resolution

Analog comparator

Low-power operation mode

SRAM and EEPROM

10. EPROM or flash memory

11. Controller Area Network (CAN)

These peripheral functions are studied in detail in the following chapters. By October 2003,
40 devices in the PIC18 family have been in production, and more devices will be introduced in
the coming few years. All these MCUs implement 77 instructions. Among them, 73 instruc-
tions are 16 bits, and the remaining four are 32 bits.

The features of all PIC18 devices are shown in Table 1.1. This table mentions many
acronyms that may not make any sense at this point. However, all of them are explained in
detail in later chapters.
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Feature PIC18C242 PIC18C252 PIC18C442 PIC18C452 PIC18C601 PIC18C801 PIC18C658

Operating frequency DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-25 MHz DC-25 MHz DC-40 MHz
Program memory 16 KB 32 KB 16 KB 32 KB 0 KB 0 KB 32 KB
Data memory 512 Bytes 1.5 KB 512 Bytes 1.5 KB 1.5 KB 1.5 KB 1.5 KB Data
EEPROM 0 0 0 0 0 0 0
External program memory  No No No No 256 KB 2 MB No
Inerrupt sources 16 16 17 17 15 15 21
I/0 ports A.C A.C AE A.E A.G A.H ) A.G
Timers 4 4 4 4 4 4 4
Capture/Compare/ 2 2 2 2 2 2 2
PWM modules
Serial Communication MSSP, USART ~ MSSP, USART ~ MSSP, USART ~ MSSP, USART ~ MSSP, USART  MSSP, USART  MSSP, USART,
CAN
Paratlel Communication No No PSP PSP No _No PSP
10-bit A/D 5 channels 5 channels 8 channels 8 channels 8 channels 12 channels 12 channels
Low voltage detect Yes Yes Yes Yes Yes Yes Yes
Brown out reset Yes Yes Yes Yes No No Yes
Instruction set 77 77 77 77 77 77 77
8-bit external memory No No No NO YES YES NO
8-bit external demuxed No No No NO No YES NO
memory
8-bit external memory No No No NO YES YES NO
On-chip chip select signal No No No NO CSi €SI, €S2 NO
Packages 28-pin PDIP 28-pin DIP 40-pin DIP 40-pin DIP 64-pin TQFP 80-pin TQFP 64-pin TQFP
28-pin SOIC 28-pin SOIC 40-pin PLCC 44-pin PLCC 68-pin PLCC 84-pin PLCC 68-pin
28-pin JW 28-pin JW 40-pin TQFP 44-pin TQFP CERQUAD
40-pin JW 40-pin JW 68-pin PLCC
Feature PIC18C858 PIC18F242 PIC18F252 PIC18F442 PIC18F452 PIC18F258 PIC18F458
Operating frequency DC-40 MHz DC-40 MHz BC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz
Program memaory 32 KB 16 KB 32 KB 16 KB 32 KB 32 KB 32 KB
Data memory 1.5 KB 768 Bytes 1.5 KB 768 Bytes 1.5KB 1.5 KB 1.5 KB
Data EEPROM 0 256 256 256 256 256 256
External program memory  No No No No No No No
Interrupt sources 21 17 17 18 18 17 21
1/0 ports A.H J K A.C A.C A.E A.E A.C AE
Timers 4 4 4 4 4 4
Capture/Compare/PWM 2 2 2 2 2 1 1
modules
Enhanced Capture/ 0 0 0 0 0 0 1

Compare/PWM modules
Serial Communication MSSP, USART, MSSP, USART ~ MSSP, USART  MSSP, USART ~ MSSP, USART ~ MSSP, USART, MSSP, USART,

CAN CAN CAN
Parallel Communication PSP No No PSP PSP No PSP
10-bit A/D 16 channels 5 channels 5 channels 8 channels 8 channels 5 channels 8 channels
Low voitage detect Yes Yes Yes Yes Yes Yes Yes
Brown out reset Yes Yes Yes Yes Yes Yes Yes
Instruction set 77 77 77 77 77 77 77
Packages 80-pin TQFP 28-pin DIP 28-pin DIP 40-pin DIP 40-pin TQFP 28-pin SPDIP 40-pin PDIP
84-pin 28-pin SOIC 28-pin PLCC 40-pin PLCC 44-pin PLCC 28-pin SOIC 44-pin PLCC
CERQUAD 44-pin TQFP 44-pin TQFP 44-pin TQFP
80-pin PLCC

Table 1.1 m Features of the PIC18 Microcontrollers (continued)
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Feature PIC18F248 PIC18F448 PIC18F6620 PIC18F6720 PIC18F8620 PIC18F8720 PIC18F1220
Operating frequency DC-40 MHz DC-25 MHz DC-25 MHz DC-25 MHz DC-25 MHz DC-250 MHz  DC-40 MHz
Program memory 16 KB 16 KB 64 KB 128 KB 64 KB 128 KB 4 KB
Data memory 768 Bytes 768 KB 3840 Bytes 3840 Bytes 3840 Bytes 3840 Bytes 256 Bytes
Data EEPROM 256 Bytes 256 Bytes 1024 Bytes 1024 Bytes 1024 Bytes 1024 Bytes 256 Bytes
External program memory  No No No No Yes Yes No
Interrupt sources 17 21 17 17 18 18 15
1/0 ports A.C A.E A.G A.G A.H,J A.HJ A.B
Timers 4 4 5 5 5 5 4
Capture/Compare/ 1 1 5 5 5 5 1
PWM modules
Enhanced Capture/ 0 1 0 0 0 0 0
Compare/PWM modules
Serial Communication MSSP, USART, MSSP, USART, MSSP, USART  MSSP, USART ~ MSSP, USART ~ MSSP, USART  USART
CAN CAN
Parallel Communication No PSP PSP PSP PSP [ No
10-bit A/D module 5 channels 8 channels 12 channels 12 channels 16 channels 16 channels 7 channels
Low voltage detect Yes Yes Yes Yes Yes Yes Yes
Brown-out reset Yes Yes Yes Yes Yes Yes Yes
Instruction set 77 77 77 77 77 77 77
Packages 28-pin SPDIP  40-pin PDIP 64-pin TQFP 64-pin TQFP 80-pin TQFP 80-pin TQFP 18-pin SDIP
28-pin SOIC 44-pin PLCC 18-pin SOIC
44-pin TQFP 20-pin SSOP
28-pin QFN
Feature PIC18F1320 PIC18F2220 PIC18F2320 PIC18F2439 PIC18F2539 PIC18F8520 PIC18F8525
Operating frequency DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz
Program memory 8 KB 4 KB 8 KB 12 KB 24 KB 32 KB 48 KB
Data memory 256 Bytes 512 Bytes 512 Bytes 640 Bytes 1408 Bytes 2048 Bytes 3840 Bytes
Data EEPROM 256 Bytes 256 Bytes 256 Bytes 256 Bytes 256 Bytes 1024 Bytes 1024 Bytes
External program memory  No No No No No Yes Yes
Interrupt sources 15 19 19 15 15 18 17
1/0 ports A.B AC A.C A.C A.C AH,) AH
Timers 4 4 4 3 3 5 5
Capture/Compare/PWM 1 2 2 2 2 5 2
modules
Enhanced Capture/ 0 0 0 0 0 0 3
Compare/PWM modules
Serial Communication EUSART MSSP, USART ~ MSSP, USART  MSSP, USART ~ MSSP, USART  MSSP, MSSP,
USART (2) USART (2)
Parallel Communication No No No No No PSP PSP
10-bit A/D module 7 channels 10 channels 10 channels 5 channels 5 channels 16 channels 12 channels
Low voltage detect Yes Yes Yes Yes Yes Yes Yes
Brown out reset Yes Yes Yes Yes Yes Yes Yes
Instruction set 7 17 17 17 77 7 77
Packages 18-pin SDIP 28-pin SDIP 28-pin SDIP 28-pin DIP 28-pin DIP 80-pin TQFP 80-pin TQFP
18-pin SOIC 28-pin SOIC 28-pin SQIC 28-pin SOIC 28-pin SOIC
20-pin SSOP
28-pin QFN

Table 1.1 m Features of the PIC18 Microcontrollers (continued)




Both PIC18F8585 and PIC18F8680 can only work with 25 MHz crystal when external memory is enabled.

Feature PIC18F4439 PIC18FA4539 PIC18F6520 PIC18F6525 PIC18F6585 PIC18F6621 PIC18F6680
Operating frequency DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz
Program memory 12 KB 24 KB 32 KB 48 KB 48 KB 64 KB 64 KB
Data memory 640 Bytes 1408 Bytes 2048 Bytes 3840 Bytes 3328 Bytes 3840 Bytes 3328 Bytes
Data EEPROM 256 Bytes 256 Bytes 1024 Bytes 1024 Bytes 1024 Bytes 1024 Bytes 1024 Bytes
External program memory No No No No No No No
Interrupt sources 16 16 17 17 29 17 29
1/0 ports A.E A.E A.G A.G A.G A.G A.G
Timers 3 3 5 5 4 5
Capture/Compare/PWM 2 PWM 2 PWM 5 2 1 2 1
modules
Enhanced Capture/ 0 0 0 3 i 3 i
Compare/PWM modules
Serial Communication USART, USART, MSSP, MSSP, MSSP, MSSP, MSSP, EUSART,
MSSP MSSP USART (2) EUSART (2) EAUSART, EUSART (2) ECAN
ECAN
Parallel Communication PSP PSP PSP PSP PSP PSP PSP
10-bit A/D module 8 channels 8 channels 12 channels 12 channels 12 channels 12 channels 12 channels
Low voltage detect Yes Yes Yes Yes Yes Yes Yes
Brown out reset Yes Yes Yes Yes Yes Yes Yes
Instruction set 17 77 77 7 77 77 77
Packages 40-pin DIP 40-pin DIP 64-pin 64-pin TQFP 64-pin TQFP 64-pin TQFP 64-pin TQFP
44-pin TQFP 44-pin TQFP TQFP 68-pin PLCC
44-pin QFN 44-pin QFN
Feature PIC18F8585 PIC18F8621 PIC18F8680 PIC18F4220 PIC18F4320
Operating frequency DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz DC-40 MHz
Program memory 48 KB 64 KB 64 KB 4 KB 8 KB
Data memory 3328 Bytes 3840 Bytes 3328 Bytes 512 Bytes 512 Bytes
Data EEPROM 1024 Bytes 1024 Bytes 1024 Bytes 256 Bytes 256 Bytes
External program memory Yes Yes Yes No No
Interrupt sources 16 16 17 17 20
1/0 ports AH,J A.H,J A.H, 3 A.E A.E
Timers 4 5 4 4 4
Capture/ Compare/PWM 1 2 1 1 1
modules
Enhanced Capture/ 1 3 1 1 1
Compare/PWM modules
Serial Communication EAUSART AUSART (2) MSSP, MSSP, MSSP,
MSSP MSSP USART USART USART
ECAN ECAN
Paralle! Communication PSP PSP PSP PSP PSP
10-bit A/D module 16 channels 16 channels 16 channels 13 channels 13 channels
Low voltage detect Yes Yes Yes Yes Yes
Brown out reset Yes Yes Yes Yes Yes
Instruction set 77 77 77 77 77
Packages 80-pin TQFP 80-pin TQFP 80-pin TQFP 40-pin DIP 40-pin DIP
44-pin TQFP 44-pin TQFP
44-pin QFN 44-pin QFN
Note.

Table 1.1 m Features of the PIC18 Microcontrollers (concluded)




The block diagram of the PIC18 member PIC18F8720 is shown in Figure 1.1. This Figure
shows the peripheral functions implemented in the PIC18F8720. These are also discussed later
in more details.

PORTA

: == ; ’
2 ) B H
a— e | RAG
) | - FORTE R
N jpovan Jeoie R P s RESANTO
: | REWINTS
o — . | o REMINTZ
oo iL, Program AN ; - REYINTYOCRZ

Adbdreus Latoh

i {2 = ;
Osts Laich

§
|

W

REAKBIZPOC
REVEBINPGD

Byalam Bus s

PORTC

ROWTICGEOMTIACK -
RCUTOBICEPZ
ROMCCPY
ROVSOWSCL
ROASOVEDA

k 4

Py

ROGBHO
BOSITHACK
ROTRNHOTY

._ﬂ.’ K7} ROTIPSPT RDGPSPG

REOED
REVWR
REZDE
RE2

RE4

2

kA

Compamtor | | oopt cop2 copd cops

Figure 1.1 m Block diagram of the PIC18F8720 (reprint with permission of Microchip)
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1.5 The PIC18 Memory Organization

Memory consists of a sequence of directly addressable “locations.” A memory location is
referred to as an information unit. A memory location in the PIC18 holds eight bits of infor-
mation. Eight bits of information are called a byte. Sometimes one must deal with four bits of
information at a time. Four bits of information are called a nibble. A memory location can be
used to store data, instruction, the status of peripheral devices, and so on. An information unit
has two components: its address and its contents, shown in Figure 1.2.

Y

Address Contents

Figure 1.2 ® The components of a memory location

Each location in memory has an address that must be supplied before its contents can be
accessed. The CPU communicates with memory by first identifying the address of the location
and then passing this address on the address bus. This is similar to the fact that a mail carrier
needs an address in order to deliver a letter. The data is transferred between memory and the
CPU along the data bus.

To differentiate the contents of a register or memory location from the address of a register
or the memory location, the following notations are used throughout this text:

» [register address]: Refers to the contents of the register. For example, [WREG] refers
to the contents of the WREG register; [0x20] refers to the contents of the general-

purpose register at address 0x20. The prefix Ox indicates that the number is
represented in hexadecimal format. A number without a prefix is decimal.

® address: Refers to the register or memory location. For example, 0x10 refers to
special function register at address 0x10.

1.5.1 Separation of Data Memory and Program Memory

As shown in Figure 1.3, the PIC18 MCU assigns data and program to different memory
spaces and provides separate buses to them so that both are available for access at the same time.

Inside the MCU chip
[ — e e e — —  ————— ———————————— -
= e
1

Program é‘b“ program address 12-bit register address Data !
Memory : Memory :
IJ Space | _______ H Space !

1 (a portion .
! of this PIC18 gSpet(':laI '
i unction 1
| Stpt?: :IIICS:Sn cPU registers and | |
: chip) o - general 1
1 16-bit instruction bus 8-bit data bus purpose :
l RAM) |1
' |
d 1

Figure 1.3 m The PIC18 memory spaces
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The PIC18 MCU has a 21-bit program counter that is divided into three registers: PCU,
PCH, and PCL. Among them, only the PCL register is directly accessible to the user. Both the
PCH and the PCL are eight bits, whereas the PCU is five bits.

In the following discussion, memory addresses are referred to by using hex or decimal num-
bers. A hex number is indicated by adding a suffix H (or h) or prefix Ox to the number. For exam-
ple, 10H or 10h indicates hex 10 or decimal 16, and 0x20 represents the hex 20 or decimal 32.
The MPASM also allows us to use H'xx’ to specify a hex number xx and to use D’yy’ to specify
a decimal number yy. Hex refers to hexadecimal in the rest of this text.

Many digital systems have a large amount of memory. Therefore, special terms are often
used to refer to the size of memory system. Among them, KB, MB, and GB are most often used:

= 1 KB refers to 210 (1,024} bytes of memory.
m 1 MB refers to 220 {1,048,576) bytes of memory.
= 1 GBrefers to 230 {1,073,741,824) bytes of memory.

1.5.2 PIC18 Data Memory

The PIC18 data memory is implemented as SRAM. Each location in the data memory is
also referred to as a register or file register. The PIC18 MCU supports 4096 bytes of data mem-
ory. It requires 12 bits of address to select one of the data registers. The data memory map of
the PIC18 MCU is shown in Figure 1.4.

BSR<3:0>
= 0000 | __Accessam____| 0%
> Bank 0 060h
GPRs
QFFh
= 0001 100h
> Bank 1 GPRs
1FFh
200h
=0010
> Bank 2 GPRs
2FFh
300h
= 0011 Bank 3 Access Bank
j GPRs 3FFh Access RAM low gggg
400h Access RAM high | 060h
SFRs OFFh
Bank 4
to )k GPRs A
Bank 13 /IO AN
DFFh
EQOOh
=1110
> Bank 14 GPRs
EFFh
FOOh
=1n | ____Unused ___ F5Fh
_— Bank 15 F60h
SFRs
FFFh

Note. 1. BSR is the 4-bit bank select register.

Figure 1.4 m Data memory map for PIC18 devices (redraw with permission of Microchip)
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Because of the limited length of the PICI8 instruction (most instructions are 16 bits), only
eight bits of the PIC18 instruction are used to specify the file register to be operated on. As a
result, the PIC18 designers divided the 4096 file registers into 16 banks. Only one bank of 256
file registers is active at any time. An additional four bits are placed in a special register called
bank select register (BSR) to select the bank to be active. The user needs to change the contents
of the BSR register in order to change the active bank.

There are two types of registers: general-purpose registers (GPRs) and special-function reg-
isters (SFRs). GPRs are used to hold dynamic data when the PIC18 CPU is executing a program.
SFRs are registers used by the CPU and peripheral modules for controlling the desired operation
of the MCU!. These registers are implemented as SRAM. A summary of these SFRs is listed in
Appendix A.

The SFRs are assigned from the highest addresses and downward, whereas GPRs start from
address 0 and upward. Depending on the device, some of the GPRs in the middle are not imple-
mented. For example, the PIC18F452 has 1536 (six banks) bytes of data memory, and then banks
0 to 5 and bank 15 are implemented. The first 96 bytes (in bank 0, 0x000-0x05F) of the GPRs and
the last 160 bytes (in bank 15, 0xF60-0xFFF) of the SFRs are grouped into a special bank called
access bank. The functioning of the access bank is explained in Section 1.8. For the PIC18F242/
252/442/452 MCUs, the access bank comprises of the upper 128 bytes in bank 15 and the lower
128 bytes in bank 0.

1.5.3 EEPROM Data Memory

At the time of this writing, all the PIC18 devices that have on-chip flash program mem-
ory also have either 256 bytes or 1024 bytes of data EEPROM. The data EEPROM is readable
and writable during normal operation over the entire power supply range. The data EEPROM
memory is not directly mapped in the register file space. Instead, it is indirectly addressed
through the special function register. The operation of the data EEPROM is discussed in
Chapter 14.

1.5.4 Program Memory Organization

Each PIC18 member has a 21-bit program counter and hence is capable of addressing the 2-MB
program memory space. Accessing a nonexistent memory location will cause a read of all Os.

Different members of the PIC18 family have different memory configurations. The PIC18CXX2
and PIC18CXX8 devices have on-chip EPROM program memory only and cannot access external
memory. The PIC18C601 and PIC18C801 do not have on-chip memory. The PIC18C601 is capa-
ble of accessing 256 KB of external program memory, whereas the PIC18C801 can access 2 MB of
external program memory. The PICI8FXX2, PIC18FXX8, and the PIC18F6620/6720 devices have
on-chip flash program memory only. The PIC18F8585/8680/8621/8620/8720 can also access
external program memory in addition to their on-chip flash program memory.

The PIC18 MCU has a 31-entry return address stack that is used to hold return addresses
for subroutine call {to be discussed in Chapter 4} and interrupt processing {to be discussed in
Chapter 6). This return address stack is not part of the program memory space. The program
memory map is illustrated in Figure 1.5.
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PC<20:0>

= oy

stack level 1

stack level 31

Reset Vector ooooooh 1

High Priority Interrupt Vector 000008h

Low Priority Interrupt Vector 000018h

On-chip and external
program memory

—

yxoooxh User Memory Space

Unimplemented
program memory
Read '0'

1FFFFFh _Y_

Note. y can be 0 or 1 whereas x can be 0-F

Figure 1.5 m PIC18 memory organization (redraw with permission of Microchip)

As shown in Figure 1.5, the address 000000h is assigned to the reset vector, which is the
program-starting address after power-on or manual reset. The address 000008h is the starting address
of the high-priority interrupt service routine. Sixteen bytes are allocated to the high-priority inter-
rupt service routine by default. The address 000018h is the starting address for the low-priority inter-
rupt service routine, and there is no default size for this service routine. The user program should
follow the low-priority interrupt service routine. Reset is also discussed in Chapter 6.
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1 6 The PIC18 CPU Reglsters B

The PIC18 MCU has a group of registers, from 0xFDS8 to OxFFF {hsted in Table 1. 2) in the
data memory space that are dedicated to the general control of the CPU operation. This group
of registers can be referred to as CPU registers. Each of these CPU registers is discussed in an
appropriate chapter of this book.

address Name Description

OxFFF TOSU Top of stack (upper)

OxFFE TOSH Top of stack (high)

OxFFD TOSL Top of stack (low)

OxFFC STKPTR Stack pointer

OxFFB PCLATY Upper program counter latch
OxFFA PCLATH High program counter latch

OxFF9 PCL Program counter low byte

OxFF8 TBLPTRU Table pointer upper byte

OxFF7 TBLPTRH Table pointer high byte

OxFF6 TBLPTRL Table pointer low byte

OxFF5 TABLAT Table latch

OxFF4 PRODH High product register

OxFF3 PRODL Low product register

OxFF2 INTCON Interrupt control register

OxFF1 INTCON2 Interrupt contro! register 2

OxFFO INTCON3 Interrupt control register 3

OXFEF INDFO (1) Indirect file register pointer 0
OXFEE POSTINCO (1) Post increment pointer O (to GPRs)
OXFED POSTDECO () Post decrement pointer 0 (to GPRs)
OXFEC PREINCO (D Preincrement pointer 0 (to GPRs)
OxFEB PLUSWO () Add WREG to FSRO

OxFEA FSROH File select register O high byte
OxFE9 FSROL File select register O low byte
OxFE8 WREG Working register

OxFE7 INDF1 () Indirect file register pointer 1
OXFEB POSTINC1 () Post increment pointer 1 (to GPRs)
OxFE5 POSIDEC1 (D) Post decrement pointer 1 (to GPRs)
OxFE4 PREINC1 () Preincrement pointer 1 (to GPRs)
OxFE3 PLUSW1 (1 Add WREG to FSR1

OxFE2 FSR1H File select register 1 high byte
OxFE1 FSR1L File select register 1 iow byte
OxFEO BSR Bank select register

OxFDF INDF2 (1 Indirect file register pointer 2
OxFDE POSTINC2 (B Post increment pointer 2 (to GPRs)
0xFDD POSRDEC2 (U Post decrement pointer.2 (to GPRs)
OxFDC PREINC2 Preincrement pointer 2 (to GPRs)
OxFDB PLUSW2 (D Add WREG to FSR2

OxFDA FSR2H File select register 2 high byte
OxFD9 FSR2L File select register 2 low byte
OxFD8 STATUS Status register

Note. This is not a physical register

Table 1.2 m PIC18 CPU registers
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The STATUS register, shown in Figure 1.6, contains the arithmetic status of the ALU. As
with any other register, the STATUS register can be the destination of any instruction. If the
STATUS register is the destination for an instruction that affects the Z, DC, C, OV, or N bits,
then the write to these five bits is disabled. These bits are set or cleared according to the device
logic. Therefore, the result of an instruction with the STATUS register as the destination may
be different than intended. It is recommended, therefore, that only BCF, BSF, SWAPF, MOVEF,
and MOVWEF instructions be used to alter the STATUS register because these instructions do
not affect the Z, C, DC, OV, or N bits of the STATUS register.

N: Negative bit
1 = arithmetic result is negative
0 = arithmetic result is positive

OV: Overfiow bit
1 = Overflow occurred for signed arithmetic
0 = No overflow occurred

Z: Zero flag
1 = The result of an arithmetic or logic operation is zero.
0 = The result of an arithmetic or logic operation is not zero.

DC: Digit carry/borrow bit
For ADDWF, ADDLW, SUBLW, SUBWEF instructions.
1 = A carry-out from the 4th low-order bit of the result occurred.
0 = No carry-out from the 4th low-order bit of the result occurred.
For borrow, the polarity is reversed. For rotate (RRF, RLF)
instructions, this bit is loaded with either the bit 4 or bit 3 of the
source register.

C: Carry/borrow bit
For ADDWF, ADDLW, SUBLW, SUBWEF instructions.
1 = A carry-out from the most significant bit of the resuit occurred.
0 = No carry-out from the most significant bit of the result has

occurred.
For borrow, the polarity is reversed. For rotate (RRF, RLF)
instructions, this bit is loaded with either the high or low order bit
of the source register.
Figure 1.6 m The STATUS register (OxFD8) (redraw with permission of Microchip)

The WREG register (referred to as working register) is a special register that is involved in
the execution of many instructions and can be the destination of many instructions.
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1.7 The PIC18 Pipelining

The PIC18 designer divided the execution of most of the PIC18 instructions into two stages
(instruction fetch and instruction execution) and then overlapped the execution of two consec-
utive instructions. Each stage takes one instruction clock cycle to complete. The result of the
overlap of instruction execution is that most instructions take one instruction clock cycle to
complete. This scheme is called instruction pipelining. An example of instruction pipelining is
illustrated in Figure 1.7.

TCYO TCY1 TCY2 TCY3 I TCY4 I TCY5 |
MOVLW 55h fetch 1 execute 1
MOVWF PORTB fetch 2 execute 2
BRA sub_1 fetch 3 execute 3
BSF PORTA,BIT3 fetch 4 flush
Instruction @address sub_1 fetch sub_1 | execute sub_1

Note: All instructions are single cycle, except for any program branches.

Figure 1.7 ® An example of instruction pipeline flow

There are two problems caused by instruction pipelining: data dependency hazard and con-
trol hazard. In a prograim, it is common for one instruction to perform further operation on the
result produced by the previous instruction. If the pipeline is designed in a way that the earlier
instruction cannot write the result back to the register or memory location before it is used by
the following instruction(s], then the data-dependency hazard has occurred. Most of the data-
dependency hazards can be solved by result forwarding. However, if an instruction reads from
a memory location (e.g., a load instruction) whereas the following instruction will use the
returned value to perform certain operation, then result forwarding cannot resolve the hazard.
This problem is usually solved by rearranging the instruction sequence to avoid this type of data
dependency or inserting a no-op instruction. The dependency hazard problem will occur on
pipelined processors with more than two stages. The PIC18 instruction pipeline has only two
stages and does not have data-dependency hazard problems.

Control hazard is caused by branch instructions. Whenever a branch instruction reaches the
execution stage and the branch is taken, then the following instructions in the pipeline need to
be flushed because they are not allowed to take any effect by the program logic. In Figure 1.7,
the instruction BSF PORTA, BITS3 is flushed when it reaches the execution stage for this rea-
son. There are several options to deal with control hazards in a pipelined processor. However,
this issue is beyond the scope of this text.

The PIC18 MCU needs to access program memory during the instruction fetch stage and
needs to access data memory during the instruction execute stage. When pipelining the execu-
tion of instructions, the PIC18 MCU needs to access the program memory and the data mem-
ory in the same clock cycle. This requirement is satisfied by separating the program memory
from the data memory and providing separate buses to them.

The pipelined processor is explained clearly in Patterson and Hennessy’'s book Computer
Organization published by Morgan Kaufman.
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1.8 PIC18 Instruction Format

It was mentioned in Section 1.5.2 that data memory is divided into banks. Why would the
banking scheme be used to control the access of data memory? The instruction format must be
defined in order to understand this issue.

The instruction set is grouped into five basic categories:

1. Byte-oriented operations. The format of byte-oriented instructions is shown in
Figure 1.8. The 6-bit field opcode specifies the operation to be performed by the ALU.

15 10 9 8 7 0

opcode d a f

d = 0 for result destination to be WREG register.
d = 1 for result destination to be file register (f)
a = 0 to force Access Bank

a =1 for BSR to select bank

f = 8-bit file register address

Figure 1.8 m Byte-oriented file register operations (redraw with permission of Microchip)

2. Byte-to-byte operations (two-word). The format of the instruction in this category is
shown in Figure 1.9. There is only one instruction that uses this format: movff f1, £2,
This instruction allows one to move data from one file register to another.

15 12 11 0

opcode f (source file register)

15 12 1 0

1111 f (destination file register)

f = 12-bit file register address

Figure 1.9 m Byte-to-byte move operations (2 words) (redraw with permission of Microchip)

3. Bit-oriented file register operations. The format of instructions in this category is shown
in Figure 1.10. This format uses an 8-bit field (f} to specify a file register as the operand.

15 12 11 9 8 7 0

opcode b a f

b = 3-bit position of bit in the file register (f).
a = 0 to force Access Bank
a =1 for BSR to select bank

f = 8-bit file register address

Figure 1.10 m Bit-oriented file register operations (redraw with permission of Microchip)
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4. Literal operations. Instructions in this category specify a literal (a number) as an
operand. The format of instructions in this category is shown in Figure 1.11.

15

8 7

opcode

k = 8-bit immediate value

Figure 1.11 m Literal operations (redraw with permission of Microchip)

5. Control operations. The format of instructions in this category is shown in Figure 1.12.
The notation n<7:0> stands for the bit 7 to bit 0 of the number n, whereas the notation
n<19:8> stands for the bit 19 to bit 8 of the number n. The notation n<10:0> means that
the number n is an 11-bit number. There are four different variations in their formats.

15 7
opcode n<7:0> (literal)
15 7
1111 n<19:8> (literal)
n = 20-bit immediate value
15 7
opcode n<7:0> (literal)
15 7
1111 n<19:8> (literal)
S = fast bit
15 11 10
opcode n<10:0> (literal)
15 7
opcode n<7:0> (literal)

Figure 1.12 m Control operations (redraw with permission of Microchip)

GOTO label

CALL funct_name

BRA func_name

BC func_name

As shown in Figures 1.8 to 1.12, all the PIC18 instructions use eight bits to specify the data
register operand. A data register (excluding WREG) is also called a file register. Only 256 differ-
ent registers can be specified by eight bits. However, all the PIC18 devices have more than
256 file registers, and hence additional information is needed to pinpoint the exact register to
be operated on. This additional information is stored in the BSR register. The designer of the
PIC18 MCU divided data memory into 16 {maximum} banks, with each bank having 256 data
registers. The BSR register specifies the bank, and the f field in the instruction specifies the reg-

ister number within the bank.
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The banking scheme has been used in the PIC12, the PIC14000, the PIC16, and the PIC17
MCUs. This scheme allows a PIC MCU to incorporate more than 256 data registers on the CPU.
However, it also adds a significant amount of overhead to the software because of the need to
switch from one bank to another. In addition, it is easy to forget about bank switching, which
will cause the software to fail.

In order to solve the problem caused by the banking scheme, the designers of the PIC18
MCU incorporated the access bank. The access bank consists of the lowest 96 GPRs and the
highest 160 SFRs. As long as an instruction specifies a data register in the access bank, banking
is ignored, and bank switching is unnecessary. All SFRs except a subset in the CAN module are
in the access bank (CAN stands for controller area network). This makes bank switching unnec-
essary in many cases.

When bank switching is needed, the movlb k instruction can be used. This instruction
places the value of k in the lower four bits of the BSR register. The result of the execution of
this instruction is that it caused the data registers in bank k to become active.

In Figures 1.8 and 1.10, the a field in the PIC18 instruction allows the user to select the
access bank. When writing program in assembly language, the assembler (MPASM} allows
the user to use the letter A {a = 0) to specify the access bank. When the access bank is not
chosen, one should use the word BANKED (a = 1) to allow the BSR register to do the bank
selection.

The d field in Figure 1.8 allows the user to choose either the WREG or the file register as
the destination of the instruction. The assembler allows the user to use the letter F (d = 1) to
specify a file register and use the letter W (d = 0) to specify the WREG register as the destina-
tion. For example,

addwf sum, F, A ;sum is a GPR

adds the WREG register and sum in the access bank and places the result in sum.
addwf sum,W, A

performs the same operation but leaves the result in the WREG register.

1.9 Addressing Modes

All MCUSs use addressing modes to specify the operand to be operated on. The PIC18 MCU
provides register direct, immediate, inherent, indirect, and bit-direct addressing modes for spec-
ifying instruction operands. As discussed in Chapter 2, assembler directives allow the user to
use symbols to refer to memory locations. Using symbols to refer to memory locations makes
the user program more readable. During the following discussion, symbols are used to refer to
memory locations when appropriate.

1.9.1 Register Direct

The PIC18 device uses an 8-bit value to specify a data register as an operand. The register
may be in the access bank or other banks. In the first case, the 8-bit value is used to select a reg-
ister in the access bank, and the bank value in the BSR register is ignored. If the access bank is
not selected, then the access is completed from the memory of the bank specified in the BSR
register. The following instructions illustrate the register direct addressing mode:

movwf Ox1A, BANKED
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copies the contents of the WREG register to the memory location 0x1A in the bank specified by
the BSR register. The word BANKED {must be in uppercase) informs the assembler that the BSR
register must be included in specifying the data register to be operated on.

movwf 0x45, A
copies the contents of the WREG register to the memory location 0x45 in the access bank.
movff regl, reg2

copies the contents of the register regl to the register reg2. Both regl and reg2 are 12-bit values.
The value of BSR is ignored.

1.9.2 Immediate Mode

In the immediate addressing mode, the actual operand is provided in the instruction. There
is no need to access any memory location. The following instructions illustrate the immediate
addressing mode:

addiw 0x20
adds the hex value 20 to the WREG register and places the sum in the WREG register.

movlw 0x15
loads the hex value 15 into the WREG register.

movlb 3
places the decimal value 3 in the lower four bits of the BSR register. The lower four bits become

0011. This instruction makes bank 3 the active bank. The value to be operated on directly is
often called literal.

1.9.3 Inherent Mode

In the inherent mode, the operand is implied in the opcode field. The instruction opcode
does not provide the address of the implied operand. The following instructions illustrate the
inherent mode:

movlw 0x20

places the hex value 20 (decimal 32) in the WREG register. In this example, the value 0x20 is
specified in the instruction machine code. The destination WREG is implied in the opcode field.
No other address information for the WREG register is supplied.

andlw Ox13

performs an AND operation on the corresponding bits of the hex number 13 and the WREG reg-
ister (i.e., bit i of WREG and with bit i of the value 0x13;i=0. . . 7). In this example, only the
immediate value 0x13 is specified in the instruction machine code. The address of the WREG
register OxFE8 is not specified.

1.9.4 Indirect Mode

In this mode, a special function register is used as a pointer to the data memory location
that is to be read and written. Since this register is in SRAM, the contents can be modified by
the program. This can be useful for data tables in data memory and for software stacks. The
software stack will be explained in Chapter 4.
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There are three indirect addressing registers: FSRO, FSR1, and FSR2. To address the entire
data memory space {4096 bytes), 12 bits are required. To store the 12-bit address information,
two 8-bit registers are used. These indirect addressing registers are the following:

1. FSRO: composed of FSROH and FSROL
2. ESR1: composed of FSR1H and FSR1L
3. FSR2: composed of FSR2H and FSR2L

After placing the address of the data in one of the FSR registers, one needs to read from or write
into one of the three registers that are not physically implemented in order to activate indirect
addressing. These three registers are INDFQ, INDF1, and INDE2.

If an instruction writes a value to INDFQ, the value will be written to the data register with
the address indicated by the register pair FSROH:FSROL. A read from INDF1 reads the data from
the data register with the address indicated by the register pair FSRIH:FSRIL. INDFn can be
used in a program anywhere an operand can be used. The process of indirect addressing is illus-
trated in Figure 1.13.

11 8 7 0
l FSRnH i FSRnL |
J

Location select \
0x000
Accessing INDFn
~—
Data memory
OxFFF

Figure 1.13 m Indirect addressing
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Each FSR register has an INDF register associated with it plus four additional register
addresses. Performing an operation on one of these five registers determines how the FSR will
be modified during indirect addressing:

1. Do nothing to FSRn after an indirect access. This access is specified by using the
register INDFn (n=0. . . 2).

2. Auto-decrement FSRn after an indirect access (postdecrement). This access is specified
by using the register POSTDECn (n=0. . . 2].

3. Auto-increment FSRn after an indirect access (postincrement). This access is specified
by using the register POSTINCn (n=0. . .2).

4. Auto-increment FSRn before an indirect access (preincrement). This access is specified
by using the register PREINCn (n=0. . . 2).

5. Use the value in the WREG register as an offset to FSRn. The signed value in WREG is
added to the value in FSR to form an address before performing an indirect access.
Neither the WREG nor the FSRn is modified after the access. This access is specified
by using the register PLUSWn.
The following examples illustrate the usage of indirect addressing modes:
movwf INDFO
copies the contents of the WREG register to the data memory location specified by the FSRO

register. After the execution of this instruction, the contents of the FSRO register are not
changed.

movwf POSTDECO

copies the contents of the WREG register to the data memory location specified by the FSRO
register. The contents of FSRO are decremented by 1 after the operation.

movwf PREINCO

first increments the FSRO register by 1 and then copies the contents of the WREG register to the
data memory location specified by the FSRO register.

cif  PLUSWO

clears the memory location at the address equal to the sum of the value in the WREG register
and that in the FSRO register.

In the previous examples, one does not need to specify whether the register is in the
access bank because the complete 12-bit data register address is taken from one of the FSR
registers.

1.9.5 Bit-Direct Addressing Mode

The PIC18 MCU has five instructions to deal with an individual bit. These instructions use
three bits to specify the bit to be operated on. For example,

BCF PORTB,3,A ; integer 3 specifies the bit to be cleared

clears bit 3 of the data register PORTB, which will then pull the port B pin RB3 to low.
BSF PORTA,4,A ; integer 4 specifies the bit to be set

sets bit 4 of the data register PORTA, which will then pull the port A pin RA4 to high.
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1.10 A Sample of PIC18 Instructions

Example 1.1

The PICI18 has 77 instructions. Four of these are 32-bit instructions, whereas the others are
all 16 bits. A subset of the PIC18 instructions is examined in this section.

1.10.1 Data Movement Instructions

Memory data must be placed in appropriate registers before useful operations can be per-
formed. Data movement instructions are provided for this purpose. A subset of the data move-
ment instructions is listed in Table 1.3.

Mnemonic Description 16-bit instruction word Status affected

ffsr f,k load FSR 1110 1110 00ff kqikkk None
1111 0000 kykkk kikk

movf f, d,a Move f 0101 00da ffff  ffff Z,N

movff fs, fd Move fs (source) to f 1100 ffff  ffff  ffff None
1111 ffff  fiff  ffff

mowwf, fa Move WREG to f 0110 111a fiff  ffif None

swapf f,d,a Swapp nibbles in f 0011 10da fiff  ffff None

movlb  k Move literal to BSR<3:0> 0000 0001 kkkk kkkk None

moviw  k Move literal to WREG 0000 1110 kkkk kkkk None

Note. Both LFSR f, kand MVFF fs, fd are 32-bit instructions

Table 1.3 ®m A sample of PIC18 data movement instructions

The instruction lsr f, k, a 32-bit instruction, allows the user to place a 12-bit value in the
FSR register specified by the value f. Two bits are provided for selecting the FSR registers
(FSRO-FSR2). A 12-bit value (k) is contained in the instruction. The upper four bits (represented
as kj;kkk in Table 1.3) of k are contained in the first word of the instruction, whereas the lower
eight bits (represented as kykkk kkkk in Table 1.3) are contained in the second word.

The instruction movt {, d, a in Table 1.3 is provided for easy migration from the PIC16 fam-
ily to the PIC18 family because the PIC16 family also has the same instruction. By setting the
d field to O (represented by the letter W), this instruction will copy the contents of a file regis-
ter to the WREG register. For example, the instruction

movf 0x20,W,A

will copy the contents of the data register at 0x20 to the WREG register.

The movif instruction, a 32-bit instruction, can copy a file register in one bank to a file reg-
ister in another bank without referring to the BSR register. Both the source and the destination
registers are specified in 12 bits.

The movlb k instruction sets the bank k as the active bank. The movlw k instruction places
the value k in the WREG register.

Write a PIC18 instruction (or instruction sequence) to transfer data from (a) WREG to data
register at 0x30, (b) the data register at 0x30 to the data register at 0x40, (c) the data register at
0x40 to WREG, and (d) load the value 0x200 into FSRO.
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Solution:

(a) movwf 0x30,A ; force access bank

(b) movff 0x30, 0x40 ;

(c) movf 0x40,W,A ; force access bank and copy register 0x40 to WREG
(d) Ifsr FSRO, 0x200 ; load the value 0x200 into FSRO

A

1.10.2 ADD Instructions

ADD is the generic name of a group of instructions that perform the addition operation. The

ADD instruction may have two or three operands. A three-operand ADD instruction includes the
carry flag in the STATUS register as one of the operand. The PIC18 MCU has 3 ADD instructions:

addwff, d, a ; add WREG and f
addwfc f, d, a ; add WREG, carry bit, and f
addiw k : add literal k to WREG

A

Example 1.2

Write an instruction to perform the following operations:

(a) Add the content of WREG and that of the data register at 0x40 (in access bank) and leave the sum in WREG.

(b) Increment the WREG register by 5.

(c) Add the WREG register, the register with the name of sum, and carry and leave the result in sum. The variable
sum is in access bank.

Solution:

(a) addwf Ox40,W,A
(b) addlw 5
(c) addwfc sum, F, A

A

Example 1.3

Write an instruction sequence to increment the contents of three registers 0x30-0x32 by 3.

Solution: The procedure for incrementing the value of a register by 3 is as follows:

Step 1

Place the value 3 in the WREG register.
Step 2

Execute the addwi {, d, a instruction.

The following instruction will increment the specified three registers by 3:

moviw 0x3
addwf 0x30, F, A ; increment the register at 0x30 by 3
addwf 0x31, F, A ; increment the register at 0x31 by 3

addwf 0x32, F, A ; increment the register at 0x32 by 3
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Write an instruction sequence to add the contents of three data registers located at

0x40-0x42 and store the sum at 0x50.

Solution: The required operation can be achieved by the following procedure:

Step 1

Load the contents of the register at 0x40 into the WREG register.
Step 2

Add the contents of the register at 0x41 into the WREG register.
Step 3

Add the contents of the register at 0x42 into the WREG register.
Step 4

Store the contents of the WREG register in the register at 0x50.

The following instructions will perform the desired operation:

movf 0x40, W, A ; WREG « [0x40]
addwf Ox41, W, A ; add the contents of the register at 0Ox41 to WREG
addwf 0x42, W, A ; add the contents of the register at 0x42 to WREG
movwf 0x50, A ; 0x50 « [WREG]

A

Example 1.5

Write an instruction sequence to add 10 to the data registers at 0x300-0x303 using the indi-

rect postincrement addressing mode.

Solution: The procedure for solving this problem is as follows:

Step 1

Load the value 0x300 into the FSRO register.

Step 2

Load the value 10 into the WREG register.

Step 3

Add the value in WREG to the data register pointed by FSRO using the indirect
postincrement mode.

Step 4

Repeat Step 3 three more times.

The instruction sequence that carries the operations from Step 1 to Step 3 is as follows:

moviw 0x0A

[fsr FSR0,0x300 ; place 0x300 in FSRO
addwf POSTINCO,F

addwf POSTINCO,F

addwf POSTINCO,F

addwf POSTINCO,F
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1.10.3 SUB Instructions

SUB is the generic name of a group of instructions that perform the subtraction operation.
The SUB instruction may have two or three operands. A three-operand SUB instruction includes
the carry flag in the STATUS register as one of the operands. The PIC18 MCU provides four
SUB instructions:

subfwb f,da ; subtract f from WREG with borrow

subwf f,d,a ; subtract WREG from f

subwfb f,da ; subtract WREG from f with borrow

sublw k ; subtract WREG from literal

Example 1.6

Write an instruction sequence to subtract 9 from the data registers located at 0x50-0x53.

Solution: This operation can be implemented by placing 9 in the WREG register and then exe-
cuting the subwf f,F,A instruction. The following instruction sequence will implement the
required operation:

movlw 0x09 ; place 9 in the WREG register

subwf 0x50,F,A ; decrement the contents of the register at 0x50 by 9
subwf 0x51,F A ; decrement the contents of the register at 0x51 by 9
subwf 0x52,F,A ; decrement the contents of the register at 0x52 by 9
subwf 0x53,F,A ; decrement the contents of the register at 0x53 by 9

Example 1.7

Write an instruction to perform each of the following operations:
Subtract the WREG register from the file register at 0x30 and leave the difference in the file register at 0x30.

Subtract the file register at 0x30 and borrow from the WREG register.
Subtract the WREG register from the file register at 0x50 and leave the difference in WREG.

Solution: The following instructions will perform the specified operations:
(a)  subwfOx30, F, A

(b)  subfwb Ox30, W, A
(c)  subwf Ox50,W,A

1 11 Overv1eW of the 8-Bit MCU Market

There are many dlfferent 8 -bit MCUs in the market today Some of them follow the RISC
design approach, whereas others follow the CISC design approach. This section briefly reviews
the history of RISC and CISC and then provides a brief overview of the 8-bit MCU market.



30

Chapter 1 m introduction to the PIC18 Microcontroller

1.11.1 CISC versus RISC

In the past, processor design followed either the Complex Instruction Set Computer (CISC)
approach or the Reduced Instruction Set Computer (RISC) approach. The instructions of a
processor designed with the CISC philosophy tend to be more complicated and perform more
functions. The processor designers in the CISC camp believed that the instruction set designed
with this philosophy in mind could make the machine code shorter and better match the syn-
tax of high-level languages and hence could support high-level languages better. Experience
proved that the resultant machine code was indeed shorter. However, many of the complex
instructions are rarely used by the compiler, and the performance of the resultant machine was
poor. In addition, the CISC computer took a longer time to design, which would likely cause
the market window to be missed.

On the contrary, instructions of a RISC processor perform only simple operations. The
addressing modes supported by a RISC computer tend to be simple as well. The followers of the
RISC philosophy believed that a simple instruction set and simple addressing modes could sim-
plify the design of the processor and that the resultant processor could run at a faster clock rate.
More important, the RISC computer takes a shorter time to design and can be put on the mar-
ket sooner. The earliest RISC processors have the following common features:

® Pipelined instruction execution.
®  Fixed-length instructions (all instructions are either 32 or 16 bits long).
® Simple instruction set, simple instruction formats, and simple addressing modes.

= Large number of registers to support register-to-register operations (such operations
are faster than register-to-memory or memory-to-memory operations).

® Delayed branch instruction. The earliest RISC processor allowed the instruction
that followed the branch instruction to take effect regardless of whether the branch
was taken. The purpose of this technique is to reduce the performance reduction
caused by the branch instruction. This technique is no longer supported in the
current generation RISC processors.

® Separation of the data memory and the program memory to allow simultaneous
access of two memories. The computer architecture with separate data memory
and program memory is often called Harvard architecture.

The compiled program for the RISC processor tends to be longer than its counterpart for the
CISC processor. However, the resultant program for a RISC processor can run faster than its
counterpart in a CISC processor. The current practice of processor design is to combine the
strengths of both the RISC and the CISC processor.

Computer makers like to benchmark the performance of one another’s machines. The
adopted metric for comparing the performance of different machines is the running times of the
same set of application programs on different machines. Because of the differences in design,
machine A may run certain applications faster than machine B but run other applications
slower than machine B. The selection of the set of application programs for comparison is
arguable. Other metrics were also used to compare the performance of different machines. A
common but inaccurate metric is MIPS {million instructions per second). It is obvious that
MIPS means different things for processors with different instruction sets. The drawbacks of
this metric have been detailed in Patterson and Hennessy’s books. For computers made of the
same microprocessor, the MIPS is a good metric for performance comparison if the same com-
piler is used.
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1.11.2 Major 8-Bit MCUs

The 8-bit MCU market has experienced significant growth in the past decade. More than a
billion 8-bit MCUs have sold annually in the past few years. Microchip started to fabricate
8-bit MCUs in late 1980s and by 1999 had sold its first billion MCUs. Thirty months later {in
May 2002), Microchip had sold another billion MCUs. This statistic shows the strength of the
8-bit MCU market. In July 2003, Microchip became the number one vendor of the 8-bit MCU
in terms of units of shipment. The success of the Microchip 8-bit MCUs can be attributed to
the following factors:

»  Cost effectiveness. MCUs made by Microchip follow the RISC design philosophy.
They provide a simple instruction set and a fixed instruction length and use the
pipelining technique to achieve high instruction execution throughput. Many
Microchip devices have flash memory and provide in-system programming {ISP)
capability, which allows the end user to upgrade product software without
removing the MCU from the end product, an attractive feature. In addition,
Microchip sells its MCU s at a competitive price.

s Rich peripheral functions. MCUs from Microchip have implemented all the
peripheral functions that can be found in MCUs from other vendors. These
peripheral functions include (1) parallel I/O ports; (2) timer functions, such as input
capture, output compare, pulse-width modulation (PWM), counters, real-time
interrupt (RTI), and watchdog timer; (3) 8-bit to 12-bit A/D converter; (4) multiple
serial interface protocols (USART, SPI, and I?C}; and (5) controller area network
(CAN) controller.

»  Technical support. Microchip provides sample designs and design consultation
service to help its customers. Customers can ask for technical questions via phone
calls or e-mail.

» Development tools support. The MPLAB-: IDE from Microchip is undoubtedly the
most important component in this area. MPLAB IDE is essentially an integrated
development environment that incorporates a text editor, cross assemblers,
simulators, programmer drivers, and a source-level debugger. It allows the user to
perform source-level debugging in assembly or C language. Microchip makes
MPLAB IDE even more attractive: it is free. Microchip also provides demo boards,
programmers, in-circuit emulators, C compilers for the PIC17 MCU and the PIC18
MCU, and low-cost in-circuit debuggers to help customers develop their products.
Many of these development tools are reviewed in Chapter 3.

»  University program. Universities can request (so do other commercial users) free
samples of MCUs and other development tools. Universities and students can
purchase Microchip products at a discounted price. The web address for Microchip
is www.microchip.com.

The PIC18 MCU can run with a 40-MHz crystal oscillator. With pipelining, most of the
PIC18 instructions will take one instruction cycle (four crystal oscillator cycles) to execute.
Therefore, the PIC18 MCU's performance is close to 10 MIPS.

Other major 8-bit MCUs include the following:

m  The 68HCO05, 68HCO08, and 68HC11 from Motorola
» The 8051/8052 variants from more than 45 companies
s The AVR from Atmel
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1.11.3 Motorola 8-Bit MCUs

Motorola is competing with Microchip for being the leader in terms of units of shipment of
8-bit MCUs. The 68HCO05 and the 68HC08 MCUs are designed to serve low-end applications.
The 68HCI11 is the high-end 8-bit MCU from Motorola and was initially designed to serve the
automotive market. The 68HCI11 follows the CISC design philosophy. Its rich instruction set
and addressing modes illustrate that. The rich instruction set and addressing modes make
assembly programming easy. However, this is not an advantage for C programmers. Motorola
has a good university support program. They provided free samples, low-cost demo boards, and
free software (cross assembler) to help promote the 68HC11 and made it the most taught 8-bit
MCU in U.S. universities. Most 68HC11 MCUs do not have on-chip flash memory. Serial inter-
face protocols, such as UART and SPI, are standard. The 68HC11 provides a rich set of timer
functions, including input capture, output compare, real-time interrupt (RTI), computer operate
properly (COP) timer, and pulse accumulator. Most of the 68HC11 members have 8-bit A/D res-
olution only and do not implement the PWM function, which is an important feature for auto-
motive and motor control applications. Motorola realizes these drawbacks and hence is pushing
68HCO8 to take over the low-end applications of the 68HC11 and introduced the 16-bit HCS12
to take over 68HC11’s high-end applications. Most of the 68HC08 members and all HCS12
members have on-chip flash memory and provide in-system programming capability. Motorola
8-bit MCUs have a combined 64-KB program and data memory.

1.11.4 Intel 8051/8052 Variants

The 8051 was designed by Intel and is the oldest 8-bit MCU. The 8051 has separate data
memory and program memory spaces and follows the CISC design philosophy. Each memory
space is 64 KB. The original 8051 has 4 KB of ROM, two 8-bit timers, four 8-bit I/O ports, and
an asynchronous serial port. Later, Intel introduced 8052 as an enhancement to the 8051,
adding another 8-bit timer to it. The initial 8051 MCU was very slow. It divides the crystal
oscillator signal by 12 and uses it as the instruction clock signal to control the instruction exe-
cution. One instruction clock cycle takes 12 crystal oscillator cycles. An instruction may take
from one to four instruction cycles to execute. The original 8051 MCU can run with a 12-MHz
crystal oscillator. Therefore, the throughput of the original 8051 MCU is less than 1 MIPS.
The 8051 provides one data pointer DPTR for accessing data memory. In many cases, this is
inadequate.

Intel licensed the 8051 design to many semiconductor companies. To be competitive, most
of the 8051 vendors add many enhancements to their implementations of the 8051. Many use-
ful peripheral functions have been added by the 8051 variants. Some vendors even modified the
8051 design to shorten the instruction cycle time from 12 to 6 or 4 or even to a single oscilla-
tor clock cycle. Many vendors also add one or more data pointers to facilitate the access of data
memory. On-chip flash program memory is also added by many vendors.

Philips produces the most 8051 variants, whereas Atmel produces the most flash-memory-
based 8051 variants. Dallas/MAXIM Semiconductor shortens the 8051-instruction clock cycle
time from 12 to 4 crystal oscillator cycles. Silicon Laboratory takes this approach to the limit
and pushes the instruction clock cycle to one crystal oscillator cycle and provides devices run-
ning at 100 MHz. Silicon Laboratory 8051 variants are also pipelined. The 8051 variants from
Silicon Laboratory provide (1) eight to over 100 I/O pins; {2) A/D converter with 8- to 16-bit res-
olutions; {3} serial communication interfaces, such as UART, SPI, I2C, and CAN controller;
(4) on-chip flash program memory and in-system programming capability; (5) timer functions,
such as input capture, output compare, counter, and PWM,; (6) on-chip temperature sensor; and
(7) free development software tools and inexpensive demo boards. The peak performance of
Silicon Laboratory’s 8051 variants could range from 20 to 100 MIPS.
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Analog Devices Inc. focuses on the data acquisition market. Analog Devices call their 8051-
based devices MicroConverters (ADuC). The ADuC provides A/D converters with 12- to 24-bit
resolution and D/A converters with 12-bit resolution. Other peripheral functions, such as
UART and SPI serial interface protocol, timers, power management, and COP, are also standard.
The MSC1210 MCU from TI is another 8051 variant that follows an approach similar to that of
Analog Devices. The MSC1210 has 32 KB of on-chip flash program memory, a 24-bit A/D con-
verter, a 32-bit accumulator, three 8-bit timers, UART and SPI ports, and a watchdog timer. The
MSC1210 uses four crystal oscillator cycles for one instruction cycle, as does the Dallas/
MAXIM semiconductor.

Philips and Infineon are two major producers of 8051 variants. Many of their devices have
flash program memory and in-system programming capability. Their 8051 variants also provide
peripheral functions available in other 8051 vendors.

Because of the large number of 8051 variants and vendors, many hardware and software
development tools are available from many vendors. The huge spectrum of the 8051 variants
provides the user with the most choices in vendors, features, and development tools.

1.11.5 The Atmel AVR

In addition to producing 8051 variants, Atmel also produces an 8-bit RISC MCU, the AVR.
The AVR has devices from 8 pin to over 64 pin. These devices are pipelined to achieve high
throughput just like Microchip PIC18 MCU and Silicon Laboratory 8051 variants. The AVR
provides up to 128 KB of on-chip flash program memory and optional 64-KB external memory
and has in-system programming capability. Most peripheral functions available in the PIC18 are
also available in the AVR. The AVR RISC MCU provides more instructions (133) than the
PIC18 MCU does. The AVR has 32 general-purpose 8-bit registers and many other registers that
are dedicated to the configuration and control of peripheral functions. Atmel also provides free
software development tools and low-cost demo boards. Atmel’s AVR MCU can run with a 16-
MHz crystal oscillator and achieve the peak performance of 16 MIPS.

It is apparent that many 8-bit MCUs can be used in the same application because many
devices have similar peripheral functions. The choice is often made on the basis of the follow-
ing considerations:

= Device cost and system cost

% Availability of development tools and technical support

®  Availability of engineering expertise on the specific MCU
= Device performance

® Personal preference

1.12 Summar

A computer system consists of hardware and software. The hardware consists of four major
components: a processor (called the CPUJ, an input unit, an output unit, and memory. The
processor can be further divided into three major parts: (1) registers, (2) the arithmetic logic unit,
and (3} the control unit. All CPU activities are synchronized by the system clock. The clock fre-
quency of the current generation of microprocessors {mainly Intel Pentium 4 and AMD Athlon-
64) has exceeded 3 GHz. The CPU maintains a register called program counter (PC), which
controls the memory address of the next instruction to be executed. During the execution of an
instruction, the occurrence of an overflow, an addition carry, a subtraction borrow, and so forth
are flagged by the system and stored in another register called the status register. The PIC18
MCU uses the STATUS register to record the occurrence of these conditions.
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A microprocessor is a processor fabricated on a single integrated circuit. A microcomputer
is a computer that uses a microprocessor as its CPU. Although microprocessors have been
widely used since their invention, there are several limitations that led to the development of
microcontrollers. First, a microprocessor requires external memory to store data and programs.
Second, a microprocessor cannot interface directly to I/O devices; peripheral chips are needed.
Third, glue logic is needed to interconnect external memory and peripheral interface chips to
the microprocessor.

A microcontroller is a computer implemented on a VLSI chip. It contains everything con-
tained in a microprocessor along with one or more of the following components:

® Memory

s Timer

® Pulse-width modulation (PWM) module
®  Analog-to-digital converter

® Digital-to-analog converter

» Direct memory access (DMA] controller
® Parallel I/O interface

»  Serial I/O interface

®» Memory component interface circuitry
®  Software debug circuitry

Software and data are stored in memory. Semiconductor memory chips can be classified
into two major categories: random-access memory (RAM) and read-only memory (ROM).

There are many different types of ROM. MROM is a type of ROM that is programmed when
it is fabricated. PROM is a type of fuse-based ROM that can be programmed in the field by the
end user. EPROM is a type of ROM that is programmed electrically and erased by ultraviolet light.
EEPROM is a type of ROM that can be erased and programmed electrically. The user can erase a
location, a row, or the whole EEPROM chip in one operation. Flash memory can be erased and
programmed electrically. However, flash memory can be erased only one row at a time or in bulk.

Programs are known as software. A program is a set of instructions that the computer
hardware can execute. Programmers write a program in some kind of programming language.
Only machine language was available during the early days of computers. A machine language
program consists of a sequence of machine instructions. A machine instruction is a combina-
tion of Os and 1s that inform the CPU to perform certain operation. Using machine language to
write programs is difficult, and hence assembly language was developed to improve the pro-
ductivity of programmers. Programs written in assembly language consist of a sequence of
assembly instructions. An assembly instruction is the mnemonic representation of some
machine instruction. Programs written in assembly language are still difficult to understand,
and programming productivity is not high. High-level languages, such as C, C++, and Java, were
invented to avoid the drawback of the assembly language. Programs written in assembly or
high-level languages are called source code. Source code must be translated before it can be exe-
cuted. The translator of a program written in assembly language is called an assembler, whereas
the translator of a program written in a high-level language is called a compiler.

A memory location has two components: its contents and its address. When accessing a
memory location, the CPU sends out the address on the address bus, and the memory compo-
nents will place the requested value on the data bus.

The PIC18 MCU separates the program memory and data memory spaces and provides sep-
arate buses to access them. This Harvard architecture allows the PIC18 MCU to access the
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instruction and data in the same clock cycle: The group of data registers located between 0xFD8
and OxFFF are used to control the general operation of the CPU and should be referred to as CPU
registers. The program counter is 21 bits, which allows the PIC18 MCU to access up to 2 MB of
program memory.

The PIC18 MCU provides 77 instructions. Seventy-three instructions are 16 bits. Four are
32 bits. These instructions are pipelined so that most of them will take one clock cycle to
complete.

A data memory location is referred to as a data register. A small set of them provides the
control and records the status of peripheral functions. This group is often referred to as special-
function registers (SFRs). SFRs are located in the highest data memory space. The remaining
data registers are used to store data or address information and are referred to as general-purpose
registers (GPRs).

Each data register is associated with a 12-bit address. However, all (except one} PIC18
instructions provide 8-bit addresses for selecting the data register operand. An additional four
bits of register address are stored in the bank select register (BSR). This addressing scheme
divides data registers into 16 banks. The user needs to specifically change the value in the BSR
register in order to switch to different bank.

Bank switching increases program complexity and may cause software errors. The designer
of the PIC18 MCU minimized the problem of bank switching by creating the access bank. The
access bank consists of the first 96 bytes of GPRs and the last 160 bytes of SFRs. Most of the
PIC18 instructions have an “a” field for the user to force the access of access bank, which will
ignore the BSR register during the addressing process of data registers. This scheme eliminates
the need for bank switching in most cases.

The PIC18 instructions provide five different addressing modes for accessing instruction
operands:

®  Register direct
s Immediate

® Inherent

® Indirect

® Bit direct

The indirect mode is used mainly to access data arrays and matrices. Three indirect point-
ers (FSRO-FSR2) are provided to support indirect access mode. Indirect pointers can be incre-
mented or decremented before or after the access.

1.13 Exercises

E1.1 What is a processor? What components does it have?
E1.2 What makes a microprocessor different from the processor of a large computer?

E1.3 What makes an MCU different from a general-purpose microprocessor?

E1.4 What is the length (number of bits) of a PIC18 instruction?

E1.5 What is the length of the PIC18 program counter? How many different program memory
locations can be addressed by the PIC18 MCU?

E1.6 How many bits are used to select a data register?

E1.7 What is the access bank? What benefits does the access bank provide?

E1.8 What is an assembler? What is a compiler?

E1.9 What is a cross assembler? What is a cross compiler?

E1.10 Explain the features of EPROM, EEPROM, and flash memory.
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E1.11 What is instruction pipelining? What benefits does it provide?

E1.12 Write an instruction sequence to swap the contents of data registers at 0x300 and 0x200.
E1.13 Write an instruction sequence to load the value of 0x39 into data memory locations
0x100-0x103.

E1.14 Write an instruction sequence to subtract 10 from data memory locations 0x30-0x34.
E1.15 Write an instruction to store the contents of the WREG register in the data register
located at 0x25 of bank 4.

E1.16 Write an instruction sequence to copy the contents of data memory at 0x100-0x103 to
0x200-0x203 using the postincrement addressing mode.

E1.17 Write an instruction sequence to copy the contents of data memory at 0x100-0x103 to
0x203-0x200, that is, in the reverse order by combining the use of postincrement and post-
decrement modes.

E1.18 Write an instruction sequence to add 5 to data registers at $300-$303.

E1.19 Write an instruction sequence to add the contents of the data registers at $10 and $20 and
store the sum at $30.

E1.20 Write an instruction sequence to subtract the contents of the data register at 0x20 from
that of the data register at 0x30 and store the difference in the data register at 0x10.
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2.2 Introduction

.3 Assembly Language Program Structure

Assembly language programming is a method of writing programs using instructions that
are the symbolic equivalent of machine code. The syntax of each instruction is structured to
allow direct translation to machine code.

This chapter begins the formal study of Microchip PIC18 assembly language programming.
The format rules, specification of variables and data types, and the syntax rules for program state-
ments are introduced in this chapter. The rules for the Microchip MPASM® assembler will be
followed. The rules discussed in this chapter also apply to all other Microchip families of MCUs.

A program written in assembly language consists of a sequence of statements that tell the
computer to perform the desired operations. From a global point of view, a PIC18 assembly pro-
gram consists of three types of statements:

»  Assembler directives. Assembler directives are assembler commands that are used
to control the assembler: its input, output, and data allocation. An assembly
program must be terminated with an END directive. Any statement after the END
directive will be ignored by the assembler.

»  Assembly language instructions. These instructions are PIC18 instructions. Some
are defined with labels. The PIC18 MCU allows us to use up to 77 different
instructions.

»  Comments. There are two types of comments in an assembly program. The first type
is used to explain the function of a single instruction or directive. The second type
explains the function of a group of instructions or directives or the whole routine.

The source code of an assembly program can be created using any ASCII text file editor.
Each line of the source file may consist of up to four fields:

m Label
= Mnemonic

Operand(s)
= Comment

The order and position of these four fields are important. Labels must start in column 1.
Mnemonics may start in column 2 or beyond. Operands follow the mnemonic. Comments may
follow the operands, mnemonics, or labels and can start in any column. The maximum column
width is 256 characters.

One should use space(s) or a colon to separate the label and the mnemonic and use space(s) to
separate the mnemonic and the operand(s). Multiple operands must be separated by commas.

2.3.1 The Label Fields

A label must start in column 1. It may be followed by a colon (), space, tab, or the end of
line. Labels must begin with an alphabetic character or an underscore (_) and may contain
alphanumeric characters, the underscore, and the question mark.

Labels may be up to 32 characters long. By default, they are case sensitive, but case sensi-
tivity can be overridden by a command line option. If a colon is used when defining a label, it
is treated as a label operator and not part of the label itself.
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The following instructions contain valid labels:

(a) loop addwf 0x20,F,A
(b) _again addiw 0x03
(c) ¢?gtm andlw Ox7F

(d) may2_june  bsf 0x07, 0x05,A
The following instructions contain invalid labels:

(e) ishig btfsc 0x15,0x07,B ;label starts at column 2
(f) 3orb5 clrf 0x16,A ;label starts with a digit
(g) three-four cpfsgt Ox14,A ;label contains illegal character “-”

A

Example 2.2

2.3.2 The Mnemonic Field

This field can be either an assembly instruction mnemonic or an assembler directive and
must begin in column 2 or greater. If there is a label on the same line, instructions must be sep-
arated from that label by a colon or by one or more spaces or tabs.

Examples of mnemonic field:

(a) false equ 0 ;equ is an assembler directive
(b) goto  start ;goto is the mnemonic
(c) loop: incf 0x20,W,A  ;incf is the mnemonic

A

2.3.3 The Operand Field

If an operand field is present, it follows the mnemonic field. The operand field may contain
operands for instructions or arguments for assembler directives. Operands must be separated
from mnemonics by one or more spaces or tabs. Multiple operands are separated by commuas.
The following examples include operand fields:

(a) cpfseq 0x20,A ; “Ox20" is the operand
(b) true equ 1 ; “1” is the operand
(c) movff  0x30,0x65 ; “Ox30” and “Ox65” are operands

2.3.4 The Comment Field

The comment field is optional and is added for documentation purpose. The comment field
starts with a semicolon. All characters following the semicolon are ignored through the end of
the line. The two types of comments are illustrated in the following examples.

(a) decf 0x20,F.A ;decrement the loop count

(b) ;the whole line is comment
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Identify the four fields in the following source statement:
too_low addlw 0x02 ; increment WREG by 2

Solution: The four fields in the given source statement are as follows:
(a) too_low is a label

(b) addlw is an instruction mnemonic

(c) 0x02is an operand

(d) sincrement WREG by 2 is a comment

A

2.4 Assembler Directives

Assembler directives look just like instructions in an assembly language program. Most
assembler directives tell the assembler to do something other than creating the machine code
for an instruction. Assembler directives provide the assembly language programmer with a
means to instruct the assembler how to process subsequent assembly language instructions.
Directives also provide a way to define program constants and reserve space for dynamic vari-
ables. Each assembler provides a different set of directives. In the following discussion, [ }is used
to indicate that a field is optional.

MPASMG® provides five types of directives:

®  Control directives. Control directives permit sections of conditionally assembled
code.

®  Data directives. Data directives are those that control the allocation of memory
and provide a way to refer to data items symbolically, that is, by meaningful
names.

m [isting directives. Listing directives are those directives that control the MPASM®
listing file format. They allow the specification of titles, pagination, and other
listing control.

®»  Macro directives. These directives control the execution and data allocation within
macro body definitions.

®  Object directives. These directives are used only when creating an object file.

2.4.1 Control Directives

The control directives that are used most often are listed in Table 2.1. Directives that are
related are introduced in a group in the following:
if <expr>
else
endif
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Directive Description Syntax
CODE Begin executable code section [<name>] code [<address>]
#DEFINE Define a text substition section #define <name> [<value>]
#define <name> [<arg>, . . . <arg>] <value>
ELSE Begin alternative assembly block to IF else
END End program block end
ENDIF End conditional assembly block endif
ENDW End a while loop endw
IF Begin conditionally assembled code block if <expr>
IFDEF Execute if symbol has been defined ifdef <label>
IFNDEF Execute if symbol has not been defined ifndef <label>
#INCLUDE Include additional source code #include <<include_file>> | “<include_file>"
RADIX Specify default radix radix <default_radix>
#UNDEFINE Delete a substition label #undefine <label>
WHILE Perform loop while condition is true while <expr>

Table 2.1 m MPASM

control directives

The if directive begins a conditionally assembled code block. If <expr> evaluates to true,
the code immediately following if will assemble. Otherwise, subsequent code is skipped
until an else directive or an endif directive is encountered. An expression that evaluates to 0
is considered logically false. An expression that evaluates to any other value is considered

logically true.

The else directive begins alternative assembly block to if. The endif directive marks the end
of a conditional assembly block. For example,

if version == 100 ; check current version

moviw 0xOa

movwfio_1,A
else

movlw Ox1a

movwf io_2 A
endif

will add the following two instructions to the program when the variable version is 100:

moviw 0x0a
movwf io_1,A

Otherwise, the following two instructions will be added instead:

moviw Ox1a
movwf io_2,A
end
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This directive indicates the end of the program. An assembly language program looks like
the following:

list p=xxxx ; XX is the device name such as pic18F452
; executable code

.
’

end ; end of program
[<label>] code [<ROM address>]

This directive declares the beginning of a section of program code. If <label> is not speci-
fied, the section is named “.code”. The starting address is initialized to the specified address or
will be assigned at link time if no address is specified. For example,

reset code 0x00
goto start

creates a new section called reset starting at the address 0x00. The first instruction of this
section is goto start.

#define <name> [<string>]
This directive defines a text substitution string. Whenever <name> is encountered in the
assembly code, <stting> will be substituted. Using this directive with no <string> causes a def-

inition of <name> to be noted internally and may be tested for using the ifdef directive. The fol-
lowing are examples for using the #define directive:

#define length 20

#define config 0x17,7,A

#define sum3(x,y,z) X+y+2)

test dw sum3(1, length, 200) ; place (1 + 20 + 200) at this location
bsf config ; set bit 7 of the data register 0x17 to 1

#undefine <label>
This directive deletes a substitution string.
ifdef <label>
If <label> has been defined, usually by issuing a #define directive or by setting the value on

the MPASM command line, the conditional path is taken. Assembly will continue until a
matching else or endif directive is encountered. For example,

#define test_val 2

ifdef test_val
<execute test code> ; this path will be executed
endif

ifndef <label>

If <label> has not been previously defined or has been undefined by issuing an #undefine
directive, then the code following the directive will be assembled. Assembly will be enabled or
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disabled until the next matching else or endif directive is encountered. The following examples
illustrate the use of this directive:

#define led_port 1 ; set time_cnt on
#undefine led_port ; set time_cnt off

infdef led_port
; execute this

.
]

endif
end
#include “<include_file>”

This directive includes additional source file. The specified file is read in as source code.
The effect is the same as if the entire text of the inciuded file were inserted into the file at the
location of the include statement. Up to six levels of nesting are permitted. <include_file> may
be enclosed in quotes or angle brackets. If a fully qualified path is specified, only that path will
be searched. Otherwise, the search order is current working directory, source file directory,
MPASM executable directory. The following examples illustrate the use of this directive:

#include “p18F8720.inc” ;search the current working directory
#include <p18F452.inc>
radix <default_radix>

This directive sets the default radix for data expressions. The default radix is hex. Valid
radix values are: hex, dee, or oct.

while <expr>
endw

The lines between while and endw are assembled as long as <expt> evaluates to true. An
expression that evaluates to zero is considered logically false. An expression that evaluates to
any other value is considered logically true. A while loop can contain at most 100 lines and be
repeated a2 maximum of 256 times. The following example illustrates the use of this directive:

test_mac  macro chk_cnt
variable i

while i < chik_cnt
movlw i

endw
endm

start
test_mac 6
end

The directives related to macro will be discussed later.
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2.4.2 Data Directives
The MPASM data directives are listed in Table 2.2.

Directive Description Syntax

CBLOCK Define a block of constant chlock [<expr>]

CONSTANT Declare symbol constant constant <label> [=<expr>, . . ., <label>[=<expr>]

DA Store strings in program memory [<label>] da <expr>[,<expr>, . . ., <expr>]

DATA Create numeric and text data {<label>} data <expr>[,<expr>, . . ., <expr>)
[<label>] data “<text string>"[, “<text_string>", . . .]

DB Declare data of one byte [<label>] db <expr>[,<expr>, . . ., <expr>]
[<label> db “<text string>"[, “<text_string>", . . .]

DT Define table [<label>] dt <expr>[,<expr>,. . ., <expr>]
[<label>] dt “<text_string>"{, “<text string>", . . .|

bW Declare data of one word [<label>] dw <expr>[,<expr>, . . ., <expr>]
[<label>] dw “<text_string>"[,"<text_string>", . . .]

ENDC End an automatic constant block ende

EQU Define an assembly constant <label> equ <expr>

FILL Fill memory [<label> fill <expr>,<count>

RES Reserve memory |<label>] res <mem_units>

SET Define an assembler variable <labei> set <expr>

VARIABLE Declare symbol variable variable <label>{=<expr>, . . ., <label>[=<expr>]]

Table 2.2 m MPASM* data directives

The user can choose his or her preferred radix to represent the number. MPASM supports the
radices listed in Table 2.3.

chlock [<expr>]
<lahel>[:<increment>][,<label>[:<increment>]]

endc

Type Syntax Example

Decimal D'<decimal digits>’ D'1000’

Hexadecimal H'<hex_digits>’ or H'234D’
Ox<hex_digits> 0xC000

Octal O’<oetal_digits>' 01357

Binary B’<binary_digits>’ B'01100001

ASCIl ‘<character>' T
A'<character>’ AT

Table 2.3 ® MPASMD radix specification

The cblock directive defines a list of named constants. Each <label> is assigned a value of
one higher than the previous <label>. The purpose of this directive is to assign address offsets
to many labels. The list of names ends when an ende directive is encountered.

<expr> indicates the starting value for the first name in the block. If no expression is found,
the first name will receive a value one higher than the final name in the previous cblock. If the
first cblock in the source file has no <expr>, assigned values start with zero.
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If <increment> is specified, then the next <label> is assigned the value of <increment> higher
than the previous <label>. The following examples illustrate the use of these two directives:
cblock 0x50
test1, test2, test3, test4 ;testl..test4 get the value of 0x50..0x53
endc
cblock 0x30
twoByteVal: 0, twoByteHi, twoBytelo
queue: 40
queuehead, queuetail
double 1:2, double2:2
endc

The values assigned to symbols in the second cblock are the following:
= twoByteVal: 0x30
= twoByteHi: 0x30
= twoByteLo: 0x31
w  queue: 0x32
= queuchead: 0x5A
®  queuetail: 0x5B
u doublel: 0x5C

® double2: Ox5E
constant <label> = <expr> [. . .,<label> = <expr>]

This directive creates symbols for use in MPASM expressions. Constants may not be reset
after having once been initialized, and the expression must be fully resolvable at the time of the
assignment. For example,

constant duty_cyle = D'50’
will cause 50 to be used whenever the symbol duty_cycle is encountered in the program.

[<label>] data <expr>,[,<expr>, . . ., <expr>]
[<label>] data “<text_string>"[, “<text_string>"]

The data directive can also be written as da. This directive initializes one or more words
of program memory with data. The data may be in the form of constants, relocatable or exter-
nal labels, or expressions of any of the above. Each expr is stored in one word. The data may
also consist of ASCII character strings, <text_string>, enclosed in single quotes for one charac-
ter or double quotes for strings. Single character items are placed into the low byte {higher
address) of the word, while strings are packed two bytes into a word. If an odd number of char-
acters are given in a string, the final byte is zero. The following examples illustrate the use of
this directive:

data 1,2,3 ; constants

data  “countfrom 1,2,3" ;text string

data ‘A ; single character

data main ; relocatable 1abel
[<label>] db <expr>[, <expr>, . . ., <expr>]

This directive reserves program memory words with packed 8-bit values. Multiple
expressions continue to fill bytes consecutively until the end of expressions. Should there be
an odd number of expressions, the last byte will be zero. When generating an object file, this
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directive can also be used to declare initialized data values. An example of the use of this
directive is as follows:

db ",0x22, ‘v, Ox1f, 's’, Ox03, ', “\»’
[<label>] de <expr>[, <expr>, . . ., <expr>]

This directive reserves memory words with 8-bit data. Each <expr> must evaluate to an 8-
bit value. The upper eight bits of the program word are zeroes. Each character in a string is
stored in a separate word. Although designed for initializing EEPROM data on the PIC16C8X,
the directive can be used at any location for any processor. An example of the use of this direc-
tive is as follows:

org 0x2000
de “this is my program”, 0 ; 0 is used to terminate the string
[<label>] dt <expr> [, <expr>, . . ., <expr>]

This directive generates a series of retlw instructions, one instruction for each <expr>. Each
<expr> must be an 8-bit value. Each character in a string is stored in its own retlw instruction.
The following examples illustrate the use of this directive:

dt “A new era is coming”, 0
dt 12,34
[<label> dw <expr> [, <expr>, . . ., <expr>]

This directive reserves program memory words for data, initializing that space to specific
values. Values are stored into successive memory locations, and the location is incremented by
one. Expressions may be literal strings and are stored as described in the data directive.
Examples on the use of this directive are as follows:

dw 39, 24, “display data”
dw array_cnt-1
<label> equ <expr>

The equ directive defines a constant. Wherever the label appears in the program, the assem-
bler will replace it with <expr>. Some examples of this directive are as follows:

true equ 1
false equ 0
four equ 4

[<label>] fill <expr>, <count>

This directive specifies a memory fill value. The value to be filled is specified by <expr>,
whereas the number of words that the value should be repeated is specified by <count>. The fol-
lowing example illustrates the use of this directive:

fill 0x2020, 5 ;fill five words with the value of 0x2020 in program memory
[<label>] res <mem_units>

The MPASM® uses a memory location pointer to keep track of the address of the next mem-
ory location to be allocated. This directive will cause the memory location pointer to be advanced
from its current location by the value specified in <mem_units>. In nonrelocatable code, <label>
is assumed to be a program memory address. In relocatable code {using the MPLINK®}, res can also
be used to reserve data storage. For example, the following directive reserves 64 bytes:

buffer res 64
<label> set <expr>
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Using this directive, <label> is assigned the value of the valid MPASM expression specified
by <expr>. The set directive is functionally equivalent to the equ directive except that a set
value may be subsequently altered by other set directive. The following examples illustrate the
use of this directive:

length set 0x20
width set 0x21
area_hi set 0x22
area_lo set 0x23

variable <label> [=<expr>][,<label>[=<expr>]. . .]

This directive creates symbols for use in MPASM expressions. Variables and constants may
be used interchangeably in expressions. The variable directive creates a symbol that is func-
tionally equivalent to those created by the set directive. The difference is that the variable direc-
tive does not require that symbols be initialized when they are declared.

2.4.3 Macro Directives

A macro is a name assigned to one or more assembly statements. There are situations in
which the same sequence of instructions need to be included in several places. This sequence
of instructions may operate on different parameters. By placing this sequence of instructions in
a macro, the sequence of instructions need be typed only once. The macro capability not only
makes us more productive but also makes the program more readable. The MPASM assembler
macro directives are listed in Table 2.4.

<label> macro [<arg>, . . ., <arg>]

endm
Directive Description Syntax
ENDM End of a macro definition endm
EXITM Exit from a macro exitm
MACRO Declare macro definition <label> macro [<arg>, . . ., <arg>]
EXPAND Expand macro listing expand
LOCAL Declare local macro variable local <label> {, <label>]
NOEXPAND Turn off macto expansion noexpand

Table 2.4 m MPASM macro directives

A name is required for the macro definition. To invoke the macro, specify the name and the
arguments of the macro, and the assembler will insert the instruction sequence between the
macro and endm directives into our program. For example, a macro may be defined for the
PIC18 as follows:

sum_of_3 macro argl,arg2, arg3
movf argl, WA
addwf arg2, WA
addwf arg3,W,A
endm
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If the user wants to add three data registers at 0x20, 0x21, and 0x22 and leave the sum in
WREG, he or she can use the following statement to invoke the previously mentioned macro:

sum_of_3 0x20,0x21,0x22

When processing this macro call, the assembler will insert the following instructions in the
user program:

movf 0x20,W,A

addwf 0x21,W,A

addwf 0x22,W,A
exitm

This directive forces immediate return from macro expansion during assembly. The effect
is the same as if an endm directive had been encountered. An example of the use of this direc-
tive is as follows:

test  macro argl
if argl == ; check for valid file register
exitm
else
error “bad file assignment”
endif
endm
expand
noexpand

The expand directive tells the assembler to expand all macros in the listing file, whereas
the noexpand directive tells the assembler to do the opposite.
local <label>[,<label> . . .}

This directive declares that the specified data elements are to be considered in local con-
text to the macro. <label> may be identical to another label declared outside the macro defini-
tion; there will be no conflict between the two. The following example illustrates the use of this
directive:

<main code segment>

len equ 5 ; global version
width  equ 8 ;
abc macro  width

local len, label  ; local len and label
len set width ; modify local len
label  res len ; reserve buffer
len set len-10

endm ; end macro

2.4.4 Listing Directives

Listing directives are used to control the MPASM listing file format. The listing directives
are listed in Table 2.5.
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Directive Description Syntax

ERROR Issue an error message error “<text_string>"

ERRORLEVEL Set eror level errorievel 0| 1|2 <+ | -><message number>
LIST Listing options list [<list_option>, . . ., <list_option>}
MESSG Create user defined message messg “<message_text>"

NOLIST Turn off listing options nolist

PAGE Insert listing page eject page

SPACE Insert blank listing lines space <expr>

SUBTITLE Specify program subtitle . subtitle “<sub_text>

TITLE Specify program title fitle “<title_text>"

Table 2.5 m MPASM assembler listing directives

error “<text_string>”

This directive causes <text_string> to be printed in a format identical to any MPASM error
message. The error message will be output in the assembler list file. <text_siring> may be from
1 to 80 characters. The following example illustrates the use of this directive:

bnd_check macro argl
if argl >= 0x20
error “argument out of range”
endif
endm
errorlevel {0|1|2+<msgnum> | - <msgnum>} [, . . .]

This directive sets the types of messages that are printed in the listing file and error file.
The meanings of parameters for this directive are listing in Table 2.6.

Setting Effect

0 Messages, warnings, and errors printed
1 Warnings and errors printed

2 Errors printed

- <msgnum> Inhibits printing of message <msgnum>
+ <msgnum> Enables printing of message <msgnum>

Table 2.6 m Meaning of parameters for ERRORLEVEL directive

For example,

errorlevel 1, -202
enables warnings and errors to be printed and inhibits the printing of message number 202.

list [<list_option>, . . ., <list_option>]

nolist

The list directive has the effect of turning listing output on if it had been previously turned
off. This directive can also supply the options listed in Table 2.7 to control the assembly process
or format the listing file. The nolist directive simply turns off the listing file output.

messg “message_text”
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Option Default Description

b = nnn 8 Set tab spaces

c=nnn 132 Set column width

f = <format> INHX8M Set the hex file output, <format> can be INHX32, INHX8M, or INHX8S
free Fixed Use free-format parser. Provided for backward compatibility
fixed Fixed Use fixed format paper

mm = {ON | OFF} ON Print memory map in list file

n=nnn 60 Set lines per page

p = <iype> None Set processor type; for example, PIC18F8720

1 = <radix> hex Set default radix; hex, dec, oct.

st = {ON | OFF} ON Print symbol table in list file

t={ON | OFF} OFF Truncate lines of listing (otherwise wrap)

w={0 ] 1 l 2} 0 Set the message level. See ERRORLEVEL.

x={ON | OFF} ON Turn macro expansion on or off

Table 2.7 m List directive options

This directive causes an informational message to be printed in the listing file. The mes-
sage text can be up to 80 characters. The following example illustrates the use of this directive:

msg_macro macro
messg “this is an messg directive”
endm
page
This directive inserts a page eject into the listing file.
space <expr>
This directive inserts <expr> number of blank lines into the listing file. For example,
space 3
will insert three blank lines into the listing file.
title “<title_text>"

This directive establishes the text to be used in the top line of each page in the listing file.
<title_text> is a printable ASCII string enclosed in double quotes. It must be 60 characters or
less. For example,

title “prime number generator, rev 2.0"

causes the string “prime number generator, rev 2.0” to appear at the top of each page in the
listing file.
subtitle “<sub_text>”

This directive establishes a second program header line for use as a subtitle in the list-
ing output. <sub_text> is an ASCII string enclosed in double quotes, 60 characters or less in
length.

2.4.5 Object File Directives

There are many MPASM directives that are used only in controlling the generation of
object code. A subset of these directives is shown in Table 2.8.
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Directive Description Syntax

BANKSEL Generate RAM bank selecting code banksel <label>

CODE Begin executable code section [<name> code [<address>}

__ CONFIG Specify configuration bits __config <expr> OR __ config <addr>, <expr>
EXTERN Declare an external label extern <label>[, <label>]

GLOBAL Export a defined label global <label>[,<!abel>]

IDATA Begin initialized data section [<name>] idata [<address>]
ORG Set program origin <label> org <expr>

PROCESSOR Set processor type processor <processor_type>
UDATA Begin uninitialized data section [<name>] udata [<address>]
UDATA_SHR Begin shared uninitialized data section [<name>] udata_shr [<address>]

Table 2.8 m MPASM object file directives

banksel <label>

This directive is an instruction to the linker to generate bank-selecting code to set the
active bank to the bank containing the designated <label>. Only one <label> should be speci-
fied. In addition, <label> must have been previously defined. The instruction movlb k will be
generated, and k corresponds to the bank in which <label> resides. The following example illus-
trates the use of this directive:

udata
varl res 1
vark res 1
code

banksel varl
movwf varl
banksel  vark
movwf vark

pagesel  sub_x ; to be discussed later
call sub_x

sub_x  clw
retlw 0

[<label>] code [<ROM address>]

This directive declares the beginning of a section of program code. If <label> is not speci-
fied, the section is named “.code”. The starting address is initialized to the specified address or
will be assigned at link time if no address is specified. The following example illustrates the use
of this directive:

reset  code 0x00
goto start
___config <expr> or
__config <addr>, <expr>

This directive sets the processor’s configuration bits to the value described by <expr>. Before
this directive is used, the processor must be declared through the processor or Iist directive. The
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hex file output format must be set to INHX32 with the Iist directive when this directive is used
with the PIC18 family. The following example illustrates the use of this directive:

list p = 18F8720, f = INHX32
__config OxFFFF ; default configuration bits

extern <label> [, <label>, . . .]

This directive declares symbols names that may be used in the current module but are
defined as global in a different module. The external statement must be included before <label>
is used. At least one label must be specified on the line. The following example illustrates the
use of this directive:

extern function_x

call function_x
global <label> [, <label>, . . .]

This directive declares symbol names that are defined in the current module and should be
available to other modules. This directive must be used after <label> is defined. At least one label
must be included in this directive. The following example illustrates the use of this directive:

udata

ax res 1

bx res 1
global ax, bx
code
addiw 3

[<label> idata [<RAM address>]

This directive declares the beginning of a section of initialized data. If <label> is not spec-
ified, the section is named “.data”. The starting address is initialized to the specified address or
will be assigned at link time if no address is specified. No code can be generated in this section.
The res, db, and dw directives may be used to reserve space for variables. The tes directive will
generate an initial value of zero. The db directive will initialize successive bytes of RAM. The
dw directive will initialize successive bytes of RAM, one word at a time, in low-byte/high-byte
order. The following example illustrates the use of this directive:

idata
i dw 0
j dw 0
tent dw 20
flags db 0
prompt db “hello there!”
[<label>] org <expr>

This directive sets the program origin for subsequent code at the address defined in <expr>.
If <label> is specified, it will be given the value of the <expr>. If no org is specified, code gener-
ation will begin at address zero. Some examples of this directive follow:

reset org 0x00

.. ; reset vector code goes have
goto start
org 0x100

start N ; code of our program
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processor <processor_type>
This directive sets the processor type. For example,
processor p18F8720
[<label>] udata [<RAM address>]

This directive declares the beginning of a section of uninitialized data. If <label> is not
specified, the section is named “.udata”. The starting address is initialized to the specified
address or will be assigned at link time if no address is specified. No code can be generated in
this section. The res directive should be used to reserve space or data. Here is an example that
illustrates the use of this directive:

udata
varl res 1
var2 res 2

[<label>] udata_shr [<RAM address>]

This directive declares the beginning of a section of shared uninitialized data. If <label> is not
specified, the section is named “.udata_shr”. The starting address is initialized to the specified
address or will be assigned at link time if no address is specified. This directive is used to declare
variables that are allocated in RAM and are shared across all RAM banks. The res directive should
be used to reserve space for data. The following examples illustrate the use of this directive:

temps udata_shr

1 res 1
2 res 1
sl res 2
s2 res 4

2.5 Representing the Program Logic
foo e R e e e i e e S ]

An embedded product designer must spend a significant amount of time on software develop-
ment. It is important for the embedded product designer to understand software development issues.

Software development starts with the problem definition. The problem presented by the
application must be fully understood before any program can be written. At the problem defi-
nition stage, the most critical thing is to get you, the programmer, and your end user to agree
on what needs to be done. To achieve this, asking questions is very important. For complex and
expensive applications, a formal, written definition of the problem is formulated and agreed on
by all parties.

Once the problem is known, the programmer can begin to lay out an overall plan of how to
solve the problem. The plan is also called an algorithm. Informally, an algorithm is any well-
defined computational procedure that takes some value or a set of values as input and produces
some value or set of values as output. An algorithm is thus a sequence of computational steps
that transform input to output. An algorithm can also be viewed as a tool for solving a well-
specified computational problem. The statement of the problem specifies in general terms the
desired input/output relationship. The algorithm describes a specific computational procedure
for achieving that input/output relationship.

An algorithm is expressed in pseudocode that is very much like C or Pascal. Pseudocode is
distinguished from “real” code in that pseudocode employs whatever expressive method is most
clear and concise to specify a given algorithm. Sometimes, the clearest method is English, so do
not be surprised if you come across an English phrase or sentence embedded within a section of
“real” code.
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An algorithm provides not only the overall plan for solving the problem but also documen-
tation to the software to be developed. In the rest of this book, all algorithms will be presented
in the format as follows:

Step 1

Step 2

An earlier alternative for providing the overall plan for solving software problem is using
flowcharts. A flowchart shows the way a program operates. It illustrates the logic flow of the
program. Therefore, flowcharts can be a valuable aid in visualizing programs. Many people pre-
fer using flowcharts in representing the program logic for this reason. Flowcharts are used not
only in computer programming but in many other fields as well, such as business and con-
struction planning.

The flowchart symbols used in this book are shown in Figure 2.1. The terminal symbol is

used at the beginning and the end of each program. When it is used at the beginning of a pro-
gram, the word Start is written inside it. When it is used at the end of a program, it contains the

word Stop.

Process

Subroutine

Input or
output I B I

off-page connector

on-page connector

Figure 2.1 m Flowchart symbols used in this book

The process box indicates what must be done at this point in the program execution. The
operation specified by the process box could be shifting the contents of one general-purpose reg-
ister to a peripheral register, multiplying two numbers, decrementing a loop count, and so on.

The input/output box is used to represent data that are either read or displayed by the
computer.

The decision box contains a question that can be answered either yes or no. A decision box
has two exits, also marked yes or no. The computer will take one action if the answer is yes and
will take a different action if the answer is no.
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The on-page connector indicates that the flowchart continues elsewhere on the same page.
The place where it is continued will have the same label as the on-page connector. The off-page
connector indicates that the flowchart continues on another page. To determine where the
flowchart continues, one needs to look at the following pages of the flowchart to find the match-
ing off-page connector.

Normal flow on a flowchart is from top to bottom and from left to right. Any line that does
not follow this normal flow should have an arrowhead on it.

When the program gets complicated, the flowchart that documents the logic flow of the
program also becomes difficult to follow. This is the limitation of the flowchart. In this book,
both the flowchart and the algorithm procedure are mixed to describe the solution to a problem.

After one is satisfied with the algorithm or the flowchart, one can convert it to source code
in one of the assembly or high-level languages. Each statement in the algorithm (or each block
in the flowchart) will be converted into one or multiple assembly instructions or high-level lan-
guage statements. If an algorithmic step (or a block in the flowchart) requires many assembly
instructions or high-level language statements to implement, then it might be beneficial to
either (1] convert this step (or block} into a subroutine and just call the subroutine or (2) further
divide the algorithmic step (or flowchart block) into smaller steps {or blocks) so that it can be
coded with just a few assembly instructions or high-level language statements.

The next major step is program testing, which means testing for anomalies. Here one will
first test for normal inputs that one always expects. If the result is as one expects, then one
goes on to test the borderline inputs. Test for the maximum and minimum values of the
input. When the program passes this test also, one continues to test for illegal input values.
If the algorithm includes several branches, then enough values should be used to exercise all
the possible branches to make sure that the program will operate correctly under all possible
circumstances.

In the rest of this book, most of the examples are well defined. Therefore, our focus is on
how to design the algorithm that solves the specified problem and also convert the algorithm
into source code.

2.6 A Template for Writing Assembly Programs

When testing a user program, it should be considered as the only program executed by the
computer. To achieve that, it should be written in a way that can be executed immediately out
of reset. The following format will allow us to do that:

org 0x0000
goto start
org 0x08
o ;high-priority interrupt setvice routine
org 0x18
;low-priority interrupt setvice routine
start
Ce ;your program
end

The PIC18 MCU reserves a small block of memory locations to hold the reset handling rou-
tine and high-priority and low-priority interrupt service routines. The reset, the high-priority
interrupt, and the low-priority interrupt service routines start at 0x000, 0x0008, and 0x0018,
respectively. The user program should start somewhere after 0x0018.
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In an application, the reset handling routine will be responsible for initializing the MCU
hardware and performing any necessary housekeeping functions. The reset signal will provide
default values to many key registers and allow the MCU to operate. At this moment, the user
will take advantage of this by simply using the goto instruction to jump to the starting point of
the user program. By doing this, the user program can be tested.

Since interrupt handling has not been covered yet, we will be satisfied by making both the
high- and the low-priority interrupt service routines dummy routines that do nothing but simply
return. This can be achieved by placing the retfie instruction in the default location. Therefore,
the following template will be used to test the user program until interrupts are discussed:

org 0x0000

goto start sreset handling routine

org 0x08

retfie ;high-priority interrupt service routine

org 0x18

retfie ;low-priority interrupt service routine
start

Ce ;your program

end

2.7 Case Issue

The PIC18 instructions can be written in uppercase or lowercase. However, Microchip
MPASM cross assembler is case sensitive. Microchip provides a free integrated development envi-
ronment MPLAB IDE to all of its users. The MPLAB IDE provides an include file for every MCU
made by Microchip. Each of these include files provides the definitions of all special-function reg-
isters for the specific MCU. All function registers and their individual bits are defined in upper-
case. Since one will include one of these MCU include files in his or her assembly program, using
uppercase for special-function register names becomes necessary. The convention adopted in this
book is to use lowercase for instruction and directive mnemonics but uppercase for all function
registers and their bits.

2.8 Writing Programs to Perform Arithmetic Computations

The PIC18 MCU has instructions for performing 8-bit addition, subtraction, and multipli-
cation operations. Operations that deal with operands longer than eight bits can be synthesized
by using a sequence of appropriate instructions. The PIC18 MCU provides no instruction for
division, and hence this operation must also be synthesized by an appropriate sequence of
instructions. The algorithm for implementing division operation will be discussed in Chapter 4.

In this section, smaller programs that perform simple computations will be used to demon-
strate how a program is written.

2.8.1 Perform Addition Operations

As discussed in Chapter 1, the PIC18 MCU has two ADD instructions with two operands
and one ADD instruction with three operands. These ADD instructions are designed to per-
form 8-bit additions. The execution result of the ADD instruction will affect all flag bits of the
STATUS register.
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The three-operand ADD instruction will be needed in performing multibyte ADD opera-
tions. For an 8-bit MCU, a multibyte addition is also called a multiprecision addition. A multi-
precision addition must be performed from the least significant byte toward the most
significant byte, just like numbers are added from the least significant digit toward the most
significant digit.

When dealing with multibyte numbers, there is an issue regarding how the number is
stored in memory. If the least significant byte of the number is stored at the lowest address,
then the byte order is called little-endian. Otherwise, the byte order is called big-endign. This
text will follow the little-endian byte order in order to be compatible with the MPLAB IDE soft-
ware from Microchip. MPLAB IDE will be used throughout this text.

Write a program that adds the three numbers stored in data registers at 0x20, 0x30, and
0x40 and places the sum in data register at 0x50.

Solution: The algorithm for adding three numbers is as follows:
Step 1
Load the number stored at 0x20 into the WREG register.
Step 2
Add the number stored at 0x30 and the number in the WREG register and leave the sum in
the WREG register.
Step 3
Add the number stored at 0x40 and the number in the WREG register and leave the sum in
the WREG register.
Step 4
Store the contents of the WREG register in the memory location at 0x50.
The program that implements this algorithm is as follows:

#include <p18F8720.inc>

org 0x00
goto start
org 0x08
retfie
org 0x18
retfie

start movf 0x20,W,A ;copy the contents of 0x20 to WREG
addwf 0x30,W,A ;add the value in 0x30 to that of WREG
addwf 0x40,W,A ;add the value in 0x40 to that of WREG
movwf 0x50,A ;save the sum in memory lacation 0x50
end

A

Example 2.5

Write a program that adds the 24-bit integers stored at 0x10 . . . 0x12 and 0x13 . . . 0x15,
respectively, and stores the sum at 0x20 . . . 0x22.
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Solution: The addition starts from the least significant byte (at the lowest address for little-
endian byte order). One of the operand must be loaded into the WREG register before addition
can be performed. The program is as follows:

#include <p18F8720.inc>

org 0x00
goto start
org 0x08
retfie
org 0x18
retfie

start  movf 0x10,W,A ;copy the value of location at 0x10 to WREG
addwf 0x13,W,A ;add & leave the sum in WREG
movwf 0x20,A ;save the sum at memory location 0x20
movf Ox11,W,A ;copy the value of location at Ox11 to WREG
addwfc Ox14,W,A ;add with carry & leave the sum in WREG
movwf 0x21,A ;save the sum at memory location 0x21
movf O0x12,W,A ;copy the value of location at 0x12 to WREG
addwfc 0x15,W,A ;add with carry & leave the sum in WREG
movwf 0x22,A ;save the sum at memory location 0x22
end

A

Example 2.6

2.8.2 Perform Subtraction Operations

The PIC18 MCU has two two-operand and two three-operand SUBTRACT instructions.
SUBTRACT instructions will also affect all the flag bits of the STATUS register. Like other
MCUs, the PIC18 MCU executes a SUBTRACT instruction by performing two’s complement
addition. When the subtrahend is larger than the minuend, a borrow is needed, and the PIC18
MCU flags this situation by clearing the C flag of the STATUS register.

Three-operand subtraction instructions are provided mainly to support the implementation
of multibyte subtraction. A multibyte subtraction is also called a multiprecision subtraction. A
multiprecision subtraction must be performed from the least significant byte toward the most
significant byte.

Write a program to subtract 5 from memory locations 0x10 to 0x13.

Solution: The algorithm for this problem is as follows:

Step 1

Place 5 in the WREG register.

Step 2

Subtract WREG from the memory location 0x10 and leave the difference in the memory
location 0x10.

Step 3

Subtract WREG from the memory location 0x11 and leave the difference in the memory
location Ox11.

Step 4

Subtract WREG from the memory location 0x12 and leave the difference in the memory
location 0x12.



Step 5

Subtract WREG from the memory location 0x13 and leave the difference in the memory
location 0x13.

The assembly program that implements this algorithm is as follows:

#include <p18F8720.inc>

org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start  movlw 0x05 ;place the value 5 in WREG
subwf 0x10,F,A ;subtract 5 from memory location 0x10
subwf Ox11,F.A ;subtract 5 from memory location 0x11
subwf Ox12,F.A ;subtract 5 from memory location 0x12
subwf 0x13,F,A ;subtract 5 from memory location 0x13
end
A
Example 2.7
Write a program that subtracts the number stored at 0x20 . . . 0x23 from the number stored

at 0x10 . . . 0x13 and leaves the difference at 0x30 . . . 0x33.

Solution: The logic flow of this problem is shown in Figure 2.2.

WREG « [0x20}

1

0x30 « [0x10] - [WREG]

WREG « [0x21]

1

0x31 « [0x11] - [WREG] - B

WREG « [0x22]

0x32 < [0x12] - [WREG] - B

WREG « [0x23]

0x33 ¢ [0x13] - [WREG] - B

Three-operand subtraction

Three-operand subtraction

Three-operand subtraction

Figure 2.2 m Logic flow of Example 2.7
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The program that implements the logic illustrated in Figure 2.2 is as follows:
#include <p18F8720.inc>

org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start movf 0x20, W, A
subwf 0x10, W, A ;subtract the least significant byte
movwf 0x30, A
movf 0x21, W, A

subwfb 0x11, W, A ;subtract the second to least significant byte
movwf 0x31, A

movf 0x22, W, A

subwfb 0x12, W, A ;subtract the second to most significant byte
movwf 0x32, A

movf 0x23, W, A

subwfb 0x13, W, A ;subtract the most significant byte

movwf 0x33, A

end

A

2.8.3 Binary Coded Decimal Addition

All computers perform arithmetic using binary arithmetic. However, input and output
equipment generally uses decimal numbers because we are used to decimal numbers. Computers
can work on decimal numbers as long as they are encoded properly. The most common way to
encode decimal numbers is to use four bits to encode each decimal digit. For example, 1234 is
encoded as 0001 0010 0011 0100. This representation is called binary-coded decimal (BCD). If
BCD format is used, it must be preserved during the arithmetic processing.

The BCD representation simplifies input/output conversion but complicates the internal
computation. The use of the BCD representation must be carefully justified.

The PIC18 MCU performs all arithmetic in binary format. The following instruction
sequence appears to cause the PIC18 MCU to add the decimal numbers 31 and 47 and store the
sum at the memory location 0x50:

movlw 0x31

addlw 0x47
movwf 0x50, A

This instruction sequence performs the following addition:
h31

+h47
h78
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When the PIC18 MCU executes this instruction sequence, it adds the numbers according to the
rules of binary addition and produces the sum h’78’, which is a correct decimal number. However,
a problem occurs when the PIC18 MCU adds two BCD digits that yield a sum larger than 9:

h24 h36 h29
+h67 +h47 +hd7
h8B h7D h70

The first two additions are obviously incorrect because the results have illegal characters. The
third example does not contain any illegal character. However, the correct result should be 76
instead of 70. There is a carry from the lower digit to the upper digit.

In summary, a sum in BCD is incorrect if the sum is greater than 9 or if there is a catry from
the lower digit to the upper digit. Incorrect BCD sums can be adjusted by performing the fol-
lowing operations:

1. Add 0x6 to every sum digit greater than 9.
2. Add 0x6 to every sum digit that had a carry of 1 to the next higher digit.
These problems are corrected as follows:

h24 h36 h29
+h67 +h47 +h47
h8B h7D h70
+h 6 +h 6 +h 6
hot h83 h76

The bit 1 of the STATUS register is the digit carry (DC) flag that indicates if there is a carry from
bit 3 to bit 4 of the addition result. The decimal adjust WREG (daw) instruction adjust the 8-bit
value in the WREG register resulting from the earlier addition of two variables (each in packed
BCD format} and produces a correctly packed BCD result. Multibyte decimal addition is also
possible by using the DAW instruction.

Write an instruction sequence that adds the decimal number stored in 0x23 and 0x24
together and stores the sum in 0x25. The result must also be in BCD format.

Solution: The instruction is as follows:

movf  Ox23,W,A
addwf 0x24,W,A
daw
movwf 0x25,A
Example 2.9
Write an instruction sequence that adds the decimal numbers stored at 0x10 . . . 0x13 and

0x14 . . . 0x17 and stores the sum in 0x20 . . . 0x23. All operands are in the access bank.
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WREG « [0x10]
1
WREG « [WREG] + [0x14]
]

0x20 « decimal adjusted
WREG
1
WREG « [0x11]
|
WREG « [WREG] + [0x15] + C
1
0x21 « decimal adjusted
WREG
|
WREG « [0x12]
]
WREG <« [WREG] + [0x16] + C
|
0x22 « decimal adjusted
WREG
I
WREG « [0x13]
1
WREG « [WREG] + [0x17] + C
|
0x23 « decimal adjusted
WREG

Figure 2.3 m Logic flow of Example 2.9

Solution: In order to make sure that the sum is also in decimal format, decimal adjustment must
be done after the addition of each byte pair. The logic flow of this problem is shown in Figure 2.3.
The program is as follows:

#include <p18F8720.inc>

org 0x00
goto start
org 0x08
retfie

org 0x18

retfie
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stat  movf 0x10,W,A  ;WREG « [0x10]
addwf 0x14,W,A  ;WREG « [0x10] + [Ox14]
daw ;decimal adjust WREG
movwf 0x20,A ;save the least significant sum digit
movf Ox11,W,A  ;WREG « [Ox11]
addwfc Ox15,W,A
daw
movwf 0x21,A
movf 0x12,W,A  ;WREG « [0x12]
addwfc 0x16,W,A
daw
movwf 0x22,A
movf 0x13,W,A  ;WREG « [0Ox13]
addwic  Ox17,W,A
daw
movwf 0x23,A ;save the most significant sum digit
end

A

2.8.4 Multiplication

The PIC18 MCU provides two unsigned multiply instructions. The mullw k instruction
multiplies an 8-bit literal with the WREG register and places the 16-bit product in the register
pair PRODH:PRODL. The upper byte of the product is placed in the PRODH register, whereas
the lower byte of the product is placed in the PRODL register. The mulwf f,a instruction mul-
tiplies the contents of the WREG register with that of the specified file register and leaves the
16-bit product in the register pair PRODH:PRODL. The upper byte of the product is placed in
the PRODH register, whereas the lower byte of the product is placed in the PRODL register.

Example 2.10

Write an instruction sequence to multiply two 8-bit numbers stored in data memory loca-
tions 0x10 and Ox11, respectively, and place the product in data memory locations 0x20 and 0x21.

Solution: The instruction sequence is as follows:

movf 0x10, W,A
mulwf Ox11,A
movff PRODH, 0x21
movff PRODL, 0x20

The unsigned multiply instructions can also be used to perform multiprecision multiplications.
In a multiprecision multiplication, the multiplier and the multiplicand must be broken down
into 8-bit chunks, and multiple 8-bit by 8-bit multiplications must be performed. Assume that
we want to multiply a 16-bit hex number P by another 16-bit hex number Q. To illustrate the
procedure, we will break P and Q down as follows:

P= PHPL
Q=04Q
where Py and Qy are the upper eight bits of P and Q, respectively, and Py, and Qy, are the lower

eight bits. Four 8-bit by 8-bit multiplications are performed, and then the partial products are
added together as shown in Figure 2.4. A
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[}
| 8-bit 8-bit 8-bit 8-bit
;
1
i upperbyte | lowerbyte || partial product P Q.
I
i upper byte | lower byte partial product P4Q,
i
| upper byte | lower byte partial product P.Qy
:

+i upper byte | lower byte partial product P,Qy
1
1

Address i R+3 R+2 R+1 R Final product P Q

i msb Isb

Note: msb stands for most significant byte and Isb stands for least significant byte

Figure 2.4 m 16-bit by 16-bit multiplication

Example 2.11
Write a program to multiply two 16-bit unsigned integers assuming that the multiplier and
multiplicand are stored in data memory locations M1 . . . M1 + 1 and N1. . . N1 + 1, respec-
tively. Store the product in data memory locations PR . . . PR + 3. The multiplier, the multi-

plicand, and the product are located in the access bank.

Solution: The algorithm for the unsigned 16-bit multiplication is as follows:
Step 1
Compute the partial product M1;N1y and save it in locations PR and PR + 1.
Step 2
Compute the partial product M1gzNI1y and save it in locations PR + 2 and PR + 3.
Step 3
Compute the partial product M1yN1y, and add it to memory locations PR + 1 and PR + 2.
The C flag may be set to 1 after this addition.
Step 4
Add the C flag to memory location PR + 3.
Step 5
Compute the partial product M1; N1y and add it to memory locations PR + 1 and PR + 2.
The C flag may be set to 1 after this addition.
Step 6
Add the C flag to memory location PR + 3.



The assembly program that implements this algorithm is as follows:

nl_h
ni_1
ml_h
mi_1
M1
N1
PR

start

#include <p18F8720.inc>

equ
equ
equ
equ
set

set

set

org
goto
org
retfie
org
retfie
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
movf
muiwf
movff
movff
movf
mulwf
movff
movft
movf
mulwf
movf
addwf
movf
addwfc
moviw
addwfc
movf
mulwf
movf
addwf
movf
addwfc
moviw
addwfc
nop
end

0x37
0x23
0x66
Ox45
0x00
0x02
0x06
0x00
start
0x08

0x18

mil_h

M1+ 1,A
mi_1

M1,A

nl_h
N1+1,A
nl_1

N1,A
Mi+1,WA
N1+1,A
PRODL, PR+2
PRODH,PR+3
M1,W,A
N1,A
PRODL, PR
PRODH,PR+1
M1,W,A
N1+1,A
PRODL,W,A
PR+1,FA
PRODH,W,A
PR+2,F,A

0

PR+3,F,A
M1+1,WA
N1i,A
PRODL,W,A
PR+1,F,A
PRODH,W,A
PR+2,F,A

0

PR+3,F.A

; upper byte of the first number

; lower byte of the first number

; upper byte of the second number
; lower byte of the second number
; multiplicand

; multiplier

; product

; set up test numbers

; compute M1y x N1,

; compute M1, x N1

; compute M1, X N1y
; add M1 x N1; to PR

; add carry

; compute M1y < N1;
;add M1, x N1, to PR

; add carry

Multiplication of other lengths [such as 32-bit by 32-bit or 24-bit by 16-bit) can be per-
formed using an extension of the same method.

A
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2.9 Program Loops

One of the most powerful features of a computer is its ability to perform the same opera-
tion repeatedly without making any error. In order to tell the computer to perform the same
operation repeatedly, program loops must be written.

A loop may be executed for a finite number of times or forever. A finite Ioop is a sequence
of instructions that will be executed for a finite number of times, while an endless loop is a
sequence of instructions that will be repeated forever.

2.9.1 Program Loop Constructs
There are four major looping methods:

1. Do statement S forever. This is an infinite loop in which the statement S will be
executed forever. In some applications, the user may add the statement “If C then
exit” to get out of the infinite loop. An infinite loop is illustrated in Figure 2.5.

Figure 2.5 m An infinite loop

An infinite loop requires the use of “goto target” or bra target” as the last instruction
of the loop for the PIC18 MCU, where target is the label of the start of the loop.

2. Fori=nl ton2 do S or For i = n2 downto n1 do S. In this construct, the variable i is
used as the loop counter that keeps track of the remaining times that the statements S
is to be executed. The loop counter can be incremented (the first case) or decremented
(the second case). The statement S is executed n2 — n1 + 1 times. The value of n2 is
assumed to be larger than nl. If there is concern that the relationship nl < n2 may not
hold, then it must be checked at the beginning of the loop. Four steps are required to
implement a For loop:

Step 1

Initialize the loop counter.

Step 2

Compare the loop counter with the limit to see if it is within bounds. If it is, then
perform the specified operations. Otherwise, exit the loop.

Step 3

Increment (or decrement} the loop counter.

Step 4

Go to Step 2.

A For-loop is illustrated in Figure 2.6.
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no

i« i+1

(a) Fori=ijtoi; Do S

i-1

Figure 2.6 m A For-loop looping construct

67

no

(b) Fori=i, downtoi; Do S

3. While C Do 8. In this looping construct, the condition C is tested at the start of the
loop. If the condition C is true, then the statement S will be executed. Otherwise, the
statement S will not be executed. The While C Do S looping construct is illustrated in
Figure 2.7. The implementation of a while loop consists of four steps:

Step 1
Initialize the logical expression C.
Step 2
Evaluate the logical expression C.
Step 3

Perform the specified operations if the logical expression C evaluates to true. Update
the logical expression C and go to Step 2. The expression C may be updated by

external events, such as interrupt.

Step 4
Exit the while loop.

true

false

Figure 2.7 m The While ... Do looping construct
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4. Repeat S until C. The statement S is executed, and then the logical expression C is
evaluated. If C is true, then the statement S will be executed again. Otherwise, the
next statement will be executed, and the loop is ended. The action of this looping
construct is illustrated in Figure 2.8. The statement S will be executed at least once.
This looping construct consists of three steps:

Step 1

Initialize the logical expression C.

Step 2

Execute the statement S.

Step 3

If the logical expression C is true, then go to Step 2. Otherwise, exit the loop.

initialize C

true

false

Figure 2.8 m The Repeat ... Until looping construct

2.9.2 Changing the Program Counter

A normal program flow is one in which the CPU executes instructions sequentially start-
ing from lower addresses toward higher addresses. The implementation of a program loop
requires the capability of changing the direction of a normal program flow. The PIC18 MCU
supplies a group of instructions (shown in Table 2.9) that may change the normal program flow.

In the normal program flow, the program counter value is incremented by 2 or 4 (for two-word
instructions). The PIC18 program counter is 21 bits wide. The low byte is called the PCL register.
The high byte is called the PCH register. This register contains the PC<15:8> bits and is not
directly readable or writable. Updates to the PCH register may be performed through the PCLATH
register. The upper byte is called the PCU register. This register contains the PC<20:16> bits and
is not directly readable or writable. Updates to the PCU register may be performed through the
PCLATU register.

Figure 2.9 shows the interaction of the PCU, PCH, and PCL registers with the PCLATU and
PCLATH registets.
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Mnemonics,
operands

Description

16-bit instruction word

Status
affected

BCn

BN n
BNC n
BNN n
BNOV n
BNZn
BOV n
BRAn
BZn
CALLn,s

GOTOn
RCALL n

RETLW k
RETURN s

Branch if carry

Branch if negative
Branch if no carry
Branch if not negative
Branch if not overflow
Branch if not zero
Branch if overflow
Branch unconditionally
Branch if zero

Call subroutine

Go to address

Relative call

Return with literal in WREG

Return from subroutine

1110 0010 nnnn nnnn
1110 0110 nnnn nnnn
1110 0011 nnnn nnnn
1110 0111 nnnn nnnn
1110 0101 nnnn nnnn
1110 0001 nnnn nnnn
1110 0100 nnnn nnnn
1110 Onnn nnnn nnnn
1110 0000 nnnn nnnn
1110 110s kkkk kikk
1111 kkkk kkkk kkkk
1110 1111 kkkk kkkk
1111 kkkk kkkk kikkk
1101 Lnnn nnnn nnnn
0000 1100 kkkk kkkk
0000 0000 0001 001s

None
None
None
None
None
None
None
None
None
None

None
None

None
None

Table 2.9 m PIC18 instructions that change program flow

PC

PCLATU

PCLATH

PCL

reserved

Figure 2.9 m Program counter structure
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The low byte of the PC register is mapped in the data memory. PCL is readable and writable
just as is any other data register. PCU and PCH are the upper and high bytes of the PC, respec-
tively, and are not directly addressable. Registers PCLATU<4:0> and PCLATH<7:0> are used as
holding latches for PCU and PCH and are mapped into data memory. Any time the PCL is read,
the contents of PCH and PCU are transferred to PCLATH and PCLATU, respectively. Any time
PCL is written into, the contents of PCLATH and PCLATU are transferred to PCH and PCU,

respectively. The resultant effect is a branch. This is shown in Figure 2.10.
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20 16 15 8 7 0
PCU PCH PCL
PCLATU PCLATH ALU Resuilt

Figure 2.10 m Action taken when an instruction uses PCL as the destination

The PC addresses bytes rather than words in the program memory. Because the PIC18
MCU must access the instructions in program memory on an even byte boundary, the least sig-
nificant bit of the PC register is forced to 0, and the PC register increments by two for each
instruction. The least significant bit of PCL is readable but not writable. Any write to the least
significant bit of PCL is ignored.

Finite loops require the use of one of the conditional branch instructions. The PIC18 MCU
can make a forward or a backward branch. When a branch instruction is being executed, the 8-
bit signed value contained in the branch instruction is added to the current PC. When the signed
value is negative, the branch is backward. Otherwise, the branch is forward. The branch dis-
tance (in the unit of word) is measured from the byte immediately after the branch instruction
as shown in Figure 2.11. The branch distance is also called branch offset. Since the branch off-
set is 8-bit, the range of branch is between —128 and +127 words.

[ target Branch instruction
next instruction -1

branch offset < 0 branch ofiset > 0

Branch instruction
next instruction

(a) Backward branch (b) Forward branch

y L—» target —_

Figure 2.11 m Sign of branch offset and branch direction

The PIC18 CPU makes the branch decision using the condition flags of the STATUS regis-
ter. Using the conditional branch instruction as the reference point, the instruction

bn  -10

will branch backward nine words if the N flag is set to 1.
bc 10

will branch forward 11 words if the C flag is set to 1.
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Usually, counting the number of words to branch is not very convenient. Therefore, most
assemblers allow the user to use the label of the target instruction to replace the branch offset.
For example, the bn -10 can be written as

is_minus

bn is_minus

Using the label of the target instruction to replace the branch offset has another advantage:
the user does not need to recalculate the branch offset if one or more instructions are added or
deleted between the branch instruction and the target instruction.

The following two instructions are often used to increment or decrement the loop counter
and hence update the condition flags:

incf f,d,a ; increment file register f
decf f,d,a ; decrement file register f

In addition to conditional branch instructions, the PIC18 MCU can also use the goto
instruction to implement program loops. This method will require one to use another instruc-
tion that performs a compare, decrement, increment, or bit test operation to set up the condi-
tion for making a branch decision. These instructions are listed in Table 2.10.

Mnemonics, Status
operands Description 16-bit instruction word affected
CPFSEQ f,a Compare f with WREG, skip = 0110 001a ffff fiff None
CPFSGT f,a Compare f with WREG, skip > 0110 010a ffff ffff None
CPFSLT f,a Compare f with WREG, skip < 0110 000a ffff ffff None
DECFSZ f,d,a Decrement f, skip if 0 0010 11da ffff fiff None
DCFSNZ f,d,a Decrement f, skip if not 0 0100 11da fiff ffff None
INCFSZ f,d,a Increment f, skip if 0 0011 11da ffff ffff None
INFSNZ f,d,a Increment f, skip if not 0 0100 10da ffff ffff None
TSTFSZ f,a Test f, skip if 0 0110 011a fiff ffif None
BTFSC f,b,a Bit test f, skip if clear 1011 bbba ffff ffff None
BTFSS f,b,a Bit test f, skip if set 1010 bbba ffff ffff None
goton goto address n (2 words) 1110 11171 kkkk kkkk None
1111 kkkk kkkk kkkk

Table 2.10 m Non-branch Instructions that can be used to implement conditional branch

Suppose the loop counter is referred to as i_ent and that the loop limit is placed in WREG.
Then the following instruction sequence can be used to decide whether the loop should be
continued:

i_loop
Ca ; Lcnt is incremented in the loop
cpfseq i_cnt,A ; compare i_cnt with WREG and skip if equal
goto i_loop ; executed when I_cnt # loop limit
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Suppose that a program loop is to be executed n times. Then the following instruction
sequence can do just that:

n equ 20 ;n has the value of 20
Ip_cnt set 0x10 ; assign file register 0x10 to Ip_cnt
moviw n
movwf Ip_cnt ; prepare to repeat the loop for n times
loop C ; program loop
decfsz Ip_cnt,F,A ; decrement Ip_cnt and skip if equal to 0
goto loop ; executed if Ip_cnt 2 0

If the loop label is within 128 words from the branch point, then one can also use the one-
word bra loop instruction to replace the goto loop instruction. The previously mentioned loop
can also be implemented using the bnz loop instruction as follows:

Ip_cnt set 0x10 ; use file register Ox10 as Ip_cnt
moviw n
movwf Ip_cnt ; prepare to repeat the loop for n times
loop RN ; program loop
decf Ip_cnt,F.A ; decrement Ip_cnt
bnz. loop ; executed if Ip_ent = 0

The btisc £,b,a and btfss fb,a instructions are often used to implement a loop that waits for
a certain flag bit to be cleared or set during an I/O operation. For example, the following instruc-
tions will be executed repeatedly until the ADIF bit (bit 6) of the PIR1 register is set to 1:
again btfss PIR1, ADIF,A ; wait until ADIF bit is set to 1
bra again
The following instruction sequence will be executed repeatedly until the DONE bit (bit 2)
of the ADCONO register is cleared:

wait_loop btfsc ADCONO,DONE,A ; wait until the DONE bit is cleared
bra wait_loop
Example 2.12
Write a program to compute 1 +2+3 +. . . +n and save the sum at 0x00 and 0x01 assum-

ing that the value of n is in a range such that the sum can be stored in two bytes.

Solution: The logic flow for computing the desired sum is shown in Figure 2.12. This flowchart
implements the For i = i; to i; Do S loop construct.
The following program implements the algorithm illustrated in Figure 2.12:

#include <pi18F8720.inc>

n equ D50

sum_hi set 0x01 ;high byte of sum
sum_lo set 0x00 ;low byte of sum
i set 0x02 ;loop index i

org 0xQ0 ;reset vector
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start

sum_lp

add_lp

exit_sum

goto
org
retfie
org
retfie
cirf
cirf
clrf
incf
moviw
cpfsgt
bra
bra
movf
addwf
moviw
addwfc
incf
bra
nop
end

( Start )

i« 1
sum « 0

i>n?

no

sum <— sum + i

yes

ie—i+1

I

Figure 2.12 m Flowchart for computing 1+2+...+n

start
0x08

0x18

sum_hi,A
sum_lo,A
i,A

i,F,A

n

i,A

add_Ip
exit_sum
WA
sum_{o,F,A
0
sum_hi,F,A
i,F,A
sum_Ip

; initialize sum to O

s initialize i to O

; i starts from 1

: place n in WREG

; compare i with n and skip if i > n
: perform addition when i < 50

; it is done when i > 50

; place i in WREG

; add i to sum_lo

; add carry to sum_hi
; increment loop index i by 1

73
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Example 2.13

Write a program to find the largest element stored in the array that is stored in data mem-
ory locations from 0x10 to Ox5F.

Solution: We use the indirect addressing mode to step through the given data array. The algo-
rithm to find the largest element of the array is as follows:

Step 1

Set the value of the data memory location at 0x10 as the current temporary array max.

Step 2

Compare the next data memory location with the current temporary array max. If the new
memory location is larger, then replace the current array max with the value of the
current data memory location.

Step 3

Repeat the same comparison until all the data memory locations have been checked.

The flowchart of this algorithm is shown in Figure 2.13.

( Start )

arr_max « arr[0]
i1

arrfi] > arr_max?

yes

arr_max « arrfi]

o

je—i+1

\

Figure 2.13 m Flowchart for finding the maximum array element
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We use the While C Do S looping construct to implement the program loop. The condition
to be tested is i < n. The PIC18 assembly program that implements the algorithm shown in
Figure 2.13 is as follows:

arr_max  equ 0x00
i equ 0x01
n equ D80’ ; the array count
#include <p18F8720.inc>
org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start movf Ox10,W,A ; set arr[0] as the initial array max
movwf  arr_max,A i
Ifsr FSRO,0x11 ; place Ox11 (address of an[1]) in FSRO
clrf i,A ; initialize loop countito O
again moviw n-1 ; establish the number of comparisons to be made
; the next instruction implements the condition C(i = n)
cpfsit i,A ;skipifi<n-1
goto done ; all compatisons have been done
; the following 7 instructions update the array max
movf POSTINCO,W ; place arr[i] in WREG and increment array pointer
cpfsgt  am_max,A ; is arr_max > anfi]?
goto replace ; o
goto next_i ;yes
replace  mowwf  amr_max,A ; update the array max
next_i incf i,F,A
goto again
done nop
end

2 10 Readlng and Writing Data in Program Memory

The PIC18 program memory is 16-bit, whereas the data memory is 8 b1t In order to read
and write program memory, the PIC18 MCU provides two instructions that allow the proces-
sor to move bytes between the program memory and the data memory:

m Table read (TBLRD)
= Table write (TBLWT)

Because of the mismatch of bus size between the program memory and data memory, the
PIC18 MCU moves data between these two memory spaces through an 8-bit register (TABLAT).
Figure 2.14 shows the operation of a table read with program memory and data memory.
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Program memory
Table pointer

TBLPTRU | TBLPTRH | TBLPTAL Table latch
B
— TABLAT

Figure 2.14 m Table read operation (redrawn with permission of Microchip)

Table-write operations store data from the data memory space into holding registers in pro-
gram memory. Figure 2.15 shows the operation of a table write with program memory and data
memory.

Program memory
Table pointer

Table latch
TABLAT

TBLPTRU | TBLPTRH | TBLPTRL

Figure 2.15 m Table write operation (redrawn with permission of microchip)

The on-chip program memory is either EPROM or flash memory. The erasure operation
must be performed before an EPROM or flash memory location can be correctly programmed.
The erasure and write operations for EPROM or flash memory take much longer time than the
SRAM. This issue will be discussed in Chapter 14.
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Eight instructions are provided for reading from and writing into the table in the program
memory. These instructions are shown in Table 2.11.

Mnemonic, Status
operator Description 16-bit instruction word affected
TBLRD* Table read 0000 0000 0000 1000 none
TBLRD*+ Table read with post-increment 0000 0000 0000 1001 none
TBLRD*- Table read with post-decrement 0000 0000 0000 1010 none
TBLRD+* Table read with pre-increment 0000 0000 0000 1011 none
TBLWT* Table write 0000 0000 0000 1100 none
TBLWT*+ Table write with post-increment 0000 0000 0000 1101 none
TBLWT*~ Table write with post-decrement 0000 0000 0000 1110 none
TBLWT+* Table write with pre-increment 0000 0000 0000 1111 none

Table 2.11 m PiC18 MCU table read and write instructions

The table pointer [TBLPTR) addresses a byte within the program memory. The TBLPTR is
comprised of three special-function registers {table pointer upper byte, high byte, and low byte).
These three registers together form a 22-bit-wide pointer. The low-order 21 bits allow the
device to address up to 2 MB of program memory space. The 22nd bit allows read-only access
to the device ID, the user ID, and the configuration bits. The table pointer is used by the
TBLRD and TBLWT instructions. Depending on the versions of these two instructions {shown
in Table 2.11), the table pointer may be postdecremented (decremented after it is used), prein-
cremented (incremented before it is used), or postincremented (incremented after it is used).

Whenever a table-read instruction is executed, a byte will be transferred from program
memory to the table latch [TABLAT). All PIC18 members have a certain number of holding reg-
isters to hold data to be written into the program memory. Holding registers must be filled up
before the program-memory-write operation can be started. The write operation is complicated
by the EPROM and flash memory technology. The table-write operation to on-chip program
memory (EPROM and flash memory) will be discussed in Chapter 14.

Example 2.14

Write an instruction sequence to read a byte from program memory location at 0x60 into
TABLAT.

Solution: The first step to read the byte in program memory is to set up the table pointer. The
following instruction sequence will read the byte from the program memory:

clrf TBLPTRU,A  ; set TBLPTR to point to data memory at
clrf TBLPTRH,A  ; 0x60

moviw  0x60 e

movwf TBLPTRLA ;*“

tbird* ; read the byte into TABLAT
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In assembly language programming, the programmer often uses a label to refer to an array.
The MPASM assembler allows the user to use symbolic names to extract the values of the
upper, the high, and the low bytes of a symbol:

® upper name refers to the upper part of name.
®  high name refers to the middle part of name.
* low name refers to the low part of name.
Suppose that the symbol arr_x is the name of an array. Then the following instruction
sequence places the address represented by arr_x in the table pointer:
moviw  upper arr_x
movwf  TBLPTRU,A  ; set up the upper part of the table pointer
movlw  high arr_x
movwf  TBLPTRH,A ; set up the middle part of the table pointer
movlw  low arr_x
movwf  TBLPTRLA ; set up the lower part of the table pointer

2.11 Logic Instructions

The PIC18 MCU provides a group of instructions (shown in Table 2.12) that perform logi-
cal operations. These instructions allow the user to perform AND, OR, exclusive-OR, and com-
plementing on 8-bit numbers.

Mnemonic, Status
operator Description 16-bit instruction word affected
ANDWF f.d,a AND WREG with f 0001 Oida ffff ffff ZN
COMF f,d,a, Complement f 0001 11lda ffff ffff ZN
IORWF f,d,a Inclusive OR WREG with f 0001 00da  ffif ffif ZN
NEGF f,a Negate f 0110 110a  ffff fftf all
XORWF f,d,a Exclusive OR WREG with f 0001 10da  ffff ffff ZN
ANDLW k AND literal with WREG 0000 1011 kkkk  kkkk ZN
10LW k Inclusive OR literal with WREG 0000 1001 kkkk  kkkk ZN
XORLW k Exclusive OR literal with WREG 0000 1010 kkkk  kkkk ZN

Table 12,12 m PIC18 MCU logic instructions

Logical operations are useful for looking for array elements with certain properties (e.g.,
divisible by power of 2) and manipulating 1/O pin values (e.g., set certain pins to high, clear a
few pins, toggle a few signals, and so on).

Example 2.15

Write an instruction sequence to do the following:
(a) Sethits 7, 6, and O of the PORTA register to high

(b) Clear bits 4, 2, and 1 of the PORTB register to low
{c) Toggle bits 7, b, 3, and 1 of the PORTC register



Solution: These requirements can be achieved as follows:

(a) moviw B’11000001’
iorwf  PORTA, F, A

(b) moviw B’11101001’
andwf PORTB, F, A

(c) moviw B'10101010
xorwf  PORTC

A

Example 2.16

Write a program to find out the number of elements in an array of 8-bit elements that are
a multiple of 8. The array is in the program memory.

Solution: A number is a multiple of 8 if its least significant three bits are 000. This can be tested
by ANDing the array element with B’'00000111’. If the result of this operation is zero, then the
element is a multiple of 8. The algorithm is shown in the flowchart in Figure 2.16. This algo-
rithm uses the Repeat S until C looping construct. The program is as follows:

#include <p18F8720.inc>

ilimit equ 0x20 ; loop index limit
count set 0x00
ii set 0x01 ; loop index
mask equ 0x07 ; used to masked upper five bits
org 0x00
goto start
org 0x08 ; high-priority interrupt seice routine
retfie
org 0x18 ; low-priority interrupt service routine
retfie
start clrf count,A
moviw ilimit
movwf i ; initialize ii to ilimit

moviw upper array
movwf  TBLPTRU,A
moviw high array
movwf  TBLPTRH,A
moviw low array
movwf  TBLPTRL,A
moviw mask

i_loop tblrd*+ ; read an array element into TABLAT
andwf  TABLATF,A
bnz next ; branch if not a multiple of 8
incf count, F.A ; is a multiple of 8

next decfsz i,F,A ; decrement loop count
bra i_loop
nop

array db 0x00,0x01,0x30,0x03,0x04,0x05,0x06,0x07,0x08,0x09
db 0x0A,0x0B,0x0C,0x0D,0x0E, 0xOF,0x10,0x11,0x12,0x13
db 0x14,0x15,0x16,0x17,0x18,0x19,0x1A,0x1B,0x1C,0x1D
db Ox1E,Ox1F
end
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D

|
i< N
count « 0

prod « array[i] AND 0x07

no
prod = 0?

yes

count « count + 1

ie—i-1 -
-
yes

C s D

Figure 2.16 m Flowchart for Example 2.16

2.12 Using Program Loop to Create Time Delays

A time delay can be created by repeating an appropriate instruction sequence for certain
number of times.

Example 2.17

Write a program loop to create a time delay of 0.5 ms. This program loop is to be run on a
P18F8680 demo board clocked by a 40-MHz crystal oscillator.

Solution: Because each instruction cycle consists of four oscillator cycles, one instruction cycle
lasts for 100 ns. The following instruction sequence will take 2 ps to execute:
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loop_cnt equ Ox00
again nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

nop

defsnz loop_cnt,F,A ; decrement and skip the next instruction
bra again

This instruction sequence can be shortened by using the following macro:

dup_nop macro kk ; this macro will duplicate the nop instruction
variable | ; kk times
i=0
while i<kk
nop
i+=1
endw
endm

The nop instruction performs no operation. Each of these instructions except bra again
takes one instruction cycle to execute. The bra again instruction takes two instruction cycles
to complete. Therefore, the previous instruction sequence takes 20 instruction cycles (or 2 us)
to execute.

To create a delay of 0.5 ms, the previous instruction sequence must be executed 250 times.
This can be achieved by placing 250 in the loop_cnt register. The following program loop will
create a time delay of 0.5 ms:

moviw D250’
movwf loop_cnt, A

again  dup_nop D17 ; 17 instruction cycle
decfsz loop_cnt,F,A ;1 instruction cycle (2 when [loop_cnt] = 0)
bra again ;2 instruction cycle

This program tests the looping condition after 17 nop instructions have been executed, and
hence it implements the repeat S until C loop construct. Longer delays can be created by adding
another layer of loop. A
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Example 2.18

Write a program loop to create a time delay of 100 ms. This program loop is to be run on a
PIC18 demo board clocked by a 40-MHz crystal oscillator.

Solution: A 100-ms time delay can be created by repeating the program loop in Example 2.17 for
200 times. The program loop is as follows:

Ip_cntl  equ 0x21

Ip_cnt2  equ 0x22
moviw D200’
movwf lp_cntl,A

loop1 moviw D250
movwf lp_cnt2,A

loop2 dup_nop D17 ; 17 instruction cycles
decfsz lp_cnt2,F, A ; 1 instruction cycle (2 when [lp_cntl] = 0)
bra loop2 ; 2 instruction cycles
decfsz fp_cntl,F A
bra loopl

2.13 Rotate Instructions

The PIC18 MCU provides four rotate instructions. These four instructions are listed in

Table 2.13.
Mnemonic, Status
operator Description 16-bit instruction word affected
RLCFf, d, a Rotate left f through carry 0011 Q1da ffff ffff C,ZN
RLNCFf, d, a Rotate left f (no carry) 0100 t1lda ffff ffff ZN
RRCFf, d, a Rotate right f through carry 0011 Q0da ffff ffff C,ZN
RRNCFf, d ,a Rotate right f (no carty) 0100 00da ffff ffff Z,N

Table 2.13 m PiC18 MCU rotate instructions

Rotate instructions can be used to manipulate bit fields and multiply or divide a number
by a power of 2.

The operation performed by the tlef f,d,a instruction is illustrated in Figure 2.17. The result
of this instruction may be placed in the WREG register (d = 0] or the specified f register (d = 1).

Figure 2.17 m Operation performed by the rlcf f,d,a instruction
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The operation performed by the rlnef £,d,a instruction is illustrated in Figure 2.18. The result
of this instruction may be placed in the WREG register (d = 0} or the specified f register (d = 1).

Figure 2.18 m Operation performed by the rinef f,d,a instruction

The operation performed by the rref f,d,a instruction is illustrated in Figure 2.19. The result
of this instruction may be placed in the WREG register (d = 0} or the specified f register (d = 1).

O
~
[2]
[6)]
IS
w
N
-
o

Figure 2,19 m Operation performed by the rref f,d,a instruction

The operation performed by the renef f,d,a instruction is illustrated in Figure 2.20. The result
of this instruction may be placed in the WREG register {d = 0) or the specified f register {d = 1).
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=T T T T

L..

T
O ORI O U S
o e T P i —

1 I 1 1 1

T
1.

L T
L 1

Figure 2.20 m Operation performed by the rmef f,d,a instruction

Example 2.19

Compute the new values of the data register 0x10 and the C flag after the execution of the
rlef 0x10,F,A instruction. Assume that the original value in data memory at 0x10 is 0xA9 and
that the C flag is O.

Solution: The operation of this instruction is shown in Figure 2.21.

The result is

[

i 0 1 0 1 O
L.

0 1
A ’f'/' // / // Original value New value
1 0 1 0 1 0

y4
[0x10] = 10101001  [0x10] = 01010010
0 c=0 C=1

Figure 2.21 m Operation of the RCLF 0X10,F,A instruction
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Example 2.20

Compute the new values of the data register 0x10 and the C flag after the execution of the
rref 0x10,F,A instruction. Assume that the original value in data memory at 0x10 is 0xC7 and

that the C flagis 1.

Solution: The operation of this instruction is shown in Figure 2.22.

1

\

1

ANAAN A

1

The result is

Original value

New value

{0x10} = 1100 0111
C=1

[0x10] = 1110 0011
C=1

Figure 2.22 m Operation of the rref 0x10,F,A instruction

Example 2.21

Compute the new values of the data memory location 0x10 after the execution of the rrncf
0x10,F,A instruction and the rlnct 0x10,F,A instruction, respectively. Assume that the data
memory location 0x10 originally contains the value of 0x6E.

Solution: The operation performed by the rrncf 0x10,F,A instruction and its result are shown in

Figure 2.23.

ANARRANN

The result is

original value

new value

[0x10] = 0110 1110

[0x10] = 0011 0111

Figure 2.23 m Operation performed by the rmef 0x10,F,A instruction

The operation performed by the rlnef 0x10,F,A instruction and its result are shown in

Figure 2.24.
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The resuilt is

0 1 1 0 1 1 1 0
/ w / / / Before After
i 1 1 1 0 0

[0x10] = 0110 1110 [0x10] = 1101 1100
0 1

Figure 2.24 m Operation performed by the rincf 0x10,F,A instruction

2.14 Using Rotate Instructions to Perform Multiplications
and Divisions

The operation of multiplying by the power of 2 can be implemented by shifting the operand
to the left an appropriate number of positions, whereas dividing by the power of 2 can be imple-
mented by shifting the operand to the right a certain number of positions.

Since the PIC18 MCU does not provide any shifting instructions, the shift operation must
be implemented by using one of the rotate-through-carry instructions. The carry flag must be
cleared before the rotate instruction is executed. As shown in Table 2.14, the PIC18 provides
three instructions for manipulating an individual bit of a register. The b field specifies the bit
position to be operated on.

Mnemonic, Status
operator Description 16-bit instruction word affected
BCFf, b, a Bit clear f 1001 bbba ffff ffff none
BSF,f, b, a Bit set f 1000 bbba ffff ffff none
BTG f, b, a Bit toggle f 0111 bbba ffff ffff none

Table 2.14 m PIC18 bit manipulation instructions

Example 2.22

Write an instruction sequence to multiply the three-byte number located at 0x00 to 0x02
by 8.

Solution: Multiplying by 8 can be implemented by shifting to the left three places. The left-
shifting operation should be performed from the least significant byte toward the most signifi-
cant byte. The following instruction sequence will achieve the goal:

moviw 0x03 ; set loop count to 3
loop bef STATUS, C, A ; clear the C flag
tlcf 0x00, F, A ; shift left one place
ricf " 0x01,F,A ;e
tlcf 0x02, F, A e
decfsz WREG, W, A ; have we shifted left three places yet?
goto loop ; not yet, continue
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Example 2.23

Write an instruction sequence to divide the three-byte number stored at 0x10 to 0x12
by 16.

Solution: Dividing by 16 can be implemented by shifting the number to the right four posi-
tions. The right-shifting operation should be performed from the most significant byte toward
the least significant byte. The following instruction sequence will achieve the goal:

moviw 0x04 ; set loop count to 4

loop  bef STATUS, C, A ; shift the number to the right 1 place
rrcf 0x12,F, A e
rref Ox11,F, A M
rref 0x10, F, A 0t
decfsz WREG, W, A ; have we shifted right four places yet?
bra loop ; not yet, continue

2.15 Summary

An assembly program consists of three types of statements: assembler directives, assembly
language instructions, and comments. An assembler directive tells the assembler how to
process subsequent assembly language instructions. Directives also provide a way for defining
program constants and reserving space for dynamic variables. A statement of an assembly pro-
gram consists of four fields: label, operation code, operands, and comment.

Although the PIC18 MCU can perform only 8-bit arithmetic operations, numbers that are
longer than eight bits can still be added, subtracted, or multiplied by performing multiprecision
arithmetic. Examples are used to demonstrate multiprecision addition, subtraction, and multi-
plication operations.

The multiprecision addition can be implemented with the addwic f,d,a instruction, and
multiprecision subtraction can be implemented with the subwib f,d,a instruction. To perform
multiprecision muitiplication, both the multiplier and the multiplicand must be broken down
into 8-bit chunks. The next step is to generate partial products and align them properly before
adding them together.

The PIC18 MCU does not provide any divide instruction, and hence a divide operation
must be synthesized.

Performing repetitive operation is the strength of a computer. For a computer to perform
repetitive operations, one must write program loops to tell the computer what instruction
sequence to repeat. A program loop may be executed a finite or an infinite number of times.
There are four looping constructs:

= Do statement S forever

® Fori=i; toi, Do S or Fori=i;, downtoi; Do S
= While CDo S

= Repeat S until C

The PICI8 MCU provides many flow-control and conditional branch instructions for
implementing program loops. Instructions for initializing and updating loop indices and vari-
ables are also available.
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Rotate instructions are useful for bit-field manipulations. They can also be used to implement
multiplying and dividing a variable by a power of 2. All rotate instructions opetate on 8-bit regis-
ters only. One can write a sequence of instructions to rotate or shift a number longer than 8 bits.

A PIC18 instruction takes either one or two instruction cycles to complete. By choosing an
appropriate instruction sequence and repeating it for a certain number of times, a time delay can
be created.

2.16 Exercises

E2.1 Identify the four fields of the following instructions:

(a) addwf 0x10,W A ;add register 0x10 to WREG
(b) wait  btfss STATUS,F.A ; skip the next instruction if the C flagis 1
(c) decfsz cnt, F, A : decrement cnt and skip if it is decremented to O

F2.2 Find the valid and invalid labels in the following instructions and explain why an invalid
label is invalid.

column 1
d
a. sum_hi equ 0x20
b low_t incf WREG, W,A ; increment WREG by 1
c. abc: movwf 0x30, A
d. 5plus3 clrf 0x33, A
c. _may decf  Ox35,F, A
f. ?less iorwf  Ox1A,F, A
g. two_three goto  less

E2.3 Use an assembler directive to define a string “Please make a choice (1/2):” in program
memory.

E2.4 Use assembler directives to define a table of all uppercase letters. Place this table in pro-
gram memory starting from location 0x2000. Assign one byte to one letter.

E2.5 Use assembler directives to assign the symbols sum, Ip_cnt, height, and weight to data
memory locations at 0x00, 0x01, 0x02, 0x03, respectively.

E2.6 Write an instruction sequence to decrement the contents of data memory locations 0x10,
0x11, and 0x12 by 5, 3, and 1, respectively.

E2.7 Write an instruction sequence to add the 3-byte numbers stored in memory locations
0x11-0x13 and 0x14-0x16 and save the sum in memory locations 0x20-0x2.2.

E2.8 Write an instruction sequence to subtract the 4-byte number stored in memory locations
0x10-0x13 from the 4-byte number stored in memory locations 0x00-0x03 and store the differ-
ence in memory locations 0x20-0x23.

E2.9 Write an instruction sequence to shift the 4-byte number stored in memory locations
0x20-0x23 to the right arithmetically four places and leave the result in the same location.
E2.10 Write a program to shift the 64-bit number stored in data memory locations 0x10-0x17
to the left four places.

F2.11 Write an instruction sequence to multiply the 24-bit unsigned numbers stored in data
memory locations 0x10-0x12 and 0x13-0x15 and store the product in data memory locations
0x20-0x25.

E2.12 Write an instruction sequence to multiply the unsigned 32-bit numbers stored in data
memory locations 0x00-0x03 and 0x04-0x07 and leave the product in data memory memory
locations 0x10-0x17.
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E2.13 Write a program to compute the average of an array of 32 unsigned 8-bit integers stored in
the program memory. Leave the array average in WREG. (Hint, the array contains 32 8-bit num-
bers. Therefore, the array average can be computed by using shift operation instead of division.)
E2.14 Write an instruction sequence that can extract the bit 6 to bit 2 of the WREG register and
store the resultant value in the lowest five bits of the data register 0x10.

E2.15 Write an instruction sequence to create a time delay of 1 second.

E2.16 Write an assembly program to count the number of odd elements in an array of n 16-bit
integers. The array is stored in program memory starting from the label arr_x.

E2.17 Write a PIC18 assembly program to count the number of elements in an array that are
greater than 20. The array consists of n 8-bit numbers and is stored in program memory start-
ing from the label arr_y.

E2.18 Write an assembly program to find the smallest element of an array of n 8-bit elements.
The array is stored in program memory starting with the label arr_z.

E2.19 The sign of a signed number is the most significant bit of that number. A signed number
is negative when its most significant bit is 1. Otherwise, it is positive. Write a program to count
the number of elements that are positive in an array of n 8-bit integers. The array is stored in
bank 1 of data memory starting from 0x00.

E2.20 Determine the number of times the following loop will be executed:

#include <p18F8720.inc>
moviw  0x80

loop bef STATUS, C, A ; clear the carry flag
rref WREG, W, A
addwf  WREG, W, A ; add WREG to itself
bifsc WREG, 7, A ; test bit 7
goto loop

E2.21 What will be the value of the carry flag after the execution of each of the following
instructions? Assume that the WREG register contains 0x79 and that the carry flag is 0 before
the execution of each instruction.

(a) addlw 0x30
(b) addlw OxA4
(c) sublw 0x95
(d) sublw 0x40

E2.22 Write a program to compute the average of the squares of 32 8-bit numbers stored in the
access bank from data memory location 0x00 to Ox1F. Save the average in the data memory loca-
tions 0x21-0x22.

E2.23 Suppose the contents of the WREG register and the C flag are 0x95 and 1, respectively.
What will be the contents of the WREG register and the C flag after the execution of ecach of the
following instructions?

(a) mcf WREG, W, A
(b) rcf WREG, W, A
(c) rlcf WREG, W, A
(d) rincf WREG, W, A

E2.24 Write a program to swap the first element of the array with the last element of the array,
the second element with the second-to-last element, and so on. Assume that the array has 20
8-bit elements and is stored in data memory. The starting address of this array is 0x10 in the
access bank.
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3.2 Development Tools

Development tools for microprocessors/microcontrollers can be classified into two cate-
gories: software and hardware. Software tools include programmers’ editors, assemblers, compil-
ers, simulators, debuggers, communication programs, and integrated development environment.
Hardware tools include demo boards, logic analyzers, emulators, oscilloscopes, and logic probes.

Discussing all these tools is beyond the scope of this book. However, hardware and software
tools made by Microchip and a few vendors for the PIC18 microcontrollers are reviewed in this
book.

3.3 Software Tools

Software tools include text editors, cross assemblers, cross compilers, simulators, source-
level debuggers, and integrated development environment.

3.3.1 Text Editors

The text editor is a program that allows us to enter and edit programs and text files. Editors
range from very primitive to very sophisticated. A simple editor like the Notepad bundled with
Windows 98/2000/XP provides simple editing functions in four different categories: file, edit,
search, and option.

The Wordpad program bundled with the Windows 98/2000/XP is another simple editor that
you can use to enter your prograrm.

The Microchip MPLAB IDE has an embedded text editor for the user to enter programs.
Most of the basic text editing functions are available in the MPLAB editor.

For professional programmers, neither Notepad nor Wordpad is adequate because of their
primitive functions. A programmer’s editor provides additional features, such as automatic key-
word completion, keyword highlighting, syntax checking, and parentheses matching. These
functions can speed up the user’s program entry speed dramatically. The PFE editor is a free-
ware programmer’s editor available from the Internet and can be downloaded from www.wintel
.com or www.simtel.net.

3.3.2 Cross Assemblers and Cross Compilers

Cross assemblers and cross compilers generate executable code to be placed in ROM,
EPROM, EEPROM, or flash memory of a PIC18-based product. Currently, several vendors are
providing cross assemblers and cross-C compilers for the PIC18 microcontroller. At the time
of this writing, Microchip, CCS, IAR, and HI-TECH provide cross compilers for the PIC18
microcontroller.

3.3.3 Simulator

A simulator allows us to run a PIC18 program without having the actual hardware. The
contents of registers, internal memory, external memory, and the program source code are dis-
played in separate windows. The user can set breakpoints to the program and examine the pro-
gram execution results. The simulator allows the user to step through the program to locate
program bugs. The MPLAB IDE development software from Microchip includes simulators for
all PIC16/PICI7/PIC18 devices.
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3.3.4 Source-Level Debugger

A source-level debugger is a program that runs on a PC (or a workstation) and allows you
to find problems in your code at the high level (such as C) or assembly language level. A source-
level debugger allows you to set breakpoints at statements either at the high or assembly lan-
guage level. It can execute the program from the start of the program until the breakpoint and
then display the values of program variables. A source-level debugger can also trace your pro-
gram statement by statement. A source-level debugger may have the option to run your program
on the demo board or simulator. Like a simulator, a source-level debugger can display the con-
tents of program variables, registers, memory locations, and program code in separate windows.
With a source-level debugger, all debugging activities are done at the source level.

A source-level debugger can also invoke a simulator to perform debugging activity. The
C-Spy from IAR is a source-level debugger for the PIC18 microcontrollers that uses this
approach. In addition to running the program on a demo board, the debugger of the MPLAB IDE
can also use simulator to debug your program.

3.3.5 Integrated Development Environment

An integrated development environment (IDE) includes everything that you need to enter,
assemble, compile, link, and debug your application program. It includes every software tool
mentioned earlier. A tool is invoked by clicking on the icon of the corresponding tool. The
MPLAB IDE is an IDE designed for all Microchip microcontrollers. It is free and can be down-
loaded from Microchip’s Web site at www.microchip.com. The Embedded Workbench from IAR
is also an IDE for the PIC18 microcontrollers.

3.4 Hardware Tools

Numerous hardware development tools are available for the PIC18 microcontrollers.
Microchip provides the following hardware development tools to support the hardware devel-
opment of PIC18-based product:

1. In-circuit emulators

2. Device programmers

3. Demo boards

4. In-circuit debugger (ICD2)

3.4.1 The Nature of Debugging Activities

When an embedded product is being designed, both the hardware and the software compo-
nents are being developed in parallel. Therefore, software debugging needs to be done before the
final hardware is completed. Software debugging in microcontroller-based product development
can be classified into a software-only approach and a hardware-assisted approach. Using a demo
board with a resident monitor or simulator to test the program is the software-only approach.
In the hardware-assisted approach, either the logic analyzer or the emulator is used to trace the
program execution. No matter what approach is used, one needs to run the application programs
in order to find out if program execution results are what one expects. When the program exe-
cution results are not what one expects, one would examine the programs to find out if there
are any obvious logical errors. Many errors can be identified in this manner. However, there are
some errors that cannot be easily identified by examining the program.
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Many microcontroller demo boards have an onboard monitor program. A good monitor
allows the user to enter commands to display and modify the contents of registers and memory
locations, set breakpoints, trace program execution, and download the user program onto the
demo board for execution. By using appropriate monitor commands, the user will be able to
determine whether his or her program executes correctly up to the breakpoint. Instruction trac-
ing is also available from most monitors in case the user needs to pinpoint the exact instructions
that cause the error. All peripheral functionality can be actually exercised using this approach.
A source-level debugger can be written to communicate with the monitor on the demo board or
invoke the simulator to execute the user program. Using this approach, you need not examine
the contents of memory locations in order to find out if the program execution result is correct.
Instead, values of program variables are available for examination during the process of program
execution. In other words, debugging activity is carried out at the source level.

In the hardware-assisted approach, designers use an in-circuit emulator (ICE} to identify pro-
gram errors. The ICE needs to reconstruct instructions being executed from the data flowing on
the system bus of the target prototype (including address, data, and control signals). This
approach may require certain built-in hardware support from the microcontroller used in the pro-
totype in order to identify the boundary of instructions. The ICE also allows us to set breakpoints
at those locations that are likely to have errors so that program execution result can be exam-
ined. This approach is especially useful when a demo board with a resident monitor is not avail-
able. The price of an ICE usually costs much more than a demo board with a resident monitor.

In the past decade, more and more microcontrollers provide hardware support for software
debugging. The IEEE 1149.1 JTAG Boundary Scan Interface was initially proposed to standard-
ize the interface for testing newly designed integrated circuits. Many companies (e.g., 8051-
variant vendor Silicon Laboratory and Atmel] also utilize this interface to provide support for
software debugging and programming the on-chip flash memory or one-time-programmable
EPROM. Other companies (including Motorola and Microchip) provide a serial interface (called
Background Debug Module) that utilizes two to four pins to support in-circuit programming and
software debugging but do not provide boundary scan test capability. These interfaces allow
nonintrusive inspection of memory and register contents, support breakpoints, and allow single
stepping of user programs. Tool developers can take advantage of these capabilities to imple-
ment inexpensive source-level debugger. The ICD2 from Microchip is an in-circuit debugger
that utilizes this interface.

3.4.2 ICE

All debugging activities for microcontroller-based products involve running the application
program. Depending on the progress of the product development, some debugging activities must
be performed before the hardware product is available. An ICE allows the user to debug his or her
software before the final hardware is constructed. An ICE includes a target processor module to
emulate the final hardware. It can reconstruct the instruction stream being executed on the fly.

Microchip manufactures the MPLAB ICE2000 ICE. As shown in Figure 3.1, the MPLAB
ICE-2000 consists of four components:

1. Emulator pod. This unit communicates with a PC to receive the software program to
be tested.

2. Processor module. This module executes the instructions downloaded into the
emulator pod.

3. Device adapter. A device adaptor consists of IC sockets and additional circuitry to
allow the MCU to be connected to the target hardware.

4. Transition socket. This socket and the device adapter plugs into the target hardware
so that signals can be exercised to the target hardware.
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Parallel Cable (2)

Emulator Pod (1)

Power Supply

Cable (3) Processor Module

" with Cable {4)

Logic Probe
Connector {7)

Device Adapler (5)

7@

Figure 3.1 m MPLAB ICE2000 Emulator (reprint with permission of Microchip)

Transition Socket (6

3.4.3 Device Programmer

The software program must be programmed into the on-chip ROM of the microcontroller
before it can be tested. Microchip provides two programmers to meet the need of different users:

PICSTART® PLUS. PICSTART® Plus is a low-cost programmer for the PIC18
microcontrollers and other microcontrollers from Microchip. The photograph of this
programmer is shown in Figure 3.2. A 40-pin socket is provided. By adding appropriate
adapters, the PICSTART Plus can program PIC18 members with higher pin count.
PICSTART Plus is connected to a PC through the serial port and is driven by the
MPLAB IDE software.

Figure 3.2 m PICSTART Plus programmer (reprint with permission of Microchip)
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PRO MATE® II. The PRO MATE®II device programmer, shown in Figure 3.3, is
another programmer made by Microchip that can program all microcontrollers from
Microchip. Appropriate adapters are needed for different packages. Like the PICSTART
Plus programmer, this programmer is also connected to the serial port of a PC and is
controlled by the MPLAB IDE software.

Figure 3.3 m PRO MATE Il programmer (reprint with permission of Microchip)

In addition to programming microcontrollers, PRO MATE II can also program many
EPROM and EEPROM devices.

3.4.4 In-Circuit-Debugger 11

In-Circuit-Debugger II (ICD2) is designed to be a low-cost solution for debugging devices
that support In-Circuit Serial Programming {ICSP} protocol. These devices provide on-chip flash
memory to hold application programs. To enable in-circuit debugging, the ICD2 programs a
small debug executive module into the target PIC® microcontroller device (i.e., the PIC18
microcontroller in your demo board). This debug executive module will reside at the end of the
program memory. The debug executive works by communicating with special on-chip func-
tions built inside the PIC18 microcontroller.

Utilizing the in-circuit debugging capability of the Flash PIC microcontroller and Micro-
chip’s ICSP protocol, the ICD2 also acts as a programmer. It operates under MPLAB IDE, con-
nects to an application, and runs the actual microcontroller in the design.

The ICD2 module contains the logic for debugging, programming, and control. It is con-
nected to either a PC’s serial port via a nine-pin serial cable or a USB port via a USB cable and
to the PIC18 demo board or target application using a six-wire modular cable. A photograph of
ICD2 is shown in Figure 3.4.
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Figure 3.4 m Microchip ICD2 in-circuit debugger (reprint with permission of Microchip)

The module contains the software to provide serial communications to the PC and the tar-
get application or demo board and to program a supported PIC microcontroller device, all from
the MPLAB IDE. The ICD2 module can provide power to the demo board/target application.
The user can select VDD source on the Power tab in the ICD2 Settings dialog. If the target appli-
cation draws over 200 mA, an additional power adapter must be connected to the demo board
or target application. The target application also provides power to the ICD2 module only for
the purpose of logic-level conversion.

The ICD2 interface cable must be plugged into a modular connector on the application cir-
cuit with the appropriate connections to the PIC microcontroller device. The interface cable
carries the signals necessary to allow in-circuit debugging of the target application.

3.4.5 Demo Boards

Demo boards are useful for learning the microcontroller and testing the software before the
final hardware is completed. As a learning tool, a well-designed demo board should allow the
user to experiment with every peripheral function. Three demo boards will be reviewed in
Section 3.8. Each of these demo boards can be used to test the programs in this book.

3.5 Using MPLAB IDE

MPLAB IDE is the center of Microchip’s software development tool suite. It supports all the
devices produced by Microchip that require software control. It consists of a text editor, a simula-
tor, a cross assembler that supports all microcontrollers and digital signal processors, a simulator,
and device drivers (for programmers, ICE, ICD, and ICD2) made by Microchip. A small number of
third-party development tools {e.g., Hi-Tech C compiler) can also work with MPLAB IDE.
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MPLAB IDE is a 32-bit window application that uses projects to manage software develop-
ment tasks. A project may consist of a single or multiple files. This section will provide a step-
by-step tutorial that sets up a project and gets you familiar with the debug capabilities of
MPLAB IDE.

3.5.1 Getting Started with MPLAB IDE
MPLAB IDE provides the ability to do the following:
1. Create source code using the built-in editor.

2. Assemble, compile, and link source code using various language tools. An assembler,
linker, and librarian come with MPLAB IDE, which also supports C compilers
(MCC17 and MCC18} by Microchip. A limited number of third-party C compilers are
also supported.

3. Debug the executable logic by watching program flow with the built-in simulator or
in real time with the MPLAB ICE2000 emulator or MPLAB ICD2 in-circuit debugger.

4. Make timing measurements with the simulator or emulator.
5. View variables in Watch windows.

6. Program firmware (executable machine code) into devices with PICSTART® Plus or
PRO MATE®TI device programmers.

7. Find quick answer to questions from the MPLAB IDE online help.

To start the IDE, select Start>Programs>Microchip MPLAB IDE>MPLAB IDE from your
monitor screen or simply double-click on the MPLAB IDE icon. A splash screen will display
first, followed by the MPLAB IDE desktop as shown in Figure 3.5.

Figure 3.5 m MPLAB IDE desktop (reprint with permission of Microchip)
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The major steps in software development using MPLAB IDE are as follows:
Step 1

Create a new project.

Step 2

Enter source files.

Step 3

Add source files into the project,

Step 4

Compile and build the executable code.

Step 5

Debug the project using the simulator, or ICD2, or ICE.

3.5.2 Creating a Simple Project

Before creating a new project, the user must configure the project and select the target
device. After creating a new project, the user needs to set the language tool location and select
the tool suite.

To configure the project, go to the Configure> settings menu and choose the Projects tab.
Make sure the setup is as shown in Figure 3.6. Click on OK after making sure the setting is right.

Figure 3.6 m Configure the project (reprint with permission of Microchip)

The next step is to make sure the right device is selected. For this tutorial, the PIC18F452
has been chosen. To select the target device, go to Configure>Select Devices . . . and make the
selection as shown in Figure 3.7.
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Figure 3.7 m Select device dialog (reprint with permission of Microchip)

After the correct target device has been selected, the user is ready to create a new project.
When creating a new project, the user needs to decide where to place the project. This tutorial
will assume that the user has decided to use the directory c:\pic18\ch03 to place his or her proj-
ects. Follow these steps to create a new project:

1. Select the Project>-New menu. The New dialog will open as shown in Figure 3.8.
2. Enter the name of the new project (e,g., tutorl).

New Project

Figure 3.8 m New project dialog (reprint with permission of Microchip)
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3. Use the Browse button to select the path to place the new project or type
in the path.

4. When the Project name and Location are correct, click on OK.

After creating a new project, the user needs to make sure the language tool locations are set
propetly. To do this, select Project>Set Language Tool Locations to confirm the location of the
Microchip Tool Suite. Click on MPASM Assembler (mpasmwin.exe). The full path to the
MPASM Assembler executable should appear in the Location of Selected Tool text box as
shown in Figure 3.9. If it is incorrect or empty, click on Browse to locate mpasmwin.exe. After
the language tool location has been set up, the user can skip this step until he or she switches
language tools. '

5ek Language Tool anatluns

73 Hl- TEEH PICC-18 Toolsuite
- 18R Spstems Midrange
- |AR Systems PIC18 Toolsuite
Microchip C17 Toolsuite
Mizrochip C18 Toolsuite
7 Microchip C30 Toolsuite
Micr-:uc:hip MPASHK Toolsuite
E] E:-:ecutables

. MF‘LINK Object Lmker [mplmk e:-:e]
(i} Default Search Paths & Directories

mplab_ide'M CHF‘_T ools\mpasmtin, exe

Figure 3.9 m Setting language tool location dialog (reprint with permission
of Microchip)

Before starting entering your source code, one needs to set the language tool suite to be used
in the new project. This allows the MPLAB IDE to tailor its operation more accurately with
regard to context-sensitive editing and file extensions. Perform the following steps to select the
language suite:

1. Select Project> Set Language Toolsuite.

2. For Active Toolsuite, select Microchip MPASM Toolsuite for this tutorial. The
PICmicro® language tools will appear under Toolsuite Contents.

3. Click on OK.

The dialog for selecting language suite is shown in Figure 3.10.
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elect Language Toplsuite

Microchip MPASH T oolsuite

HI-TECH PICC Toolsuite
HI-TECH PICC-18 Toolsuite

= Microchip C18 Toalsuite

i 30 Toalsuite

Figure 3.10 m Dialog for selecting language tool suite
(reprint with permission of Microchip)

3.5.3 Entering Source Code

After the new project has been configured properly, one can now enter the source code for
the project.

Select File> New. A blank edit window will be opened in the workspace of MPLAB IDE.
Enter the following program to the Edit window:

title “Finding the Number of Elements That Are a Multiple of 4”
#include <p18F452.inc>

ilimit equ 0x20
count set 0x00
loop_cnt  set 0x01
mask equ 0x03 ; used to mask upper six bits
org 0x00
goto start
org 0x08 ; high-priority interrupt service routine
retfie
org 0x18 ; low-priority interrupt service routine
retfie
start clrf count,A
movlw ilimit
movwf loop_cnt ; initialize iito N
moviw upper array ; use table pointer to point to the array
movwf TBLPTRU, A 0
movlw high array 0
movwf TBLPTRH,A e
moviw low array P
movwf TBLPTRL,A 0
i_loop moviw mask
tblrd*+ ; read an array element into TABLAT
andwf TABLAT,F,A
bnz next ; branch if not a multiple of 4

incf count,F,A ; increment count if it is a multiple of 4
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next decfsz loop_cnt,F,A ; decrement loop count
goto i_loop
nop

array db 0x00, 0x01, 0x30, 0x03, 0x04, 0x05, 0x06, 0x07, 0x08, 0x09
db 0x0A, 0x0B, 0x0C, 0xOD, 0xOE, OxOF, 0x10, 0x11, 0x12, 0x13
db 0x14, 0x15, 0x16, 0x17, Ox18, 0x19, Ox1A, Ox1B, Ox1C, Ox1D
db Ox1E, Ox1F
end

This program counts the number of elements in the given array that are divisible by 4. The low-
est two bits of a number divisible by 4 are 00. This program starts with the first element and
checks if it is divisible by 4. It increments the variable count by 1 if an element is divisible by
4 until the last element is checked. The array is located in program memory.

Once the source code has been entered, the user should select File> Save and save the file
in the project directory as tutorl.asm. After the user has saved the code, the program is shown
with identifying colors for readability. This context-sensitive colorization is customizable. For
more information about the editor, see Help> MPLAB Editor Help.

3.5.4 Adding Source Files to the Project

To add a source file to the project, select Project> add Files to Project. A dialog window as
shown in Figure 3.11 will appear on the screen. Select the file that you just created and saved
(tutorl.asm) and click on Open. After this, the newly inserted file should appear in the project
pane under Source Files (shown in Figure 3.12). If it appears under Unclassifiable, confirm that
you have selected the correct language tool suite by selecting Project> Set Language Toolsuite.
“Microchip Toolsuite” should appear as the Active Toolsuite. If not, select it and click on OK.
The file name should now appear under Source Files.

Insert Files Into Project

2
=

\pic18ich03itutorl.mep*]
oo =

-tutarl.asm
~Header Files
-~ (Object Files
- Library Files
i Linker Scripts

Figure 3.11 m Select input file dialog Figure 3.12 m Project pane
(reprint with permision of Microchip) (reprint with permission of Microchip)
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Save the project by selecting Project> Save. You call also add files and save projects by using
the right mouse button in the project pane. Experiment by clicking the right mouse button
while the cursor is over Source Files. Note that the menu options are different.

3.5.5 Building the Project

After adding source files into the project, it is time to build the project. This step will com-
pile the source code using the selected language tool suite.

To build the project, select Project> Build All or Project> Make (or press function key F10).
This file [tutor.asm) should assemble successfully. If this project does not build correctly, check
the following items and then build the project again:

»  Check the spelling and format of the program in the editor window. If the
assembler reported errors in the Qutput window, double-click on the error in the
Output window. This will indicate the corresponding line in the source code with a
green arrow in the gutter of the source code window.
®  Check that the correct assembler (MPASM assembler] for the PICmicro device is
being used.
On a successful build, the debug files (with file name extension .cod or .cof) generated by the
language tool will be loaded. This file allows one to debug using the source code and view pro-
gram variables symbolically in Watch windows.

For this one-file example, a project does not seem necessary. However, the real power of
projects comes when many files are to be compiled/assembled and linked to form the final exe-
cutable application. Projects keep track of all this for the user.

3.5.6 Debugging the Project

After building the project, one will want to check that it is functioning the way he or she
intended. To do this, one will need to select a debug tool. There are five debug tools under the
Debugger>Select Tool menu:

1. MPLAB ICD2

2. MPLAB ICE4000
3. MPLAB SIM

4. MPLAB ICE2000
5. MPLAB SIM30

Among these five debug tools, ICD2, SIM, and ICE2000 can be used to debug PIC18 microcon-
troller applications. The uses of SIM and ICD2 are discussed in the next two sections. The use
of MPLAB ICE2000 or the ICE4000 is not discussed because of their higher cost.

3.6 Using the MPLAB SIM in Debugging PIC18 Applications

Program simulation involves the following major operations:
s Simulator setup
®  Running the code
®  Viewing variables
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5 Using Watch windows
m  Setting breakpoints
® Tracing code

3.6.1 Setting Up the Simulator

The first step for simulating the program is to select MPLAB SIM as the debugging tool.
This is done by selecting Debugger>Select Tool> MPLAB SIM. After selecting MPLAB SIM as
the debugging tool, the status bar on the bottom of the MPLAB IDE window should change to
“MPLAB SIM”. Additional menu items should now appear in the Debugger menu. Additional
toolbar elements would also appear on the MPLAB IDE window. This is shown in Figure 3.13.

MPLAE IDE

Linker Scripts

Figure 3.13 m MPLAB IDE window status change after selecting SIM.
Additional menu items also appear under Debugger menu.
(reprint with permission of Microchip)

3.6.2 Running Code under MPLAB SIM

Before running the program, one needs to set the program counter to the start of the pro-
gram by selecting Debugger> Reset (or press function key F6). A green arrow should appear in
the gutter of the source code window {in Figure 3.14), indicating the first source code line that
will be executed.
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title "Finding the Numker of Elements Tth
#include =plBF452.inc>
ilimit 0x20
count sat Ox0D
ii aat Ox01
mask pdn] uzerd Lo wask upper
Q=00
goto start
arg Ox08 high-priority inter
retfie
OFG Ox18 low-priority interr
retfie
olrf count, i
movriw ilimit
mavwE ii initialize ii
oy L uppEr (sarray)
movwEt TELPTRU, &
moriw high {array}
morwt TBLPTEH, &
moviw low(array)
mowwE TBLFTEL, A&
moviy mask
TBLRD *+ read an arreay elews
andwrt TABLAT, F, A
bnz next branch if not a mual
inct count, F, A iz & raultiple of 3
decfsy 1ii,F. A decrement loop coun

Figure 3.14 m Source code window after Reset (reprint with permission of Microchip)

Select Debugger>Run (or press function key F9) to run the program. The message
“Running. . .” will appear on the status bar.

Because the simulator was not told where to stop, it will keep running. To halt the program
execution, select Debugger > Halt (or press function key F5). The line of code where the appli-
cation halted will be indicated by the green arrow.

We can also single step through the application program by selecting Debugger > Step Into
(or press function key F7). This will execute the currently indicated line of the code and move
the arrow to the next line of code that will be executed.
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3.6.3 Viewing Variables

One can see the values of variables at any time by putting the mouse cursor over their
names anywhere in the source file. A small output window will pop up to show the current
value. A screen shot for placing mouse over the variable count is shown in Figure 3.15.

mowrwE ii inicialize ii to H
moviw upper (array)
movwE TBLPTRU, &
moeriw high {avray)
morwt TBLPTEH, 4
o Lar lowiarray)
morit TELPTEL, &

i loop mowlw mask
TELED *-+ read an array =lems
andwt TABLAT,F, A
bnz next
inct count, F, 24
decfsz i, ]
goto i 1
nop

arvay cih Ox=00,0=x01,0x36,0x03,0x04,0x05, 0x0
dk Ox0A, Ox0B, 0x0C, Ox0D, OX0OE, 0x0F , Ox1
di Ox14,0x15,0x16,0x17,0x18,0x19,0x1
b Ox1E,0x1F

count =

Figure 3.15 m Mouse over variable “count” (reprint with permission of Microchip)

3.6.4 Using Watch Window to View Variables

Often one wants to watch certain key variables all the time. Rather than floating the mouse
cursor over the name each time one wants to see the value, one can open a Watch window. The
Watch window will remain on the screen and show the current variable values. Watch windows
can be found under the View menu.
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To open a Watch window, View> Watch. There are two ways to add a symbol into the
Watch window:

1. Click the mouse in the Watch window and then type the name of the symbol and
press the Enter key.

2. Select from the symbol selection box at the top of the window and then click on Add
Symbol to add it to the Watch window list.

One can also add any special-function register {SFR) into the Watch window list. The procedure
is identical to the procedure for adding symbols.

The only symbol of interest to us is count. Add it to the Watch window. The resultant
Watch window is shown in Figure 3.16.

Figure 3.16 m Watch window for tutord (reprint with permission of Microchip)

Now we can watch the symbol value change as we step through the program:
1. Press function key F6 to reset your program.

2. Press function key F7 to step through the program one instruction at a time until you
have stepped to the following program line:

incf count,F,A ; increment count if it is a multiple of 4

3. Step one more time to see the value of count in the Watch window change from
0 to 1. The changed value appears in red color.

4. Continue to step through the program until you reach the instruction that follows
incf count,F A. You will see that the value of count increments if a value that is
divisible by 4 is reached.

5. Continue to step through the program until all the array elements have been checked.
The final value of count is 9 for this example.

3.6.5 Setting Breakpoints

Sometimes one wants to run the program to a specific location and then halt. This is
accomplished by using breakpoints. To set a breakpoint, press the right mouse button on the
code line that one wants to set a breakpoint. Suppose one wants to set a breakpoint at the nop
instruction. Press the right mouse button, and a pop-up window as shown in Figure 3.17 will
appear. It is correct that Figure 3.17 appeared overlapping.
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inicialize ii to N
use table pointesr Lo point to the

resd an array element into TABLAT

branch if not 8 pultiple of 4
ingrement count if it iz s wultiple
decrement loop count

ArTRY Ox00, 0x01, 0x30, 0x03, 0x04, O0x05, 0x06, 0x07, 0x08, Ox0S
Ox0A, Ux0E, 0x0C, 0=x0D, Ox0E, Ox0F, 010, 0x11, 0x12, 0x13
Ox14,0x15,0x16,0x17,0x18, 019, 0x14, 0x1B,0x1C, 0x1D
0x1E,Dx1iF

Figure 3.17 m A screen snapshot after pressing the right mouse button at “nop”
(reprint with permission of Microchip)

From the pop-up menu that appears, select Set Breakpoint. A “stop sign” should appear in
the gutter next to the line (shown in Figure 3.18). Before running the program, press function
key F6 to reset the program.

andwf  TABLALT,.F, A

bnz nERT ; branch if not & multiple of 4
incf ocount, F, A ; increment count if it iz s wultiple
nERt decfsz 1i,F,A : degrement loop count

goto i _loup
g

array db Dx00,0x01, 0x30, 0x03, Ox04, 0x05, D06, 0x07, 0x03, Ox09
db  OwOh, OxO0R, 0x0C, Ox0D, Ox0F, 0x0F , Ox10,0x11, 0x12, Ox13
g Oxi4,0%15,0x16,0x17,0x18,0x19, 0x14, 0x1E, 0x1C, 0x1D
df  Ox1E,0x1F

Figure 3.18 m Source code window - Set Breakpoint (reprint with permission of Microchip)
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To run the program, select Debugger> Run. It should run briefly and then halt on the line
at which the breakpoint was set. The screen should look like that in Figure 3.19 after the pro-
gram halts.

TBLED ¥ : read an array element into TABLAT
andwt TABLAT,F., 4

bnz next ; branch if not a multiple of 4

incg count, F, & increment pount if it iz a maltipl
deofsz  1ii,F,. 4 ; decrement loop count

gota i_loop

noﬂ

KETAY dly  Ox00, 0x01, 0x30, 0x03, Ox04, 0x05, Ox06, 0x07, 0x08, 0x0S
i Ox04, 0x0F, 0x0C, 0x0D, Ox0E, Ox0OF , 0Ox10, 0x11,0x12, 0x13
db Ox14,0x15,0x16,0x17, 0x18,0%19, 0x14, 0x1E, Ox1C, Ox1D
db Ox1E,0Ox1iF

Figure 3.19 m Source code window—Breakpoint Halt {reprint with permission of Microchip)

3.6.6 Tracing Code

There are times that the user will have difficulty identifying the program bugs. Tracing pro-
gram becomes necessary under such situations. Although single stepping through the program
would allow the user to identify the program bugs, it would be easier for the simulator to cap-
ture the execution trace of many instructions all at once while the user goes through them
instruction by instruction.

The Simulator Trace can be used to record the execution of the user program. The user can
enable the Simulator Trace by selecting Debugger> Settings and choosing the Pins/Trace tab.

As shown in Figure 3.20, there are two check boxes to control how the Simulator Trace col-
lects data. When only the top box is checked, the simulator collects data when the simulator is
in Run mode, it collects data until the user halts at a breakpoint or manually stops the simula-

Figure 3.20 m Simulation Trace enable (reprint with permission of Microchip)
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tor. It will show the last 8192 cycles collected. This mode is useful if the user wants to see the
record of instructions leading up to a breakpoint.

If the second button is also checked, the trace memory will collect 8192 cycles of data and
then stop collecting and halt the user application at a breakpoint. This mode is useful for see-
ing the record of instructions after the user presses run.

After enabling Simulator Trace, make sure that the program is reset before running the pro-
gram. Since tutorl.asm is a short program, the simulator will halt at the breakpoint. Select
View> Simulator Trace to view the simulation trace. The trace display is shown in Figure 3.21.
The trace display shows a time stamp at every cycle, and the data that were read or written into
file registers will be captured and displayed.

MPLABIDE - [ Trace]

GOTO Oxla 100000000
NOF 100000001
CLEF @0, O jacoocoaz
MOVLY Ox20 100090093
HOVUF 100000004
HOVLW O 100000005
NOWUF OxIifs, plululaluin]a]nl}
MOVLE O Jaoooooa?
MOVWF Ox££7, 100000008
HOVLW Ox3e Jooooaoneg
HOVWF Oxf£6, J00000O0A
MOVLY Ox3 100000008
TBLRD*+ 30000000C
ANDWF Oxff5, JO000Ja0E

10000000F

[u]
1
2
3
4
5
5
7
8

lc 0000000000000
[= 0 e Y = = e e i e e
fooococ0DOBOOODOAOO
Wic COoDOoODODOoOCOOCODOO
mEloooco0oo0CcO0O0OQ0O0OO0QOO
oD O0ONDOoO0DODOCOQOO0
o OCcOCO0OO0OCDOoOOOOQOO

fc

:
¢
(i

DECFSZ 0Ox1, DxQQ01 Jopoooo1l
GOTO Oxze -— 100000012
NCF 100000013
HOVLW 0x3 100000014
TBLRD*+ Jo000D0a1s
ANDWF OxffS, DOFFS 00000017
BNZ Ox36 -_— 100000013
DECF3Z Oxi, Ox0001 00000014
GOTO Ox2c ———— 100000018
HCF )o0ancoic

cococoonooooao
Donooooooo
DocooDoDoocoo
coooocooooo
DomoDooDocoo0o
(=10 i = = R T e R = =)
[ = I o Y = = R

Figure 3.21 m Simulation trace display (reprint with permission of Microchip)

There are 18 columns in the trace display. The meanings of these columns are as follows:
m Line. Decimal cycle number from start of trace session
m  Addr. Program address of instruction
= Op. Numeric op code of instruction
= Label. Symbolic label of instruction, if known
» Instruction. Disassembled instruction
& SA. Source address, the register address of read operation
= SD. Source data, the data read from the register
® DA. Destination address, the register address of the destination
= DD. Destination data, the data written into the destination register
®  Cycles. Time before the execution of an instruction, from reset

» 1 Probe [n = 7, 0). Irrelevant in simulator, used in MAPLAB ICE2000 emulator only
{each n value is in one column)
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If there is any dash in the row for these values, it means that the operation did not access any
file register for this instruction. The column with the label of “Time” is the time stamp. This
can be used to measure the execution time of routines. The time is calculated on the basis of
the clock frequency entered in the Debugger> Settings Clock tab.

In line 15 of Figure 3.21, both the source register and the destination register are the same
register (at 0x00, the count value). The value of count is 1 after the first array element (0x00) is
checked because 0x00 is 2 multiple of 4. You can scroll down the Simulator Trace and find that
the final value of count is 9.

If the user puts the cursor over the top row of the trace display where the column headings
are listed and presses the right mouse button, a configuration dialog will pop up as shown in
Figure 3.22. All the checked items will appear in the trace window. The user can uncheck
columns to reduce clutter if the user is not interested in the data in those columns. The entries
labeled as Probe 7, Probe 6, and so on are for the MPLAB ICE2000 emulator trace and are not
relevant to the simulator. They should be unchecked.

L o TR w R I O
1 NOP WO0BO01 0 0 O O O O O O
z CLEF 0, O 0 0O JOOODO0Z O O O O O O O O
3 D01C DE20 MOVLY 0x20 5 2010000003 0 0O O O 0 0 O O
4 OOLE 6EDL KOVWF Ox1, O 1 200000004 0 O 0 0 O O O O
5 0020 OEOO0 HOVLY 0 8 000000005 0 O O 0O O O O O
6 0022 6EFS HOVWF OX££8, | g 00 1000000 O O O D O O O O
7 0024 OEOQ MOVLY O 5 00 10000007 O 0O O 0 O 0 O O
g 0026 GEF7 HOVUF Ox££7, 7 00 10000008 0 0 O Q O G O O
9 0028 OESE NOVLW 0x3e 8 3E JOOOOOOS O O O O O O @ O
10 0024 6EFG HOVWF OxEE6, 5 3L J000000A 0 0 O O O O 0O O
11 002C 0EGS i loop HONLY Ox3 s 03 B000OCE 0 0 O 0 0 O O O
12 CQOZE o0DO09 - TELRD %+ i 5 00 o00000C 0O 0 0O 0 o [n} s} o
13 D030 16FS ANDWF UXE£5, 5 00 J0ODOOCE 0 0 0 0 0 O 0 O
14 003z E101 BNZ Ox36 —-JODoOGOF 0 0 O 0 O O 0 0
15 0034 2400 INCF O, Ox1, 0130000010 0 0 O O O 0 0 O
16 0036 2ED1 next DECF3Z Ox1, O iIF 00DO0it 0 0 0 O O 0O 0O O
17 0035 EFle GOTO Ox2c --poO0iz © 0 8 0 @ O O O
18 003 FOOO NOP —-Joooooi3 0 0 0 0 0 O 0 O
19 002C OE03 i_loop MOVLY Ox3 03 )0000014 0 0 0 O 0O 0 O O}

Figure 3.22 m Configure Simulation Trace (reprint with permission of Microchip)

3.6.7 Advanced Simulator Options

There are other characteristics of the simulator that can be configured from the MPLAB
IDE dialogs. Normally, the default condition of the configuration bits has the Watch Dog Timer
(WDT]} enabled. This will cause the simulator to reset when the internal WDT times out.

Unless one wants to test the functioning of the WDT, one would be better off by disabling
the WDT. To disable the WDT, one needs to bring up the Configuration Bits dialog by select-
ing Configure> Configuration Bits. The Configure Bits dialog is shown in Figure 3.23.

Click on the line that contains Watchdog Timer, and then a selection box will appear. Scroll
down to select Disabled to prevent the WDT from causing the program to reset. The WDT selec-
tion box is shown in Figure 3.24. If the user uses ICD?2 to perform software debugging, then Low
Voltage Program should also be disabled, whereas Background Debug should be enabled.
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=
Osc. Switeh Enable

A 30000z FF Power Up Timer Dissbled
i Brown OQut Deteet Enabled
, Brown Cut Voltage z2.0v
4 300003 FF Vatchdog Timer Ensbled v
3 Batchdogy Postscaler 1:128
300005 FF CCPZ Mux RC1 §
300006 FF Low Voltage Program Ensbled §
Background Debug Dissbled i
Stack Overflow Reset Eneb led |
300008 FF Code Protact D0Z00-O1FFF Dissbled -
Code Protect 02000-03FFF Disabled
Code Protect 04000-05FFF Disabled
Code Protect DE0DO-D7FFF Disabled %
300009 FF Data EE Read Protect Disabled %
Code Protect Boot Disahled |
300004 FF Table Write Protect 0DZ200-01FFF Disabled
Table Write Protect 0Z000-03FFF Disabled
e e e 35 s s

300001 Oscillator RC-05C2 as RA6
Osc. Switch Enable Disabled

300002 FF Power TUp Timer Disabled
Brown Out Detect Enabled

Brown Out Voltage

|2Rg00s

Watchdog Postscaler

300005 FF CCFZ Mux

300006 FF Low Voltage Program
Backaround Debug Disakled
Stack Overflow Reset Enabled

300008 FF Code Protect O0zZOD-Q1FFF Disabled
Code Frotect D2Z00D0-D3FFF Disabled

Figure 3.24 m Diable the WDT timer (reprint with permisson of Microchip)

3.7 Using the MPLAB ICD2

ICD2 can be connected to the PC via one of the COM ports or USB ports. The USB port con-
nection is preferred because it provides much faster data transfer between the PC and the ICD2.

After building the project, the user can select ICD2 to debug his or her program. This choice
is preferred when the hardware, such as a PIC18 demo board, is available. ICD2 can be selected
by selecting Debugger> Select Tool> MPLAB ICD2.

Before using the ICD2 to debug the application, the user must make sure that his or her tar-
get hardware or demo board is connected to the ICD2 using a modular connector. The shape of
the modular connector is shown in Figure 3.25.



Not Used

Bottom View of Modular Connector
Pinout on Designer's Board

Figure 3.25 m MPLAB ICD2 modular connector (reprint with permission of Microchip)

3.7.1 ICD2 Settings

ICD2 needs to be set up properly before it can be used. Select Debugger> Settings |or
Programmer> Settings) to configure ICD2. A setting window as shown in Figure 3.26 will appear
on the screen. Figure 3.26 shows the status of the ICD programmer. The status of ICD2 is con-
nected and it is automatically connected at startup.

Figure 3.26 m ICD2 set up window (reprint with permission of Microchip)
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The user must make sure that every setting is correct. There are three settings that need to
be set properly: power, communication, and program. Click on the Power tab, and the screen
will change to that in Figure 3.27. Notice that the Power Target Circuit From ICD2 setting is
not selected. This is not desirable because ICD2 does not have enough power to drive the tar-
get hardware or demo board.

Click on the Communication tab shown in Figure 3.26, and the available settings will be
made visible as shown in Figure 3.28. Choose USB if the PC has an available USB port.
Otherwise, choose one of the COM ports. When selecting a COM port, the user will also need
to set the baud rate. There are two baud rates to choose from: 19200 and 57600. Try the higher
data rate. If it is not working properly, then switch to 19200.

e Bl
e

ST
S

i

e
S

e

i
e
.

Figure 3.27 m ICD2 power status and setting Figure 3.28 m Communication settings for [CD2
(reprint with permission of Microchip) (reprint with permission of Microchip)

The last setting to be made is Program. Click on the Program tab, and its setting will be
brought out as shown in Figure 3.29. The default settings are acceptable for this tutorial.

The remaining two tabs (Limitations and Versions) are for information purpose. The user
should know the limitations of ICD2. Click on the Limitations tab, and its contents are shown
in Figure 3.30.
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Regquires on-chip resources for debugging,

Only one breakpoint may be set.

Program/EEFROM data not updated during debugging.
Stack viewing/madificaton not zupported.

Click 'Tetails’ for additional information.

Figure 3.29 m [CD2 program setting Figure 3.30 m ICD2 limitations (reprint with permission
(reprint with permission of Microchip) of Microchip)

ICD2 will use certain program memory and special- function registers (SFRs) on the tar-
get microcontroller unit. By clicking on the Details tab, the user can look for device specific
limitations.

After completing the settings of ICD2, the user is ready to debug his or her application on
the target hardware with the help of ICD2. Most of the debug techniques applicable to MPLAB
SIM are also applicable to ICD2.

Here we use a program that computes the sum of integers from 1 to n to illustrate the process.
The program is as follows:
#inciude <p18F452.inc>
n equ D100
sum_hi set 0x01 ; high byte of sum
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sum_lo
i

start

sum_lIp

add_lp

done

set
set
org
goto
org
retfie
org
retfie
cirf
clrf
cirf
incf
moviw
cpfsgt
goto
goto
movf
addwf
moviw
addwfc
incf
goto
nop
end

0x00
0x02
0x00
start
0x08

0x18

sum_hi,A
sum_lo,A
i,A

i,F,A

n

i,A

add_lIp
done
i,W,A
sum_lo,F,A
0
sum_hi,F.A
i,F,A
sum_lIp
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; low byte of sum
; loop index i
; reset vector

; initialize sum to O

; initialize i to O
;i starts from 1

; compare i with n and skip if greater than
; perform addition when i < 50

; it is done when i > 50

; place i in WREG

;add i to sum_lo

; add carry to sum_hi
; increment loop index i by 1

Perform the following steps to enter and build the project:

1. Follow the procedure described in Section 3.5.3 to enter the source code
(call it tutor2.asm).

2. Follow the procedure described in Section 3.5.4 to add source code to the project
(call the project tutor?2).

3. Follow the procedure described in Section 3.5.5 to build the project.

After building the project, perform the following steps:

1. Configure the ICD2 debugger properly.

2. Before debugging the program using ICD2, the target device needs be programmed.

Program the hex file {generated by the assembler] into the demo board by selecting the
Program command under the Debugger menu.

[S2 I NS

. Set up a watch window and add variables sum_hi and sum_lo into the Watch window.
. Set a breakpoint at the statement of done nop.
. Reset ICD2 by pressing function key F6.

6. Run the program (the program execution will be halted at the breakpoint].

The resultant screen on the MPLAB IDE window is shown in Figure 3.31. The Watch window
displays the sum as a hex value 13BA (equivalent to decimal 5050) and is correct.
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#include <P1BF452.incy
) egu Do’

zum ki get Ox0l ! high byte of sum
sum_lo  =et Ox00 ; low byte of sum
i set Ox02 2 loop index i

obg Oxao P resgl vector
gota shars
org axns

retfie
org

Oxia

retfie
atars olxf sum hi,d }oinitialize suw to O
clyf swn 1o, & H -
olrE i, A 2 ipitialize i te O
inof i,F, 4 ;1 starts frow 1
swa_lp moviw 1
cpfzgt 1,4 ; wompare 1 with b and skip if gres
goto add_1p ; perforw sddition when 1 50
goto done : it i done vhen 1 > 50
add_lp movE i, ¥, 4 : place i oin WREG
addwf sum lo,F, 4 add 1 to sue_lo
moviw a
addwic swa ki, F. 2 ; add cerry to sum hi
inct i,F. 4 ; imcremsnt loop indsx 3 by 1
goto sum_1lp
done nop

end

Figure 3.31 m Program for computing the sum of integers from 1 to 100 and the watch window
(reprint with permission of Microchip)

It the program is not running correctly, then the user will need to use the techniques
described in Sections 3.6.2 to 3.6.6 to debug the program. The user can combine the use of
breakpoints, single stepping, and code tracing to identify the errors in the program.

3.8 Demo Boards from Shuan-Shizu Enterprise

Shuan-Shizu Enterprise has designed three PIC18 demo boards for learning the PIC18
microcontroller. The SSE452, the SSE8720, and the SSE8680 use the PIC18F452, the
PIC18F8720, and the PIC18F8680, respectively, as their microcontrollers. Product information
about these demo boards can be found at the Web site at www.evb.com.tw or by e-mail at
Vincent-fan@umail. hinet.net. The features of these demo boards are described in the following
sections.

3.8.1 SSE452 Demo Board

The main design feature of this demo board is that it allows the user to easily switch micro-
controllers {sce Figure 3.32). The SSE452 allows the user to specify the option of adding 28-pin
and/or 40-pin ZIF sockets for the microcontroller. This allows the user to experiment with dif-
ferent 28-pin or 40-pin PIC18 microcontrollers.
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Figure 3.32 m Photo of the SSE452 demo board (reprint with permission
of Shuan-Shizu Enterprise)

In addition to the PIC18F452 on-chip peripheral functions, the SSE452 adds the following

features:

— = =
BN = O

Y NN, A e

One PCB suitable for any 28-pin or 40-pin PIC18 microcontroller

. High-current sink/source: 25 mA

One RS-232 connector

Two debounced push-button switches (can be used as external interrupt sources)
One 8-bit DIP switch for digital input

One 4 x 4 keypad connector for interfacing with 16-key keypad

One rotary encoder with push button for optional input

One TC77 temperature sensor with SPI interface

One EEPROM (24L.C04B) with I2C interface

. One 2 x 20 bus expansion port to make signals available to end user

. One potentiometer for exercising the A/D function

. Optional devices: 2 x 20 character LCD, 48/28-pin ZIF socket

. Digital signals with frequency from 1 Hz up to 8 MHz for exercising timer functions
. ICD2 connector
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3.8.2 SSE8720 Demo Board

This demo board uses the PICI8F8720 as its microcontroller and was designed for those
users who need more I/O pins and more on-chip flash program memory (see Figure 3.33). The

features
1.

of the SSE8720 are as follows:

Digital signals with frequency from 1 Hz up to 16 MHz for experimenting with timer
functions

. ICD2 connector for debugging
. DB9 connector provides EIA232 interface to connect to USART1

4. Four debounced switches {connected to RBO/INTO, RB1/1INT1, RB2/INT2, and

RB3/INT3) and one reset button

. One potentiometer connected to RAG/ANO pin for evaluating the A/D converter
. One 8-bit DIP switch (Port F)

. Eight LEDs

. One 2 x20 LCD

. On-board 5-V regulator

. One EEPROM with I>C interface

. An SPI-compatible (four-wire) digital temperature sensor TC72

. An 8-Q speaker (driven through an NPN transistor) connected to RC2/CCP1 pin
. Omne Dallas DS1306 SPI-compatible real-time clock chip

. Two 2 x 20 connectors for accessing microcontroller signals

Figure 3.33 m SSE8720 demo hoard with speaker (reprint with permission
of Shuan-Shizu Enterprise)
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3.8.3 The SSE8680 Demo Board

The SSE8680 is designed for those users who are interested in experimenting with the CAN
network (see Figure 3.34). Since this board uses the 80-pin PIC18F8680, it is also suitable for
those applications that require many I/O pins. The CAN network is widely used in automotive
and control applications. In addition to the on-chip peripheral functions of the PIC18F8680
microcontroller, the SSE8680 demo board has the following features:

1. Digital signals with frequency ranging from 1 Hz up to 16 MHz for experimenting
with timer functions

2. ICD2 connector for debugging
3. DB9 connector provides EIA232 interface to connect to USART1

Four debounced switches (connected to RBO/INTO, RBI/INT1, RB2/INT2, and RB3/
INT3) and one reset button (not connected to any pin)

One potentiometer connected to RAO/ANO pin for evaluating the A/D converter
One 8-bit DIP switch {Port F)
Eight LEDs

s

® N v

One 2 x 20 LCD

Figure 3.34 m SSE8680 demo board with LCD Kit (reprint with permission
of Shuan-Shizu Enterprise)
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9. On-board 5-V regulator
10. One EEPROM with I2C interface
11. An SPI-compatible (four-wire) digital temperature sensor TC72
12. An 8-Q speaker {driven through an NPN transistor] connected to RC2/CCP1 pin
13. One Dallas DS1306 SPI-compatible real-time clock chip
14. Two 2 x 20 connectors for accessing microcontroller signals
15. MCP2551 CAN transceiver
16. Rotary encoder

3.8.4 Debug Monitor

A debug monitor is being developed for these demo boards. The debug monitor will allow
the user to download the hex file (created by MPLAB® IDE) onto the demo board without using
the ICD2 in-circuit debugger. In addition, this monitor will allow the user to set breakpoints,
single step the program, and display and modify the contents of register values. The monitor
will also be able to display the program downloaded into the demo board. (It needs a disassem-
bler to do this.). The beta version of the monitor is functioning. The stable version of the mon-
itor should be available by the time this book is published.

Without a monitor, one needs the MPLAB IDE, a demo board, and an ICD?2 to experiment
with the hardware. With the monitor, one needs only the MPLAB IDE and a demo board in order
to experiment with the hardware peripheral functions.

Hardware and software development tools are essential for learning the features of the
microcontroller and developing microcontroller-based products. This chapter provides a brief
review of most of the development tools from Microchip and also the demo boards made by
Shuan-Shizu Enterprise.

Undoubtedly, the MPLAB® IDE is the most important software development tool from
Microchip. This package consists of the following:

®»  Assemblers for all microcontrollers manufactured by Microchip
= MPLINK linker
n  Simulators for all microcontrollers manufactured by Microchip

»  Control programs for several hardware tools, such as MPLAB ICD2 debugger and
other debugging hardware made by Microchip

»  An IDE that combines all the software development tools and allows the user to
perform development work from program entry until simulation without leaving
the same environment

All microcontrollers provide certain features to support software debugging. Many micro-
controllers utilize the JTAG interface to support software debugging in addition to performing
chip-testing function. The PIC18 microcontroller provides the ICSP protocol to support soft-
ware debugging and on-chip flash memory programming.

Tutorials on the use of MPLAB IDE, ICD2, and demo boards are provided at the end of this
chapter.
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3.10 Lab Exercises and Assignments

L3.1 Start the MPLAB IDE program and enter the following program as a text file with the file
name progLl.asm:

#include  <p18F452.inc>

radix dec
sum_hi set 0x01
sum_lo set 0x00
fp_ent  set 0x02
kk equ 50
org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start moviw kk
movwf Ip_cnt
clrf sum_hi,A
clrf sum _lg,A
moviw upper array
movwf TBLPTRU,A
moviw high array
movwf TBLPTRH,A
moviw low array
movwf TBLPTRL,A
foop tbird*+
btfsc TABLAT,0,A
goto next
movf TABLAT,W,A
addwf sum_lo,F,A
cirf WREG,A
addwfc sum_hi,F,A
next decfsz Ip_cnt,F,A
goto loop
nop
array db 01,02,03,04,05,06,07,08,09,10
db 11,12,13,14,15,16,17,18,19,20
db 21,22,23,24,25,26,27,28,29,30
db 31,32,33,34,35,36,37,38,39,40
db 41,42,43,44,45,46,47,48,49,50
end

Perform the following operations:

1. Create a new project called progLl in the same directory where the program
proglLl.asm is stored.

2. Configure MPLAB IDE propetly.
3. Add the source code file progL1.asm into the project.



122 Chapter 3 m PIC18 Development Tools

4. Build the project.

@

Select MPLAB SIM as the debug tool and perform appropriate configuration as
described in Sections 3.6.1 to 3.6.7.

Set a breakpoint at the last instruction {nop).
Open a Watch window and enter symbols sum_hi and sum_lo into the window.
Reset the project by pressing the function key F6.

Y o N

Run the program by pressing the function key F9.
10. Check the values of symbols sum_hi and sum_lo.

11. View the simulation trace to identify errors. You should not see any error if you type

everything correctly.

Can you figure out what this program is doing?

L3.2 Enter the following program as a text file and name it progl2.asm:

#include <p18F452.inc>

radix dec
ar_cnt  equ 30 ; array count
Ip_cnt  set 0x00 ; loop count symbol
buffer set 0x010
org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start moviw upper array ; set TBLPTR as the array pointer
movwf TBLPTRU,A .
moviw high array -
movwf TBLPTRH,A e
moviw low array 0
movwf TBLPTRL,A e
Ifsr FSRO,buffer ; use FSRO as a pointer to buffer
moviw ar_cnt

movwf Ip_cnt

loopl tblrd*+
movff TABLAT,POSTINCo
decfsz Ip_cnt, FA

; set up loop count value

; move from table latch to buffer in data memary
; decrement Ip_cnt and skip if zero

goto loopl
Ifsr FSRO,buffer ; set FSRO to point to the first array element
Ifsr FSR1,buffer+ar_cnt-1  ; set FSR1 to point to the last array element
movlw ar_cnt/2
movwf Ip_cnt ; set loop count
loop2 movf INDFO,W ; COpy array element
movff INDF1,POSTINCO ; store and increment pointer FSRO
movwf POSTDEC1 ; store and decrement pointer FSR1
decfsz Ip_cnt,F,A
goto loop2

nop
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forever  goto forever

array db 1,2,3,4,5,6,7,8,9,10
db 11,12,13,14,15,16,17,18,19,20
db 21,22,23,24,25,26,27,28,29,30
end

Perform the following operations:

1. Create a new project called progL?2 in the same directory where the file progL2.asm
is saved.

Add the file progL2.asm into the project.
Build the project.

Select ICD?2 as your debug tool.

Make sure that ICD2 is configured properly.

R

Program the hex code into the microcontroller on your demo board. It takes a few
seconds for the programming to be completed. You will see the message
“Programming Target. . .” at the left bottom of the MPLAB IDE window. When
programming is done, this message will disappear.

7.Open the Program Memory window by sclecting View> Program Memory. Scroll the
program memory so that program lines 44 to 60 can be seen on the window as shown in
Figure L3.1. Look at the column with the title Opcode. The numbers from 1 to 30 can
be seen starting from line 46. How does the Program Memory window store the data?

NOP

NULWF Ox1, O
DECF 0Ox3, 0, 0O
DECF Ox5, Oxl, O

SUBLW
ZORLW
RETLW
MOVLW
IORWF
IORWF
ANDWF
ANDWF
ZORWF
XORWF

COMF Dx1b,
CONF D

ox7
ox9
gxh
Oxd
oxf,
Ox11,
Ox13,
0x15,
0x17,
Oox19,

o, 0

Figure L3.1 ®m Snap shot of program memory window for lab exercise L3.2
(reprint with permission of Microchip)
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8. Open the File Register window. Resize and scroll so that the data memory locations
0x00 to 0x40 can be seen on the screen.

9. Set a breakpoint at line 30 and run the program until it halts at the breakpoint.
The contents of the File Registers window should change to that in Figure L3.2.

10. Set a new breakpoint at line 42 {the last nop instruction) and rerun the program.
The contents of the File Registers window should change to that in Figure 1.3.3.

Figure L3.2 m Contents of file registers at the first breakpoint (reprint with permission
of Microchip)

Figure L3.3 m File register contents when program halts at the second breakpoint
{reprint with permission of Microchip)

What operation is performed by this program?

L3.3 Write a program to compute the average of an array of 32 8-bit elements. The array is
stored immediately after your program with the name of arrayl. Store the sum (two bytes) and
average in data memory 0x00-0x01 and 0x02, respectively. Use the simulator to simulate the
program. Hint: Divide-by-32 can be implemented by shifting to the right by five places.

L3.4 Write a program to count the number of elements that are greater than 30 in an array of n
8-bit elements using the for i = n1 to n2 do looping construct. Debug the program using the
ICD2 and the demo board. Open a Watch window to view the result.
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4.2 Introduction

Many quantities are unsigned and can be handled by unsigned arithmetic that you learned
in Chapter 2. However, there are also many quantities that are signed (e.g., temperature, volt-
age, and profit). They can be positive and negative. Signed numbers are represented in two’s
complement format in a computer. Signed arithmetic operations are discussed in this chapter.
Bit-field operations are also very common in microcontroller (MCU] applications. Such opera-
tions require the use of logical instructions (e.g., AND, OR, and XOR), rotate instructions, and
data movement instructions. Bit-field operations are useful in input and output operations.

A program consists of data structures and algorithms. There are many data structures being
used today. However, a full coverage of data structures is out of the scape of this textbook. This
text deals only with arrays, stacks, and strings.

When a problem gets complicated, writing a program to solve the problem becomes diffi-
cult. A common approach is to use the divide-and-conquer strategy in which a large problem is
divided into several smaller ones and each small problem solved by a subroutine.

The issues related to subroutine calls, including parameter passing, local variables alloca-
tion, and result returning, are discussed here. The instructions used in making subroutine calls
and returning from the subroutine are also presented.

4.3 Signed Arithmetic

In a computer system, all negative numbers are represented in the two’s complement for-
mat. One of the advantages in using the two’s complement system is that it allows the hardware
designer to use the adder to perform subtraction. When subtracting a number from the minuend,
the PIC18 MCU actually adds the two’s complement of the subtrahend to the minuend.

As long as the operands are represented in the two’s complement format, additions and sub-
tractions of signed numbers can be performed by executing the add and subtract instructions.
This can be verified by using the MPLAB® simulator, ICD2 in-circuit debugger, and any PIC18
demo board.

To understand the following discussion, one must understand that the MCU is performing
modulus arithmetic when performing an arithmetic operation. For example, an 8-bit MCU will
drop (or discard) the part of the result that is equal to or larger than 28. A 16-bit MCU will drop
the part of the result that is equal to or larger than 216, A 32-bit MCU will discard the part of
the result that is equal to or larger than 232, Adding 28 to the result of the arithmetic operation
performed by an 8-bit MCU has no effect on the result because this value {28} cannot be kept in
the arithmetic hardware of an 8-bit MCU. In summary, in an n-bit MCU, the result of any arith-
metic operation performed by an n-bit MCU is equal to the remainder of the initial result
divided by 2" (i.e., it is performing a modulus-2® operation).

4.3.1 Signed 8-Bit Multiplication

The multiplication of signed numbers requires the programmer to consider the signs of the
multiplier and the multiplicand. Let M and N represent the magnitudes of two numbers. There
are four possible situations: ,

Case 1. Both operands are positive {opl = M, op2 = N). The product of these two
operands can be computed by using either the mulwf f, A or the mullw k instruction.
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Case 2. The first operand is negative (opl = -M) whereas the second operand is
positive (op2 = NJ. The first operand op1 will be represented in two’s complement of
M (28 - M) in the PIC18. The product of -M and N can be rewritten as follows:
SMXN=(28-MyxN=(28xN)-MxN=216-MxN+28xN

—_—

@ ®

The value 216 is added to this expression. Since in this case the PIC18 is performing a
modulo-216 arithmetic {PIC18 uses PRODH and PRODL to hold the product}, adding
the value of 216 makes no difference to the result. Item 1 is the two’s complement of
the number —-M x N and is the correct product. Part 2 is an extra term and should be
subtracted from the product. This extra item can be eliminated by subtracting op2
from the upper byte of the product of -M and N.

Case 3. The first operand is positive (opl = M), but the second operand is negative
(op2 = —N}. Similar to Case 2, the product of M and —N can be rewritten as follows:
Mx(-N)=Mx(28-N)=(28xM)-MxN=210-MxN+28xM

—_ —

@ @

The value of 216 is added to this expression and it makes no difference to the result for
the same reason as in Case 2. Again, the first term is the correct product, which is
represented as the two’s complement of -M x N. The second term of this product is an
extra term and can be eliminated by subtracting op1 from the upper byte of the
product of M and -N.

Case 4. Both operands are negative (opl = -M, op2 = -N). The product of -M and -N
can be rewritten as follows:

(-M) X (-N) = (28 - M) x (28 - N) =216 - 28 x M- 28 x N+ M X N

=MXN+216-28xM+216-28xN

=MxN+28x (28 - M) +28 x (28 - N}

—_— e —
@ @ ®

The value of 216 is added to this expression. It makes no difference to the result for
the same reason as in Case 2. The first term is the product of -M and -N. The
second term and the third term are extra terms and must be eliminated. The second
term can be eliminated by subtracting opl from the upper byte of the product,
whereas the third term can be eliminated by subtracting op2 from the upper byte of
the product.

By combining these four situations, we conclude that the signed 8-bit multiplication can be
implemented by the following algorithm:

Step 1

Multiply two operands (i.e., compute opl x op2] disregarding their signs.

Step 2

If op1 is negative, then subtract op2 from the upper byte of the product.

Step 3

If op2 is negative, then subtract opl from the upper byte of the product.
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Example 4.1
Write a program to compute the product of two 8-bit signed numbers represented by data
memory locations opl and op2 and leave the product in file registers PRODH and PRODL.
Solution:
#include <pl18F8720.inc>
opl set 0x00 ; the first operand
op2 set 0x01 ; the second operand
numl equ 0x87 ; test number 1
num2  equ 0x98 ; test number 2
org 0x00 ; reset vector
goto start
org 0x08 ; high priority interrupt service routine
retfie
org 0x18 ; low priority interrupt service routine
retfie

start moviw numi
movwf oplA
moviw num2
movwf op2,A
movf opl,WA
mulwf op2,A
btfsc op2,7,A : test the sign bit of the second operand
subwf PRODH,F,A ; if negative, eliminated extra term
movf op2,W,A

btfsc opl,7,A ; test the sign bit of the first operand
subwf PRODH,F,A  ;if negative, eliminated extra term
nop

end

A

4.3.2 Signed 16-Bit Multiplication

Let P and Q be the magnitudes of two 16-bit numbers to be multiplied. There are four sit-
uations for the multiplication operation:

Case 1. Both operands are positive. (opl = P, 0p2 = Q). The resultant product is P x Q.
The method discussed in Section 2.7.4 should be used to carry out the multiplication.

Case 2. The first operand is negative (opl = —P), whereas the second operand is
positive (0p2 = Q). The operand opl would be represented as 216 — P, The product of
opl and op2 can be rewritten as follows:
-PxQ=(215-P)xQ=(2¥xQ)-PxQ=232-PxQ+21xQ

——

@ @

The number of 232 is added to this expression. Adding 232 makes no difference
because the MCU is performing a modulo-232 arithmetic in this case. The product of
—P and Q is represented as the two’s complement of P x Q, that is, 232 - P x Q. The
second item in this expression is an extra term and should be climinated. This can be
done by subtracting the second operand {op2) from the upper 16 bits of the product of
—P and Q.
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Case 3. The first operand is positive (opl = P), and the second operand is negative
(op2 = -Q). The second operand op2 would be represented as 216 — Q. The product of
opl and op2 can be rewritten as follows:
Px(-Q)=Px(21-Q)= (218 xP)-PxQ=2%2-PxQ+21¥xP

—_— -

@ @

The value of 232 is also added to the above expression. It makes no difference to the
result for the same reason as in Case 2. The first term of this expression is the product,
whereas the second item is an extra term and should be eliminated. This can be done
by subtracting the first operand (op1) from the upper 16 bits of the product of P and -Q.

Case 4. Both operands are negative (opl = -P, 0p2 = -Q). Since both operands are
negative, they will be represented in two’s complement forms. The first operand
would be represented as 216 — P, whereas the second operand would be represented as
216 _ Q. The product can be rewritten as follows:

(-P)x (-Q)= (216 -P) x (216 -Q) =232 - 216 x p - 216 x Q+ P x Q
=PxQ+2%2-216xp+232_218xQ

=PXxQ+216x (216 p)+ 216 x (216 _ )
e

@ &) ®
The value of 232 is also added to this expression. It makes no difference to the result for the
same reason as in Case 2. The first term in this expression is the product of —P and —-Q. Both the
second and the third terms are extra items and should be eliminated. The second term can be
eliminated by subtracting the first operand (ep1) from the upper 16 bits of the product of —P and

—Q. The third term can be eliminated by subtracting the second operand (op2) from the upper
16 bits of the product.

By combining these four situations, we conclude that the signed 16-bit multiplication can
be implemented by the following algorithm:

Step 1

Multiply two operands [i.e., compute opl x op2) disregarding their signs.

Step 2

If opl is negative, then subtract op2 from the upper 16 bits of the product.

Step 3

If op2 is negative, then subtract opl from the upper 16 bits of the product.

Write a program to compute the product of two 16-bit signed integers and leave the prod-
uct in memory locations represented by result . . . result+3.

Solution: The program that implements the algorithm is as follows:

#include <p18F8720.inc>
argl_hi set 0x00 ; high byte of the first argument
argl_lo set 0x01 ; low byte of the first argument
arg2_hi set 0x02 ; high byte of the second argument
arg2_lo set 0x03 ; low byte of the second argument
result set 0x04 ; location to hold the product
numi_hi equ 0x83
numl_lo equ 0x45

num2_hi equ 0x81



num2_lo

start

sign_argl

more

equ
org
goto
org
retfie
org
retfie
movlw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
movf
mulwf
movif
movff
movf
mulwf
movff
movff
movf
muiwf
movf
addwf
movf
addwfc
clrf
addwfc
movf
mulwf
movf
addwf
movf
addwfc
clrf
addwfc
btfss
goto
movf
subwf
movf
subwfb
btfss
goto
movf
subwf
movf
subwfb
nop
end

0x47
0x00
start
0x08

0x18

numi_hi
argl_hi,A
numil_lo
argl_lo,A
num2_hi
arg2_hi,A
num2_lo
arg2_lo
argl_lo,W,A
arg2_lo
PRODL,result
PRODH, result+1
argl_hi,W,A
arg2_hi,A
PRODL, result+2
PRODH, result+3
argl_lo,W,A
arg2_hi,A
PRODL,W,A
result+1,F,A
PRODH,W,A
result+2,F,A
WREG,A
result+3,F,A
argl_hi,W,A
arg2_lo,A
PRODL,W,A
result+1,F,A
PRODH,W,A
result+2,F,A
WREG,A
result+3,F,A
arg2_hi,7,A
sign_argl
argl_lo,W,A
result+2,F,A
argl_hi,W,A
result+3,F,A
argl_hi,7,A
more
arg2_lo,W,A
result+2,F,A
arg2_hi,W,A
result+3,F,A

; reset vector
; high-priority interrupt service routine
; low-priority interrupt service routine

; set up test number

, compute argl_lo x arg2_lo

; compute argl_hi x arg2_hi

; compute argl_lo x arg2_hi

; add carry to the most significant byte

; compute argl_hi x arg2_lo

; add carry to the most significant byte

]
’

; check the sign of arg2

; delete extra term

; check the sign of argl
; continue to perform other operation

; delete extra term

. #
¥
. %
’
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4.4 Unsigned Divide Operation

Example 4.3

The PIC18 MCU does not provide any divide instruction. Therefore, a divide operation
must be synthesized by other instructions. A simple but popular divide algorithm in use today
is the repeated subtraction method. This method performs unsigned divide operation. The
hardware required for implementing the repeated subtraction method is shown in Figure 4.1.

C R Q
n-bit n-bit
n-bit

— N

Figure 4.1 m Division hardware

Before performing the repeated subtraction operation, one needs to load 0, the dividend, and
the divisor into registers R, Q, and N, respectively. The carry flag is used to indicate whether
the subtraction result is negative. The ALU can perform n-bit unsigned addition and subtrac-
tion operations. The repeated subtraction method consists of n steps. Each division step con-
sists of three parts:

Step 1
Shift the register pair (R, Q) one place to the left.

Step 2
Subtract the contents of N from R and put the result back to R if the result is positive.

Step 3
If the result of Step 2 is negative, then set the least significant bit of Q to 0. Otherwise, set
the least significant bit of Q to 1.

Write a program to divide an 8-bit number into another 8-bit number.

Solution: The following program is a direct translation of the paper-and-pencil division algorithm:
#include <p18F8720.inc>

Ip_cnt set 0x00

rem set 0x01 ; register to hold remainder
quo set 0x02 ; register to hold quotient
dsr set 0x03 ; register to hold divisor
dvd set 0x04 ; register to hold dividend

dd equ 0xf5 ; value used as dividend
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dr

start

loop

negative
next

equ
org
goto
org
retfie
org
retfie
moviw
mowwf
moviw
movwf
clrf
moviw
movwf
bef
ricf
ricf
movf
subwf
btfss
goto
bsf
mowvf
goto
bef
decfsz
goto
nop
end

Ox11
0x00
start
0x08

0x18

dd

quo,A

dr

dsr,A
rem,A
0x08
Ip_cnt
STATUS,C,A
quo,F.A
rem,F,A
dsr, W,A
rem,W,A
STATUS,C,A
negative
quo,0,A
rem,A

next
quo,0,A
Ip_cnt,F,A
loop

; value used as divisor

; initialize Q register in Figure 4.1.

; initialize N register in Figure 4.1
; initialize R register in Figure 4.1

; initialize loop count to 8
; clear the C flag
; rotate (R, Q) pair to the left one place

L6
’

; subtract and leave the difference in WREG
; skip if carry is 1

; set the least significant bit of Q1 to 1
; place the difference in rem

; set the quotient bit to O
; decrement the loop count and skip if zero

A

Example 4.4

Write a program to divide an unsigned 16-bit number into another unsigned 16-bit number.

Solution: The assembly program for the 16-bit unsigned division is as follows:
#include <p18F8720.inc>

Ip_cnt
temp
dst
quo
rem
dd_h
dd_|
dr_h
dr_|

set
set
set
set
set
equ
equ
equ
equ
org
goto
org
retfie

0x00
0x01
0x04
0x06
0x08
0x68
0x20
0x01
0x48
0x00
start

0x08

; loop count

; temporary storage

; divisor

; quotient

; remainder

; high byte of dividend test number
; low byte of

; high byte of divisor test number

; low byte of divisor test number
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org 0x18
retfie
start movlw dd_h ; initialize Q register in Figure 4.1
movwf quo+1,A .
moviw dd_|I e
movwf quo,A 0
moviw dr_h ; initialize N register in Figure 4.1
movwf dsr+1,A "
movlw dr_| H
movwf dsr,A e
clrf rem,A ; initialize R register in Figure 4.1t0 0
cirf rem+1,A e
moviw D16
movwf Ip_cnt,A ; initialize foop count to 16
loop bef STATUS,C,A ; clear the C flag
ricf quo,F,A ; rotate (R, Q) pair to the left one place
ricf quo+1,FA P
ricf rem,F,A ¢
rlcf rem+1,F,A N
movf dsr,W,A
subwf rem,W,A
movwf temp,A ; save the low byte of the difference
movf dsr+1,W,A
subwfb rem+1,W,A
btfss STATUS,C ; skip if carry is 1
goto less
bsf quo,0,A ; set the quotient bit to 1
movwf rem+1,A ; place the difference in R register
movff temp,rem .
goto next
less bcf quo,0,A ; set the quotient bitto O
next decfsz Ip_cnt,F,A ; decrement the loop count and skip is zero
goto loop
nop
end

Unsigned division program for numbers in other lengths {e.g., 32-bit by 32-bit} can be writ-
ten in the same way and hence is left for you as an exercise. A

4.5 Signed Divide Operation

The one complication for the signed division is that we must also set the sign of the
remainder. The following equation must always hold for division:
Dividend = Quotient x Divisor + Remainder

Our common sense requires that the magnitude of the quotient be the same as long as the
magnitudes of the dividends are the same and the magnitudes of the divisors are the same. We
can determine the sign of the remainder on the basis of this principle. To illustrate, let’s use
(£35) + (+6) as an example. The first situation is simple:

35 + 6: Quotient = +5, Remainder = +5
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If we change the sign of the dividend, the quotient must be changed as well:
-35 + 6: Quotient = -5
Rewriting our basic formula to find the remainder,
Remainder = Dividend - Quotient x Divisor
=35-(-5_6)=-35+30=-5
If we change the sign of the divisor and keep the sign of dividend unchanged,
35 + (-6): Quotient = -5
Remainder=35-(-5%x-6)=35-30=5
If we change the signs of both the dividend and the divisor,
-35 + -6: Quotient =5
Remainder = -35 - (-b x-6)=-35+30=-5
From this discussion, we conclude that the correctly signed division algorithm negates the

quotient if the signs of the operands are opposite and makes the sign of the nonzero remainder
match the dividend.s

Example 4.5

Write a PICI8 program that performs the 8-bit signed divide operation. This program will
leave the quotient and remainder in the data registers represented by quo and rem, respectively.

Solution: The following program implements the 8-bit signed divide operation described in this

section:

#include <p18F8720.inc>

sign set 0x00

dvd set 0x01 ; dividend

dsr set 0x02 ; divisor

quo set 0x03 ; quotient

rem set 0x04 ; remainder

Ip_cnt set 0x05 ; loop count

dd equ 0x82 ; testing number for dividend

dr equ Oxf5 ; testing number for divisor
org 0x00
goto start
org 0x08
retfie
org 0x18
retfie

start bef sign,2,A ; initialize the sign of quotient to positive
bef sign,1,A ; initialize the sign of dividend to positive
bcf sign,0,A ; initialize the sign of divisor to positive
moviw dd
movwf dvd,A
moviw dr
movwf dsr,A
btfss dvd,7,A ; check the sign of dividend
goto second

btg sign,2 ; change the sign of quotient
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second

do_it

loop

negative
next

check_re

ok_skip

bsf
negf
bifss
goto
btg
bsf
negf
movf
movwf
cirf
moviw
movwf
bef
rlcf
rcf
movf
subwf
btfss
goto
bsf
movwf
goto
bef
decfsz
goto
btfss
goto
negf
btfss
goto
negf
nop
end

sign,1
dvd,A
dsr,7,A
do_it
sign,2,A
sign,0,A
dsr,A
dvd,W,A
quo,A
rem,A
0x08
Ip_cnt,A
STATUS,C,A
quo,F.A
rem,F,A
dsr,W,A
rem,W,A
STATUS,C,A
negative
quo,0,A
rem,A
next
quo,0,A
lp_cntF A
loop
sign,2,A
check_re
quo,A
sign,1,A
ok_skip
rem,A

; record the sign bit of the dividend
; compute the magnitude of dividend
; check the sign of the divisor

; change the sign of quotient
; set the sign of the divisor
; compute the magnitude of divisor

; initialize R register in Figure 4.1

; initialize loop count to 8
; clear the C flag
; rotate (R, Q) pair to the left one place

.
’

; suibtract and leave the difference in WREG
s skip if canry is 1

; set the least significant bit of Q1 to 1
; place the difference in R1

; set the quotient bit to 0
; decrement the loop count and skip if zero

; skip if sign of quotient is negative
; skip if dividend is negative

L«
’

135

Example 4.6

Write a program to divide a signed 16-bit number into another 16-bit signed integer.

Solution: The following program will perform the signed 16-bit divide operation:
#include <p18F8720.inc>

sign

dvd

dsr

quo

rem
lp_cnt
temp
dd_h

set
set
set
set
set
set
set
equ

0x00
0x02
0x04
0x06
0x08
0x0A
0x0B
0xD9

; keep track of the signs of dividend and divisor
; dividend

; divisor

; quotient

; remainder

; loop count

; temporary storage

; testing number for dividend
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dd_|
dr_h
dr_|

start

second

do_it

foop

equ
equ
equ
org
goto
org
retfie
org
retfie
bef
bef
bef
moviw
movwi
moviw
movwf
moviw
movwf
moviw
movwf
btfss
goto
btg
bsf
comf
comf
incf
moviw
addwfc
btfss
goto
btg
bsf
comf
comf
incf
moviw
addwfc
movff
movff
clrf
clrf
moviw
movwf
bef
rlcf
tlef
ricf
ricf
movf

0xB8
OxFF
0x80
0x00
start

0x08

0x18

sign,2,A
sign,1,A
sign,0,A
dd_|
dvd,A
dd_h
dvd+1,A
dr_|

dsr,A

dr_h
dsr+1,A
dvd+1,7,A
second
sign,2
sign,1
dvd,F,A
dvd+1,F,A
dvd,F.A
0x00
dvd+1,F,A
dsr+1,7,A
do_it
sign,2,A
sign,0,A
dst,F.A
dsr+1,F,A
dsr,F,A
0x00
dsr+1,F,A
dvd,quo
dvd+1,quo+1
rem,A
rem-+1,A
D'16’
Ip_cnt,A
STATUS,C,A
quo,F.A
quo+1,FA
rem,F,A
rem+1,F,A
dsr,W,A

. u
)

; testing number for divisor

; initialize the sign of quotient to positive
; initialize the sign of dividend to positive
; initialize the sign of divisor to positive

; set up dividend

; check the sign of dividend

; change the sign of quotient
; record the sign bit of the dividend
; compute the magnitude of dividend

; check the sign of the divisor

; change the sign of quotient
; set the sign of the divisor
; compute the magnitude of divisor

; place dividend in Q register in Figure 4.1

; initialize R register in Figure 4.1

; initialize loop count to 8
; clear the C flag
; rotate (R, Q) pair to the left one place

; compute R-N and places the difference
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subwf rem,W,A ; in WREG and temp
movwf temp,A i
movf dsr+1,W,A .
subwfb rem+1,W,A “
btfss STATUS,C,A ;skip if carry is 1
goto negative
bsf quo,0,A ; set the least significant bitof Q to 1
movwf rem+1,A ; place the difference in R in Figure 4.1
movff temp,rem e
goto next
negative bef quo,0,A ; set the quotient bit to O
next decfsz Ip_cnt,F,A ; dectement the loop count and skip if zero
goto loop
btfss sign,2,A ; skip if sign of quotient is negative
bra check_re e
comf quo,F,A ; complement the quotient
comf quo+1,FA e
incf quo,F.A ;
moviw 0x00 i
addwfc quo+1,F,A
check_re btfss sign,1,A ; skip if dividend is negative
bra ok_skip P
comf rem,F,A ; complement the remainder
comf rem+1,F,A H
incf rem,F,A 0
moviw 0x00 0
addwfc rem+1,F,A i
ok_skip nop
end

Signed division program for numbers in other lengths {e.g., 32-bit by 32-bit division) can be
written in the same manner and hence are left for you as an exercise.

4.6 The Stack

A stack is a first-in-last-out {or last-in-first-out) data structure. To implement a stack, two
things are needed:

1. A stack pointer that points to the top (or the byte immediately above the top) of the stack
2. A block of RAM of adequate size

The PIC18 MCU has no register designated as the stack pointer. However, the user can use
one of the FSR registers as the stack pointer and use one or more banks of the data memory to
implement the data stack. The stack implemented this way is called a software stack.

A stack can grow from a low address toward higher addresses or from a high address toward
lower addresses. This text follows the convention used by the Microchip C18 compiler:

1. Use the FSR1 register as the stack pointer and set it to point to the next available byte
on the stack as shown in Figure 4.2.

2. Grow the stack from a low address toward higher addresses.
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[<— stack pointer (FSR1)

higher address top byte
A

low address bottom

Figure 4.2 m The PIC18 Software Stack

A software stack is used mainly in saving program contexts and providing space for local
variables during a subroutine call. The contents of some CPU registers such as WREG and STA-
TUS are the program contexts, whereas local variables are those variables that exist only when
a subroutine is entered (being called). The appropriate size for the stack is dependent on the
application. An application that makes a lot of recursive subroutine calls will need a larger soft-
ware stack. Unless the application requires, one data memory bank is used for the software bank
in this text. Any unused data memory bank can be used for the software stack. This text uses
the highest data memory bank for the software stack. For example, the bank that covers the
address range from 0x500 to Ox5FF is used for the PIC18F452 and PIC18F458, whereas the bank
that covers the address range from 0xEOO to OxEFF is used for the PIC18F8720.

4.6.1 Stack Operations

The stack pointer needs to be initialized before the stack can be accessed. The user can ini-
tialize the stack pointer by using the LFSR instruction. For example, the instruction

ifsr FSR1,0x500
will initialize the stack pointer for the PIC18F452 and PIC18F458. The instruction
Ifsr FSR1,0xEOQQ

will initialize the stack pointer for the PIC18F8720.

The most common stack operations are the push and pop (also called pull) operations. A push
operation places the contents of a register into the stack location pointed to by the stack pointer
and then increments the stack pointer by one. A pop operation decrements the stack pointer by
one and then copies the contents of the memory location pointed to by the stack pointer to the
specified register.

The following instruction will push the WREG register onto the stack:

movwf POSTINC1
The following instruction will push the STATUS register onto the stack:

movff STATUS,POSTINC1
The following instruction sequence will pull the top byte of the stack onto the STATUS
register:

movff POSTDEC1,STATUS ; get the stack pointer decremented

movif INDF1,STATUS ; pop the stack onto STATUS
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To make the push and pop operations more understandable, the user can create macros for
these operations:

»  pushr—macro to push a file register onto the stack
= popr—macro to pop a byte off the stack
The definitions of these two macros are as follows:

pushr macro arg ; macro to push the WREG register
movff arg,POSTINC1
endm

popr macro arg ; arg is a file register
movff POSTDEC1,arg ; decrement the stack pointer
movff INDF1,arg ; pop off a byte from the stack onto arg
endm

A third macro that pushes a value into the stack can be created by calling the pushr macro:

push_dat macro dat ; this macro push the value dat onto the stack
moviw dat
pushr WREG
endm

Utilize the macro defined earlier to push the WREG and STATUS register onto the stack
and pop the top two bytes of the stack onto the data memory locations at 0x00 and 0x01.

Solution: The required operations can be performed as follows:

1. Pushing WREG: pushr WREG
2. Pushing STATUS: pushr STATUS
3. Popping onto 0x00: popr 0x00

4. Popping onto 0x01: popr 0x01

4.7 Subroutines

A subroutine is a sequence of instructions that can be called from many different places in
a program. Parameters can be passed to the subroutine so that it can perform the same opera-
tion on different variables. There are two main reasons for creating subroutines:

1. The problem at hand is too complicated to be solved by a single program. It would be
easier to use the divide-and-conquer strategy to divide the problem into smaller ones
and create a subroutine to solve each smaller problem. By doing this, a complicated
problem will be more manageable and can easily be solved.

2. There are several places in a program that need to perform the same operation on
possibly different values. By creating a single subroutine to perform the same
operation on different values, the program can be dramatically shortened.

When dealing with a complicated problem, one normally begins with a simple main pro-
gram whose steps clearly outline the logical flow of the algorithm and then assigns the execu-
tion details to subroutines. Subroutines may also call other subroutines. Programs written in
this manner are called structured programs. Writing programs in this manner is called struc-
tured programming. The structure of a complicated program may look like that in Figure 4.3.
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main program

|subroutine1 | | subroutine 2 I | subroutine 3 I

- A4

rSubroutine HJ I Subroutine 1.2 I I Subroutine 2.1 | bubroutineei] rSubroutine 3.24‘

ISubroutine 2.1 .1] [ Subroutine 3.1.1 |

Figure 4.3 m A structured program

The PIC18 MCU provides the following mechanisms to support subroutine calls:

1. The reall n and call k[,s] instructions for making the subroutine call and the return
instruction for returning from the subroutine

2. A return address stack for saving and restoring return addresses

w

. A return stack pointer that points to the top of the return address stack

4. The push and pull instructions for pushing values onto the return address stack and
pulling values from the return address stack

5. A one-layer-deep fast register stack for fast saving and restoring the STATUS, WREG,
and BSR registers during interrupts and subroutine calls

4.7.1 Instructions for Supporting Subroutine Calls

The PIC18 MCU provides two instructions for malking subroutine calls. The subroutine being
called can be up to 1 K words away from the reall n instruction. The return address (PC + 2} will
be pushed onto the return address stack before the subroutine is entered. The subroutine being
called is normally referred to by its name. For example,

rcall  find_max

calls the subroutine find_max. The subroutine find_max must be no more than 1 K words away
from the reall instruction.

When the subroutine is farther than 1 K words, the call k[,s] instruction should be used to
call the subroutine. This instruction can call a subroutine in the entire 2-MB memory range.
The call instruction has an option to push the STATUS, WREG, and BSR registers onto their
respective shadow registers. This option is enabled by setting the s flag to 1. For example,

call  sq_root,1

will call the subroutine sq_root and save the BSR, STATUS, and WREG registers in the fast reg-
ister stack {also called shadow registers). Because this is a 32-bit instruction, the saved return
address is the address of the call instruction plus 4.

The last instruction of a subroutine must be a return [s] instruction. When this instruction
is executed, the return address stack is popped, and the top of the stack is loaded into the pro-
gram counter. Program control is thus transferred back to the caller of the subroutine. If the s
flag is 1, then the BSR, STATUS, and WREG registers are reloaded from the fast register stack.
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4.7.2 Return Address Stack

The return address stack allows any combination of up to 31 subroutine calls and interrupts
to occur. The program counter is pushed onto the stack when a push, call, or reall instruction
is executed or an interrupt is acknowledged. On a teturn, retlw, or retfie instruction, the PC
value is pulled from the return address stack. The retlw instruction is explained later.

The return address stack operates as a 31-word-by-21-bit stack memory and a 5-bit stack
pointer (STKPTRJ. The stack space is neither part of the program nor part of the data memory
space. The stack pointer is readable and writable, and the data on the top of the return address
stack is readable and writable through SFR registers. Status bits {in the STKPTR register) indi-
cate whether the stack pointer is at or beyond the 31 levels provided.

4.7.3 Top-of-Stack Access

The top of the return address stack is readable and writable through three register locations:
TOSU, TOSH, and TOSL. These three registers allow access to the contents of the stack loca-
tion indicated by the STKPTR register. The current PC value can be pushed into this stack by
using the push instruction. The user can pop the top of the return address stack into the pro-
gram counter by invoking the pull instruction.

4.7.4 Return Address Stack Pointer (STKPTR)

The contents of the STKPTR register are shown in Figure 4.4. In addition to the 5-bit
pointer, the STKPTR also contains the STKFUL and STKUNF flags to indicate whether the
return address stack has been pushed or pulled too many times.

7 6 5 4 3 2 1 0

STKFUL | STKUNF -- SP4 SP3 Sp2 SP1 SPO

STKFUL.: stack full flag bit
0 = stack has not become full or overflowed
1 = stack has become full
STKUNF: stack underflow flag bit
0 = stack underflow did not occur
1 = stack underflow occurred
SP4:SPQ: stack pointer location bits

Figure 4.4 m The STKPTR register (at OxFFC) (redraw with permission of Microchip)

4.7.5 Fast Register Stack

A subroutine call usually requires the saving and restoring of certain CPU registers, such
as the BSR, STATUS, and WREG registers. The PIC18 MCU provides a fast return option to
speed up this process. The fast register stack is provided for the BSR, STATUS, and WREG reg-
isters and is only one layer deep. Stated in another way, each of the BSR, STATUS, and WREG
registers has a shadow register in the fast register stack. The fast register stack is not readable
nor writable.
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To use the fast register stack, the s flag in the call instruction and the corresponding return
instruction must be set to 1, In assembly language, this is represented by the symbol FAST. For
example, the following instruction sequence utilizes the fast register stack:

call sub_x, FAST ; save BSR, STATUS, and WREG in fast
; register stack
sub_x
return FAST ; restore values saved in fast register stack

4.7.6 Table Lookup instruction

A lookup table can be implemented by using the call and retlw instructions together. The
following code segment will perform the desired table lookup:

moviw i ; prepare to lookup the it" entry
call look_up
look_up addwf PCL
retlw kO
retlw k1
retlw kn ; end of table

4.8 ssues Relaed to Subroutine Calls

The subroutine being called is referred to as callee, whereas the program that makes the call
is referred to as caller. A subroutine is entered when it is executed. There are three issues
involved in the subroutine call:

m  Parameter passing. The user usually wants the subroutine to perform a certain
operation on the values passed to it. There are several parameter passing methods:

1. Use general-purpose CPU registers. In this method, parameters are placed in
registers before the subroutine is called.

2. Use the stack. In this method, parameters are pushed into the stack before the
subroutine is called. The stack needs to be cleaned up after the subroutine
completes the desired computation. This can be done by either the caller or the
callee.

3. Use global memory. Global memory is accessible to both the caller and the
callee. As long as the caller places parameters in global memory before it calls
the subroutine, the callee will be able to access them. For the PIC18 MCU, this
method is the same as the first one because general-purpose registers are
identical to the global memory.

»  Result returning. The result of a computation performed by the subroutine can be
returned to the caller using three methods:
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1. Use general-purpose CPU registers. The subroutine places the computation
result in one or more general-purpose CPU registers before returning to the
caller.

2. Use the stack. The caller makes a hole in the stack before calling the
subroutine. The callee places the computation result in the hole before
returning to the caller.

3. Use global memory. The callee places the result in global memory, and the
caller will be able to use them. For the PIC18 MCU, this method is identical
to the first one because general-purpose CPU registers are identical to the global
memory.

n Allocation of local variables. In addition to the parameters passed to it, the
subroutine may need memory space to hold temporary variables and results. These
temporary variables are called local variables because they exist only when the
subroutine is entered. Local variables are always allocated in the stack so that they
are not accessible to any other program units. For the PIC18 MCU, local variables
can be allocated by adding a number to the stack pointer (FSR1). Before the
subroutine returns, the space allocated for local variables must be deallocated.
Deallcoation is the reverse operation of allocation, and it can be done by
subtracting a number (same as the number added to the stack pointer earlier) from
the stack pointer.

When writing a subroutine, the programmer should keep in mind that the subroutine is to
be invoked by many different programs and should try to write it in a general way. This will
make the subroutine more useful.

Example 4.8

Write a macro to allocate n bytes for local variables and a macro to deallocate n bytes from
the stack by following the convention described in Section 4.6 where n is an 8-bit number.

Solution: The macro that allocates n bytes in the stack for local variables is as follows:

alloc_stk macro n ; this macro allocates n bytes in stack
movlw n
addwf FSR1L,F.A
movlw 0x00
addwfc FSR1H,F,A
endm

The macro that deallocates n bytes from the stack is as follows:

dealloc_stk macro n ; this macro deallocates n bytes from stack
moviw n
subwf FSR1L,F.A
moviw 0
subwfb FSR1H,F,A ; subtract borrow from high byte of FSR1
endm




144

Chapter 4 m Advanced Assembly Programming

4.8.1 The Stack Frame

The stack is used heavily during a subroutine call. The caller may pass parameters to the
callee, and the callee may need to save registers and allocate local variables in the stack. The
area in the stack that holds incoming parameters, saved registers, and local variables is referred
to as the stack frame. Some microprocessors have a dedicated register for managing the stack
frame—the register is referred to as the frame pointer. For the PIC18 MCU, the FSR2 register
can be used as the frame pointer {The C18 compiler uses the FSR2 register as the frame pointer.)
The stack frame for the PIC18 MCU is shown in Figure 4.5.

<—— FSR1 (stack pointer)

local variables

saved registers <— FSR2 (frame pointer)

previous frame pointer

Increasing addresses

incoming parameters

Figure 4.5 m PIC18 Stack frame

The frame pointer is mainly used to reference the location on the stack that separates the
stack-based arguments and the stack-based local variables. Incoming parameters are located at
negative offsets from the frame pointer whereas the local variables are located at positive off-
sets from the frame pointer.

Immediately on entry to the subroutine, the callee pushes the value of FSR2 onto the stack
and copies the value of FSR1 to FSR2, thereby saving the caller’s frame pointer and initializing
the frame pointer for the current subroutine. The callee may save some registers other than
those saved in the fast register stack and then add the size of the local variables for the callee to
the stack pointer {FSR1). References to stack-based incoming parameters and stack-based local
variables are resolved according to offsets from the frame pointer.

The reason for having a dedicated frame pointer is due to the fact that the stack pointer may
change during the lifetime of a subroutine. Once the stack pointer changes value, there can be
problem in accessing the variables stored in the stack frame. The frame pointer is added to point
to a fixed location in the stack and can avoid this problem.

4.8.2 Accessing Locations in the Stack Frame

As stated earlier, a local variable can be accessed by adding a positive value {placed in
WREG] to the frame pointer to form an address and then performing an indirect access, whereas
an incoming parameter can be accessed by adding a negative value (also placed in WREG] to the
frame pointer to form an address and then performing an indirect access.
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For illustration purpose, assume that we have a stack frame as shown in Figure 4.6. The off-
sets from FSR2 for local variables i, j, k, sum, in_order, and loop_cnt are 0, 1, 2, 3, 4, and 5 respec-
tively. The offsets from FSR2 for incoming parameters n and m are -2 and -3, respectively.

0 L FSR2

-—— FSR1
i loop_cnt A
I E— in_order
\ sum %]
5 a
[}
4 i k g
3 - 3
J
2 1( - g
@
5]
G
£

previous FSR2

n

m

Figure 4.6 m Stack frame and variable offsets

The following instruction sequence will load the local variable sum into the WREG register:

moviw 0x3
movf PLUSW2,W,A
The following instruction sequence will load the incoming variable m into the WREG register:
movlw -3 ; place -3 in WREG
movf PLUSW2,W,A ; load m into WREG

To make one’s program more readable, symbolic names should be used to access local variables
and incoming parameters. This can be achieved as follows:

loop_cnt equ 5 : offset of loop_cnt from frame pointer

in_order equ : offset of in_order from frame pointer

4
sum equ 3 : offset of sum from frame pointer
k equ 2 ; offset of k from frame pointer
j equ 1 ; offset of j from frame pointer
i equ 0 : offset of i from frame pointer
n equ -2 : offset of n from frame pointer
m equ -3 : offset of m from frame pointer
; loading sum into WREG

movlw sum

movf PLUSW2,W,A
; loading m into WREG

movlw m

movf PLUSW2,W,A

The following example illustrates the use of all the stack macros defined earlier and the access-
ing of local variables in the stack frame.
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Example 4.9

Write a subroutine that finds the maximum element of an array of 8-bit elements in pro-
gram memory. Pass the array count and starting address in the software stack.

Solution: The algorithm of this problem has been explained in Figure 2.13. The stack frame of
this subroutine is shown in Figure 4.7, which shows that the subroutine find_amax will do the

1. Save the current frame pointer in the stack

|
|
‘\ following:
\

2. Save the table pointer in the stack

3. Allocate two bytes for local variables—one byte for loop count Ip_ent and one byte for
temporary array max ar_iax.

-— FSR1 (stack pointer)

ar_max

Ip_cnt

TBLPTRU

TBLPTRH

TBLPTRL

~— FSR2 (frame pointer)

FSR2H

FSR2L

ar_cnt

arr_xup

arr_xhi

arr_xlo

Figure 4.7 m Stack frame for Example 4.9

The testing program and the subroutine are as follows:
<p18F8720.inc>

#include

radix
pushr macro
movff
endm
popr macro
movff
movff
endm
alloc_stk macro
moviw
addwf

dec
arg

arg,POSTINC1

arg

POSTDEC1,arg

INDF1,arg

n
n
FSRILFA

; macro to push the arg register into stack

; macro to pop the arg register
; decrement the stack pointer
; pop off a byte from the stack onto arg

; this macro allocates n bytes in the software
; stack
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dealloc_stk

acnt
Ip_cnt
ar_max
ar_cnt
am_xup
arr_xhj
arr_xlo
array_max

start

here

movlw
addwfc
endm
macro
movlw
subwf
moviw
subwfb
endm
equ
equ
equ
equ
equ
equ
equ
set
org
goto
org
ratfie
org
retfie
Ifsr
moviw
pushr
moviw
pushr
moviw
pushr
moviw
pushr
call
movff
dealloc_stk
nop
bra

0x00

FSR1H,F,A

n ; this macro deallocate n bytes from
n ; the software stack

FSR1LF.A

0x00

FSR1H,F,A

D'32' ; afray count

3 ; stack frame offset for Ip_cnt

4 ; stack frame offset for array max
-3 ; stack frame offset for array count
-4 ; stack frame offset for array base
-5 ; “

_6 ; “

0x00 ; register to hold array max

0x00 ; reset vector

start

0x08

0x18

FSR1,0xEQ0 ; set up software stack pointer
low arr_x ; pass array base in the stack
WREG Y

high arr_x e

WREG H

upper arr_x e

WREG M

acnt ; pass array count in stack

WREG e

find_amax,FAST ; call the subroutine
PRODL,array_max ; save the result

4 ; clean up the allocated stack space
here

« sk sk 3k ok ok ok e e ke ok ke e e ke ke ke ok ok ok sk ok sk ok sk ok ok oK 3K 6 e o sk ke s s ke ke ke ke ok g sk ok sk oK 3K ok ok ok oK oK Sk e ok sk ke ke ke ok sk Sk K ok K oK oK ok ok o ok
!

; The following subroutine finds the maximum element of an array of 8-bit elements
; and return the result in the PRODL register. Both the array base and array count

; are passed in the software stack.

=3Ok S ok e ok ok ok ok sk ok e sk Sk ok sk ok ok sk ok ok sk sk sk ok ok sk ok ok sk sk sk ok sk ok sk sk ke ke ok e sk ok sk sk 3k sk ok 3k sk ol Sk ok sk sk sk e ok 3k ok sk K ok ok ok ok skokok sk ok
'

find_amax

pushr
pushr
movff
movft
pushr
pushr
pushr
alloc_stk

FSR2L ; save callers frame pointer
FSR2H i

FSR1L,FSR2L ; set up new stack frame
FSR1H,FSR2H ; pointer

TBLPTRL ; save table pointer in stack
TBLPTRH .

TBLPTRU e

2 ; allocate two bytes for local variables
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cmp_lp

next

done

movlw
movff
decf
movlw
movff
moviw
movff
moviw
movff
moviw
movff
tblrd*+
moviw
movff
movlw
tsifsz
goto
goto
moviw
decf
third*+
moviw
movf
cpfsgt
goto
movlw
movff
goto
moviw
movff
dealloc_stk
popr
popr
popr
popr
popr
return

ar_cnt
PLUSW2,PRODL
PRODL,F,A

Ip_cnt
PRODL,PLUSW?2
arr_xlo

PLUSW2, TBLPTRL
arr_xhi
PLUSW2,TBLPTRH
arm_xup
PLUSW2,TBLPTRU

ar_max
TABLAT,PLUSW2
Ip_cnt

PLUSW?2

next

done

Ip_cnt
PLUSW2,F

ar_max
PLUSW2,W,A
TABLAT

cmp_Ip

ar_max
TABLAT,PLUSW2
cmp_lp

ar_max
PLUSW2,PRODL
2

TBLPTRU
TBLPTRH
TBLPTRL

FSR2H

FSR2L

FAST

; initialize Ip_cnt to arcnt-1
; place array pointer in TBLPTR

’
]
’
]
)
. &
’
]
)

; assign arr_x[0] as the initial array max

]
.
'

; decrement the loop index
; read in the next array element

; update the current array max

; deallocate local variables

; define an array of 32 8-bit elements. The even bytes will be at lower addresses
1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16
17,18,19,20,21,22,23,24,25,26,27,28,29,30,31,32

arr_x

Searching an array or a file is a common operation in computer applications. When the
array or file is not sorted, the search program will need to search the whole array. However, if
the array has been sorted, more efficient search algorithms can be applied. The binary search
algorithm is one such algorithm. Assuming that the array is sorted in ascending order, the

db
db
end

binary search algorithm will divide the array into three sections:
» The upper half

= The middle element

s The lower half
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To make the algorithm more specific, three integers are used to index the array:
®  max—upper bound of array indices for search
= mean—middle index for array search
= min—lower bound of array indices for search
A search key will be compared to the middle element of the search range. There are three

possibilities for the search outcome:

1. The key is equal to the middle element of the search range. In this case, the search
operation is over.

2. The key is greater than the middle element of the search range. In this case, the search
operation should be continued in the upper half of the search range.

3. The key is smaller than the middle element of the search range. In this case, the search
operation should be continued in the lower half of the search range.

The exact algorithmic steps are as follows:

Step 1
Use max and min as the upper and lower indices of the array for searching and initialize
max and min ton -1 and 0, respectively.

Step 2

'If max < min, then stop. No element matches the key.

Step 3

Let mean = (min + max)/2.

Step 4

If key = array_y[mean], then key is found; stop.

Step 5

If key < array_y{mean], then set max to mean -1 and go to Step 2.
Step 6

If key > array_y[mean]|, then set min to mean +1 and go to Step 2.

A

Example 4.10

Write a subroutine to implement the binary search algorithm. The starting address of the

array, array count, and search key are passed in the stack. A value of 1 will be returned in
PRODL if the key is found in the array. Otherwise, a value of 0 will be returned.

Solution: The stack frame for calling the binary search subroutine is shown in Figure 4.8. To
make the search easy, each array element is stored in one word. By doing this, the address of the
element arr_x[mean] is equal to art_x[0] + 2 x mean {the PIC18 MPASM follows little-endian
storage format). The binary search subroutine and its testing program are as follows:

#include <p18F8790.inc>
radix dec ; set default radix to decimal

1

; include stack macros pushr, push_dat, popr, alloc_stk, and dealloc_stk here

1

acnt equ D'32’ ; array count
local_var equ 4 ; number of bytes for local variables
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skey
min
mean
max
result
key
ar_cnt
arr_xup
arr_xhi
arr_xlo
find_it

start

here
bin_search

equ
equ
equ
equ
equ
equ
equ
equ
equ
equ
set
org
goto
org
retfie
org
retfie
Ifsr
movlw
pushr
moviw
pushr
movlw
pushr
moviw
pushr
moviw
pushr
call
movif
dealloc_stk
nop
bra
pushr
pushr
movif
movff
pushr
pushr
pushr
alloc_stk
moviw
movff
decf
moviw
movff
moviw
clrf
moviw
cirf

D7

-7

0x00
0x00
start
0x08

0x18

FSR1,0xEQ0
low arr_x
WREG

high arr_x
WREG

upper arr_x
WREG

acnt

WREG

skey

WREG
bin_search, FAST
PRODL,find_it
5

here

FSR2L

FSR2H

FSR1L, FSR2L
FSR1H,FSR2H
TBLPTRL
TBLPTRH
TBLPTRU
local_var
ar_cnt
PLUSW2,PRODL
PRODL,F,A

max

PRODL, PLUSW2
min

PLUSW2,A
result

PLUSW?2

; key for search

; offset for lower bound of search range index
; offset for middie element index

; offset for upper bound of search range index
; offset for search result

; offset for search key

; stack frame offset for array count

; stack frame offset for array base

L,k
5
.
’

; register to hold array max
; reset vector

; set up software stack pointer
; pass array base in the stack

; pass array count in stack

¥

; pass key for search

; call the subroutine
; save the result
; clean up the allocated stack space

; save callers frame pointer
.

; set up frame pointer

; save table pointer in stack

.
’
.
)

; allocate space for local variables
;max<=ar_cnt-1

; set the search result to not found
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; place max index in PRODL

; place min index in W

; is max < min?

; max >= min and continue

; no match is found in the array

; compute (min+max), this may set C flag
; compute (min+max)/2 and place it

; in PRODL

; place mean index in the stack frame slot

; place array base in TBLPTR

; multiply mean by 2

; add the msb of (2*mean) to TBLPTRH

]
’

; add lower 8 bits of 2 x mean to
; TBLPTR

; read array[mean] into TABLAT

; place key in WREG

; set search result to “found”

; Set min to mean+1 to
; search upper half

bloop moviw max
movff PLUSW2,PRODL
moviw min
movff PLUSW2,WREG
cpfslt PRODL
goto do_it
goto done
do_it addwf PRODL,F,A
bef STATUS,C
rref PRODL,F,A
movlw mean
movff PRODL, PLUSW2
; compare arrayjmean] with the search key
moviw arr_xlo
movff PLUSW2,TBLPTRL
moviw arr_xhi
movff PLUSW2,TBLPTRH
moviw arr_xup
movff PLUSW2,TBLPTRU
; add (meanx2) to TBLPTR to compute the address of arr_x{mean]
bef STATUS,C,A
ricf PRODL,F,A
moviw 0
addwfc TBLPTRH,F,A
addwfc TBLPTRU,F.A
movf PRODL,W,A
addwf TBLPTRL,F,A
moviw 0
addwfc TBLPTRH,F,A
addwfc TBLPTRU,F,A
tblrd*
; compare key with array[mean]
moviw key
movf PLUSW2,W,A
cpfseq TABLAT,A
goto not_equal
moviw result
incf PLUSW2,F
goto done
not_equal cpfsit TABLAT,A
goto go_low
moviw mean
movff PLUSW2,PRODL
incf PRODL,F.A
moviw min
movff PRODL,PLUSW2
goto bloop
go_low movlw mean
movif PLUSW2,PRODL

151
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decf PRODL,F,A
moviw max
movff PRODL,PLUSW2 ; set max to mean - 1 and
goto bloop ; search lower half
done moviw result
movff PLUSW2,PRODL ; place the result in PRODL before return
dealloc_stk local_var ; deallocate local variabies
popr TBLPTRU
popr TBLPTRH
popr TBLPTRL
popr FSR2H
popr FSR2L
return FAST

; define an array of 32 8-bit elements for testing purpose. The element arr_x{i] is
; located at arr_x[0] + 2 * i due to the fact that PIC18 assembler follows
; Little-Endian storage format.
ar_x dw 1,2,3,4,5,6,7,8,9,10
dw 11,12,13,14,15,16,17,18,19,20
dw 21,22,23,24,25,26,27,28,29,30
dw 31,32
end

-+ FSR1 (stack pointer)

result

max

mean

min

TBLPTRU

TBLPTRH

stack offset

reference point TBLPTRL <— FSR2 (frame pointer)

FSR2H

FSR2L

key

ar_cnt

arr_xup

arr_xhi

arr_xlo All slots are one byte

Figure 4.8 m Stack frame of example 4.10
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4.9 String Processing

A string is a sequence of characters terminated by a NULL (ASCII code 0) or other charac-
ter such as EOT [ASCII code 4). The NULL character is used to terminate a string in this book.
Common operations applied to strings include string concatenation, character and word count-
ing, string matching, and string insertion and deletion.

Strings are also needed in input and output operations. Before a number (in binary format
in memory) is output, it must be converted to ASCII code because most output devices accept
only ASCII code. A number can be output in BCD or hex format.

Assuming that the user wants to output the unsigned binary number 0010 1010 0011 0101
{equivalent to decimal value 10805), the computer must convert it to the ASCII code sequence
0x31 0x30 0x38 0x30 0x35 so that the user can quickly recognize its value.

To convert a binary number into its equivalent decimal digit string, the repeated divide-by-
10 operation is performed. The hex number 0x30 is then added to the remainder to obtain its
corresponding ASCII code. Since division operation is needed, the unsigned 16-bit division pro-
gram will be converted to a subroutine so that it can be used in the binary-to-decimal-string
conversion process.

Example 4.11

Convert the unsigned 16-bit division program into a subroutine. The caller of this subrou-
tine will push the dividend and divisor into the stack and make a hole in the stack for the callee
to return the remainder and the quotient.

Solution: The stack frame of the subroutine is shown in Figure 4.9.

<— FSR1
temp
Ip_cnt
offset from FSR2
FSR2 ————» PRODL [— .
reference point
FSR2H
FSR2L
dsr_hi
pushed by caller
dsr_lo
rem_hi
a hole made by the caller (R register)
rem_lo
quo_hi (dvd_hi)
pushed by caller (Q register)
quo_lo (dvd_lo)

Figure 4.9 m Stack frame of example 4.11
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As shown in Figure 4.9, the caller of the divul6 subroutine will perform the following oper-
ations before calling the divi6u subroutine:

® Push the dividend into the stack
= Make a hole of two bytes to hold the remainder
= Push the divisor into the stack
The div16u routine will perform the following operations before executing the divide algorithm:
= Save the previous frame pointer in the stack
= Set up the current frame pointer
m  Save the PRODL register in the stack
®  Allocate space for local variables
The divi6u subroutine and its testing program are as follows:
#include <p18F8720.inc>

; include macros pushr, popr, alloc_stk, and dealloc_stk here

loc_var equ 2 ; local variable size
Ip_cnt equ 1 ; loop count
temp equ 2 ; temporary storage
quo_hi equ -7 ; offset for quotient and dividend
quo_lo equ -8 0
rem_hi equ -5 ; offset for remainder
rem_lo equ -6 0
dsr_hi equ -3 ; offset for divisor
dsr_lo equ -4 e
dd_h equ OxEC ; high byte of dividend test number
dd_| equ 0x46 ; low byte of
dr_h equ 0x00 ; high byte of divisor test number
dr_| equ 0x87 ; low byte of “
quo set 0x00 ; memory space to hold the quotient
rem set 0x02 ; memory space to hold the remainder
org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start lfsr FSR1,0xE00 ; set up software stack pointer
moviw dd_l ; pass dividend in stack
pushr WREG P
moviw dd_h e
pushr WREG 0
alloc_stk 2 ; make a hole for remainder
moviw dr_| ; pass divisor in stack
pushr WREG e |
movlw dr_h i |
pushr WREG B ‘

call divi6u,FAST ; call 16-bit unsigned divide subroutine
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forever
divl6u

loop

dealloc_stk
popr
popr
popr
popr
nop
bra
pushr
pushr
movff
movff
pushr
alloc_stk
moviw
clrf
moviw
cirf
moviw
movwf
moviw
movff
bef
movlw
ricf
moviw
ricf
moviw
ricf
movlw
ref
moviw
movff
moviw
movf
subwf
moviw
movff
moviw
movff
moviw
movf
subwfb
btfss
goto
moviw
bsf
movilw
movff
moviw
movff
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2 ; deallocate stack space
rem+1 ; retrieve the quotient (hi byte)
rem i “ (lo byte)

quo+1 ; retrieve the quotient (hi byte)
quo ;“ (lo byte)

forever

FSR2L ; save the previous frame pointer
FSR2H P

FSR1L,FSR2L ; set up frame pointer
FSR1H,FSR2H e

PRODL ; save PRODL in stack

loc_var ; allocate space for local variables
rem_hi ; clear R register to 0

PLUSW2 e

rem_lo ;
PLUSW2 0

D'16’ ; initialize loop count to 16
PRODL e

Ip_cnt ;
PRODL, PLUSW2 e

STATUS,C,A ; clear the C flag

quo_lo ; rotate (R, Q) pair to the left one place
PLUSW2,F P
quo_hi ;
PLUSW2,F Y
rem_lo ;
PLUSW2,F ¢
rem_hi ;
PLUSW2,F .

rem_lo ; get the low byte of the remainder in
PLUSW2,PRODL ; PRODL

dsr_lo ; 8et the low byte of the divisor in WREG
PLUSW2,W e

PRODL,F,A

temp

PRODL,PLUSW2 ; save the low byte of difference at temp
rem_hi

PLUSW2,PRODL

dsr_hi

PLUSW2,W

PRODL, F ; subtract the high byte

STATUS,C ; skip if carry is 1

less

quo_lo

PLUSW2,0 ; set the quotient bit to 1

rem_hi

PRODL, PLUSW2 ; place the difference in the R register
temp i

PLUSW2,PRODL e
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moviw rem_lo e

movff PRODL, PLUSW2 0

goto next
less moviw quo_lo

bef PLUSW2,0 ; set the quotient bit to 0
next moviw Ip_cnt

decfsz PLUSW2,F ; decrement the loop count and skip if zero

goto loop

dealloc_stk loc_var ; deallocate local variables

popr PRODL

popr FSR2H

popr FSR2L

retum FAST

end

A

Example 4.12

Write a subroutine to convert a 16-bit signed number to an ASCII string that represents its
equivalent decimal value.

Solution: Let p, rem, quo, and sign represent the integer to be converted, the remainder after the
divide-by-10 operation, the quotient after the divide-by-10 operation, and the sign of p, respec-
tively. The algorithm for converting a binary number into a decimal string is as follows:

Step 1

If p = 0, then store $30 and $00 in the buffer and stop.

Step 2

If p <0, then set sign to 1. Otherwise, set sign to 0.

Step 3

Divide p by 10 and leave the remainder and the quotient in rem and quo, respectively.
Step 4

Add $30 to the remainder and save it in the next available space in the buffer.

Step 5

If quo # O then p<—quo and go to Step 3.

Step 6

Push the characters in the buffer into the stack.

Step 7

If — is 1, then store the ASCII code of the minus sign as the first character in the buffer.
Step 8

Pop out all the decimal digits from the stack into the buffer.

The repeated divide-by-10 operation will derive the one’s digit first, then the ten’s digit, and so
on. Since the corresponding decimal digits are generated from one’s digit toward the most sig-
nificant digit, they will be saved in the buffer in the reverse order. Hence, the algorithm needs
to reverse it in Step 7 and Step 8.

The stack frame for this subroutine is shown in Figure 4.10. This function has only one
local variable: sign.



<+— FSR1

sign

FSROH

FSROL

-5

PRODL l+— FSR2

FSR2H
-4 -3

FSR2L

obuf_hi

obuf_lo

testd_hi

testd_lo

Figure 4.10 m Stack frame for example 4.12

The assembly that performs the conversion is as follows:
#include <p18F8720.inc>

s

; include macro definitions of pushr, pop, push_dat, alloc_stk, and dealloc_stk here

tstd_hi
tstd_lo
sign
testd_lo
testd_hi
obuf_lo
obuf_hi
minus
loc_varc
obuf

start

con_loop

equ
equ

equ

equ

equ

equ

equ

equ

equ

set

org

goto

org

retfie

org

retfie

Ifsr
push_dat
push_dat
push_dat
push_dat
call
dealloc_stk
nop

bra

0x88 ; test data high byte

0x89 ; test data low byte

3 ; stack offset for sign in bin2dec
-6 ; stack offset for test data in bin2dec
5 ;‘,

-4 ; stack offset for conversion buffer
_3 ;“

0x2D ; ASCI code of minus sign

1 ; local variable size of bin2dec routine
0x0100

0x00

start

0x08 ; high-priority interrupt vector
0x18 ; low-priority interrupt vector
FSR1,0xE00 ; set up stack pointer

tstd_lo ; pass test data in stack

tstd_hi e

low(obuf) ;e

high(obuf) M

bin2dec,FAST ; call bin2dec subroutine

4 ; clean up stack space

con_loop

= s ok ok ok ok ok ok sk sk sk ok sk ok sk ok ok sk sk ok sk ok ok sk sk 3k ok ok sk sk ok ok ok ok 3k sk sk ok sk sk ok ok ok sk 3k sk ok sk ok ok ok ok ok ok sk sk sk sk ok ok
’

; This routine converts a 16-bit binary number into a decimal number
; represented by an ASCII string. The number to be converted is
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; passed in stack.

=3k ok sk ok ok e ok sk ok s ok ok ok 3k ok sk 3k ok ok 3k 3K 3 3k ok ok 3k ok ok sk ok ok 3 K ok ok ok ok sk ok ok sk ok ok ok ok sk sk sk ok ok ok ok o ok ok ok ok ok ok ok
'

; save previous frame pointer

; set up new frame pointer

; save FSRO in stack

L u
’

.
1
.
’

; compute the magnitude when negative
; no need to complement when positive
; complement the upper byte

; add carry to testd_hi (carry may be 0)
; compute the two’s complement of data
; to be converted

; test high byte

; test low byte

; terminate the buffer with NULL character

; pass the dividend

bin2dec pushr FSR2L
pushr FSR2H
movff FSR1L,FSR2L
movff FSR1H,FSR2H
pushr PRODL
pushr FSROL
pushr FSROH
alloc_stk loc_varc
; set FSRO as the pointer to the buffer that holds the conversion result
moviw obuf_lo
movff PLUSW2,FSROL
moviw obuf_hi
movff PLUSW2,FSROH
; initialize the sign of the number to be converted to positive
movlw sign
clrf PLUSW2
; test to find out if the number is negative. If yes, compute its two’s complement.
movlw testd_hi
btfss PLUSW2,7
goto tst_zero
comf PLUSW2,F
clif PRODL,A
movlw testd_lo
negf PLUSW2
moviw testd_hi
movf PLUSW2, W
addwfc PRODL, F
moviw testd_hi
movff PRODL,PLUSW2
; change sign to 1 to indicate minus
moviw sign
incf PLUSW2, F
bra normal
; check if the number to be tested is zero
tst_zero moviw testd_hi
tstfsz PLUSW2
bra normal
moviw testd_lo
tstfsz PLUSW2
bra normal
moviw 0x30
movwf POSTINCO
cirf INDFO
goto done
; normal repeated divide-by-10 loop starts here
normal moviw testd_lo
movf PLUSW2,W
pushr WREG
moviw testd_hi
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div_Ip

; is quotient equal to 07

push_ip

; reverse the converted string

to_pop

pop_loop

done

.
’
.
’

; make room for remainder
; push 10 into the stack as divisor

G
’

; call subroutine to perform division

; deallocate the stack space (3 bytes remain)
; pop off low byte of remainder

; convert the remainder into ASCIl code

; and save it in buffer

; terminate the buffer with NULL
; clean up the stack

; push a NULL character onto the stack

; is this the NULL character

; set FSRO to point to the start of buffer

L u
’

; is the converted data negative?

; reverse string loop
; reach the end of string?

; get rid of sign

movf PLUSW2,W
pushr WREG
alloc_stk 2
push_dat Ox0A
push_dat 0
call divi6u
dealloc_stk 3
popr WREG
addlw 0x30
movwf POSTINCO
moviw -1
tstfsz PLUSW1
goto div_Ip
moviw -2
tstfsz PLUSW1
goto div_Ip
clrf INDFO
dealloc_stk 2

; set FSRO to point to the start of the buffer to reverse the string
moviw obuf_lo
movif PLUSW2,FSROL
moviw obuf_hi
movff PLUSW2,FSROH
push_dat 0
movf POSTINCO,W
bz to_pop
pushr WREG
goto push_Ip
moviw obuf_lo
movff PLUSW2, FSROL
movlw obuf_hi
movff PLUSW2,FSROH
moviw sign
movf PLUSW2 W
bz pop_loop

; add a minus sign if the number is negative
moviw minus
movwf POSTINCO
popr WREG
movwf POSTINCO
tstfsz WREG,A
goto pop_loop
popr WREG
popr FSROH
popr FSROL
popr PRODL
popr FSR2H
popr FSR2L
return FAST
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To convert a decimal digit string into a binary number, we will need a subroutine to perform
16-bit by 16-bit multiplication or even 32-bit by 32-bit multiplication, The following example
will convert the 16-bit by 16-bit unsigned multiplication program into a subroutine.

offset
l <— FSR1
7 . pd0
6 pdi
product
5 pd2
4 pd3
FSROH
FSROL
PRODH
PRODL -<+— FSR2
FSR2H
FSR2L
-3 buf_hi pointer to buffer
for saving the
-4 buf_lo product
-5 nd_hi
multiplier
-6 nd_lo
-7 md_hi
multiplicand
-8 md_lo

Figure 4.11 m Stack frame for Example 4.13
Example 4.13

Write a subroutine that computes the product of two unsigned 16-bit integers. The num-
bers to be multiplied and the pointer to the buffer for storing the product are passed in the stack.

Solution: The subroutine will save all the used registers in the stack and allocates four bytes for
local variables to hold the product. The stack frame is shown in Figure 4.11.
The function mul_16U and its testing instruction sequence are as follows:

#include <p18F8720.inc>

; include macro definitions of pushr, popr, push_dat, alloc_stk, and dealloc_stk here

M_hi equ 0x53 ; test num1 high byte
M_lo equ 0x29 ; test num1 low byte
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N_hi equ 0x84
N_lo equ 0x37
ptr_hi equ 0x01
ptr_fo equ 0x00
loc_varm equ 4
pdo equ 7
pdl equ 6
pd2 equ 5
pd3 equ 4
md_lo equ -8
md_hi equ -7
nd_lo equ -6
nd_hi equ -5
buf_lo equ -4
buf_hi equ -3
org 0x00
goto start
org 0x08
retfie
org 0x18
retfie
start Ifsr FSR1,0xE00
push_dat M_lo
push_dat M_hi
push_dat N_lo
push_dat N_hi
push_dat ptr_lo
push_dat ptr_hi
call mul_16U,FAST
dealloc_ stk 6
nop
tst_loop bra tst_loop
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; test num2 high byte
; test num2 low byte
; address of buffer to hold product

o #
’

; number of bytes used for local variable
; offset of pdo from frame pointer

; offset of pd1 from frame pointer

; offset of pd2 from frame pointer

; offset of pd3 from frame pointer

; offset of md_lo from frame pointer

; offset of md_hi from frame pointer

; offset of nd_lo from frame pointer

; offset of nd_hi from frame pointer

; high-priority interrupt vector
; low-priority interrupt vector

; set up stack pointer
; pass test data in stack

; pass buffer pointer

.
y

; call bin2dec subroutine
; clean up stack space

=3k ok sk ok ok ok sk ok sk 3k ke ok ok ok sk ok ok ok sk sk sk ok sk sk ke ke ok ok sk ok ok 3K 3Kk ok sk sk ok ok sk sk sk ok sk sk sk ok ok K ok ok ok ok sk sk ok sk ok ok ok ok ok oK R ok K
’

; This routine performs a 16-bit unsigned multiplication. Both the multiplicand

; and multiplier and address of the buffer to hold the product are passed in stack.
o ok 3k ok ok sk ok K ok s ok ok sk sk sk sk ok ok sk sk ok 3k 3k e sk o ok sk sk sk o sk ok ok sk ok sk sk sk ke ok ol ok sk ok sk ok sk ok ok ok ok sk ke ok ok ok ok ok ok ok ok ok ok b sk ok ok ok

mul_16U pushr FSR2L
pushr FSR2H
movff FSR1L, FSR2L
movff FSR1H, FSR2H
pushr PRODL
pushr PRODH
pushr FSROL
pushr FSROH
alloc_stk loc_varm

; compute md_lo x nd_lo and place in pd1..pd0
moviw md_lo
movff PLUSW2,PRODL
movlw nd_lo
movf PLUSW2,W
mulwf PRODL

; save previous frame pointer

; set up new frame pointer
; save PRODL in stack

; save PRODH in stack

; save FSRO in stack

.
’

; place md_lo in PRDOL

; place nd_lo in WREG
; compute nd_lo * md_fo



moviw
movff
moviw
movff

pdo
PRODL,PLUSW2
pdl
PRODH,PLUSW2

; compute md_hi x nd_hi and place the product in pd3..pd2

moviw
movff
movilw
movf
mulwf
moviw
movff
moviw
movff
;compute md_fo X nd_hi
movlw
movff
moviw
movf
mulwf
moviw
movf
addwf
moviw
movff
moviw
movf
addwfc
moviw
movff
clrf
moviw
movf
addwfc
moviw
movff
; compute md_hi X nd_lo
moviw
movff
moviw
movf
mulwf
moviw
movf
addwf
movlw
movff
moviw
movf
addwfc
moviw
movff
clrf
movlw

md_hi
PLUSW2,PRODL
nd_hi
PLUSW2,W
PRODL

pd2
PRODL,PLUSW2
pd3
PRODH,PLUSW?2

md_lo
PLUSW2,PRODL
nd_hi
PLUSW2,W
PRODL

pdl

PLUSW2,W
PRODL,F

pdi
PRODL,PLUSW2
pd2

PLUSW2,W
PRODH,F

pd2
PRODH,PLUSW2
PRODL

pd3

PLUSW2,W
PRODL, F

pd3
PRODL,PLUSW2

md_hi
PLUSW2,PRODL
nd_lo
PLUSW2,W
PRODL

pd1

PLUSW2,W
PRODL,F

pd1
PRODL,PLUSW?2
pd2

PLUSW2,W
PRODH,F

pd2
PRODH,PLUSW2
PRODL

pd3

; place md_hi in PRDOL

; place nd_hi in WREG
; compute nd_hi * md_hi

; add to pd1

; add to pd1

; add carry to most significant byte

.
’
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movf PLUSW2 W .
addwfc PRODL, F 0
moviw pd3 .
movff PRODL,PLUSW2 ;¢
; use FSRO as a pointer to the buffer that holds the product
moviw buf_lo
movff PLUSW2,FSROL
moviw buf_hi
movff PLUSW2,FSROH-
; save product in the buffer
popr WREG
movwf POSTINCO
popr WREG
movwf POSTINCO
popr WREG
movwf POSTINCO
popr WREG
movwf POSTINCO
popr FSROH
popr FSROL
popr PRODH
popr PRODL
popr FSR2H
popr FSR2L
return FAST
end

An application may require the user to enter a decimal number from the keyboard. The
number is represented in a decimal digit ASCII string. For example, when the user enters the
decimal number 1234, it will be represented in the ASCII code sequence 0x31 0x32 0x33 0x34.
This string must be converted to the binary number that it represents before the number can be
manipulated. Let the variables sign, error, and number represent the sign of the number,
whether error occurs, and the equivalent binary number that the ASCII string represents,
respectively. Suppose in_ptr is the pointer to the input ASCII string; then the algorithm to con-
vert an ASCII string into a binary number is as follows:

Step 1

sign « 0
error « 0
number « 0

Step 2

If the character pointed to by in_ptr is the minus sign, then

sign « 1

in_ptr e« in_ptr+1

Step 3

If the character pointed to by in_ptr is the NULL character, then go to Step 4; otherwise, if
the character is not a BCD digit (i.e., m[in_ptr] > $39 or m[in_ptr] < $30), then
error « 1;

go to Step 4;

otherwise,

number « number x 10 + mlin_ptr] - $30;

in_ptr « in_ptr + 1;

go to Step 3
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Step 4

If sign = 1 and error = 0, then
number < two’s complement of number;

otherwise, stop

The following example converts a decimal digit ASCII string into a binary number.

A

Example 4.14

Write a subroutine that converts a decimal digit string into the binary number that it repre-
sents. The string is stored in the data memory, and its starting address is passed to this function
in the FSRO register. The string may represent a positive or a negative number and is no longer
than seven bytes. Thus, the converted binary number can be accommodated in two bytes. The
converted result will be returned in PRODL and PRODH. Do not check for illegal characters.

Solution: This program needs to call the mul_16U subroutine to carry out the multiplication
required in the previously mentioned algorithm. The mul_16U subroutine requires the caller to
pass a pointer to the buffer that holds the product. A buffer will be reserved in the stack for this
purpose. The frame pointer FSR2 is also the pointer to this buffer. The stack frame of this sub-
routine is shown in Figure 4.12. This subroutine will check the sign of the decimal digit string.
If the first character is the minus sign, the converted number will be negated.

-— FSR1

dsign

buffer to hold

product

FSR2 —»

FSR2H

FSR2L

Figure 4.12 m Stack frame for Example 4.14

The assembly program is as follows:

#include <p18F8720.inc>

¥

; include macro definitions pushr, push_dat, popr, alloc_stk, and dealloc_stk here

loc_vard equ

dsign equ

dec_strg set
org
goto
org
retfie

org

5

4
0x10
0x00
start
0x08

0x18

; size of local variables for d2b
; offset of dsign from FSR2
; address of the buffer for the decimal string

; high-priority interrupt vector

; low-priority interrupt vector
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start

forever
dec2bin

con_Ip

normal

retfie
Ifsr
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
clrf
moviw
movwf
moviw
movwf
call
goto
pushr
pushr
movff
movff
alloc_stk
movlw
clrf
incf
clrf
incf
chrf
incf
cirf
moviw
clrf
movff
movlw
cpfseq
goto
moviw
incf
movf
movff
tstfsz
goto
goto .
moviw
subwf

FSR1,0xE00
high dec_strg
FSROH

low dec_strg
FSROL

0x2D
POSTINCO
0x39
POSTINCO
0x38
POSTINCO
0x38
POSTINCO
0x37
POSTINCO
INDFO

high dec_strg
FSROH

low dec_strg
FSROL
dec2bin
forever
FSR2L
FSR2H
FSR1L, FSR2L
FSR1H,FSR2H
loc_vard

0

PLUSW2
WREG,W
PLUSW2
WREG,W
PLUSW2
WREG,W
PLUSW2
dsign
PLUSW2
INDFO,PRODL
0x2D

PRODL
con_lp

dsign
PLUSW2
POSTINCO,W
POSTINCO,PRODL
PRODL,A
normal

done

0x30
PRODL,F,A

; set up stack pointer
; use FSRO as the string pointer

; terminate the string with a NULL character
; re-establish the string pointer

; call the decimal to binary conversion function

; save the current frame pointer

]
¥

; set up new frame pointer

; allocate 5 bytes for local variables

clear the buffer that holds the product

; initialize sign to positive

; get a character from string
; place minus sign in WREG
;-is the first character a minus sign?

; set sign to minus

; move pointer to next character
; reach the NULL character?

; not yet

; yes, reach NULL character

; convert to digit value

165



; push multiplicand

; push multiplier 10 into stack

L
]

; push buffer pointer

)

; multiply the current result by 10
; clean up stack space

; add the converted digit to the product

]
’

; place the upper byte of the product in WREG

’
.
’
.
’

; move down the stack pointer

; place upper byte of product in PRODH
; place lower byte of product in PRODL
; check the sign

.5
)

; find 2’s complement of the result

.
’
. u
’
L, u
]

moviw 0
movf PLUSW2,W
pushr WREG
moviw 1
movf PLUSW2,W
pushr WREG
push_dat 0x0A
push_dat 0x00
pushr FSR2L
pushr FSR2H
call mul_16U
dealloc_stk 6
movf PRODL,W
addwf INDF2,F
clrf PRODL,A
moviw 1
movf PLUSW2,W
addwfc PRODL,F
moviw 1
movff PRODL,PLUSW2
goto con_lp
; check the sign of the converted binary number before return
done dealloc_stk 3
popr PRODH
popr PRODL
moviw dsign
tstfsz PLUSW2
goto negate
goto getback
negate negf PRODL
comf PRODH
moviw 0
addwfc PRODH,F
getback popr FSR2H
popr FSR2L
return

y

; include MUL16U and its associated equ directives here.

y

end

This program does not check for illegal characters in the string. The checking of illegal

characters in the string is straightforward and hence is left for you as an exercise.

A

4.10 More Examples on Subroutine Calls

Several commonly used subroutines are developed in this section. The first one is a sorting
subroutine. Sorting is important for those applications that require searching the same set of data
repeatedly. A sorted data set allows more efficient search methods to be applied. The bubble sort
is a simple, inefficient, but widely known sorting method. Many other more efficient sorting
methods require the use of recursive subroutine calls that fall outside the scope of this book.
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The basic idea underlying the bubble sort is to go through the array or file sequentially sev-
eral iterations with each iteration placing one element in its right position. Each iteration con-
sists of comparing each element in the array or file with its successor (x[i] with x[i+1]) and
interchanging the two elements if they are not in proper order (either ascending or descending).

For an array with n elements, n — 1 comparisons are performed during the first iteration. As
more and more iterations are performed, more and more elements would be moved to their right
positions. Fewer comparisons are needed. In the worst case, n — 1 iterations are needed, and only
one comparison is made during the last iteration.

The bubble sort can be made more efficient by keeping track of whether swap operations
have been performed. If no swap is made in an iteration, then the array is already in sorted order,
and the process should be terminated. The logic flow of the bubble sort algorithm is illustrated

in Figure 4.13.

iteration < N — 1

in_order « 1
inner « iteration
i« 0

array[i] > array[i+1]?

swap arrayli] & array[i+1]
in_order « 0O

A

inner « inner — 1
i—i+1

yes
no

iteration « iteraetion — 1

e

)

Figure 4.13 m Logic flow of bubble sort
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Write a subroutine to implement the bubble sort algorithm and a sequence of instructions
along with a set of test data for testing this subroutine. Use an array in data memory that con-
sists of n 8-bit unsigned integers for testing purpose.

Solution: The subroutine has the following local variables:
® in_order—{flag to indicate whether the array is in order after an iteration

= inner—number of comparisons remained to be performed in an iteration

» jteration—number of iterations remained to be performed

The caller of this subroutine will pass the array base address and the array count in the
stack. The stack frame of this subroutine is shown in Figure 4.14. In many PIC18-based sys-
tems, program memory is in ROM rather than in RAM. This example will declare test data in
the program memory and use a program loop to copy it to data memory (in SRAM) so that the

bubble sort subroutine can be tested.

~—— [SR1

T iteration

1 mnner

4 in_order

2 PRODH

PRODL

~+— FSR2

FSR2H

-4 FSR2L

ar_cnt

arbas_hi

arbas_lo

Figure 4.14 m Stack frrame for Example 4.16

The bubble sort subroutine and its testing instruction sequence are as follows:

#include <p18F8720.inc>

’

; include macro definitions pushr, push_dat, popr, alloc_stk, and dealloc_stk here

s

NN equ D30’ ; array count

loc_varb equ 3 ; number of bytes of local variables

arbas equ 0x0100 ; array base address

Ip_cnt set 0 ; use data memory location O for loop count

in_order equ 2

; offset of local variable from frame pointer
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inner
iteration
ar_cnt
arbas_hi
arbas_lo

start

equ
equ
equ
equ
equ
org
goto
org
retfie
org
retfie
Ifsr
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf
moviw
movwf

0x00
start
0x08 ; high-priority interrupt vector

0x18 ; low-priority interrupt vector

FSR1,0xE00 ; set up stack pointer

high arbas ; use FSRO as the pointer to the array
FSROH,A ; to be sorted

low arbas .

FSROL,A e

upper xarr ; set up table pointer to point to
TBLPTRU,A ; the array in program memory

high xarr e

TBLPTRH,A .

low xarr ;
TBLPTRL,A e
NN

Ip_cnt

+ ok 3k ok ok sk sk ok sk sk ok ok ok sk 3k sk sk ok ok ok ke ok ok sk sk 3k ok sk sk ok sk sk ok ok sk ok ok ok sk ok K ok ok sk sk sk sk ok ok 3 sk ok ok sk sk ok ok sk sk sk sk ok ok ok ok sk ok ok sk ok ok ok ok sk ok ok
1

; copy an array from program memory to data memory to test the bubble sort subroutine.
3k sk ok e sk sk ok ok vk sk sk Ak sk ok sk sk sk ok ke ol 3 sk sk ok ok ok ok ok ok sk o sk sk sk ok K ok ok sk ok sk ok ok ok ok ok ke ok sk sk ok ok sk ok sk sk o ok ok 3k sk ok ok ok sk ok 3k ok ok ok ok ok ok ok ok
1

copy_lp

forever

third*+
movff
decfsz
bra
movlw
pushr
moviw
pushr
push_dat
call
goto

; read a byte into the table latch
TABLAT,POSTINCO ; copy one byte
lp_cnt,F,A
copy_lp
low arbas ; push array base address into stack
WREG ;e
high arbas ¢
WREG 0
NN ; push array count
bubble,FAST ; call the decimal to binary conversion function
forever

=3 ke ok ok ok ok ok ok ok ok ol ok ok e sk ok ok ok 3k e ok sk sk ok ok ok ok ok sk ok ok ok sk e ke ok sk sk ok ok ok ok skl ok ok ok sk ok ko sk sk sk sk sk sk sk sk k k ok

; This function implement bubble sort. The array base address and array

; count are passed to this function via the stack.
w3k ok ok 3k ok ok ok ok sk ok ok ok sk ok sk ok sk sk ok ok Sk ok ok sk sk ok 3k ok Ok ok ok ok sk sk sk o Sk ok ok sk sk ok ok ok 3K ok sk ok ok ok ok sk ok s ok ok oK ok ok ok sk sk ok
;

bubble

pushr
pushr
movff
movff
pushr
pushr
alloc_stk

FSR2L ; save the current frame pointer
FSR2H Ve

FSR1L,FSR2L ; set up new frame pointer
FSR1H,FSR2H 0

PRODL ; save PRODL in stack

PRODH ; save PRODH in stack

loc_varb
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ploop

cloop

looptst

nexti

done

xarr

moviw
maovff
decf
moviw
movff
moviw
clrf
moviw
movff
moviw
movff
moviw
movff
moviw
movff
movff
moviw
movf
cpfsgt
goto
movwf
movlw
movff
movff
moviw
bsf
movf
moviw
decfsz
goto
moviw
tstfsz
goto
goto
moviw
decfsz
goto
dealloc_stk
popr
popr
popr
popr
return
db

db

db
end

ar_cnt
PLUSW2,PRODL
PRODL,F,A
iteration
PRODL,PLUSW2
in_order
PLUSW2
iteration
PLUSW2,PRODL
inner
PRODL,PLUSW2
arbas_lo
PLUSW2,FSROL
arbas_hi
PLUSW2,FSROH
INDFO,PRODL

1

PLUSWO,W
PRODL,A
looptst

PRODH

1
PRODL,PLUSWO
PRODH,INDFO
in_order
PLUSW2,0
POSTINCO,W
inner
PLUSW2,F
cloop

in_order
PLUSW?2

nexti

done

iteration
PLUSW2 F
ploop

loc_varb
PRODH

PRODL

FSR2H

FSR2L

FAST

; set iteration to array count - 1

; set in_order flag to true (0)

; initialize inner loop count
; use FSRO as the array pointer

; place art]i] in PRODL

; place arr[i+1] in WREG
; swap arnri] with ani+1]

; set the in_order flag to false (1)

. H
'

; increment array pointer
; decrement inner loop count and skip if it
; has been decremented to zero

; Is the array in order?
; not yet
; yes, return.

0x56,0x1F,0x01,0x08,0x11,0x47,0x21,0x20,0x30,0x07
0x19,0x18,0x17,0x16,0x15,0x14,0x13,0x12,0x29,0x28
0x27,0x26,0x25,0x24,0x23,0x22,0x06,0x05,0x04,0x03
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4.10.1 Square Root Computation

The computation of the square root of a number is complicated, and hence no commercial
8- or 16-bit MCU provides an instruction for computing the square root. The square root can be
computed by using the successive approximation method. This method has been widely used
to perform analog-to-digital conversion. Most of the 8-bit or 16-bit MCUs use this method to
implement their A/D converters.

The square root of a 2n-bit number would be an n-bit number. Let SAR be an n-bit register
and Q be a 2n-bit number that we want to find its square root. The algorithm for finding the
square root of Q is illustrated in Figure 4.15.

The algorithm illustrated in Figure 4.15 will always compute an approximate integer square
root smaller than or equal to the actual one. The better approximate square root could be the
value in SAR or [SAR]+1. By comparing Q — [SAR*SAR] and {[SAR] + 1)2 - Q, the better approx-
imate square root can be found. The following example incorporates this consideration.

SAR[N-1, ..., 0] < 0

ie~n-1

SAR(i] « 1

yes
SAR[i] « 0

no

Figure 4.15 m Successive approximation method for computing the square root of a 2n-bit number Q

Write an assembly routine to implement the successive approximation method for com-
puting the square root of a 16-bit integer. The 16-bit integer will be pushed into the stack. The
square root is returned in PRODL.
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Solution: The stack frame of the subroutine is shown in Figure 4.16. The subroutine find_sqr
and its calling instruction sequence are as follows:

#include <p18F8720.inc>

H

; include macro definitions pushr, push_dat, popr, alloc_stk, and dealloc_stk here

testd_hi
testd_lo
loc_vars
Q_hi
Q_lo
sar
mask
Ip_cnt
sq_root

start

forever
find_sqr

equ
equ

equ

equ

equ

equ

equ

equ

set

org

goto

org

retfie

org

retfie

Ifsr
push_dat
push_dat
call
movff
dealloc_stk
goto
pushr
pushr
movff
movff
alloc_stk

0x41
Ox2E

0x00
0x00
start
0x08

0x18

FSR1,0xEQ0
testd_lo
testd_hi
find_sqr
PRODL,sq_root
2

forever

FSR2L

FSR2H
FSR1L,FSR2L
FSR1H,FSR2H
loc_vars

; data to be tested

LK
y

; number of bytes for local variable
; offsets of Q from frame pointer

; memoty location to save square root
; reset vector

; high priority interrupt vector
; low priority interrupt vector

; set stack pointer to OxE0O
; pass test data in stack

. :
s !

; call the square root routine
; save the square root in memory

; save caller’s frame pointer
o

; set up new frame pointer

; allocate local variables

-— FSR1

Ip_cnt

mask

sar

-— FSR2

FSR2H

L FSR2L

Q_hi

Q_lo

Figure 4.16 m Stack frame for example 4.17
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moviw 8
movwf PRODL,A
moviw Ip_cnt
movff PRODL,PLUSW2
movlw 0x80
movwf PRODL
moviw mask
movff PRODL,PLUSW2
clrf INDF2
loop moviw mask
movf PLUSW2,W
iorwf INDF2,W
mulwf WREG,A
moviw Q_lo
movf PLUSW2,W
subwf PRODL,F
moviw Q_hi
movf PLUSW2,W
subwfb PRODH,F
btfsc STATUS,C
goto nexthit
moviw mask
movf PLUSW2,W
iorwf INDF2,F
nextbit moviw Ip_cnt
decf PLUSW2,F
bz done
bef STATUS,C,A
moviw mask
rrcf PLUSWZ2,F
goto loop

173

: initialize loop count to 8

; initialize SAR to O

; place mask in WREG

: set the ith bit of SAR

; compute SAR*SAR

; compute SAR*SAR - Q

; skip if Q > SAR*SAR

; the guess is right, so
; set bit i of SAR

LU
’

: decrement the loop count

L u
)

sitis done if Ip_cnt=0
; clear the C flag

; shift the mask to the right

-*****************************************************************************

: Before return, find out if SAR*SAR or (SAR+1)**2 is closer to Q and

: return SAR or SAR+1 accordingly.

-*****************************************************************************
¥

done movf INDF2,W
mulwf WREG,A
moviw Q_lo
movf PLUSW2,W
subwf PRODL,F,A
moviw Q_hi
movf PLUSW2,W
subwfb PRODH,F,A
comf PRODH,F,A
negf PRODL,A
moviw 0
addwfc PRODH,F,A
moviw Ip_cnt
movff PRODH,PLUSW2
moviw mask

movff PRODL,PLUSW2

; get the estimated square root
; compute SAR*SAR
; compute SAR*SAR - Q (is < 0)

: compute the magnitude of
: | SAR*SAR - Q|

5
L u

; COpy |SAR*SAR - Q| into Ip_cnt
; and mask

o u
]
LU
'
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movf INDF2,W ; compute SAR+1

incf WREG,W,A -

mulwf WREG,A ; compute (SAR+1)**2

moviw Q. lo ; compute (SAR+1)**2 - Q

movf PLUSW2,W ; and leave the difference in

subwf PRODL,F,A ; PRODH:PRODL

moviw Q_hi 0

movf PLUSW2,W .

subwfb PRODH,F,A e

movlw mask ; compare [Q-(SAR*SAR)] with

movf PLUSW2,W ; (SAR+1)**2 - Q

subwf PRODL,F.A D

moviw p_cnt ;-

movf PLUSW2,W P

subwfb PRODH,F,A M

bifsc STATUS,C ;"

goto sel_SAR e

incf INDF2,F ; increment SAR by 1
sel_SAR dealloc_stk 2 ; remove Ip_cnt and mask from stack

popr PRODL ; place SAR in PRODL

popr FSR2H

popr FRS2L

return

end

The subroutine for finding the square root of a 32-bit number is similar and hence is left for
you as an exercise.

4.10.2 Finding Prime Numbers

Finding prime numbers would require the MCU to perform a lot of divide operations. One
could use the square root of the number under test to set the limit of number of divide opera-
tions that need to be performed.

Example 4.17

Write a subroutine to test whether a 16-bit unsigned integer is a prime number. The inte-
ger to be tested is pushed into the stack, and the test result is returned in the WREG register, If
the number is a prime number, the subroutine returns a 1. Otherwise, a 0 is returned.

Solution: The most efficient algorithm for testing whether a number is a prime number is to
divide the given number by all the prime numbers smaller or equal to the square root of the
given number. If the given number cannot be divided by any of these testing numbers, then it
is a prime number. Since we don’t have a list of prime numbers at hand, we will be satisfied by
dividing the given number from 2 to the square root of the given number. As long as a number
cannot be divided by all integers from 2 to its integral square root, it is a prime number.

The stack frame for the prime_test subroutine is shown in Figure 4.17. This subroutine will
use the local variable i to test divide the given number. This subroutine calls the find_sqr sub-
routine to compute the square root of the given number and use it as the upper limit of i. This
upper limit is stored in the stack slot labeled ilimit. The stack slots num_hi and num_lo are
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-— FSR1
ilimit
i -— FSR2
FSR2H
FSR2L
num_hi
num_lo

Figure 4.17 m Stack frame for example 4.18

used to hold the upper byte and the lower byte of the number to be tested. The subroutine
divl6u is invoked to carry out the division.
The prime_test subroutine and its testing instruction sequence are as follows:

#include <p18F8720.inc>

; include macro definitions pushr, push_dat, popr, alloc_stk, and dealloc_stk here

;
loc_varp
ilimit
num_hi
num_lo

start

forever
prime_tst

equ
equ

equ

equ

org

goto

org

retfie

org

retfie

lfsr
push_dat
push_dat
call

nop
dealloc_stk
bra

pushr
pushr
movff
movff
alloc_stk
moviw
movf
pushr
moviw
movf

-3
-4
0x00
start
0x08

0x18

FSR1,0xE00
pdat_lo
pdat_hi
prime_tst

2

forever

FSR2L

FSR2H
FSR1L, FSR2L
FSR1H,FSR2H
loc_varp
num_fo
PLUSW2,W
WREG

num_hi
PLUSW2,W

’
y
’

’

)

local variable size for prime_test

offset of ilimit from FSR2

offset of test number high byte from FSR2
offset of test number low byte from FSR2

set up stack pointer

set up frame pointer

’
'
’

1

allocate local variables
get a copy of the low byte
of the incoming number

get a copy of the high byte
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loop

inloop

nexti

not_prime

isprime

]

pushr

call
dealloc_stk
moviw
movff
moviw
movwf
moviw
movf
cpfsgt

goto

goto

moviw
movf

pushr
moviw
movf

pushr
alloc_stk
movf

pushr
push_dat
call
dealloc_stk
moviw
tstfsz

goto

goto

incf
dealloc_stk
goto
dealloc_stk

popr
popr
moviw
return
dealloc_stk
popr

popr
movlw
return

WREG
find_sqr

2

ilimit
PRODL, PLUSW2
2

INDF2
ilimit
PLUSW2,W
INDF2
inloop
isprime
num_lo
PLUSW2,W
WREG
num_hi
PLUSW2,W
WREG

2

INDF2,W
WREG

0

divi6u

3

-1
PLUSW1
nexti
not_prime
INDF2,F

3

loop
2-+oc_varp

FSR2H
FSR2L
0

loc_varp
FSR2H
FSR2L

1

; compute the upper limit for prime test
; clean up the pushed data from stack
; set up the upper limit for prime

; test

; initialize i to 2
; place the ilimit in WREG

;

;s i > ilimit?

; itis prime if i > ilimit
; push the number to be test for prime
; onto the stack

; allocate two bytes for R register

; get the value of i

; push i into the stack

; push O as the upper byte of, divisor

; remove the pushed top three bytes

; the low byte of the remainder is one

; below the byte pointed to by FSR1

; remainder is not zero, test next i

; deallocate the pushed remaining 3 bytes
; deallocate the pushed remaining 3 bytes
; and two bytes of local variables

; return a 0 to indicate non_prime

; deallocate local variables

; include subroutine find_sqr and its associated equ directives here

’

¥

; include subroutine divi6u and its associated equ directives here

¥

end
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4.11 Summaty

Many applications require the software to perform signed and unsigned multiprecision
multiplication and division. These operations must be implemented as programs. To be
reusable in other applications, these programs should be written as subroutines.

A subroutine is a sequence of instructions that can be called from many different places in
a program. There are three issues involved in the subroutine call: parameter passing, result
returning, and local variables allocation. For the PIC18 MCU, parameters can be passed in the
stack or global memory, and the result can also be returned in the stack or global memory.

To solve a complicated problem, software developers should follow the structured program-
ming methodology. In the structured programming approach, the software developer begins with
a simple main program whose steps clearly outline the logical flow of the algorithm and then
assigns the execution details to subroutines. Subroutines may also call other subroutines. The
structured programming methodology makes a complicated problem more manageable.

The PIC18 MCU provides the call n and reall n instructions for making the subroutine call.
The subroutine will use the return instruction to transfer the program control back to the caller.

The stack data structure is important in making subroutine calls. The PIC18 MCU has a
31-word by 21-bit return address stack for saving returning addresses. The return address stack
can be accessed by executing the push and pop instructions. The PIC18 MCU does not have a
stack for passing incoming parameters and returning results. However, the user can use one of
the FSR registers as the stack pointer and implement the data stack in data memory. In this
text, we use the FSR1 register as the data stack pointer. During the lifetime of a subroutine, the
stack pointer might change, which makes the access of variables in the data stack tricky. To
solve this problem, the frame pointer is added. The frame pointer points to a fixed location in
the data stack and is never changed during the lifetime of a subroutine. The FSR2 register is
used as the frame pointer in this text.

The data stack grows from a low address toward higher addresses. The data structure that
consists of incoming parameters, frame pointer, saved registers, and local variables is called a
stack frame. The frame pointer points to the memory slot immediately above the saved frame
pointer. Therefore, incoming parameters have negative offsets relative to the frame pointer,
whereas local variables have positive offsets relative to the frame pointer.

To write a subroutine, the user must lay out the exact location of each local variable and
each incoming parameter. The offsets (relative to the byte pointed to by the frame pointer) of
them are defined by using the equate directive. Using the equate directive allows the local vari-
ables and incoming parameters to be added or moved around without changing your subroutine.
The stack frame for each subroutine should be clearly laid out before the subroutine is written.
The subroutine examples in this chapter follow this convention. Following this convention will
make the subroutine more reusable.

Most of the subroutine examples in this chapter pass parameters in the stack. They return
the result in registers when only one or two bytes are needed. Otherwise, they return the result
in the stack. In this situation, the caller of the subroutine will need to allocate space in the stack
before making the subroutine call.

4.12 Exercises

F4.1 Write a subroutine that computes the product of two signed 8-bit numbers. The incoming
parameters are passed in the data stack, and the result is also returned in the stack.
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E4.2 Write a subroutine to compute the product of two 16-bit signed numbers. Pass the multi-
plier and the multiplicand in the stack and also return the product in the stack.

E4.3 What will be the contents of the top 10 bytes of the stack after the execution of the fol-
lowing instructions? Enter xx in the stack slot that has an unknown value.

org 0x20
Ifsr FSR1,0xE00
Ifsr FSR2, OxEQQ
push_dat 0x55
push_dat 0x20
call sub_abc
sub_abc pushr FSR2L
pushr FSR2H
pushr PRODL
pushr PRODH
alloc_stk 4

E4.4 What will be the contents of the top 10 bytes of the stack after the execution of the fol-
lowing instructions? Enter xx in the stack slot that has an unknown value.

org 0x20

Ifsr FSR1,0xE0Q
Ifsr FSR2,0xE00
movlw 0x30

pushr WREG

push_dat 0x20
push_dat 0x39

call find_lem
find_lem  pushr FSR2L
pushr FSR2H
pushr PRODL
alloc_stk 4

E4.5 Write a subroutine to create a delay of a multiple of 1 ms assuming that the frequency of
the crystal oscillator is 32 MHz. The number of milliseconds to be delayed is passed in the
PRODL register.

E4.6 Write a subroutine that will divide a 32-bit unsigned number into another 32-bit unsigned
number. Pass the divisor and dividend in the stack and also return the remainder and quotient
in the stack.

E4.7 Write a subroutine that will divide a 16-bit signed number into another 16-bit signed num-
ber. Pass the divisor and dividend in the stack and also return the remainder and quotient in the
stack.

E4.8 Write a subroutine that will divide a 32-bit signed number into another 32-bit signed num-
ber. Pass the divisor and dividend in the stack and also return the remainder and quotient in the
stack.

E4.9 Write a subroutine that will convert all the lowercase letters in a string into uppercase
without changing other nonalphabetic characters. The starting address of the string is passed in
FSRO, and the string is stored in data memory.
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F4.10 Write a subroutine to convert all the uppercase letters in a string into lowercase without
changing other nonalphabetic characters. The starting address of the string is passed in FSRO,
and the string is stored in data memory.

E4.11 Write a subroutine that will return a 16-bit random number to the caller in the PRODL
and PRODH register pair. This subroutine would return different number each time it is called.
E4.12 Write a subroutine that will compute the greatest common divisor (GCD) of two 16-bit
integers passed in the stack and return the GCD in the PRODL and PRODH register pair.
E4.13 Write a subroutine that will convert a 32-bit signed number to an ASCII string that rep-
resents its equivalent decimal value. The number to be converted and the starting address of the
buffer to hold the resultant string is passed in the stack.

F4.14 Write a subroutine that converts the temperature in Fahrenheit scale to Celsius scale or
vise versa. The temperature value to be converted is passed in the PRODH register, whereas the
intended conversion {from °F to °C (0} or °C to °F (1)} is passed in the PRODL register. The con-
verted result is returned in the PRODL register.

E4.15 Write a subroutine to convert a 16-bit binary number into four hex digits (in ASCII code).
The number to be converted is passed in the stack, and the converted result is also returned in
the stack.

E4.16 Write a subroutine that will compute the least common multiple (LCM) of two 16-bit
integers passed in the stack and return the LCM in the stack as a 4-byte number.

F4.17 Write a subroutine to count the number of characters and words contained in a string ter-
minated by a NULL character. The string is stored in the program memory, and the starting
address (three bytes) of the string is passed to this subroutine in TBLPTR. This routine returns
the character count and word count in PRODL and PRODH, respectively.

E4.18 Write a subroutine to compute the square root of a 24-bit integer and also write a pro-
gram to test it. The 24-bit number is passed in the stack, and the square root is returned in the
PRODH:PRODL register pair. The upper four bits of PRODH should be all Os.

E4.19 Write a subroutine to compute the square root of a 32-bit integer and also write a pro-
gram to test it. The 32-bit number is passed in the stack, and the square root is returned in the
PRODH:PRODL register pair.

E4.20 Write a subroutine to find the prime numbers between n1 and n2 and store the result in
a buffer specified by the caller of this routine. Both n1 and n2 are 16-bit integers and are passed
to this routine in the stack. The pointer to the data memory buffer to hold the prime numbers
is also passed in the stack. The caller will push nl, n2, and the pointer to the buffer onto the
stack in that order. Write a program to test this subroutine.

E4.21 Write a subroutine to test if a 32-bit integer is prime. The number to be tested is passed
in the stack. If the number-under-test is prime, then this subroutine returns a 1 in the WREG
register. Otherwise, it returns a 0.

E4.22 Modify the subroutine in Example 4.14 so that it checks invalid character in the input
string and returns an indicator in WREG to the caller.

4.13 Lab Exercises and Assignments

L4.1 Write a subroutine to count the number of characters and words contained in a string. The
string is stored in the program memory, and its starting address is passed in TBLPTR. The sub-
routine will return the character count and word count in PRODL and PRODH, respectively.
Use the MPLAB IDE to enter, compile, and simulate the program.
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L4.2 Write a subroutine to search for a word from a string. The starting addresses of the word
to be looked for and the string are passed in the stack. The string is stored in the program
memory, whereas the word to be looked for is stored in data memory. Write a test program to
prepare the word and the string and then call this subroutine. The algorithm for searching a
word is shown in Figure L4.1. The variables used in Figure L4.1 are the following:

str_ptr string pointer

wd_ptr word pointer

match_flag  flag to indicate search result
m[str_ptr]  the character pointed to by str_ptr
m|wd_ptr]  the character pointed to by wd_str

L4.3 Write a subroutine to implement selection sort and write a program to test it. The selec-
tion sort method works like this:

1. Suppose we have an array of integer values. Search through the array, find the
largest value, and exchange it with the value stored in the first array element
position. Next, find the second-largest value in the array and exchange it with the
value stored in the second array location. Repeat the same process until the end of
the array is reached.

2. Store the array in data memory. The caller of this subroutine passes the starting
address of the array and the array count in the software stack.

Before testing the subroutine, one needs to prepare an array in data memory. This can be done
by declaring an array in program memory and copying it into the data memory in the caller.
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CR, or LF?
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str_ptr < str_ptr + 1

1

—0

Figure L4.1 m Algorithm for searching a word from a string
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5.2 Introduction to C

This tutorial is not intended to provide a complete coverage of the C language. Instead, it
provides only a summary of those C language constructs that are used in this book. It should be
adequate to deal with the basic PIC18 interface programming,.

C language is gradually replacing assembly language in many embedded applications
because it has several advantages over assembly language. The most important one is that it
allows us to work on the program logic at a level higher than the assembly language; thus, pro-
gramming productivity is greatly improved.

A C program, whatever its size is, consists of functions and variables. A function contains
statements that specify the operations to be performed. The types of statements in a function
could be declaration, assignment, function call, control, and null. A variable stores a value to
be used during the computation. The main() function is required in every C program and is the
one to which control is passed when the program is executed. A simple C program is as follows:

1. #include <stdio.h> /*includes information about standard library*/

2. /* this is where program execution begins */

3. main {void) /*defines a function named main that receives */

/*1n0 argument values*/

4. { /*statements of main are enclosed in braces*/

5. inta, b, ¢; /*defines three variables of type int*/

6. a=3; /*assigns 3 to variable a*/

7. b=5; [*assigns 5 to variable b*/

8. c=a+bh; /*adds a and b together and assigns it to ¢*/

9. printf(“ a+b = %d\n”, c); /*calls library function printf to print the result*/
10. return 0, [*returns O to the caller of main*/
11. } /*the end of main function*/

The first line of the program,
#include <stdio.h>

causes the file stdio.h to be included in your program. This line appears at the beginning of
many C programs. The header file stdio.h contains the prototype declarations of all I/O routines
that can be called by the user program and constant declarations that can be used by the user
program. The C language requires a function prototype be declared before that function can be
called if a function is not defined when it is called. The inclusion of the file stdio.h allows the
function printf{. . .) to be invoked in the program.

The second line is a2 comment. A comment explains what will be performed and will be
ignored by the compiler. A comment in C language starts with /* and ends with */. Everything
in between is ignored. Comments provide documentation to our code and enhance readability.
Comments affect only the size of text file and do not increase the size of executable code. Many
commercial C compilers also allow us to use two slashes {//) for commenting out a single line.
The third line main() is where program execution begins. The opening brace on the fourth line
marks the start of the main() function’s code. Every C program must have one and only one
main() function. Program execution is also ended with the main function. The fifth line declares
3 integer variables a, b, and ¢. In C, all variables must be declared before they can be used.

The sixth line assigns 3 to the variable a. The seventh line assigns 5 to the variable b. The
eighth line computes the sum of variables a and b and assigns it to the variable ¢. Assignment
statements are major components in the C program.
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The ninth line calls the library function printf to print the stringa + b = followed by the
value of ¢ and move the cursor to the beginning of the next line. The tenth line returns a 0 to
the caller of main(). The closing brace in the eleventh line ends the main() function.

5.3 Types, Operators, and Expressions

Variables and constants are the basic objects manipulated in a program. Variables must be
declared before they can be used. A variable declaration must include the name and the type
of the variable and may optionally provide its initial value. A variable name may start with a
letter (A through Z or a through z) or underscore character followed by zero or more letters,
digits, or underscore characters. Variable names cannot contain arithmetic signs, dots, apos-
trophes, C keywords, or special symbols, such as @, #, or 2. Adding the underscore character {_}
may sometimes improve the readability of long variables. Do not begin variable names with
underscore, however, since library routines often use such names. Upper- and lowercase letters
are distinct.

5.3.1 Data Types

There are only a few basic data types in C: void, char, int, float, and double. A variable
of type void represents nothing. The type void is used most commonly with functions. A
variable of type char can hold a single byte of data. A variable of type int is an integer, which
is normally the natural size for a particular machine. For most commetcial PIC18 C compil-
ers, type integer has the length of 16 bits. The type float refers to a 32-bit, single-precision,
floating-point number. The type double represents a 64-bit double-precision, floating-point
number. In addition, there are a number of qualifiers that can be applied to these basic types.
Short and long apply to integers. These two qualifiers will modify the lengths of integers.
The modifier short does not change the length of an integer. The modifier long doubles a 16-
bit integer to 32-bit. Both the type float and type double are 32 bits in length for the PIC18
C compiler.

5.3.2 Variable Declarations

All variables must be declared before their use. A declaration specifies a type and contains
a list of one or more variables of that type, as in

inti, j, k;
char cx, ¢y,
A variable may also be initialized when it is declared, as in
inti=0;
char echo =‘y’; /* the ASCII code of letter y is assigned to variable echo. */

5.3.3 Constants

There are four kinds of constants: integers, characters, floating-point numbers, and strings.
A character constant is an integer, written as one character within single quotes, such as ‘'x’. A
character constant is represented by the ASCII code of the character. A string constant is a
sequence of zero or more characters surrounded by double quotes, as in

“PIC 18F8680 is a microcontroller made by Microchip”

or

/* an empty string */
Each individual character in the string is represented by its ASCII code.
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An integer constant such as 3241 is an int. A long constant is written with a terminal 1 (ell}
or L, as in 44332211L. The following constant characters are predefined in C language:

\a alert (bell) character A\ backslash

\b backspace \? question mark

\f formfeed \ single quote

\n newline \ double quote

\r carriage return \ooo octal number

\t horizontal tab \xhh hexadecimal number

\v vertical tab

As in assembly language, a number in C can be specified in different bases. The method to
specify the base of a number is to add a prefix to the number. The prefixes for different bases are
the following

base prefix example

decimal none 1357

octal 0 04723 ; preceded by a zero
hexadecimal Ox 0x2A

5.3.4 Arithmetic Operators
There are seven arithmetic operators:
+  add and unary plus
-~ subtract and unary minus
* multiply
/ divide
%  modulus (or remainder)
++ increment
—  decrement
The expression
a%b
produces the remainder when a is divided by b. The % operator cannot be applied to float or

double. The ++ operator adds 1 to the operand, and the — - operator subtracts 1 from the operand.,
The / operator truncates the quotient to integer when both operands are integers.

5.3.5 Bitwise Operators

C provides six operators for bit manipulations; these may be applied only to integral
operands, that is, char, short, int, and long, whether signed or unsigned:

& AND
|  OR

A XOR
-~ NOT

>> right shift
<< left shift
The & operator is often used to clear one or more bits to zero. For example, the statement
PORTC = PORTC & OxBD; /* PORTC is 8 bits */
clears bits 6 and 1 of PORTC to 0.
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The | operator is often used to set one or more bits to 1. For example, the statement
PORTB = PORTB | 0x40;  /* PORTB is 8 bits */

sets the bit 6 of PORTB to 1.
The XOR operator can be used to toggle a bit. For example, the statement

abc = abc ~ OxFO; /* abc is of type char */

toggles the upper four bits of the variable abe.
The >> operator shifts the involved operand to the right for the specified number of places.
For example,

xyz = abc >> 3;

shifts the variable abe to the right three places and assigns it to the variable xyz.
The << operator shifts the involved operand to the left for the specified number of places.
For example,

XYZ = Xyz << 4;

shifts the variable xyz to the left four places.
The assignment operator = is often combined with the operator. For example,

PORTD = PORTD & OxBD;
can be rewritten as
PORTD &= OxBD;
The statement
PORTB = PORTB | 0x40;
can be rewritten as
PORTB |= 0x40;

5.3.6 Relational and Logical Operators

Relational operators are used in expressions to compare the values of two operands. If the
result of the comparison is true, then the value of the expression is 1. Otherwise, the value of
the expression is 0. Here are the relational and logical operators:

== equal to (two “=" characters)
I= not equal to

> greater than

>=  greater than or equal to

< less than

<= less than or equal to

&& and

Il or
! not {one’s complement|

Here are some examples of relational and logical operators:
if (I{ADCTL & 0x80))

statementy; /* if bit 7 is O, then execute statement; */
if i>08&&i<10)

statement,; /* if 0 <i< 10 then execute statement, */
if (al == a2)

statements /* if al equals a2 then execute statements */
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5.3.7 Precedence of Operators

Precedence refers to the order in which operators are processed. The C language maintains
a precedence for all operators. The precedence for all operators is shown in Table 5.1. Operators
at the same level are evaluated from left to right. A few examples that illustrate the precedence
of operators are listed in Table 5.2.

Precedence Operator Associativity

Highest Orll-. left to right
A I~ 4+ -- + - * & (type) sizeof right to left
*/ % left to right
+- left to right
<< >> left to right
<L=>>= left to right
=== left to right
& left to right
A left to right
‘ left to right
&& left to right
‘ | left to right
? right to left
=== *e f= O &= A= | = g=>>m fight to left
' left to right

Lowest

Table 5.1 m Table of precedence of operators

Expression Result Note

15-2*7 1 * has higher precedence than +
(13-4)*5 45

(0x20 | 0x01)1= 0x01 1

0x20 | 0x01 != 0x01 0x20 1= has higher precedence than I
1l<<3+1 16 + has higher precedence than <<
(1<<3)+1 g

Table 5.2 m Exampies of operator precedence

5.4 Control Flow

The control-flow statements specify the order in which computations are performed. In
C language, the semicolon is a statement terminator. Braces { and } are used to group declara-
tions and statements together into a compound statement, or block, so that they are syntacti-
cally equivalent to a single statement. A compound statement is not terminated by a semicolon.

5.4.1 If Statement

The if statement is a conditional statement. The statement associated with the if statement
is executed based on the outcome of a condition. If the condition evaluates to nonzero, the state-
ment is executed. Otherwise, it is skipped.
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The syntax of the if statement is as follows:

if (expression)
statement;

Here is an example of the if statement:

if (a>b)
sum += 2;

The value of sum will be incremented by 2 if the viable a is greater than the variable b.

5.4.2 If-Else Statement

The if-else statement handles conditions where a program requires one statement to be
executed if a condition is nonzero and a different statement to be executed if the condition
is zero.

The syntax of an if-else statement is

if (expression)

statement,
else
statement,

The expression is evaluated; if it is true (nonzero), statement,; is executed. If it is false, state-
ment, is executed. Here is an example of the if-else statement:

if(al=0)

r=b;
else
r=c

The if-else statement can be replaced by the ?: operator. The statement

r=@!=0)?b:g

is equivalent to the previous if statement.

5.4.3 Multiway Conditional Statement

A multiway decision can be expressed as a cascaded series of if-else statements. Such series
looks like this:

if (expressiony)
statement;
else if (expression,)
statement,
else if (expressions)
statements
else
statement,
Here is an example of a three-way decision:

if (abc > 0) return 5;
else if (abc == Q) return 0;
else return -5;
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5.4.4 Switch Statement

The switch statement is a multiway decision based on the value of a control expression.
The syntax of the switch statement is

switch (expression) {

case const_expry:
statements;
break;

case const_expro:
statements;
break;

default;
statement,;

}

As an example, consider the following program fragment:

switch (i) {

case 1: printf(“*");
break;

case 2: printf(“**");
break;

case 3; printf(“***");
break;

case 4: printf(“****");
break;

Case b; printf(“ ****").

default:
printf(“\n");

}

The number of * characters printed is equal to the value of i. The break keyword forces the
program flow to drop out of the switch statement so that only the statements under the corre-
sponding case label are executed. If any break statement is missing, then all the statements from
that case label until the next break statement within the same switch statement will be executed.

5.4.5 For-Loop Statement
The syntax of a for-loop statement is
for (exprl; expr2; expr3)
statement;
where, exprl and expr3 are assignments or function calls and expr2 is a relational expression.
For example, the following for loop computes the sum of the squares of integers from 1 to 9:
sum = 0;
for (i=1;i<10; i++)
sum =sum+1i*j;
The following for loop prints out the first 10 odd integers:
for(i=1;1<20; i++)
if (i % 2) printf(“%d “, i);



5.4 m Control Flow 191

5.4.6 While Statement

While an expression is nonzero, the while loop repeats a statement or block of code. The
value of the expression is checked prior to each execution of the statement. The syntax of a
while statement is

while (expression)

statement;

The expression is evaluated. If it is nonzero (true), statement is executed and the expression
is reevaluated. This cycle continues until the expression becomes zero {false}, at which point
execution resumes after statement. The statement may be a null statement. A null statement
does nothing and is represented by a semicolon.

Consider the following program fragment:

int_cnt = 5;

while (int_cnt);

The CPU will do nothing before the variable int_cnt is decremented to zero. In microcon-
troller applications, the decrement of int_cnt is often done by external events, such as interrupts.

5.4.7 Do-While Statement

The while and for loops test the termination condition at the beginning. By contrast, the
do-while statement tests the termination condition at the end of the statement; the body of the
statement is executed at least once. The syntax of the statement is

do

statement

while (expression);

The following do-while statement displays the integers 9 down to 1:

int digit = 9;

do

printf(“%d “, digit--);
while (digit >= 1);

5.4.8 GOTO Statement

Execution of a goto statement causes control to be transferred directly to the labeled state-
ment. This statement must be located in the same function as the goto statement. The use of
goto statement interrupts the normal sequential flow of a program and thus makes it harder to
follow and decipher. For this reason, the use of goto statements is not considered good pro-
gramming style, and it is recommended that you do not use them in your program.

The syntax of the goto statement is

goto label
An example of the use of goto statement is as follows:

if (x> 100)
goto fatal_error;

fatal_error:
printf(“Variable x is out of bound!\n);
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5.5 Input and Output

Input and output facilities are not part of C language itself. However, input and output are
fairly important in application. The ANSI standard defines a set of library functions that must
be included so that they can exist in compatible form on any system where C exists.

Some of these functions deal with file input and output. Others deal with text input and
output. In this section, we look at the following four input and output functions:

1. int getchar (). This function returns a character when it is called. The following
program fragment returns a character and assigns it to the variable xch;

char xch;
xch = getchar (};

2. int putchar (int). This function outputs a character on the standard output device. The
following statement outputs the letter a from the standard output device:

putchar (‘a’);

3. int puts {const char *s). This function outputs the string pointed to by s on the
standard output device. The following statement outputs the string Learning
microcontroller is fun! from the standard output device:

puts (“Learming microcontroller is fun! \n");

4. int printf (formatting string, argy, argy, . . ., arg,). This function converts, formats,
and prints its arguments on the standard output under control of formatting string,
argy, argy, . . ., arg, are arguments that represent the individual output data items.
The arguments can be written as constants, single variable or array names, or more
complex expressions. The formatting string is composed of individual groups of
characters, with one character group associated with each output data item. The
character group corresponding to a data item must start with %. In its simplest form,
an individual character group will consist of the percent sign followed by a conversion
character indicating the type of the corresponding data item.

Multiple character groups can be contiguous or separated by other characters,
including white-space characters. These other characters are simply transferred
directly to the output device where they are displayed. A subset of the more
frequently used conversion characters are listed in Table 5.3.

Conversion
character Meaning

data item is displayed as a single character

data item is displayed as a signed decimal number

data item is displayed as a floating-point value with an exponent

data item is displayed as a floating-point value without an exponent
data item is displayed as a floating-point value using either e-type or
f-type conversion, depending on value; trailing zeros, trailing decimal point will not be displayed
data item is displayed as a signed decimal integer

data item is displayed as an octal integer, without a leading zero

data item is displayed as a string

data item is displayed as an unsigned decimal integer

data item is displayed as a hexadecimal integer, without the leading Os

g —» D Q. ©

x = »w O -

Table 5.3 m Commonly used conversion characters for data output
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Between the % character and the conversion character, there may be, in order, the
following:

» A minus sign, which specifies left adjustment of the converted argument.

® A number that specifies the minimum field width. The converted argument will be
printed in a field at least this wide. If necessary, it will be padded on the left (or
right, if left adjustment is called for} to make up the field width.

® A period, which separates the field width from precision.

= A number, the precision, that specifies the maximum number of characters to be
printed from a string, or the number of digits after the decimal point of a floating-
point value, or the minimum number of digits for an integer.

® An h if the integer is to be printed as a short or an 1 (letter ell} if as a long.
Several valid printf calls are as follows:
printf (“this is a challenging course!\n”);  /* outputs only a string */

printf (“%d %d %d”, x1, x2, x3}; /* outputs variables x1, x2, x3 using
minimal number of digits with one space
separating each value */

printf{“Today’s temperature is /* display the string Today’s temperature

%4.1d \n”, temp); is followed by the value of temp. Display
one fractional digit and use at least four
digits for the value. */

The printf [) function is not supported by the Microchip PIC18 C compiler.

5.6 Functions and Program Structure

Every C program consists of one or more functions. If a program consists of multiple func-
tions, their definitions cannot be embedded within another. The same function can be called
from several different places within a program. Generally, a function will process information
passed to it from the calling portion of the program and return a single value. Information is
passed to the function via special identifiers called arguments (also called parameters) and
returned via the return statement. Some functions, however, accept information but do not
return anything (e.g., the library function printf).

The syntax of a function definition is as follows:

return_type function_name (declarations of arguments)

{
declarations and statements

}

The declaration of an argument in the function definition consists of two parts: the type
and the name of the variable. The return type of a function is void if it does not return any value
to the caller. An example of a function that converts a lowercase letter to an uppercase letter is
as follows:

char lower2upper (char cx)

{
if (cx>="a’ && ox <= 7) retum (cx - (‘a’ - ‘A));
else return cx;
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A character is represented by its ASCII code. A letter is in lowercase if its ASCII code is
between 97 (0x61) and 122 (0x7A). To convert a letter from lowercase to uppercase, subtract its
ASCII code by the difference of the ASCII codes of letters a and A.

To call a function, simply write down the name of the function and replace the argument
declarations by actual arguments or values and terminate it with a semicolon.

Example 5.1

Write a function that finds the largest element of an integer array.

Solution: The parameters passed to this function include the array count and the starting
address of the array. The function is as follows:

int arr_max(int ar_cnt, int arrf])

{

int i, temp;
temp = arr[0];//set the first array element as the current max
for(i=1;i<ar_cnt; i++){
if (arr[i] > temp)
temp = ari];
}

return temp;

Example 5.2

A

Write a function to compute the square root of a 32-bit number using the successive approx-
imation method.

Solution: The function is as follows:

unsigned sq_root (unsigned long int xz)

{

unsigned int sar, guess_mask, rest_mask;

unsigned int i;

sar = 0; /*successive approximation register is initialized to 0 */
guess_mask = 0x8000; /*this mask is used to guess the ith bit to be 1 */
i=16;

do {

rest_mask = ~guess_mask; /*rest_mask is used to cancel the incorrect guess */
sar | = guess_mask; /*guess the ith bit to be 1 */
if (sar * sar > xz)
sar &= rest_mask; //change the bitto 0
guess_mask >> 1;

[
]

} while (i > 0);
if ((xy - sar * sar) < ((sar+ 1)*(sar + 1) - xy))
return sar,

else return (sar+ 1);



5.6 m Functions and Program Structure 195

A function cannot be called before it has been defined. This dilemma is solved by using the
function prototype statement. The syntax for a function prototype statement is as follows:

return_type function_name (declarations of arguments);
The statement
char test_prime (int a);

is an example of the function prototype declaration.
The following examples illustrate the use of prototype declaration:

Example 5.3

Write a function to test whether an integer is a prime number.

Solution: The integer 1 is not a prime number. A number is prime if it is indivisible by any inte-
ger between 2 and its square root:

unsigned sq_root (unsigned long int xz);
/* this function returns a 1 if ka is prime. Otherwise, it retumns a 0. */
char test_prime (unsigned long int ka)
{
unsigned int i, limit;
if (ka == 1) return 0;
else if (k2 == 2) return 1;
limit = sq_root (ka); /* find the square root of ka */
for (i = 2; i <= limit; i++)
if ((a % i) == Q) return O;
retun 1;

Example 5.4

Write a program to find out the number of prime numbers between 1000 and 10000.

Solution: We can find the number of prime numbers between 1000 and 10000 by calling the
function in Example 5.3 to find out if a number is prime.

#include <stdio.h>

char test_prime (unsigned int a); /* prototype declaration of test_prime () */
unsigned sq_root (unsigned long int xz); /* prototype of sq_root () */
main ()

{

unsigned int i, prime_count;

prime_count = 0;

for (i = 1000; i <= 10000; i++) {

if (test_prime(i))
prime_count ++;

}

printf(“\n The total prime numbers between 1000 and 10000 is %d\n”, prime_count);
}

/* include the functions sq_root () and test_prime () here */
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5.7 Pointers, Arrays, Structures, and Unions

Example 5.5

5.7.1 Pointers and Addresses

A pointer is a variable that holds the address of a variable. Pointers are used frequently in
C, as they have a number of useful applications. For example, pointers can be used to pass infor-
mation back and forth between a function and its reference (calling) point. In particular, point-
ers provide a way to return multiple data items from a function via function arguments.
Pointers also permit references to other functions to be specified as arguments to a given func-
tion. This has the effect of passing functions as arguments to the given function.

Pointers are also closely associated with arrays and therefore provide an alternate way to
access individual array elements. The syntax for declaring a pointer type is

type_name *pointer_name;
For example,

int *ax;
declares that the variable ax is a pointer to an integer,

char *cp;
declares that the variable ¢p is a pointer to a character.

To access the value pointed to by a pointer, use the dereferencing operator *. For example,

inta, *b; /* bis a pointer to int */

a=*b;
assigns the value pointed to by b to variable a.

We can assign the address of a variable to a pointer by using the unary operator &. The fol-
lowing example shows how to declare a pointer and how to use & and *:

intx, y;

int *ip; //ip is a pointer to an integer

ip = &x; //assigns the address of the variable x to ip
y = *ip; //y gets the value of x

Many beginners are confused by the pointer concept. The main difference between an ordi-
nary variable and a pointer variable is the following:

When specifying the name of an ordinary variable, one gets the value of that variable.
However, when specifying the name of a pointer variable, one gets the address of the memory
location where the value of the variable is stored.

One can perform arithmetic of the pointer variables. Adding 1 to a pointer variable will
actually add to the pointer variable the size of the object pointed to by the pointer variable. For
example, if the variable iptr is a pointer to a long integer, then iptr + 1 will actually add 4 to the
current value of iptr.

v

Write the bubble sort function to sort an array of integers.

Solution: The algorithm for bubble sort: was described in Chapter 4. Here is the C language ver-
sion of the function:
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void swap (int *, int *);
void bubble (int &[], int n) - /*n is the array count*/
{

intij;

for(i=0;i<n-1;i++)

for(=0;j<n-(i+1);j+H
if (afj] > afj+1])
swap (&alj], &a[j+1]);

}
void swap (int *px, int *py)
{

int temp;

temp = *px;

*px = *py,

*py = temp;

A

5.7.2 Arrays

Many applications require the processing of multiple data items that have common char-
acteristics (e.g., a set of numerical data, represented by x3, Xs, . . ., Xy). In such situations, it is
more convenient to place data items into an array, where they will all share the same name.
The individual data items can be characters, integers, floating-point numbers, and so on. They
must all be of the same type and the same storage class.

Each array element is referred to by specifying the array name followed by one or more sub-
scripts, with each subscript enclosed in brackets. Each subscript must be expressed as a non-
negative integer. Thus, the elements of an n-element array x are x[0], x[1], . . ., xjn - 1]. The
number of subscripts determines the dimensionality of the atray. For example, x[i] refers to an
element of an one-dimensional array. Similarly, y{i][j] refers to an element of a two-dimensional
array. Higher dimensional arrays can be formed by adding additional subscripts in the same
manner. However, higher dimensional arrays are not used very often in 8- and 16-bit micro-
controller applications.

In general, a one-dimensional array can be expressed as

data-type array_name[expression];
A two-dimensional array is defined as
data-type array_name[exprl]expr2];

An array can be initialized when it is defined. This is a technique used in table lookup,
which can speed up the computation process. For example, a data acquisition system that uti-
lizes an analog-to-digital converter can use table lookup technique to speed up the conversion
(from the digital value back to the original physical quantity) process.

5.7.3 Pointers and Arrays

In C, there is a strong relationship between pointers and arrays. Any operation that can be
achieved by array subscripting can also be done with pointers. The pointer version will in gen-
eral be faster but somewhat harder to understand. For example,

int ax[20];

defines an array ax of 20 integral numbers.
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The notation ax[i] refers to the i-th element of the array. If ip is a pointer to an integer,
declared as

int *ip;
then the assignment

ip = &ax[0];
makes ip contain the address of ax[0]. Now the statement

X = *ip;

will copy the contents of ax|[0] into x.

If ip points to ax[0], then ip + 1 points to ax[1], ip + i points to ax[i], and so on.

5.7.4 Passing Arrays to a Function

An array name can be used as an argument to a function, thus permitting the entire array
to be passed to the function. To pass an array to a function, the array name must appear by itself,
without brackets or subscripts, as an actual argument within the function call. When declaring
a one-dimensional array as a formal argument, the array name is written with a pair of empty
square brackets. The size of the array is not specified within the formal argument declaration.
If the array is two-dimensional, then there should be two pairs of empty brackets following the
array name.

The following program outline illustrates the passing of an array from the main portion of
the program to a function:

int average (int n, int arr]);

void main ()

{
int n, avg; /* variable declaration */
int ar[50]; /* array definition */

avg = average(n, arr); /* function call */

}

int average (int k, int brr[]) /* function definition */

{
}

Within main, we see a call to the function average. This function call contains two actual
arguments—the integer variable n and the one-dimensional, integer array arr, Note that arr
appears as an ordinary variable within the function call.

In the first line of the function definition, we see two formal arguments k and brr. The for-
mal argument declarations establish k as an integer variable and brr as a one-dimensional inte-
ger array. Note that the size of brr is not defined in the function definition.

As formal parameters in a function definition,

int brrf);
and
int *brr;

are equivalent.
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5.7.5 Initializing Arrays

C allows initialization of arrays. Standard data type arrays may be initialized in a straight-
forward manner. The syntax for initializing an array is as follows:

array_declarator = { value-list }

The following statement shows a five-element integer array initialization:
inti[5] = {10, 20, 30, 40, 50};

The element i[0] has the value of 10, and the element i[4] has the value of 50.

A string (character array) can be initialized in two ways. One method is to make a list of
each individual character:

char strgx[5] = {'W', X, 'Y, ‘7, 0};
The second method is to use a string constant:
char myname [16] = “microcontrolier”;

A null character is automatically appended at the end of microcontroller. When initializing
an entire array, the array size (which is one more than the actual length) must be included:

char prompt [24] = “Please enter an integer:”;

5.7.6 Structures

A structure is a group of related variables that can be accessed through a common name.
Each item within a structure has its own data type, which can be different from the other data
items. The syntax of a structure declaration is as follows:

struct struct_name { /* struct_name is optional */
typel memberl;
type2 member2;

L

The struct_name is optional and, if it exists, defines a structure tag. A struct declaration
defines a type. The right brace that terminates the list of members may be followed by a list of
variables, just as for any basic type. The following example is for a card catalog in a library:

struct catalog_tag {
char author [40];
char title [40];
char pub [40];
unsigned int date;
unsigned char rev;
} card;

where the variable card is of type catalog_tag.

A structure definition that is not followed by a list of variables reserves no storage; it
merely describes a template or the shape of a structure. If the declaration is tagged (i.e., it has a
name), however, the tag can be used later in definitions of instances of the structure. For exam-
ple, suppose we have the following structure declaration:

struct point §
int x;
inty;
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We can then define a variable pt of type point as follows:
struct point pt;

A member of a particular structure is referred to in an expression by a construction of the
form

structure-name.member
or
structure-pointer — member

The structure member operator “.” connects the structure name and the member name. As
an example, the square of the distance of a point to the origin can be computed as follows:

long integer sq_distance;
sq_distance = pt.x * ptx+ pty * pty;

Structure can be nested. One representation of a circle consists of the center and radius as
shown in Figure 5.1.

radius

A

Figure 5.1 m A circle

This circle can be defined as follows:

struct circle {
struct point center;
unsigned int radius;

}
5.7.7 Unions

A union is a variable that may hold (at different times) objects of different types and sizes,
with the compiler keeping track of size and alignment requirements. Unions provide a way to
manipulate different kinds of data in a single area of storage without embedding any machine-
dependent information in the program.
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The syntax of the union is as follows:

union union_name {
type-namey elementy;
type-name, elementy;

type name, element,;
k
The field union_name is optional is also called a union tag. You can declare a union vari-
able at the same time when you declare a union type. The union variable name should be placed
after the right brace “}”.
Suppose we want to represent the current temperature using both the integer and the string;
we can use the following declaration:
union u_tag {
inti;
char c[4];
} temp;

Four characters must be allocated to accommodate the larger of the two types. The integer
type is good for internal computation, whereas the string type is suitable for output. Of course,
some conversion may be needed before we make certain kinds of interpretations. Using this
method, we can interpret the variable temp as an integer or a string, depending on our purpose.

Syntactically, members of a union are accessed as

union-name.member
or

union-pointer — member
just as for structures.

5.8 Miscellaneous Items

5.8.1 Automatic/External/Static/Volatile

A variable defined inside a function is an internal variable of that function. These variables
are called automatic because they come into existence when the function is entered and disap-
pear when it is left. Internal variables are equivalent to local variables in assembly language.
External variables are defined outside of any function and are thus potentially available to
many functions. Because external variables are globally accessible, they provide an alternative
to function arguments and return values for communicating data between functions. Any func-
tion may access an external variable by referring to it by name, if the name has been declared
somehow. External variables are also useful when two functions must share some data, yet nei-
ther calls the other.

The use of static with a local variable declaration inside a block or a function causes the
variable to maintain its value between entrances to the block or function. Internal static vari-
ables are local to a particular function just as automatic variables are, but unlike automatic vari-
ables, they remain in existence rather than coming and going each time the function is
activated. When a variable is declared static outside of all functions, its scope is limited to the
file that contains the definition. A function can also be declared as static. When a function is
declared as static, it becomes invisible outside the file that defines the function.
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A volatile variable has a value that can be changed by something other than the user code.
A typical example is an input port or a timer register. These variables must be declared as
volatile so that the compiler makes no assumptions on their values while performing opti-
mizations. The keyword volatile prevents the compiler from removing apparently redundant
references through the pointer.

5.8.2 Scope Rules

The functions and external variables that make up a C program need not all be compiled at
the same time; the source text of the program may be kept in several files, and previously com-
piled routines may be loaded from libraries.

The scope of a2 name is the part of the program within which the name can be used. For a
variable declared at the beginning of a function, the scope is the function in which the name is
declared. Local {internal) variables of the same name in different functions are unrelated.

The scope of an external variable or a function lasts from the point at which it is declared
to the end of the file being compiled. Consider the following program segment:

void 1 (. . )

{

}

inta, b, c;
voidf2 (. . .)

{
}

Variables a, b, and ¢ are accessible to function f2 but not to f1.

When a C program is split into several files, it is convenient to put all global variables into
one file so that they can be accessed by functions in different files. Functions residing in differ-
ent files that need to access global variables must declare them as external variables. In addi-
tion, we can place the prototypes of certain functions in one file so that they can be called by
functions in other files.

The following example is a skeletal outline of a two-file C program that makes use of exter-
nal variables:

In filel:

extern int xy;
extern long arr|];
main ()

{

}

void foo (intabc) {. . .}

long soo (void) { . . .}

In file2:

int xy;

long arr[100];

Free C compiler is available for PC platform if the user installs Linux or Free BSD Unix as
the machine’s operating system. By making the PC dual-bootable to Linux or Free BSD Unix,
one can use the Gnu C compiler to practice C language programming.
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5.9 Introduction to Project Build Process of the Microchip
PIC18 Compiler

The process for building a project that consists of multiple files using the Microchip
MPLAB® IDE is shown in Figure 5.2. As shown in the figure, a project may consist of a mix of
assembly and C language program files. There are four major steps in the process:

1. Source code entering and editing. In this step, the user will use the text editor
provided by the MPLAB IDE to enter the source code and save the source code in one
or multiple files.

2. Object code generation. In this step, MPLAB IDE invokes the cross assembler and/or
cross compiler to assemble and/or compile source code into object code. In Figure 5.2,
mpasm.exe is a cross assembler, whereas mec18.exe is a cross compiler. As shown in
the figure, the cross compiler invokes a C language preprocessor (cpp18.exe) to make
constants and macros substitutions and directives processing.

source ) ] ] legend
files input.asm inputt.c input2.c file

O program
( mpasm.exe ) mcci8.exe mcci8.exe

cppl18.exe cppi8.exe

Yy

object input.o input1.0 input3.o input2.0
files
mplib.exe
liorary lib.lib script Ikr
linker script
files
\
mplink.exe
( mplmk exe ) (meCOd exe) Cmp2hex exe)
I

ﬁ;g ut output.map output.out output.hex

output.Ist output.cod

Figure 5.2 m Project build process (reprint with permission of Microchip)
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3. Library files creation and maintenance. This step is optional. The user may optionally
put related reusable function modules in a single library file, which will make the
reuse of code easier. The linking process will also become easier. The program
mplib.exe is responsible for the creation and maintenance of library functions.

4. Program linking and executable code generation. The linker {mplink.exe) is invoked
in this step. When a project consists of multiple files, the linker is indispensable.
A function in a file may do the following:

m Reference variables contained in other files
®  Call functions contained in other files
®  Call library functions

These issues are resolved by the linker. As shown in Figure 5.2, several files are
created in this step. The file output.hex represents the executable code in hex format
so that it can be programmed into the target device. The file output.cod provides
information needed in debugging process. The file output.lst contains source code side
by side with final binary code and line numbers so that users may examine the code
generated. The file output.out is an intermediate file used by the linker to generate
cod file, hex file, and listing files. The file output.map shows the memory layout after
linking. It indicates used and unused memory regions. The programs that generate
these files are also indicated in Figure 5.2.

5.10 The MPLINK Linker

The MPLINK® linker (hereafter the linker) is used with the Microchip MPASM® relocat-
able assembler and the Microchip MPLAB C18 C compilers to generate executable (hex) code.
The MPLINK linker performs many functions:

® Locating code and data. The MPLINK linker accepts relocatable source files as
input. Using the linker script, it decides where the code will be placed in the
program memory and where variables will be placed in data RAM.

m  Resolving addresses. The cross assembler and cross compiler generate relocation
entries in the object file with respect to external references in a source file. After
the linker locates code and data, it uses this relocation information to update all
external references with the actual addresses.

®  Generating an executable. The linker produces an executable file {with .exe as the
suffix) that can be programmed into a PIC18 device or loaded into an emulator or
simulator to be executed.

» Configuring stack size and location. The linker allows MPLAB mcc18 to set aside
RAM space for dynamic stack usage.

» Jdentifying address conflicts. The linker checks to ensure that program data do not
get assigned to space that has already been assigned or reserved.

» Providing symbolic debug information. The linker outputs a file that the MPLAB
IDE uses to track address labels, variable locations, and line/file information for
source-level debugging.

A linker file (with a suffix .lkr to the file name) is usually needed to provide instruction to
the linker regarding how program and data memory can be allocated. A linker file contains
scripts that specify the following:
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m  Program and data memory for the target part
®  Stack size and location (for MPLAB MCC18)
m Logical sections used in source code to place code and data

Linker script directives form the command language that controls the linker’s behavior.
There are four basic categories of linker script directives:

1. Command line directives. There are four directives in this category:

LIBPATH: Library and object files that do not have a path are searched for using the
library/object search path. Additional search paths can be specified using this
directive. The following directive appends additional search directories to the
library/object search path:
LIBPATH ‘libpath’

where, libpath is a semicolon-delimited list of directories. A period without other
modifiers represents the current project directory.

LKRPATH: Linker command files that do not have a path are searched for using
the linker command file search path. The following directive appends additional search
directories to the linker command file search path:

LKRPATH ‘lkrpath’

where lktpath is a semicolon-delimited list of directories.

FILES: This directive specifies additional files to be linked.

INCLUDE: This directive specifies additional linker command files to be included.

2. Memory region definition directives. These directives define ROM and RAM regions.
A ROM directive starts with the keyword CODEPAGE. The CODEPAGE directive is
used for program code, initialized data values, constant data values, and external
memory for PIC18 devices. It has the following format:

CODEPAGE NAME=memName START=addr END=addr [PROTECTED]
[FILL=fillvalue]

where memName is any ASCII string used to identify a CODEPAGE, addr is a dec-
imal or hexadecimal number specifying an address, and fillValue is a value that fills any
unused portion of a memory block. If this value is in decimal notation, it is assumed to
be a 16-bit quantity. If it is in hexadecimal notation (e.g., 0x2346), it may be any length
divisible by full words (16 bits). The optional keyword PROTECTED indicates a region
of memory that can be used only by program code that specifically requests it.

A RAM directive can be used to define a databank, a shared bank, or an access
bank. The formats for these directives are as follows:
Banked registers:
DATABANK NAME=memName START=addr END=addr [PROTECTED]
Unbanked registers:
SHAREBANK NAME=memName START=addr END=addr [PROTECTED]
Access registers:
ACCESSBANK NAME=memName START=addr END=addr [PROTECTED]

where memName is any ASCII string used to identify an area in RAM and addr is
a decimal or hexadecimal number specifying an address. The optional keyword PRO-
TECTED indicates a region of memory that can be assigned only to variables that are
specifically identified in the source code.
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3. Logical section definition directives. Logical sections are used to specify which of the
defined memory regions should be used for a portion of source code. To use logical
sections, define the section in the linker script file with the SECTION directive and
then reference that name in the source file using the built-in mechanism of that
language (e.g., #pragma section for MPLAB C18).

The section directive defines a section using the following syntax:

SECTION NAME="secName’ {ROM="memName’ | RAM="memName’}

where seeName is an ASCII string used to identify a SECTION and memName is a
previously defined ACCESSBANK, SHAREBANK, DATABANK, or CODEPAGE.
The ROM attribute must always refer to program memory previously defined
using a CODEPAGE directive. The RAM attribute must always refer to data memory
previously defined with an ACCESSBANK, DATABANK, or SHAREBANK directive.

4. Stack definition directive. The MPLAB C18 requires a software stack to be set up.
This command specifies the size and the data bank used to implement the software
stack. The syntax of this command is as follows:

STACK SIZE="allocSize’ [RAM="memName’']

where allocSize is the size in bytes of the stack and memName is the name of a
memory bank previously declared using a ACCESSBANK, DATABANK, or
SHAREBANK statement.

Examples of linker scripts are shown in Figures 5.3a and 5.3b. The MPLAB C18 compiler
provides two sample linker files for each PIC18 microcontroller: one for use with source-level
debugger and the other for use without debugger. For example, the linker file 188720.1kr is to
be used when debugger is not involved. The linker file 18£8720i.lkr is to be used for source-level
debugging. These two files are shown in Figures 5.3a and 5.3b.

Figure 5.3a shows the following:

® The linker command “LIBPATH.” adds the project (current) directory as one of the
search paths for the library functions.

»  The linker command “FILES c018i.0” adds the startup code ¢018i into the
project.

» The linker command “FILES clib.lib” adds the general and math library functions
into the project.

® The linker command “FILES p18f8720.1ib” adds peripheral library functions into
the project.

»  The linker command “CODEPAGE NAME=vectors . . .” informs the linker that

the section named vectors is assigned to the address range from 0x00 to 0x29. No
other section can be assigned to this address range.

®  The linker command “CODEPAGE NAME=page . . .” informs the linker that the
section named page is assigned to the address range from 0x2A to Ox1FFFFF. This is
the page where your executable code should be placed or programmed into.

»  The linker command “CODEPAGE NAME=idlocs . . .” informs the linker that the
section named idlocs is assigned to the address range from 0x200000 to 0x200007.
No other section can be assigned to this address range. The user can store
checksum or other code identification numbers in this area.
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// Sample linker command file for 18F8720

//$\d: 18f8720.lkr,v 1.4 2002/08/22 20:53:50 sealep Exp $

LIBPATH .
FILES c018i.0
FILES clib.lib

FILES p18f8720.lib

CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
ACCESSBANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
ACCESSBANK
SECTION

STACK SIZE=0x100

Figure 5.3a m P18F8720 linker file without debugging support (reprint with permission of Microchip)

NAME=vectors
NAME=page
NAME=idlocs
NAME=config
NAME=devid
NAME=eedata

NAME=accessram

NAME=gpr0
NAME=gpri
NAME=gpr2
NAME=gpr3
NAME=gpr4
NAME=gpr5
NAME=gpr6
NAME=gpr7
NAME=gpr8
NAME=gpro
NAME=gpr10
NAME=gpr11
NAME=gpri2
NAME=gpri13
NAME=gpri4
NAME=accesssfr
NAME=CONFIG
RAM=gpri4

START=0x0
START=0x2A

START=0x200000
START=0x300000
START=0x3FFFFE
START=0xF00000

START=0x0
START=0x60
START=0x100
START=0x200
START=0x300
START=0x400
START=0x500
START=0x600
START=0x700
START=0x800
START=0x900
START=0xA00
START=0xB00
START=0xC00
START=0xD00
START=0xE00Q
START=0xF60
ROM=config

END=0x29
END=0x1FFFFF
END=0x200007
END=0x30000D
END=0x3FFFFF
END=0xFOOOFF
END=0x5F
END=0xFF
END=0x1FF
END=0x2FF
END=0x3FF
END=0x4FF
END=0x5FF
END=0x6FF
END=0x7FF
END=0x8FF
END=0x9FF
END=0xAFF
END=0xBFF
END=0xCFF
END=0xDFF
END=0xEFF
END=0xFFF

207

PROTECTED

PROTECTED
PROTECTED
PROTECTED
PROTECTED

PROTECTED

w The linker command “CODEPAGE NAME=config . . .” informs the linker
that the section named config is assigned to the address range from 0x300000
to 0x30000D. The configuration information for the MCU is stored in this
section. No other section can be assigned to this address range
(i.e., PROTECTED).

®  The linker command “CODEPAGE NAME=devid . . .” informs the linker that the

section named devid is assigned to the address range from 0x3FFFFE to Ox3FFFFF.
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// Sample linker command file for 18F8720i for MPLAB ICD2
/1 $id: 18f8720i.lkr,v 1.3 2002/11/07 23:23:51 sealep Exp $

LIBPATH .
FILES c018i.0
FILES clib.lib

FILES p18f8720.lib

CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
CODEPAGE
ACCESSBANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
DATABANK
ACCESSBANK
SECTION

STACK SIZE=0x100

NAME=vectors
NAME=page
NAME=debug
NAME=idlocs
NAME=config
NAME=devid
NAME=eedata

NAME=accessram

NAME=gpr0
NAME=gpr1
NAME=gpr2
NAME=gpr3
NAME=gpr4
NAME=gpr5
NAME=gpr6
NAME=gpr7
NAME=gpr8
NAME=gpr9
NAME=gpr10
NAME=gpri1
NAME=gpri2
NAME=gpr13
NAME=gpr14
NAME=dbgspr
NAME=accesssfr
NAME=CONFIG
RAM=gpr13

START=0x0
START=0x2A

START=0x1FDCO
START=0x200000
START=0x300000
START=0x3FFFFE
START=0xFQ0000

START=0x0
START=0x60
START=0x100
START=0x200
START=0x300
START=0x400
START=0x500
START=0x600
START=0x700
START=0x800
START=0x900
START=0xAQ0
START=0xB00
START=0xC00
START=0xD00
START=0xE0O
START=0xEF4
START=0xF60
ROM=config

END=0x29
END=0x1FDBF
END=0x1FFFF
END=0x200007
END=0x30000D
END=0x3FFFFF
END=0xFOO00FF
END=0x5F
END=0xFF
END=0x1FF
END=0x2FF
END=0x3FF
END=0x4FF
END=0x5FF
END=0x6FF
END=0x7FF
END=0x8FF
END=0x9FF
END=0xAFF
END=0xBFF
END=0xCFF
END=0xDFF
END=0xEF3
END=0xEFF
END=0xFFF

PROTECTED

PROTECTED
PROTECTED
PROTECTED
PROTECTED
PROTECTED

PROTECTED
PROTECTED

Figure 5.3b m P18F8720 linker file with debugging support (reprint with permission of Microchip)
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No other section can be assigned to this address arrange. Information that identifies
the MCU part number is stored in these two bytes.

» The linker command “CODEPAGE NAME=eedata . . .” informs the linker that
the section named eedata is assigned to the address range from 0xF00000 to
OxFOOOFF. No other section can be assigned to this address range.

»  The linker command “ACCESSBANK NAME=accessram . . .” informs the linker
that the section named accessram (RAM access bank) is assigned to the address
range 0x00 to Ox5F.

»  The following 15 linker commands define 15 data banks that are assigned with the
names gpr0 . . . gprl4.

s The linker command “ACCESSBANK NAME-=accesssfr. . .” defines the access
bank that covers the part of special function registers.

» The linker command “SECTION NAME=CONFIG ROM=config” associates the
section named CONFIG with the code page config in program memory.

»  The last linker command “STACK SIZE=0x100 RAM=gprl4” informs the linker
that the databank gpr14 is used as the stack and its size is 256 bytes.

The linker file in Figure 5.3b is quite similar except for a few things:

» The end address of the CODE page is changed from Ox1FFFFF to Ox1FDBF. This
implies that the ICD2 currently supports only on-chip flash program memory
debugging.

» The last DATABANK gprl4 is reduced to 244 bytes instead of 256 bytes.

» The data RAM from OxEF4 to OxEFF are reserved for the debugger and is named
dbgspr.

s The data bank gpr13 rather than gpr14 is used as the stack.

Figure 5.3 shows two possible linker files recommended by Microchip. Users should make
modifications to these files to meet the requirements of their applications at hand.

5.11 A Tutorial on Using the MCC18 Compiler

Compared to the project with a single assembly file, a few extra steps are needed to build a
project that contains C programs. The following C program will be used to illustrate the proj-
ect build process:

int counter;
void main (void)
{
counter = 0;
TRISB = 0; /* configure PORTB for output */
while (counter <= 15)
{
PORTB = counter; /* display the value of ‘counter’ on the LEDs */
counter++;
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5.11.1 Creating a New Project

Before creating a new project, the user must configure the project and select the target
device. After creating a new project, the user needs to select the tool suite and set the language
tool location.

To configure the project, go to the Configure> Settings menu and choose the Projects tab.
Make sure that the setup is as shown in Figure 3.8. Click on OK after making sure the setting
is right. You also need to select the proper target device. The device selection dialog is shown
in Figure 3.9.

After the right target device has been selected, the user is ready to create a new project.
When creating a new project, one needs to decide where to place the project. This tutorial
will use the directory c:\pic18\ch05 to place the project. Follow these steps to create a new
project.

1. Select the Project> New menu. The New dialog will open as shown in Figure 5.4.
2. Enter a name for your new project (e.g., ctutorl).

3. Use the Browse button to select the path you chose to place the new project or type in
the path.

When the project name and location are correctly specified, click on OK.

cApic1Bschls

Figure 5.4 m Creating a new project (reprint with permission of Microchip)

After creating a new project, one needs to make sure the right language tool suite is
selected. To do this, select Project> Select Language Toolsuite. Select Microchip C18 Toolsuite
as the active toolsuite. The resultant screen is shown in Figure 5.5. Click on Set Tool Locations
on the lower left to make sure that the tool suite location is correct.
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MPLINK Object Linker [mplink. sxe]
MPLAB C18 C Compiler [mze18.exe)

Figure 5.5 m Screen for selecting C language toolsuite (reprint with permission of Microchip)

The full path to the mee18 C compiler executable should appear in the Location of Selected
Tool text box as shown in Figure 5.6. If it is incorrect or empty, click on Browse to locate
mccl8.exe. After the language tool location has been set up, one can skip this step until switch-
ing language tools.

After the language tool suite is set up properly, one can enter the C program by following
the same process as shown in Chapter 3, Section 3.5.3.

Select LanguégeATnalsuitE

S

:-:e

Figure 5.6 m Setting the location of the MPLAB C18 compiler (mcc18.exe) {reprint with
permission of Microchip)
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5.11.2 Setting Build Options

Before building the project, one needs to set the build options. This is done by selecting .
Project>Build Options. This will bring up the Build Options dialog. Click on General, and the
general options will be brought up. The last three options similar to those shown in Figure 5.7 :
need to be filled in. The default settings for MPASM, MPLAB C18, and MPLINK are acceptable ;
and need not be changed.

i
i

i

o

o

L

o

2 sErnossenes B
Chas i e

Figure 5.7 a Build options dialog (reprint with permission of Microchip)

5.11.3 Add Source Files to Project

To add a source file to the project, select Project>Add Files to Project. A dialog window as
shown in Figure 5.8 will appear on the screen. Select the file that you just created and saved
(examplel.c) and click on Open. After this, the newly inserted file should appear in the project ‘
pane under Source Files.



5.11 w A Tutorial on Using the MCC18 Complier 213

Figure 5.8 m Insert C source code into project (reprint with permission of Microchip)

One also needs to add the linker file into this project. Use the same method and browse the
MCC18 C compiler installation directory (under e:\mec18\lkt) and add the appropriate linker
file (select p18f452i.lkr for this tutorial} into this project. The dialog is shown in Figure 5.9.
Select different linker file if the demo board contains different MCU.

144z ke [Biersele  [Bisfozzode (B 1674320 ke

16F448i lkr

B 18Fa52.1ke

Figure 5.9 m Adding linker script file into the project (reprint with permission of Microchip)

) 184581, Ik
18F1220. 0k
e 18F 12201 ke
16F1320. 1k

1813201 lkr

1822201 ke
1ef2320.kr
18F23201 Ik
18F4220. Ik
18f42201.lkr

16F43201. ke
18F66:20., ke
1666201, ke
186720,k
18F6720i ke
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5.11.4 Building the Project

To build the project, select Project>Build All or Project>Make (or press function key F10).
This file should be compiled successfully.

5.11.5 Choosing Debug Tool

The C program in this tutorial increments a counter and outputs it to the LEDs driven by
the lower four port B pins. It would be easier to see the result by running this program on the
demo board and use ICD2 to debug the program. Select ICD2 as the debugging tool by selecting
Debugger>Select Tool>MPLAB ICD2.

5.11.6 Build the Project

Press function key F10 to build the project. This step should run correctly. After the proj-
ect is built successfully, program the hex file into the target device on the demo board.

5.11.7 Checking the ICD2 Settings

Before programming the target device, one needs to make sure the settings of ICD2 are cor-
rect. Select Debugger>Settings to bring up the dialog. Make sure the settings on Power, Program,
and Communication are correct by following the procedures described in Chapter 3, Section 3.7.1.

One also needs to make sure the configuration bits are set up correctly. Bring up the dialog
by selecting Configure>Configuration Bits. The settings should be as shown in Figure 5.10.

00002 FF Power Up Timer Disasbled

Brown Out Detect Enabled
Brown QOut Voltage 2.0V
300003 FE Watchdog Timer Disabled
Watchdoy Postscaler 1:128
300005 FF CCP2 Mux RC1
300006 7B Low Voltage Program Disabled
Background Debug Ensbled
Stack Overflov Reset Enabled
300003 FF Code Protect 0O0200-01FFF Dizabled
Code Protect 02000-03FFF Disabled
Code Protect 04000-05FFF Disabled
Code Protect O06000-07FFF Disabled
300005 FF Data EE Read Protect Disabled
Code Protect Boot Diisabled
3gocoa FF Table Write Protect O00Z00-01FFF Disabled

Takle Write Protect 02000-03FFF Disabled
Table Write Protect 04000-05FFF Drissbled
Table Writes Protect 06000-07FFF Diszabled

30000B FF Data EE Write Protect Disabled
Tshle Write Protect Boot Disabled
Config. Write Protect Disahled
30o00a0c FF Table Read Protect 00200-01FFF Disabled

Table Read Protect 0200D0-03FFF Disabled
Tahle Read Protect 04000-05FFF Disabled
Table Read Protect 0&6000-07FFF Dissbled
30000D FF Table HRead Protect Boot Disakled

Figure 5.10 m Configuration bits settings for MPLAB ICD2 (reprint with permission of Microchip)
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5.11.8 Program the Target Device

Program the target device by selecting Debugger>Program, and the status bar of the MPLAB
IDE window will change to that as shown in Figure 5.11.

Figure 5.11 w Status bar of the MPLAB IDE window when target device programming is proceeded
(reprint with permission of Microchip)

5.11.9 Running the Program
Before running the program, set a breakpoint at the following statement:
PORTB = counter; /* display value of ‘counter’ on the LEDs */

Do this by clicking the left mouse button on this statement, pressing the right button, and
selecting the first item [Set Breakpoint) on the pop-up window. The source code window will
change to that as shown in Figure 5.12.

int counter:

void main {void}

{
counter = ;
TRISE = 0O: /* ponfigure PORTE for outpun #/7
while {counter <= 15}

ry
1

PORTE = counter: /% dizsplay value of !counter' on the LEDs +/
countert+;

Figure 5.12 m Source code window after setting a breakpoint (reprint with permission of Microchip)

One can also (optionally} set a Watch window on the MPLAB IDE window. The only variable
to watch for in this tutorial is counter. Follow the procedure described in Chapter 3, Section 3.6.4,
to set a Watch window.

Before running the program, reset the target device by pressing the function key F6. Run the
program by pressing the function key F9. The program should stop at the breakpoint, the value
of the variable counter in the Watch window should be 0, and no LED would be lighted. Press
the function key F9 to rerun the program. The program should again stop at the same statement,
the value of counter should be incremented by 1, and one LED would be lighted. Repeat this
process for a few more times.
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5.12 C Language Implementation in the MCC18 Compiler

The MCC18 compiler is not completely ANSI C compliant. It deviates from the standard
wherever the standard conflicts with efficient support for the PIC18 devices. Certain extensions are
added to better support the PIC18 devices. These specifics are detailed in the following sections.

5.12.1 Data Types and Limits

The MPLAB C18 compiler supports'the standard integer types. The ranges of the standard inte-
ger types are listed in Table 5.4. In addition to the traditional integer types, MPLAB C18 also sup-
ports a 24-bit integer type short long int (or long short int) in both signed and unsigned varieties.

type size minimum maximum
charl2 8 bits -128 127
signed char 8 bits -128 127
unsigned char 8 hits 0 255
int 16 bits -32768 32767
unsigned int 16 bits 0 65535
short 16 bits 32768 32767
unsigned short 16 bits 0 65535
short long 24 bits -8,388,608 8,388,607
unsigned short long 24 bits 0 16,777,215
long 32 bits -2,147,483,648 2,147,483,647
unsigned long 32 bits 0 4,294,967,295
Note 1. A plain char Is signed by default.
2. A plain char may be unsigned by default via the -k command line option.

Table 5.4 m Integer data type sizes and limits

The MPLAB C18 compiler also supports floating-point data types. Floating-point numbers
are declared as double or float data types. The range of the magnitudes of the floating-point
numbers is

92-126 . 9-128 (2 - 2—15)
or

1.17549435 x 10738 ~ 6.80564693 x 1038

The MPLAB C18 compiler uses a floating-point representation different from the IEEE 754
format. The IEEE 754 format can be converted to MPLAB C18 format by rotating to the left one
place, whereas a right rotation will convert from the MPLAB C18 format to the IEEE 754 for-
mat. Shown in Table 5.5 is the comparison of these two formats.

MPLAB C18 stores data in little-endian format. Bytes at lower addresses have lower
significance.

Standard Exponent byte Byte 0 Bytel Byte2
|EEE 754 sdod1dod3d,dsde d,ddd dddd dddd dddd dddd dddd
MPLAB C18 dodidadsdsdsdeds sddd dddd dddd dddd dddd dddd

Table 5.5 m MPLAB C18 floating pointformatvs. IEEE754
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5.12.2 Storage Classes

MPLAB C18 supports the standard storage classes including auto, extern, register, static,
and typedef.

Function parameters can have storage class auto or static. An auto parameter is pushed onto
the software stack [defined in Chapter 4). A static parameter is allocated globally, enabling direct
access for generally smaller code. The default storage class for function parameters is auto. This
can be changed by configuring the build options of C18 compiler. The user can bring up the Build
Options dialog by selecting Project>Build Options>Project. When the Build Options dialog
appears, click on the MPLAB C18 button and then click on the default storage class selection
window, which will bring up three options for you to choose from: Auto, Static, and Overlay.
The dialog is shown in Figure 5.13. The storage class overlay is explained shortly.
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Figure 5.13 m Select the default storage class for MPLAB C18 compiler
(reprint with permission of Microchip)
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5.12.3 Storage Qualifiers

In addition to the standard storage qualifiers (const, volatile), the MPLAB C18 compiler
introduces storage qualifiers of far, near, rom, and ram. Table 5.6 shows the location of an object
based on the storage qualifiers specified when it was defined. The default storage qualifiers for
an object defined without explicit storage qualifiers are far ram.

Near/far data memory objects. The qualifier far is used to denote that a variable that
is located in data memory resides in a memory bank such that a bank switching
instruction is required prior to accessing this variable. The qualifier near is used to
denote that a variable is located in access bank.

Near/Far program memory objects. The qualifier far is used to denote that a variable that
is located in program memory can be found anywhere in program memory or, if a pointer,
that it can access up to and beyond 64 KB of progtam memory space. The qualifier near is
used to denote that a variable located in the program memory is found at an address less
than 64 KB or, if a pointer, that it can access only up to 64 KB of program memory space.

Rom/ram gualifiers. Because the program memory and data memory of the PIC18 are
separate, MPLAB C18 requires extensions to distinguish between data located in
program memory and data located in data memory. The ANSI/ISO C standard allows
for code and data to be in separate address spaces, but this is not sufficient to locate data
in the code space as well. To this purpose, MPLAB C18 introduces the rom and ram
qualifiers. The qualifier rom denotes that the object is located in the program memory,
whereas the qualifier ram denotes that the object is located in the data memory.

rom ram
far Anywhere in program memory Anywhere in data memory (default)
near In program memory with address less than 64K In access memory

Table 5.6 m Location of object based on storage qualifiers

Pointers can point to either the data memory (tam pointer) or the program memory (tom
pointer). Pointers are assumed to be ram pointers unless declared as rom. The size of a pointer
is dependent on the type of the pointer. Data memory and near program pointers are 16 bits,
whereas far program memory pointers are 24 bits.

5.12.4 Overlay

The MPLAB C18 introduces a storage class of overlay, which allows more than one variable
to occupy the same physical memory location or more than one section to occupy the same phys-
ical memory section. The overlay mechanism is often used when physical memory resource is
limited.

The overlay storage class may be applied to local variables (but not formal parameters, func-
tion definitions, or global variables). The overlay storage class will allocate the associated sym-
bols into a function-specific, static overlay section. Such a variable will be allocated statically
but initialized on each function entry. For example, in

void func_x(void)

{

overlay intx1 = 10;
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The variable x1 will be initialized to 10 on each function entry, although its storage will be
statically allocated. If no initializer is present, then its value on function entry is undefined. The
MPLINK linker will attempt to overlay local variables specified as overlay from functions that
are guaranteed not to be active simultaneously.

5.13 ANSI/ISO Divergences

There are some divergences between the MPLAB C18’s implementation of C language and
the ANSI/ISO standard. These divergences are described in this section.

5.13.1 Integer Promotions

ISO mandates that all arithmetic be performed at int precision or greater. By default,
MPLAB C18 will perform arithmetic at the size of the largest operand, even if both operands are
smaller than an integer. The ISO-mandated behavior can be instated via the —-Oi command line
option or instated in the MPLAB IDE Build Options as shown in Figure 5.14. This is done by
clicking on the box to the left of Use Alternate Settings and entering the —~Oi option below it.

Figure 5.14 m Reinstate IS0 integer promotion rule dialog (reprint with permission of Microchip)
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For example, in the following code sequence

unsigned char j, k;

unsigned i;

j=0x79;

k = 0x87;

i=j+k
the ISO standard requires that 0x100 be assigned to i, but MPLAB C18 will assign O to i. This
divergence also applies to constant literals. The chosen type for constant literals is the first one
from the appropriate group that can represent the value of the constant without overflow. For
example,

#define X 0x20 /* X will be considered a char unless -0i is specified */
#define Y 0x5 /* Y will be considered a char unless -Oi is specified */
#define Z (X} * (Y)

unsigned i;

i=Z /* 1S0 requires i == 0x100, but in C18 i==0 */

5.13.2 Numeric Constants

MPLAB C18 supports the standard prefixes for specifying hex (0x} and octal (0] values and
adds support for specifying binary values using the 0b prefix. For example, the value 127 may
be denoted as 0bO1111111.

5.13.3 String Constants

Strings are often stored in program memory. MPLAB C18 automatically places all string con-
stants in program memory. The section that contains all constant strings is called .stringtable.
Because data memory and program memory are in different memory spaces, the C18 has four dif-
ferent variants for each standard function that deals with strings.

When using the MPLAB C18 compiler, a string table in program memory can be declared
using one of the statements in the following:

rom const tablel []]20] = {“string 1", “string 2", . . ., “string 10"};
rom const char *rom table2[] = {“string 1", “string 2", . . ., “string 10"};

The declaration of tablel declares an array of 10 strings that are each 20 characters long
and takes 100 words of program memory. table2 is declared as an array of pointers to program
memory. The rom qualifier after the * character places the array of pointers in program mem-
ory as well. All the strings in table2 are nine bytes long, and the array has 10 elements.
Therefore, table2 takes (10*9 + 10*2}/2 = 55 words of program memory. Access to table2 will
be less efficient than accesses to tablel because of the additional level of indirection required
by the pointer.

An important consequence of the separate address spaces for the MPLAB C18 is that point-
ers to data in program memory and pointers to data in data memory are not compatible. Two
pointer types are not compatible unless they point to objects of compatible types and the objects
they point to are located in the same address space.

A function to copy a string from program to data memory could be written as follows:

void str2ram (static char *dest, static char rom *src)

{
while ({(*dest++ = *src++) 1= "\0');

}
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5.13.4 Anonymous Structures

The MPLAB C18 compiler supports anonymous structures inside unions. An anonymous
structure has the form

struct { member-list };

An anonymous structure defines an unnamed object. The names of the members of an anony-
mous structure must be distinct from other names in the scope in which the structure is declared.
The members are used directly in that scope without the usual access syntax. For example,

union spic {

struct {
intal;
intbl;
k
char cx;
} tpic;

tpic.al = tpic.cx; /* ‘al’ is a member of the anonymous structure ‘tpic’ */

A structure for which objects or pointers are declared is not an anonymous structure. For
example,
union spic {
struct {
int bl;
int b2;
Jix, *ptr;
char cx;
} tpic;

tpic.b1 = tpic.cx; /* error */

tpic.ptr -> b1 = tpic.cx;/* OK */

The assignment to tpic.bl is illegal because the member name is not associated with any
particular object.

5.14 Inline Assembly

The MPLAB C18 compiler provides an internal assembler using a syntax similar to that of
the MPASM assembler. The block of inline assembly code must begin with _asm and end with
_endasm. The syntax within the block is

[iabel:] [<instruction> [argl [, arg2], arg31]]]

The internal assembler differs from the stand-alone assembler as follows:
®  No directive support
= Comments must be C or C++ notation
= Full text mnemonics must be used for table reads/writes, that is,

TBLRD (not TBLRD*}

TBLRDPOSTDEC  (not TBLRD*-
TBLRDPOSTINC  (not TBLRD*+)
TBLRDPREINC (not TBLRD+*}
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TBLWT (not TBLWT*}

TBLWTPOSTDEC  |not TBLWT*-)

TBLWTPOSTINC  (not TBLWT*+|

TBLWTPREINC (not TBLWT+*|
= No defaults for instruction operands—all operands must be fully specified
®  Default radix is decimal

n  Label must include colon
For example,

-asm
clrf count,0

loop:
moviw  0x20 // check loop count
cpfseq  count,0 //
goto doit
goto done

doit:

movf sum_lo,0,0  //move sum_lo to WREG
addwf count,0,0 //add count to sum_lo

movwf  sum_|o,0 //update sum_lo
moviw 0 //add carry to high byte of sum
addwf sum_hi,1,0 //“
incf count,1,0
goto loop
done;
nop
-endasm

It is generally recommended to limit the use of inline assembly to a minimum. Any func-
tions containing inline assembly will not be optimized by the compiler. If one needs to write a
large fragment of agsembly code, it is recommended that it be done with the stand-alone assem-
bler and link the module to the C modules using the MPLINK linker.

5.15 Bit Field Manipulation in C Language

One can use the bitwise logical operators to manipulate bit fields. For example, the follow-
ing statement will set pin 7 and pin O of the PORTD to 1s:

PORTD |- 0x81;

The following statement will clear bits 7 to 4 of the TRISD register to 0:
TRISD &= 0xOF;

The following statement will toggle all PORTD pins:

PORTD A= OxFF; //perform an exclusive-OR operation

We can summarize as follows:

= To clear a few bits of a register (or variable) to Os, one needs to AND the register
(or variable) with a mask that has Os in those bit positions to be cleared to Os.

= To set a few bits of a register (or variable) to 1s, one needs to OR the register
{or variable) with a mask that has 1s in those bit positions to be set to 1s.
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» To toggle a few bits of a register {or variable), one needs to XOR (exclusive-OR) the
register with a mask that has 1s in those bit positions to be toggled.

MPLAB C18 provides an alternative for the user to access bit fields. This alternative is
made possible through the processor-specific header files and processor-specific definition files.

5.15.1 Processor-Specific Header Files

The processor-specific header file is a C file that contains external declarations for the special-
function registers, which are defined in the register definition file. For example, in the PIC18F8720
processor-specific header file, port B is declared as

extern volatile near unsigned char PORTB;
and as

extern volatile near union {

struct {
unsigned RBO:1;
unsigned RB1:1;
unsigned RB2:1;
unsigned RB3:1;
unsigned RB4:1;
unsigned RB5:1;
unsigned RB6:1;
unsigned RBT:1;

¥

struct {
unsigned INTO:1;
unsigned INT1:1;
unsigned INT2:1;
unsigned INT3:1;
unsigned KB10:1;
unsigned KB11:1;
unsigned KB12:1;
unsigned KB13:1;

h

struct {
unsigned :3;
unsigned CCP2:1;
unsigned :1;
unsigned PGM:1;
unsigned PGC:1;
unsigned PGD:1;

L

} PORTBbits; ,

The first declaration specifies that PORTB is a byte (unsigned chax). The extern modifier is
needed since the variables are declared in the register definition file. The volatile modifier tells
the compiler that it cannot assume that port B retains values assigned to it. The near modifier
specifies that the port is located in access RAM.

The second declaration specifies that PORTBbits is a union of bit-addressable anonymous
structures. Since individual bits in a special function register may have more than one function
(and hence more than one name), there are multiple structure definitions inside the union, all
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referring to the same register. Respective bits in all structure definitions refer to the same bit in
the register. Where a bit has only one function for its position, it is simply padded in other struc-
tures. For example, bits 7, 6, 5, and 3 on port B are padded in the third structure because they
have only two names, whereas bits 4, 2, 1 and 0 have three names and are specified in each of
the structures.

Any of the following statements can be written to use the PORTB special-function register:

PORTB = 0x29; /* assign the value 0x29 to the port */
PORTBbits.INT3 =1; /* sets the INT3 pin to high */
PORTBbits,CCP2 =1; /* sets the CCP2 pin to high, same pin as INT3 */

Many of the I/O interfacing applications require the generation of clock edge. A clock edge
can be rising or falling. A falling edge on port B pin RBO can be created as follows:
In assembly language,

bsf PORTB,RBO,A ; pull high first
bcf PORTB,RBO,A ; pull low later

In C language,

PORTBbits.RBO = 1; // pull high first
PORTBbits.RBO = 0; // pull low later

In summary, one can access a bit of a register in C language as follows:
1. Appending “bits” to the register name
2. Appending a period to the symbol resulted in Step 1
3. Specifying the bit name after the period

In addition to register declarations, the processor-specific header file defines inline assem-
bly macros. These macros represent certain PIC18 instructions that an application may need to
execute from C code. Although these instructions could be included as inline assembly instruc-
tions, they are provided as C macros as a convenience for the programmer. These assembly
macros are listed in Table 5.7.

Instruction macro Action
Nop () Executes a no operation (NOP)
Clrwdt () Clears the watchdog timer(CLRWDT)
Sleep () Executes a SLEEP instruction
Reset () Executes a RESET instruction
Rlcf (var, dest, access) Rotate var to the left through the carry bit
Rincf(var, dest, access) Ratate var to the left without going through the carry bit
Rrcf (var, dest, access) Rotate var to the right through the carry bit
Rmecf {var, dest, access) Rotate var to the right without going through the cany bit
Swap (var, dest, access) Swaps the upper and lower nibbles of var
Note 1.var must be an 8-bit quantity (i.e., char) and not located on the stack.
2. If dest is 0, the result is stored in WREG, and if dest is 1, the result is located in var. If access is 0, the access bank will
be selected, overiding the BSR value. If access is 1, then the bank will be selected as per the BSR value.
3. Each of the macros affects MPLAB C18'’s ability to perform optimization on the functions using these magros.

Table 5.7 m PIC 18 instructions provided as C macros (reprint with permission of Microchip)
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In order to use the processor-specific header file, choose the header file that pertains to the
device being used (e.g., we use pl8F452.h in the tutorial C program| in the application. The
processor-specific header files are located in the c\mccl8\h directory, where c\mecl8 is the
directory where the compiler is installed.

5.15.2 Processor-Specific Register Definition Files

The processor-specific register definition file is an assembly file that contains definitions
for all the special-function registers on a given device. The processor-specific register definitions
file, when compiled, will become an object file that will need to be linked with the application
(e.g., p18F8720.asm compiles to p18F8720.0). This object file, together with others, is contained
in clib.lib.

The source code for the processor-specific register definitions file is found in the e:\mce18\
sre\proe directory, and compiled object code is found in the e:\mcel18\ib directory.

For example, port A is defined in the PIC18F452 processor-specific register definitions file as

SFR_UNBANKEDO UDATA_ACS H'F8(’
PORTA
PORTAbits RES1 ; OxF80
The first line specifies the file register bank where port A is located and the starting address
for that bank. Port A has two labels, PORTADbits and PORTA, both referring to the same loca-
tion (in this case 0xF80).

5.16 The #pragma Statement

A compiler writer can add implementation-dependent options to the C language standard
by using the #pragma statement. This statement is often used to declare data or code sections,
declare section attributes, locate code or data, declare interrupt vectors and interrupt service
routines, and many other implementation-dependent features. Here we discuss the use of
#pragma statement in declaring sections and defer the discussion of the #pragma statement
used in interrupts to Chapter 6.

5.16.1 #pragma Section Type

The MPLAB C18 compiler uses sections to manage the memory. A section is a portion of
an application located at a specific address of memory. Sections can contain code or data. A sec-
tion can be located in either program or data memory. There are two types of sections for each
type of memory:

® Program memory
code—contains executable instructions
romdata—contains variables and constants
® Data memory
udata—contains statically allocated uninitialized user variables
idata—contains statically allocated initialized user variables

Sections can be absolute, assigned, or unassigned. An absolute section is one that is given
an explicit address via the location clause of the section declaration pragma. An assigned sec-
tion is one that is ascribed to a specific section via the section directive of the linker script. An
unassigned section is one that is neither absolute nor assigned.
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The syntax for declaring sections is as follows:

#pragma udata [attribute-list] [section-name [location]]
#pragma idata [attribute-list] [section-name [location]]
#pragma romdata [overlay] [section-name] [location]
#pragma code [overlay] [section-name] [location]

where attribute-list can be access, overlay, or both; section name must be a valid C identi-
fier; and location is the starting address of the section and must be a valid integer. The access
attribute tells the compiler to locate the specified section to the access bank (defined as
ACCESSBANK in the linker script file). The overlay attribute permits other sections to be
located at the same physical address to conserve memory. The overlay attribute can be used in
conjunction with the access attribute.

Following a #pragma code directive, all generated code will be assigned to the specified code
section until another #pragma code directive is encountered. An absolute code section is declared
by specifying the starting address of the section in the #pragma code directive. For example,

#pragma code util_code = 0x3000

will locate the code section util_code at program memory address 0x3000.

Data can be placed either in data or in program memory with the MPLAB C18 compiler.
Data that is placed in on-chip program memory can be read but not written without additional
user-supplied code because on-chip program memory is in either EPROM or flash memory. Data
placed in external program memory can generally be either read or written without additional
user-supplied code.

For example, the following statement declares a section for statically allocated uninitial-
ized data {udata) at absolute address 0x2.00:

#pragma udata my_array section = 0x200

The rom keyword informs the compiler that a variable should be placed in program mem-
ory. The compiler will allocate this variable in the current romdata type section. For example,

#pragma romdata const_table
const rom char A2Dtable[50] = {0, 0, 1, 2, . . ., 49},

5.17 Mixing C and Assembly

Occasionally, one may have the need to call an assembly function from the C program or
call a C function from the assembly program. This will be an easy task as long as one knows
how function parameters are passed and how results are returned.

5.17.1 Calling Conventions

The MPLAB C18 compiler uses both the software stack and global memory {in data mem-
ory) to allocate local variables, pass parameters, and return results. The software stack defini-
tion and manipulation were discussed in Chapter 4. As shown in Figures 5.3a and 5.3b (the last
lines of the linker files), 256 bytes are reserved for the software stack by default. When neces-
sary, one can increase the size of the software stack (by changing the value in the linker file).

As described in Chapter 4, the software stack grows from a low address toward higher
addresses. The stack pointer (FSR1) always points to the next available stack location. MPLAB
C18 uses FSR2 as the frame pointer, providing quick access to local variables and parameters.
When a function is invoked, its stack-based arguments are pushed onto the stack in right-to-left
order. The leftmost {first} function argument is on the top of the software stack on entry into
the function. Figure 5.15 shows the software stack immediately prior to a function call.
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-«— FSR1 (stack pointer)

“function parameter 1

function parameter 2

increasing
addresses

function parameter n

function context ~— FSR2 (frame pointer)

Figure 5.15 m Example of software stack immediately prior to a function call

The' frame pointer references the location on the stack that separates the stack-based
arguments from the stack-based local variables. Stack-based arguments are located at negative
offsets from the frame pointer, and stack-based local variables are located at positive offsets
from the frame pointer. Immediately on entry into a C function, the called function pushes
the value of FSR2 onto the stack and copies the value FSR1 into FSR2, thereby saving the con-
text of the calling function and initializing the frame pointer of the current function. Then
the total size of stack-based local variables for the function is added to the stack pointer, allo-
cating stack space for those variables. When necessary the current function may save certain
registers before allocating local variables. Figure 5.16 shows a software stack following a call
to a C function. This figure shows that the current function does not save any registers in the
software stack.

FSR1 (stack pointer)

local variable n

local variable 2

increasing local variable 1 <— FSR2 (frame pointer)

addresses

previous frame pointer

caller function parameter 1

caller function parameter 2

caller function parameter n

caller function’s context

Figure 5.16 m Example of software stack following a C function call
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A function parameter or a local variable defined with the keyword static will be allocated
in the global memory. In general, stack-based local variables and function parameters require
more code to access than static local variables and function parameters. Functions that use
stack-based variables are more flexible in that they can be reentrant and/or recursive.

5.17.2 Return Values

The location of the return value is dependent on the size of the return value. Table 5.8
details the location or the return value based on its size.

Return value size Return value location

8 bits WREG

16 bits PRODH: PRODL

24 bits (AARGB2 + 2) (AARGB2 + 1) AARGB3

> 32 bits on the stack, and FSRO points to the retum value

Table 5.8 m MCC18 return values {reprint with permission of Microchip)

The variables AARGB2 and AARGB3 are defined in the file aarg.asm under the directory
c:\mcc18\src\math\18Cxx. Both are global variables. Their exact addresses are determined dur-
ing the link time.

5.17.3 Calling C Routines from an Assembly Program

C functions are global unless defined as static. To call a C function, the C function name
must be declared as an extern symbol in the assembly program. A CALL or RCALL instruction
must be used to make the function call.

Before calling a C function, the assembly program must push auto parameters onto the soft-
ware stack from right (last function parameter) to left {first function parameter). For multibyte
data, the last byte is pushed onto the software stack first.

Given the following prototype of a C function,
char xyz(auto char a, auto char b);
write an instruction sequence to call the function xyz with a = 0x20 and b = 0x30.

Solution: Since b is the rightmost parameter, it must be pushed onto the software stack first.
After that, the parameter a is then pushed onto the software stack.

The following instruction sequence can be used to call the function xyz and save the returned
value at memory location result:

extern Xyz ; defined in C module

push_dat 0x30 ; push b onto the stack
push_dat 0x20 ; push a onto the stack
call Xyz

movwf result ; result is returned in WREG
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\ 4

Given the following C function prototype,
int hwh (int xx, int yy);
write an instruction sequence to call the function hwh with xx = 0x1234 and yy = 0x5678.

Solution: The parameter yy should be pushed onto the stack followed by xx. The following
instruction sequence can be used to call the function hwh:

extern hwh ; defined in C module
push_dat 0x78 ; push the low byte of yy
push_dat 0x56 ; push the high byte of yy
push_dat 0x34 ; push the low byte of xx
push_dat 0x12 ; push the high byte of xx
call hwh i

movff PRODL, result ; save the low byte of result
movff PRODH, result+1 ;save the high byte of result

Static parameters are allocated globally, enabling direct access. The naming convention for
static parameters is _ function_name:n, where function_name is replaced by the name of the
function and n is the parameter, with numbering starting from 0. For example, given the fol-
lowing prototype for a C function,

char xyz(static char x, static char y);

the value for y is accessed by using __xyz:1, and the value of x is accessed by using __xyz:0.
However, because “:” is not a valid character in MPASM labels, accessing static parameters in
assembly functions is not supported.

5.17.4 Calling Assembly Functions from a C Program
The following conditions must be met before a C function can call an assembly function:
® The function label must be declared as global in the assembly module.
® The function must be declared as extern in the C module.

®  The function must maintain the MPLAB C18 compiler’s runtime model (e.g.,
return values must be returned in the locations specified in Table 5.8).

= The function is called from the C routine using the standard C function notation.

For example, given the following function in assembly language,

udata_acs
dly_cnt res 1

code
delayl setf dly_cnt ; initialize dly_cnt to 255
loop nop

nop

nop

decf dly_cnt, F

bnz loop

return

global delayl ; export so linker can see it

end
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to call the assembly function delayl from a C source file, an external prototype for the assembly
function must be added, and the function is then called using a standard C function statement:
extern void delay1 (void);
void main (void)

(

delay1 ();

}

This assembly function creates a fix delay. Suppose the time delay (the only parameter) to
be created is passed in the software stack. Then the previous assembly code is modified to

delay2

global

#include <p18Fxxx.inc>

code

moviw -2

nop

nop

decf PLUSW2, F ; the function parameter is 2 bytes below FSR2
bnz delay2

retum

delay2 ; export so finker can see it

end

The following C statements will call the delay2 function with 0xCO as the parameter:

extern void delay2 (unsigned char);
void main (void)

{

delay2(0xCO0);

}

5.17.5 Referencing C Variables in an Assembly Function

It is possible to access C variables from an assembly program. To do this, the following
must be done:

w The C variable must have a global scope in the C source file.

» The C variable must be declared as an extern symbol in the assembly file.

Suppose a C file consists of the following C statements:

unsigned int xyz;
void main (void)

{
}

The following assembly statements will assign 0x2002 to the C variable xyz:

abc_func

extern XyzZ ; Xyz is defined in C module
code

moviw 0x02

movwf Xyz ; set the low byte to 0x02

moviw 0x20
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movwf xyz+1 ; set the high byte fo 0x20
return

global abe_func ; export so linker can see it
end

5.17.6 Referencing Assembly Variables in a C Function

It is also possible to reference variables declared in an assembly file from a C program. To
do this, the following must be done:

s The variable must be declared as global in the assembly module.
» The variable must be declared as extern in the C module.
Suppose the following assembly statements are contained in an assembly program file:

asm_data udata
abc res 2 ; abc is a 2-byte variable

global  abc ; export so linker can see it
end

The following C statements can assign the value 0x2002 to the assembly variable abe:

extern unsigned int abc;
void main (void)

{
abc = 0x2002;
}

5.17.7 Startup Code

The MPLAB C18 startup begins at the reset vector {at address 0). The reset handler jumps
to a function that initializes FSR1 and FSR2 to reference the software stack, optionally calls a
function to initialize idata sections (data memory initialized data) from program memory, and
loops on a call to the application’s main () function.

There are three versions of the startup code (c018.0, c018i.0, and ¢018iz.0) that can be cho-
sen from to be linked with the user application. Whether the startup code initializes the idata
section is determined by which startup code module is linked with the application. The ¢018i.0
module performs the initialization, while the c018.0 module does not. The default linker scripts
provided by the MPLAB C18 link with c018i.0. The startup code modules are located under the
directory c:\mcc18\lib.

The ANSI standard requires that all objects with static storage duration that are not ini-
tialized explicitly be set to zero. With both the ¢018.0 and c018i.0 startup code modules, this
requirement is not met. A third startup module, c018iz.0, is provided to meet this requirement.
If this startup code is linked with the application, then, in addition to initializing idata sections,
all objects with static storage duration that are not initialized explicitly are set to zero.

After the startup code sets up the stack and optionally copies initialized data, it calls the
main() function of the C program. There are no arguments passed to main(). MPLAB C18 trans-
fers control to main() via a looped call, that is,

loop:

main();

goto loop;
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If one has the need to customize the startup code, one can edit the c018.c, c018i.c, or c018iz.c
to add any desirable customized startup code. After editing, one need to recompile it to generate
their object codes to be linked later. These startup C programs are located at c:\mecl8\src\startup.

5.18 MPLAB C18 Library Functions

A library is a collection of functions grouped for reference and ease of linking. The MPLAB
C18 libraries are included in the lib subdirectory of the installation. They can be linked directly
into an application using the MPLINK linker.

C18 libraries can be divided to two groups: processor-independent libraries and processor-
specific libraries.

5.18.1 Processor-Specific Libraries

The processor-specific library files contain definitions that may vary across individual
members of the PIC18 family. This includes all the peripheral routines and the special-function
register definitions. The peripheral routines that are provided include both those designed to use
the hardware peripherals and those that implement a peripheral interface using general-purpose
I/O lines. The processor-specific libraries are named

pprocessor.lib

For example, the library file for the PIC18F8720 is named p18£8720.1ib. The functions included
in this library are explored in subsequent chapters.

5.18.2 Processor-Independent Libraries

The processor-independent library consists of general functions and math functions. These
functions are supported across all members in the PIC18 family and are contained in the clib.lib
library.

MPLAB C18 compiler implements mathematical operations that are not directly supported
by the hardware by calling appropriate mathematical library functions. Examples are 16-bit by
16-bit multiplication, 32-bit by 32-bit multiplication, division operation in any length, and
floating-point operations. Whenever one’s C program performs any mathematical operations
that are not directly supported by the hardware, one needs to include the clib.lib library. This
has been done in the linker file shown in Figure 5.3.

The MPLAB C18 general library supports the following categories of routines:

®  Character classification functions
® Data conversion functions
= Delay functions
® Memory and string manipulation functions
Functions in these categories are discussed in the following sections.

5.18.3 Character Classification Functions

Character classification functions provided by the MPLAB C18 compiler are consistent
with the ANSI 1989 standard C library functions of the same name. The functions and proto-
type declarations of these routines are listed in Tables 5.9a and 5.9b.

One needs to include the header file ctype.h in one’s C program in order to use these routines.
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name Description

isalnum Determine if a character is alphanumeric

isalpha Determine if a character is alphabetic

iscntrt Determine if a character is a control character

isdigit Determine if a character is a decimal digit

isgraph Determine if a character is a graphical character

islower Determine if a character is a lower case
alphabetical character

isprint Determine if a character is a printable character

ispunct Determine if a character is punctuation character

isspace Determine if a character is a white space character

isupper Determine if a character is an upper case
alphabetical character

isxdgit Determine if a character is a hex digit

name Prototype declaration

isalnum unsigned char  isalnum (unsigned char eh);
isalpha unsigned char isalpha (unsigned char ¢ch);
iscntri unsigned char  isentrl (unsigned char ch);
isdigit unsigned char  isdigit (unsigned char ch);
isgraph unsigned char  isgraph (unsigned char ch);
islower unsigned char  islower (unsigned char ch);
isprint unsigned char  isprint (unsigned char ch);
ispunct unsigned char  ispunet (unsigned char ch);
isspace unsigned char  isspace (unsigned char ¢h);
isupper unsigned char  Isupper (unsigned char ch);
isxdigit unsigned char  isxdigit (unsigned char ch);

Table 5.9a m

Names and functions of character
classification C routines in MPLAB C18
compiler (reprint with permission

of Microchip)

5.18.4 Data Conversion Library Functions

Table 5.9b m Names and prototype declarations

of character classification C routines
in MPLAB C18 compiler

Most of these functions are useful for I/O operations. The need for data conversion between
internal and external number representations was explained in Chapter 4, Section 4.9. MPLAB
C18 provides a set of data conversion functions to be called by user applications. The functions
and prototype declarations of these routines are listed in Tables 5.10a and 5.10b.

One needs to include the header file stdlib.h in one’s C program in order to use these functions,

name Description

atob Convert a string to an 8-bit signed byte

atof Convert a string into a floating point value

atoi Convert a string to a 16-bit signed integer

atol Convert a string into a long integer representation

btoa Convert an 8-bit signed byte into a string

itoa Convert a 16-bit signed integer to a string

Itoa Convert a signed long integer to a string

rand Generate a pseudo-random integer

srand Set the starting seed for the pseudo-random number
generator

tolower Convert a character to a lower-case alphabetical
ASCII character

toupper Convert a character to an upper-case alphabetical
ASCH character

uftoa Convert an unsigned long integer to a string

name Prototype declaration

atob signed char atob (constchar *s);

atof double atof (const char *s);

atoi int atoi (constchar *s);

atol long atoel (const char *s);

btoa char *btoa (signed char value, char *string),
itoa char *itoa (int value, char *string);

ltoa char *Itoa (long value, char *string);

rand int rand (void);

srand void srand (unsigned int seed);

tolower char tolower (char ch);

toupper char toupper (cha ch);

ultoa char *ultoa (unsigned long value, char *string);

Table 5.10a m Names and functions of character

conversion C routines in MPLAB C18
compiler (reprint with permission
of Microchip)

Table 5.10b m Names and prototype declarations

of character conversion C routines
in MPLABC 18 compiler
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5.18.5 Memory and String Manipulation Functions

Most of these functions are consistent with the ANSI standard C library functions of the
same name. The functions and prototype declarations of these functions are listed in Tables 5.11a
and 5.11b.

One needs to include the header file string.h in one’s C program in order to use these routines.

name Description

memchr Search for a value in a specified memory region

mememp Compare the contents of two arrays (data ram and data ram)

memcmppgm Compare the contents of two arrays (data ram and program memory)

memcmppgmz2ram Compare the contents of two arrays (program memory and data ram)

memcmpram2pgm Compare the contents of two arrays (data ram and program memory)

memcpy Copy a buffer from data memory to data memory.

memepypgm2ram Copy a buffer from program memory to data memory.

memmove Copy a buffer from data memory to data memory.

memmovepgm2ram Copy a buffer from program memory to data memoty.

memset Initialize an array with a single repeated value

streat Append a copy of the source string to the end of the destination string.

strcatpgm2ram Append a copy of the source string to the end of the destination string.

strehr Locate the first occurrence of a value in a string

stremp Compare two strings in data memory.

stremppgm2ram Compare a string in data memory with a string in program memory.

strepy Copy a string from data memory to data memory.

strepypgm2ram Copy a string from program memory to data memory.

strespn Calculate the number of consecutive characters at the beginning of a string that are not contained
in a set of characters.

strlen Determine the length of a string.

striwr Convert all upper-case characters in a string to lower-case.

strncat Append a specified number of characters from the source string to the end of the destination string.

strncatpgm2ram Append a specified number of characters from the source string to the end of the destination string.

strnemp Compare two strings, up to the specified number of characters.

strncpy Copy characters from the source string to the destination string up to the specified number
of characters.

strncpypgm2ram Copy characters from the source string to the destination string up to the specified number
of characters.

strpbrk Search a string for the first occurrence of a character from a set of characters.

strrchr Locate the last occurrence of a specified character in a string.

strspn Calculate the number of consecutive characters at the beginning of a string that are contained
in a set of characters.

strstr Locate the first occurrence of a string inside another string

strtok Break a string into substrings, or tokens, by inserting null characters in
place of specified delimiters

strupr Convert ail lower-case characters in a string to upper case.

Table 5.11a ®m Names and functions of memory and string manipulation C routines in MPLAB C18

compiler (reprint with permission of Microchip).
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Name Description

memchr void *memchr (const void *mem, unsigned char ¢, size_t n);

mememp signed char memcmp (const void *buft, const void *buf2, size_t memsize);
mememppgm signed char memcmppgm (const rom *bufi, const rom *buf2, sizerom_t memsize);
mememppgm2ram signed char memcmppgm2ram (const void *buf1, const rom *buf2, sizeram_t memsize);
memempram2pgm signed char memcmpram2pgm (const rom *bufd, const void *buf2, sizeram_t memsize);
memcpy void *memcpy (void *dest, const void *sre, size_t memsize);

memcpypgm2ram void *memcpypgm2ram (void *dest, const rom *sre, size_t memsize);
memmove void *memmove (void *dest, const void *sre, sized_t memsize);
memmovepgm2ram void *memmovepgm2Zram (void *dest, const rom void *sre, sizeram_t memsize);
memset void *memset, (void *dest, unsigned char value, size_t memsize);

strcat char *strcat (char *dest, const char *sre);

strcatpgm2ram char *strcatpgrm2ram (char *dest, const rom char *sre);

strchr char *strchr (const char *str, const char e);

stremp signed char strcmp (const char *strl, const char *str2);

stremppgm2ram signed char strcmppgm2ram (const char *strl, const rom char *str2);

strepy char *strcpy (char *dest, const char *sre);

strepypgm2ram char *strcpypgm?2ram (char *dest, const rom char *src);

strespn size_t *strcspn (const char *strl, const char  *str2);

strlen size_t strlen (const char *str);

striwr char *striwr (char *str);

strncat char *strncat (char *dest, const char *sre, size_t n);

strncatpgm2ram char *strncatpgm2ram (char *dest, const rom char *sre, sizeram_t n);

stmemp signed char stmemp {const char *strl, const char *str2, size_t n);

strncpy char *strncpy (char *dest, const char *sre, size_t.n);

stmepypgm2ram char *strncpypgm2ram (char *dest, const rom char *sre, sizeram_t n);

strpbrk char *strpbrk (const char *strl, const char *str2);

strrchr char *strrchr (const char *str, const char ¢);

strspn size_t *strspn (const char *strl, const char *str2);

strstr char *strstr (const char *str, const char *substr);

strtok char *strtok (char *str, const char *delim);

strupr char *strupc (char *str);

Table 5.11b m Names and functions of memory and string manipulation C routines
in MPLAB C18 compiler

5.18.6 Delay Functions

MPLAB C18 provides a set of delay functions that will create a delay equal to a multiple of
instruction cycles. The functions and prototype declarations of these delay functions are listed
in Tables 5.12a and 5.12b.

One needs to include the header file delays.h in one’s C program in order to use these delay
functions.
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name Description name Description

Delay 1TCY Delay one instruction cycle. Delay1TCY void Delay1TCY (void)

Delay 10TCYx Delay in multiples of 10 instruction cycles. Delay10TCYx void Delay10TCYx (unsigned char unit);
Delay 100TCYx Delay in multiples of 100 instruction cycles. Delay100TCYx void Delay100TCYx (unsigned char unit);
Delay 1KTCYx Delay in multiples of 1000 instruction cycles. Delay1KTCYx void Delay1KTCYx (unsigned char unit);
Delay 10KTCYx Delay in multiples of 10,000 instruction cycles. Delay10KTCYx void Delay10KTCYx (unsigned char unit);

Table 5.12a =u

Example 5.8

Names and functions of C delay
routines in MPLAB C18 comiler
(reprint with permission of Microchip)

Table 5.12b m Names and prototype declarations of C
delay routines in MPLAB C18 compiler
(reprint with permission of Microchip)

Assuming that there is a demo board (e.g., SSE8720} using a 16-MHz crystal oscillator to
generate its clock signal and its port D is driving eight LEDs, write a program to flash these
LEDs with the following patterns forever:

1.
2.
3.

Turn on all LEDs for half a second and turn them off for half a second.

Repeat Step 1 three more times.

Turn on one LED at a time from left to right with each LED turned on for half a

second.

4. Repeat Step 3 three more times.

10.

11.

12.

13.

14.

second.

Repeat Step 5 three more times.

Turn on LEDs driven by pins RD7 and RDO on and off four times.

off time are both half a second.

. Turn on LEDs driven by pins RD6 and RD1 on and off four times.

off time are both half a second.

. Turn on LEDs driven by pins RD5 and RD2 on and off four times.

off time are both half a second.

Turn on LEDs driven by pins RD4 and RD3 on and off four times.

off time are both half a second.

Turn on LEDs driven by pins RD4 and RD3 on and off four times
off time are both half a second.

Turn on LEDs driven by pins RD5 and RD2 on and off four times.

off time are both half a second.

Turn on LEDs driven by pins RD6 and RD1 on and off four times.

off time are both half a second.

Turn on LEDs driven by pins RD7 and RDO on and off four times.

off time are both half a second.

. Turn on one LED at a time from right to left with each LED turned on for half a

The on time and

The on time and

The on time and

The on time and

. The on time and

The on time and

The on time and

The on time and
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Solution: To turn on the LEDs on the SSE8720 (or SSES680), one needs to output a 0 to the port
pin that drives the LED. By outputting different values to PORTD pins, different LEDs can be
lighted. For example, outputting the value 0x7E will turn on the LEDs driven by pins RD7 and
RDO. By placing all the LED patterns in a table, reading one pattern at a time and outputting it
to port D pins, waiting for half a second, the desired LED lighting sequence can be achieved. The
instruction cycle time for the 16-MHz crystal oscillator is 250 ns. The C program that imple-
ments this idea is as follows:

#include <delays.h>
#include <p18F8720.h>
unsigned rom char led_tab [] = {0x00,0xFF,0x00,0xFF,0x00,0xFF,0x00,0xFF,
OxT7F,0xBF,0xDF,0xEF,0xF7,0xFB,0xFD,OxFE,
0x7F,0xBF,0xDF,0xEF,0xF7,0xFB,0xFD,OxFE,
Ox7F,0xBF,0xDF,OxEF,0xF7,0xFB,0xFD,OxFE,
Ox7F,0xBF,0xDF,0xEF,0xF7,0xFB,0xFD,OxFE,
OxFE,OxFD,0xFB,0xF7,0xEF,0xDF,0xBF,0x 7F,
OXFE,OxFD,0xFB,0xF7,0xEF, OxDF,0xBF,0x 7F,
OxFE,O0xFD,0xFB,0xF7,0xEF,0xDF,0xBF,0x7F,
OxFE,OxFD,0xFB,0xF7,0xEF,0xDF,0xBF,0x 7F,
OX7E,OxFF,0x7E,OxFF,0x7E,OxFF,0x 7E, OxFF,
0xBD,0xFF,0xBD,0xFF,0xBD,0xFF,0xBD,0xFF,
0xDB,0xFF,0xDB,0xFF,0xDB,0xFF,0xDB, OxFF,
OxE7,0xFF,0xE7,0xFF,0xE7,0xFF,0xE7,OxFF,
OxE7,0xFF,0xE7,0xFF,0xE7,0xFF,0XE 7,0xFF,
0xDB, 0xFF,0xDB,0xFF,0xDB,0xFF,0xDB,0xFF,
0xBD,0xFF,0xBD,0xFF,0xBD,0xFF,0xBD, OxFF,
OX7E,OxFF,0x7E,OxFF,0x7E,OxFF,0x 7E,OxFF};
void main (void)
{
unsigned char i;
TRISD = 0x00; /* configure PORTB for output */
while (1) {
for (i=0;i< 136; i++) {
PORTD = led_tabli]; /* output a new LED pattern */
Delay 10KTCYx(200)); /* stay for about half a second */

5.19 Using the HI-TECH C18 Compiler

Commercial C compilers for the PIC18 are available from several software companies.
Among them, the HI.-TECH C18 compiler can work with MPLAB and support source-level
debugging at the time of this writing, HI-TECH C18 compiler has been used by many users. A
tutorial on the use of this compiler is provided in Appendix C.



238 Chapter 5 m A Tutorial to the C language and the Use of the C Complier

5.20 Summary

A C program consists of one or more functions and variables. The main () function is
required in every C program. It is the entry point of a C program. A function contains state-
ments that specify the operations to be performed. The types of statements in a function could
be declaration, assignment, function call, control, and null.

A variable stores a value to be used during the computation. A variable must be declared
before it can be used. The declaration of a variable consists of the name and the type of the vari-
able. There are four basic data types in C: int, char, float, and double. Several qualifiers can be
added to the variable declarations. They are short, long, signed, and unsigned.

Constants are often needed in forming a statement. There are four types of constants: inte-
gers, characters, floating-point numbers, and strings.

There are seven arithmetic operators: +, —, *, /, %, ++, --. There are six bitwise operators: &,
|, », ~ >> and <<. Bitwise operators can be applied only to integers. Relational operators are
used in control statements. They are ==, I=, >, >= <, <=, &&, | |, and !.

The control-flow statements specify the order in which computations are performed.
Control-flow statements include if-else statement, multiway conditional statement, switch
statement, for-loop statement, while-statement, and do-while statement.

Every C program consists of one or more functions. If a program consists of multiple func-
tions, their definitions cannot be embedded within another. The same function can be called
from several different places within a program. Generally, a function will process information
passed to it from the calling portion of the program and return a single value. Information is
passed to a function via special identifiers called arguments (also called parameters) and
returned via the return statement. Some functions, however, accept information but do not
return anything {e.g., the library function printf).

A pointer is a variable that holds the address of another variable. Pointers can be used to
pass information back and forth between a function and its reference (calling) point. In particu-
lar, pointers provide a way to return multiple data items from a function via function argu-
ments. Pointers also permit references to other functions to be specified as arguments to a given
function. Two operators are related with pointers: * and &. The * operator returns the value of
the variable pointed to by the pointer. The & operator returns the address of a variable.

Data items that have common characteristics are placed in an array. An array may be one-
dimensional or multidimensional. The dimension of an array is specified by the number of
square bracket pairs ([]) following the array name. An array name can be used as an argument to
a function, thus permitting the entire array to be passed to the function. To pass an array to a
function, the array name must appear by itself, without brackets or subscripts. An alternate way
to pass arrays to a function is to use pointers.

A variable defined inside a function is an internal variable of that function. External vari-
ables are defined outside of any function and are thus potentially available to many functions.
The scope of a name is the part of the program within which the name can be used. The scope
of an external variable or a function lasts from the point at which it is declared to the end of the
file being compiled.

The process of project development consists of four major steps:

1. Source code entering and editing
2. Object code generation
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3. Library code creation and maintenance
4. Program linking and executable code generation

This chapter provided a step-by-step tutorial on how to use the MPLAB C18 compiler in
program development and debugging.

The MPLAB C18 compiler is not completely ANSI C compliant. It deviates from the stan-
dard wherever the standard conflicts with efficient support for the PIC18 devices. Certain exten-
sions are added to better support the PIC18 devices. This chapter discussed these deviations and
extensions in detail.

The MPLAB C18 compiler provides many library routines to facilitate the development of
PIC18 applications. These library functions are divided into processor-dependent and processor-
independent categories. Most of these functions are compliant with ANSI C standard. The
library functions in the processor-independent category were discussed in this Chapter, whereas
those functions in the processor-dependent category are discussed in later chapters.

5.21 Exercises

E5.1 Write a program to generate a table of powers of integers. For each integer compute its
powers from 1 to 6. Print the powers of integers from 2 to 10.

E5.2 Write a function that can convert all uppercase letters in a string to lowercase. The start-
ing address of the string is passed to this function.

E5.3 Let ng be a given positive integer. Fori=0, 1,2, . . . define

Niy1 =N/ 2 if nyis even; 3n + 1 if n; is odd,;

The sequence stops whenever n; has the value 1. Numibers that are generated this way are
called hailstones. Write a program that generates some hailstones. The function

void hailstones (int n)

{
}

should be used to compute and print the sequence generated by n. The output of your pro-
gram might look as follows:

Hailstones generated by 77:

77 232 116 58 29 88
44 22 11 34 17 52
26 13 40 20 10 5
16 8 4 2 1

Number of hailstones generated: 23

Write a main program to call the hailstones function and use two different values to test it.

E5.4 Write a C function that implements the binary search algorithm.

E5.5 Write a function setbits (int x, char p, char n) that returns x with the n bits that begin at
position p inverted [i.e., 1 changed to 0 and vice versa).

F5.6 Write the function itoa (char *cpty, long int kk) that accepts a 32-bit binary number (kk)
and converts into the ASCII string that represents its value. The resultant string is to be stored
in a buffer pointed by cptr. The string must be terminated by a NULL character.
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5.22 Lab Exercises and Assignments

15.1 Create a new project and call it eg5_L1 and add the following C program in the project:

#include <P18F452.h>
unsigned char root1,ro0t2;
unsigned char sq_root_16(unsigned int xx);
void main(void)
{
rootl = sq_root_16(3600);
root2 = sq_root_16(9600);
Nop(};
1
unsigned char sq_root_16(unsigned int xx)
{
unsigned char mask, root, test, i;
mask = 0x80;
root = 0x00;
for(i=0;i<8; i++) {
fest = mask l roof;
if (test*test < xx)
root |= mask;
mask = mask >> 1;
}
if ((xx - (root*root)) < ((root+1)*(root+1)- xx))
return root;
else
retumn (root+1);

}

This program implements the successive-approximation method to compute the square
root of a 16-bit unsigned integer.

Perform the following steps:

Step 1

Set up build options as shown in Figure 5.6,

Step 2

Add the linker file p18f452i.lkr into the project.

Step 3

Select SIM simulator as the debugging tool (do not select ICD2).

Step 4

Build the project.

Step 5

Set a breakpoint at the statement Nop();

Step 6

Open a Watch window and enter the symbols rootl and root2 into the Watch window

Step 7

Run the program. What are the values of rootl and root2 in the Watch window? You have

OxFF and OxFF for rootl and root2. Do you? This is obviously wrong! Do you know why!?
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Perform the following steps:

Step 8

Move the following statement to immediately before the “void main (void)” statement:
unsigned char mask, root, test, i;

Step 9

Rebuild the project.

Step 10

Add variables mask, root, and test into the Watch window.

Step 11

Set a breakpoint at the first statement in the sq_root_16 function.

Step 12

Run the program, and the program should stop at the new breakpoint.

Step 13

Step through the function sq_root_16 by pressing the function key F7 and pay attention to

the change of the variable values in the Watch window. What do you notice? You probably
notice that the following if statement is always true:
if (test*test < xx)

root | =mask;
Why is that?
Do you remember the discussion in Section 5.6.1? Follow the description in that section
and rebuild the project.

Step 14
Reenable the breakpoint at the statement Nop{). Rerun the program. Now you should get
the correct values for rootl (0x3C) and root2 (0x62.).

15.2 Write a C program to find two prime numbers that are closest to but larger than 10000
and also two prime numbers that are closest to but smaller than 10000.

15.3 Write a C program to flash the LEDs on your demo board with the following pattern (use
port B in SSE452 and use port D in SSE8720 or SSE8680):

1. Turn on all LEDs for a quarter second and turn them off for a quarter second.
2. Repeat Step 1 three more times.

3. Turn on one LED (at odd position) at a time from left to right with each LED turned
on for half a second.

4. Repeat Step 3 three more times.

5. Turn on one LED (at even position) at a time from right to left with each LED turned
on for a guarter second.

6. Repeat Step 5 three more times.

7. Turn on LEDs driven by pins RB4 and RB3 on and off twice. The on time and off
time are both a quarter second.

8. Turn on LEDs driven by pins RB5 and RB2 on and off twice. The on time and off
time are both half a second.

9. Turn on LEDs driven by pins RB6 and RBI1 on and off twice. The on time and off
time are both half a second.

10. Turn on LEDs driven by pins RB7 and RBO on and off twice. The on time and off
time are both a quarter second.
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6.2 Basics of Interrupts

Interrupt is a mechanism provided by a microprocessor or a computer system to synchro-
nize I/O operations, handle etror conditions and emergency events, coordinate the use of shared
resources, and so on. Without the interrupt mechanism, many of these operations will become
either impossible or very difficult to implement.

6.2.1 What Is an Interrupt?

An interrupt is an event that requires the CPU to stop normal program execution and perform
some service related to the event. An interrupt can be generated internally [inside the chip) or
externally (outside the chip). An external interrupt is generated when the external circuitry asserts
an interrupt signal to the CPU. An internal interrupt can be generated by the hardware circuitry
inside the chip or caused by software errors. In some microcontrollers (e.g., the PIC18), timers, I/O
interface functions, and the CPU are incorporated on the same chip, and these subsystems can gen-
erate interrupts to the CPU. Abnormal situations that occur during program execution, such as
illegal opcodes, overflow, divided-by-zero, and underflow, are called software interrupts. The terms
traps and exceptions are also used to refer to software interrupts by some companies.

A good analogy for interrupt is how you act when you are sitting in front of a desk to read
this book and the phone rings. You probably will act like this:

1. Remember the page number or place a bookmark on the page that you are reading,
close the book, and put it aside.

2. Pick up the phone and say, “Hello, this is so and s0.”

3. Listen to the voice over the phone to find out who is calling or ask who is calling if
the voice is not familiar.

4. Talk to that person.

o

Hang up the phone when you finish talking.

6. Open the book and turn to the page where you placed the bookmark and resume
reading this book.

The phone call example spells out a few things that are similar to how the microprocessor
handles the interrupt:

1. As a student, you spend most of your time in studying. Answering a phone call
happens only occasionally. Similarly, the microprocessor is executing application
programs most of the time. Interrupts will only force the microprocessor to stop
executing the application program briefly and take some necessary actions.

2. Before picking up the phone, you finish reading the sentence and then place a
bookmark to remind you of the page number that you are reading so that you can
resume reading after finishing the conversation over the phone. Most microprocessors
will finish the instruction they are executing and save the address of the next
instruction in memory {usually in the stack} so that they can resume the program
execution later.

3. You find out the person who called you by listening to the voice over the phone, or
you ask questions so that you can decide what to say. Similarly, the microprocessor
needs to identify the cause of the interrupt before it can take appropriate actions. This
is built into the microprocessor hardware.

4. After identifying the person who called you, you start the phone conversation with
that person on some appropriate subjects. Similarly, the microprocessor will take
some actions appropriate to the interrupt source.
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5. When finishing the phone conversation, you hang up the phone, open the book to the
page where you placed the bookmark, and resume reading. Similarly, after taking
some actions appropriate to the interrupt, the microprocessor will jump back to the
next instruction when the interrupt occurred and resume program execution. This can
be achieved easily because the address of the instruction to be resumed was saved in
memory [stack). Most microprocessors do this by executing a return-from-interrupt
instruction.

6.2.2 Why Interrupts?
Interrupts are useful in many applications, such as the following:

»  Coordinating I/O activities and preventing the CPU from being tied up during the
data transfer process. The CPU needs to know if the I/O device is ready before it
can proceed. Without the interrupt capability, the CPU will need to check the
status of the I/O device periodically. The interrupt mechanism is often used by the
I/O device to inform the CPU that it is ready for data transfer. CPU time can thus
be utilized more efficiently because of the interrupt mechanism. Interrupt-driven
I/O operations are explained in more detail in later chapters.

» Performing time-critical applications. Many emergent events, such as power
failure and process control, require the CPU to take action immediately. The
interrupt mechanism provides a way to force the CPU to divert from normal
program execution and take immediate actions.

»  Providing a graceful way to exit from application when a software error occuts.
The service routine for a software interrupt may also output some useful
information about the error so that it can be corrected.

s Reminding the CPU to perform routine tasks. There are many microprocessor
applications that require the CPU to perform routine work, such as the following:

Keeping track of time of day. Without the timer interrupt, the CPU will need to
use program loops in order to update the current time. The CPU cannot do
anything else without a timer interrupt in this application. The periodic timer
interrupts prevent the CPU from being tied up.

Periodic data acquisition. Some applications are designed to acquire data
periodically.

Task switching in a multitasking operating system. In a modern computer system,
multiple application programs are resident in the main memory, and the CPU time
is divided into many short slots (one slot may be from 10 to 20 ms). A multitasking
operating system assigns a program to be executed for one time slot. At the end of a
time slot or when a program is waiting for the completion of an I/O operation, the
operating system takes over and assigns another program for execution. This
technique is called multitasking. Multitasking can dramatically improve the CPU
utilization and is implemented by using periodic timer interrupts.

6.2.3 Interrupt Maskability

Depending on the situation and application, some interrupts may not be desired or needed
and should be prevented from interrupting the CPU. Most microprocessors and microcontrollers
have the option of ignoring these interrupts. These types of interrupts are called maskable inter-
rupts. There are other types of interrupts that the CPU cannot ignore and must take immediate
actions for; these are nonmaskable interrupts. A program can request the CPU to service or
ignore a maskable interrupt by setting or clearing an enable bit. When an interrupt is enabled,
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the CPU will respond to its happening. When an interrupt is disabled, the CPU will ignore it. An
interrupt is said to be pending when it is active but not yet serviced by the CPU. A pending inter-
rupt may or may not be serviced by the CPU, depending on whether it is enabled.

6.2.4 Interrupt Priority

If a computer is supporting multiple interrupt sources, then it is possible that several inter-
rupts would be pending at the same time. The CPU has to decide which interrupt should receive
service first in this situation. The solution is to prioritize all interrupt sources. An interrupt
with higher priority always receives service before interrupts at lower priorities. Many micro-
controllers (e.g., the 68HC11) prioritize interrupts in hardware For those microcontrollers that
do not prioritize interrupts in hardware, the software can be written to handle certain interrupts
before others. By doing this, interrupts are essentially prioritized. For most microprocessors and
microcontrollers, interrupt priorities are not programmable.

6.2.5 Interrupt Service

The CPU provides service to an interrupt by executing a program called an interrupt ser-
vice routine. After providing service to an interrupt, the CPU must resume normal program exe-
cution. How can the CPU stop the execution of a program and resume it later? It achieves this
by saving the program counter and the CPU status information before executing the interrupt
service routine and then restoring the saved program counter and CPU status before exiting the
interrupt service routine. The complete interrupt service cycle involves the following:

1. Saving the program counter value.

2. Saving the CPU status {including the CPU status register and some other registers} in
the stack. This step is optional for some microcontrollers and microprocessors.

. Identifying the source of the interrupt.

. Resolving the starting address of the corresponding interrupt service routine.
. Executing the interrupt service routine.

. Restoring the CPU status from the stack.

. Restoring the program counter from the stack.

~N o U AW

8. Resuming the interrupted program.

For all maskable hardware interrupts, the microprocessor starts to provide service when it
completes the execution of the current instruction (the instruction being executed when the
interrupt occurred). For some nonmaskable interrupts, the CPU may start the service without
completing the current instruction. Many software interrupts are caused by an error in instruc-
tion execution that prevents the instruction from being completed. The service to this type of
interrupt is simply to output an error message and abort the program.

6.2.6 Interrupt Vector

To provide service to an interrupt, the processor must know the starting address of the ser-
vice routine. The starting address of the interrupt service routine is called interrupt vector. The
interrupt vector can be determined by one of the following methods:

1. Predefined. In this method, the starting address of the service routine is predefined
when the microcontroller is designed. The processor would jump to certain predefined
location to execute the service routine. All Microchip microcontrollers and 8051
variants use this approach.
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2. Fetch the vector from a predefined memory location. For many microprocessors and
microcontrollers, the interrupt vector of each interrupt source is stored at a predefined
location. The block of meémory locations where all interrupt vectors are stored is
referred to as the interrupt vector table. All Motorola microcontrollers use this
approach.

3. Execute an interrupt acknowledge cycle to fetch a vector number in order to locate
the interrupt vector. During the interrupt acknowledge cycle, the microprocessor
performs a read bus cycle, and the external I/O device that requested the interrupt
places a number on the data bus to identify itself. This number is called an
interrupt vector number. The address of the memory location where the interrupt
vector is stored is usually the sum of a multiple (2 and 4 are most common) of the
vector number and the starting address of the interrupt vector table. The CPU
needs to perform a read cycle in order to obtain the interrupt vector number. This
method is used by Intel Pentium microprocessor and many older microprocessors.
However, it is the least efficient method and hence is not used by any
microcontroller.

It is a common practice for multiple interrupt sources to share the same interrupt vector.
However, each interrupt source would have a flag associated with it to identify itself. The
source of the interrupt can be identified by examining those flags. The PIC18 MCU has only
two interrupt vectors to handle all interrupt sources. These interrupts are divided into high and
low priority levels. Within each interrupt priority level, the service routine needs to check the
flag bits of the appropriate interrupt request register in order to identify the cause of the pend-
ing interrupt.

6.2.7 Interrupt Programming
There are three steps in interrupt programming:

Step 1.

Write the service routine

An interrupt service routine is similar to a subroutine—the only difference is the last
instruction. An interrupt service routine uses the return-from-interrupt (retfie)
instruction instead of the return instruction to return to the interrupted program. In
principle, the interrupt service routine should be as short as possible. An interrupt
service routine might simply increment or decrement a variable and return. For
example, the following instruction sequence could serve as the service routine for the
PIC18 INTO pin interrupts:

cnt set 0x10

org 0x08 ; interrupt vector

incf cnt,F,A
retfie

The interrupt service routine may or may not return to the interrupted program,
depending on the cause of the interrupt. It makes no sense to return to the interrupted
program if the interrupt is caused by a software error such as divided-by-zero or overflow
because the program is unlikely to produce correct results under these circumstances. In
such situations, the service routine would return to the monitor program or the operating
system instead.
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Step 2.

Initialize the interrupt vector table (i.e., place the starting address of each interrupt service
routine in the table)

This can be done by using the assembler directive ORG {or its equivalent):

ORG  Oxkk
dw ISR_1
dw ISR_2

where ISR_i is the starting address of the service routine for interrupt source i. This step is not
needed for the PIC18 MCUs because their interrupt vector locations are fixed.

Step 3.
Enable interrupts to be serviced
Appropriate interrupt enable bits must be set in order to enable interrupt to occur.

6.2.8 Interrupt Overhead

The interrupt mechanism involves some overhead. The overhead is due to the saving and
restoring of the machine state and the execution time required by the interrupt service routine.
The default interrupt overhead of the PIC18 MCU is relatively light because the PIC18 saves
and restores only the program counter, the WREG, the STATUS, and the BSR registers. The sav-
ing and restoring of these registers take only two clock cycles each. However, several special-
function registers may need to be saved by the interrupt service routine in order to make sure
that the application program can run correctly. Other microcontrollers may save and restore
many more registers during an interrupt. For example, the Motorola 68HC11/12 MCUs save
and restore six registers (nine bytes} automatically when an interrupt is serviced.

6.3 Resets

The initial values of some CPU registers, flip-flops, and control registers in the I/O inter-
face chips must be established before the computer can operate properly. The reset mechanism
is provided for establishing the initial condition of a computer.

There are at least two types of reset in each microprocessor: the power-on reset and the
manual reset. A power-on reset allows the microprocessor to establish the initial values of reg-
isters and flip-flops and to initialize all I/O interface chips when power to the microprocessor is
turned on. A manual reset without turning off the power allows the computer to get out of most
error conditions (if the hardware has not failed) and reestablish the initial conditions. The com-
puter reboots itself after a reset.

The reset service routine has a fixed starting address and is stored in the read-only memory
of all microprocessors. At the end of the service routine, program control should be returned to
the monitor program or the operating system. An easy way to do that (for the PIC18 MCU) is
to place the upper, the middle, and the low bytes of the starting address of monitor in PCLATU,
PCLATH, and PCL, respectively.
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Like nonmaskable interrupts, resets are unmaskable. However, the microcontroller does
not save any register on a reset.

6.4 The PIC18 Interrupts

The PIC18 MCU has the following interrupt sources:
m Four edge-triggered INT pin (INTO . . . INT3) interrupts.
®  Port B pins change (any one of upper four port B pins) interrupts.

®  On-chip peripheral function interrupts. Because PIC18 members do not implement
the same number of peripheral functions, they do not have the same number of
peripheral interrupts.

6.4.1 PIC18 Interrupt Priority

The PIC18 MCU allows the user to have the option to divide all interrupts into two cate-
gories: high-priority group and low-priority group. When the application requires certain inter-
rupts to receive closer attention, the user can place them in the high-priority group. If the
application does not need to differentiate the importance of interrupts, the user can choose not
to enable priority scheme.

6.4.2 Registers Related to Interrupts

A PIC18 member may use up to 13 registers to control interrupt operation. These registers
are the following:

= RCON
= INTCON
= INTCON2
= INTCON3
= PIR1, PIR2, and PIR3
= PIEl, PIE2, and PIE3
» [PR1, IPR2, and IPR3
Each interrupt source has three bits to control its operation. These bits are the following:
» A flag bit—indicating whether an interrupt event has occurred.
®  An enable bit—enabling or disabling the interrupt source.

= A priority bit—selecting high priority or low priority. This bit has effect only when
the priority scheme is enabled.

6.4.3 RCON Register

The RCON register has a bit (IPEN] to enable interrupt priority scheme. The other bits
are used to indicate the cause of reset. The contents of the RCON register are shown in
Figure 6.1.
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7 6 5 4 3 2 1 0

IPEN - - RI TO PD POR BOR

IPEN: Interrupt priority enable bit
0: Disable priority levels on interrupts
_n Enable priority levels on interrupts
RI: RESET instruction flag bit
0: The reset instruction was executed causing a device reset
__1: The reset instruction was not executed
TO: Watchdog timeout flag bit
0: A waichdog timeout occurred
_1_ : After power-up, CLRWDT instruction, or SLEEP instruction
PD: Power-down detection flag bit
0: By execution of the SLEEP instruction
__1: Aiter power up or by the CLRWDT instruction
POR: Power-on reset status bit
0: A power-on reset has occurred
__1: A power-on reset has not occurred
BOR: Brown-out reset status bit (PIC18CX01 does not have this bit)
0: A brown-out reset has occurred
1: A brown-out reset has not occurred

Figure 6.1 m The RCON Register (reprint with permission of Microchip)

6.4.4 Interrupt Control Registers (INTCON, INTCON2, INTCON3)

These three registers contain enable, priority, and flag bits for external INT pins, port B pin
change, and Timer 0 {TMRO) overflow interrupts. The contents of these three registers are
shown in Figures 6.2a, 6.2b, and 6.2¢. Careful readers may have discovered that the INTO pin
interrupt does not have a priority bit for the user to select its interrupt priority. In fact, INTO
interrupt is always at the high priority because its request appears in both the high-priority and
the low-priority logic circuit.

It is important to know that when the priority scheme is enabled, the user needs to set the
GIEH bit (bit 7) in order to enable the low-priority interrupts. Setting the GIEL bit without set-
ting the GIEH bit will not enable any low-priority interrupts.
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7 6 5 4 3 2 1 0

GIE/GIEH | PEIE/GIEL.} TMROIE INTOIE RBIE TMROIF INTOIF RBIF

GIE/GIEH: Global interrupt enable bit

when IPEN (RCON<7>)=0

0: disables all interrupts

1: enables all interrupts

when IPEN =1

0: disables all interrupts

1: enables all high priority interrupts
PEIE/GIEL: Peripheral interrupt enable bit

when IPEN = 0:

0: disables all peripheral interrupts

1: enables all peripheral interrupts

when IPEN = 1

0: disables all low priority interrupts

1: enables all low priority interrupts
TMROIE: TMRO overflow interrupt enable bit

0: disables TMROQ overflow interrupt

1: enables TMRO overflow interrupt
INTOIE: INTO pin interrupt enable

0: disables INTO pin interrupt

1: enables INTO pin interrupt
RBIE: PORTB port change interrupt enable bit

0: disables PORTB port change interrupt

1: enables PORTB port change interrupt
TMROIF: TMRO overflow interrupt flag bit

0: TMRO has not overflowed

1: TMRO has overflowed
INTOIF: INTO pin interrupt flag bit

0: the INTO pin interrupt did not occur

1: the INTO pin interrupt has occurred
PORTB port change interrupt fiag bit

0: none of the RB7:RB4 pins have changed state

1: at least one of the RB7:RB4 pins change state

Figure 6.2a m The INTCON register (reprint with permission of Microchip)
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7 6 5 4 3 2 1 o]

RBPU [INTEDGO [INTEDG1INTEDGZ2|INTEDG3| TMROIP | INT3IP | RBIP

RBPU: PORTB pull-up enable bit
0: all PORTB puli-ups are enabled
1: all PORTB puil-ups are disabled
INTEDGO..INTEDG3: INTO..INT3 interrupt pins edge select
0: interrupt on falling edge
1: interrupt on rising edge
TMROIP: TMRO overflow interrupt priority bit
0: low priority
1: high priority
INT3IP: INT3 interrupt priority bit (not available in P18FXX8 & P18CX01)
0: low priority
1: high priority
RBIP: PORTB change interrupt priority bit
0: low priority
1: high priority
Note. 1. PIC18FXX8 does not have INTEDG2 & INTEDG3)
2. PIC18C601/801 does not have INTEDG3

Figure 6.2b m The INTCON2 register (reprint with permission of Microchip)

7 6 5 4 3 2 1 0

INT2IP | INT1IP | INT3IE | INT2IE | INT1IE | INT3IF | INT2IF | INT1IF

INT2IP..INT1IP: INT2..INT1 interrupt priority bit
0: low priority
1: high priority
INT3IE..INT1IE: INT3..INT1 interrupt enable bit
0: disable interrupt
1: enable interrupt
INT3IF..INT1IF: INT3..INT1 interrupt flag bit
0: interrupt did not occur
1: interrupt occurred
Note. 1. PIC18FXX2 , PIC18CXX2, PIC18CXX8, and PIC18FXX8 do not
have INT2 and INT3 enable and flag bits
2. PIG18C601/801 does not have INT3 enable and flag bits

Figure 6.2c m The INTCON3 register (reprint with permission of Microchip)
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6.4.5 PIR1. . . PIR3 Registers

The PIR registers contain the individual flag bits for the peripheral interrupts. Because not
all PIC18 members implement the same peripheral functions, some bits may not be present in
some PIC18 members. The flag bits allow the interrupt service routine to identify the cause of
the interrupt. The contents of these registers am shown in Figures 6.3a to 6.3d.

The PIC18C601/801 does not have the upper four bits of the PIR2 register, whereas the
PIC18CXX2/PIC18FXX?2 does not have the upper three bits of this register. The PIC18C601/801
and the PIC18CXX2/PIC18FXX2 do not have the PIR3 register. The PIR3 registers are used as
the interrupt flag bits for the CAN controller for the PIC18 devices that have a CAN controller.

7 6 5 4 3 2 1 0

PSPIF()| ADIF | RC1IF | TX1IF | SSPIF |CCP1IF | TMR2IF | TMR1IF

PSPIF: Parallel slave port Read/Write interrupt flag bit (1)
0: no read or write has occurred
1: a read or write operation has taken place (must be cleared in software)
ADIF: A/D converter interrupt flag bit
0: the A/D conversion is not completed
1: an A/D conversion completed (must be cleared in software)
RCIF: USART receive interrupt flag bit
0 = the USART receive buffer is empty
1 = the USART receive buffer is full (cleared by reading RCREG)
TXIF: USART transmit interrupt flag bit
0 = the USART transmit buffer is full
1 = the USART transmit buffer is empty
SSPIF: Synchronous serial port interrupt flag bit
0 = waiting to transmit/receive
1 = the transmission/reception is complete (must be cleared in software)
CCP1IF: CCP1 interrupt flag bit
Capture mode
0 = no TMR1 or TMRS3 register capture occurred
1 = a TMR1 or TMR3 register capture occurred (must be cleared in software
Compare mode
0 = no TMR1 or TMRS3 register compare match occurred
1 = a TMR1 or TMR3 register compare match occurred (must be cleared in :
PWM mode
Unused in this mode
TMR2IF: TMR2 to PR2 match interrupt flag bit
0 = No TMR2 to PR2 match occurred
1 = TMR2 to PR2 match occurred (must be cleared in software)
TMR1IF: TMR1 overflow interrupt flag bit
0 = TMRI1 register did not overflow
1 = TMR1 register overflowed (must be cleared in software)

Note 1. Enabled only in Microcontrolier mode for the PIC18F8X20 devices
2. PIC18CXO01 device does not have PSPIF flag bit

Figure 6.3a m The PIC18 PIR1 register (reprint with permission of Microchip)
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- CMIF - EEIF | BCLIF |LVDIF |TMRS3IF | CCP2IF

CMIF: Comparator interrupt flag bit
0: the comparator input has not changed
1: the comparator input has changed (must clear in software)
EEIF: Data EEPROM/FLASH write operation interrupt flag bit
0: the write operation is not complete
1: the write operation is complete (must cleared in software)
BCLIF: Bus collision interrupt flag bit
0: no bus collision
1: a bus collision occurred while SSP module was transmission (12C mode)
(must be cleared in software)
LVDIF: low voltage detect interrupt flag bit
0: the device voltage is above the low voltage detect trip point
1: a low voltage condition occurred (must be cleared in software)
TMR3IF: TMR3 overilow interrupt flag bit
0: TMR3 register did not overflow
1: TMR3 register overflowed
CCP2IF: CCP2 interrupt flag bit
Capture mode
0: no TMR1 or TMR3 register capture occurred
1: a TMR1 or TMR3 register capture occurred (must be cleared in software)
Compare mode
0: no TMR1 or TMR3 register compare match occurred
1: TMR1 or TMR3 register compare matich occurred (must be cleared in software)
PWM mode:
unused in this mode

Figure 6.3b m The PIC18 PIR2 register (reprint with permission of Microchip)

7 6 5 4 3 2 1 0

- - RC2IF | TX2IF [TMR4IF | CCP5IF | CCP4IF | CCP3IF

RC2IF: USART2 receive interrupt flag bit
0 = the USART receive buffer is empty
1 = the USART receive buffer is full (cleared when RCREG is read)
TX2IF: USART2 transmit interrupt flag bit
0 = the write operation is not complete
1 = the USART transmit buffer is empty (cleared when TXREG is written)
TMR4IF: TMR4 overflow interrupt flag bit
0 = TMR4 did not overflow
1 = TMR4 register overflowed (must be cleared in software)
CCPxIF: CCPx interrupt flag bit (x = 3, 4, 5)
Capture mode:
0 = no TMR1 or TMRS3 register capture occurred
1 =a TMR1 or TMRS register capture occurred (must be cleared in software)
Compare mode:
0 =no TMR1 or TMRS3 register compare match occurred
1 =a TMR1 or TMRS3 register compare match occurred (must cleared in software)
PWM mode: (not used)

Figure 6.3c m The PIR3 register (PIC18FXX20)(reprint with permission of Microchip)

\
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7 6 5 4 3 2 1 0

TXB2IF/ RXB1IF/
IRXIF | WAKIF | ERRIF | TXBnIF | TXB1IF | TXBOIF | RXBnIF | RXBOIF

IRXIF: Invalid message received interrupt flag bit
0: an invalid message has not occurred on the CAN bus
1: an invalid message has occurred on the CAN bus
WAKIF: Bus activity wakeup interrupt flag bit
0: activity on the CAN bus has not occurred
1: activity on the CAN bus has occurred
ERRIF: CAN bus error interrupt flag big
0: an error has not occurred in the CAN module
1: an error has occurred in the CAN module (multiple sources)
When CAN is in mode 0
TXB2IF..TXBOIF: Transmit buffer 2..0 interrupt flag bit
0: transmit buffer 2..0 has not completed transmission of a message
1: transmit buffer 2..0 has completed transmission of a message and may be reloaded
When CAN is in mode 1 or mode 2
TXBnlIF: Any transmit buffer interrupt flag bit
0: No message was transmitted
1: One or more transmit buffer has completed transmission of a message and may
reloaded
TXB1IF and TXBOIF are forced to 0 in mode 1 and mode 2
When CAN is in mode 0
RXB1IF..RXBOIF: Receive buffer 1..0 interrupt flag bit
0: receive buffer 1 (or 0) has not received a new message
1: receive buffer 1 (or 0) has received a new message
When CAN is in mode1 or mode 2
RXBnIF: CAN receive buffer interupt flag big
0: No receive buffer has received a new message
1: One or more receive buffer has received a new message
RXBOIF is forced to 0 when in mode 1 or mode 2

Figure 6.3d m The PIC18 PIR3 register (PIC18FXX8 or other devices with CAN)
(reprint with permission of Microchip)

6.4.6 PIE1. . . PIE3 Registers

The PIE registers contain the individual enable bits for the peripheral interrupts. When the
IPEN bit (RCON<7>) is 0, the PEIE bit must be set to enable any of these peripheral interrupts.
The contents of these three registers are shown in Figures 6.4a to 6.4d.

The 40-pin or smaller devices do not have the PIE3 register. The PIC18Fxx20 uses this reg-
ister to enable or disable the second USART, TMR4, and three input capture interrupts. The
PIC18 devices with a CAN controller use this register to enable/disable interrupts related to the
operation of the CAN controller.
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7 6 5 4 3 2 1 0

PSPIE()} ADIE | RC1IE | TX1IE | SSPIE | CCP1IE | TMR2IE | TMRI1IE

PSPIE: Parallel slave port Read/Write interrupt enable bit ()
0: disables the PSP read/write interrupt
1: enables the PSP read/write interrupt
ADIE: A/D converter interrupt enable bit
0: disables the A/D interrupt
1: enables the A/D interrupt
RC1IE: USART1 receive interrupt enable bit
0 = disable the USART1 receive interrupt
1 = enable the USART1 receive interrupt
TX1IE: USART1 transmit interrupt enable bit
0 = disable the USART1 transmit interrupt
1 = enable the USART1 transmit interrupt
SSPIE: Synchronous serial port interrupt enable bit
0 = disables the MSSP interrupt
1 = enables the MSSP interrupt
CCP1|E: CCP1 interrupt enable bit
0 = disables the CCP1 interrupt
1 = enables the CCP1 interrupt
TMR2IE: TMR2 to PR2 maitch interrupt enable bit
0 = disables the TMR2 to PR2 match interrupt
1 = enables the TMR2 to PR2 match interrupt
TMR1IE: TMR1 overflow interrupt enable bit
0 = disables TMR1 register overflow interrupt
1 = enables TMR1 register overflow interrupt

Note 1. Enabled only in Microcontroller mode for the PIC18F8X20 devices
2. The PIC18C601/801 does not have PSPIE flag bit

Figure 6.4a m The PIE1 register (reprint with permission of Microchip)
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7 6 5 4 3 2 1 0

- CMIE - EEIE | BCLIE | LVDIE | TMRSIE | CCP2IE

CMIE: Comparator interrupt enable bit
0: disables the comparator interrupt
1: enables the comparator interrupt
EEIE: Data EEPROM/FLASH write operation interrupt enable bit
0: disables the write operation interrupt
1: enables the write operation interrupt
BCLIE: Bus collision interrupt enable bit
0: disables the bus collision interrupt
1: enables the bus collision interrupt
LVDIE: low voltage detect interrupt enable bit
0: disables the device voltage detect interrupt
1: enables the device voltage detect interrupt
TMR3IE: TMR3 overflow interrupt enable bit
0: disables the TMR3 overflow interrupt
1: enables the TMR3 overflow interrupt
CCP2IE: CCP2 interrupt enable bit
0: disables the CCP2 interrupt
1: enables the CCP2 interrupt
Note 1. The PIC18C601/801 has only the lower four bits of this register.
2. The PIC18FXX2 does not have the CMIF bit

Figure 6.4b m The PIE2 register (reprint with permission of Microchip)

7 6 5 4 3 2 1 0

- - RC2IE | TX2IE | TMR4IE | CCPSIE | CCP4IE | CCP3IE

RC2IE: USART2 receive interrupt enable bit

0: the comparator input has not changed

1: the comparator input has changed (must clear in software)
TX2IE: USART2 transmit interrupt enable bit

0: disables the USART2 fransmit enable bit

1: enables the USART2 transmit enable bit
TMR41E: TMR4 overflow interrupt enable bit

0: disables the TMR4 overflow interrupt

1: enables the TMR4 overflow interrupt
CCPxIE: CCPx interrupt enable bit (x = 3, 4, or 5)

0: disables the CCPx interrupt

1: enables the CCPx interrupt

Figure 6.4c m The PIE3 register (PIC18FXX20) (reprint with permission
of Microchip)
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7 6 5 4 3 2 1 0

TXB2IE/ RXB1IE/
IRXIE |WAKIE | ERRIE | TXBnlE |TXB1IE |TXBOIE | RXBnlE | RXBOIE

IRXIE: Invalid message received interrupt enable bit
0: disables the invalid CAN message received interrupt
1: enables the invalid CAN message received interrupt
WAKIE: Bus activity wakeup interrupt enable bit
0: disables the bus activity wakeup interrupt
1: enables the bus activity wakeup interrupt
ERRIE: CAN bus error interrupt enable big
0: disables the CAN bus error interrupt
1: enables the CAN bus error interrupt
When CAN is in mode 0:
TXB2IE..TXBOIE: Transmit buffer 2..0 interrupt enable bit
0: disables transmit buffer 2..0 interrupt
1: enables transmit buffer 2..0 interrupt
When CAN is in mode 1 or mode 2:
TXBniE: CAN transmit buffer interrupt enable bit
0: disable all transmit buffer interrupts
1: enable transmit buffer interrupt; individual interrupt is enabled by TXBIE abd BIEO
When CAN is in mode 0:
TXB1IE and TXBOIE are forced to 0 in mode 1 and mode 2.
RXB1IE..RXBOIE: Receive buffer 1..0 interrupt enable bit
0: disables receive buifer 1 (or 0} interrupt
1: enables receive buffer 1 (or 0) interrupt
When CAN is in mode 1 or mode 2:
RXBnIE: CAN receive buffer interrupt enable bit
0: disable all receive buffer interrupts
1: enable receive buffer interrupts; individual interrupts is enabled by BIEQ
RXBOIE is forced to 0 when in mode 1 and mode 2.

Figure 6.4d m Contents of the PIC18 PIE3 register (PIC18FXX8 and other
devices with CAN) (reprint with permission

6.4.7 Interrupt Priority Registers (IPR1 . . . IPR3)

The IPR registers contain the individual priority bits for the peripheral interrupts. These
registers have effect only when the interrupt priority enable (IPEN) bit is set. By enabling inter-
rupt priority and setting the associated priority bit, the user can place any peripheral interrupt
at high or low priority. The contents of these registers are shown in Figure 6.5.
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7 6 5 4 3 2 1 0

PSPIPM { ADIEP | RC1IP | TX1iP | SSPIP | CCP1IP | TMR2IP | TMR1IP

PSPIP: Parallel slave port Read/Write interrupt priority bit (1)
0: low priority
1: high priority
ADIP: A/D converter interrupt priority bit
0: low priority
1: high priority
RCIP: USART receive interrupt priority bit
0: low priority
1: high priority
TXIP: USART transmit interrupt priority bit
0: low priority
1: high priority
SSPIP: Synchronous serial port interrupt priority bit
0: low priority
1: high priority
CCP1IP: CCP1 interrupt priority bit
0: low priority
1: high priority
TMR2IP: TMR2 to PR2 match interrupt priority bit
0: low priority
1: high priority
TMR1IP: TMR1 overflow interrupt priority bit
0: low priority
1: high priority

Note 1. Enabled only in Microcontroller mode for the PIC18F8X20 devices
2. The PIC18C601/801 does not have the PSPIP priority bit

Figure 6.5a m The IPR1 register (reprint with permission of Microchip)
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7 6 5 4 3 2 1 0

- CMIP - EEIP | BCLIP | LVDIP [TMR3IP |CCP2IP

CMIP: Comparator interrupt priority bit
0: low priority
1: high priority
EEIP: Data EEPROM/FLASH write operation interrupt priority bit
0: low priority
1: high priority
BCLIP: Bus collision interrupt priority bit
0: low priority
1: high priority
LVDIP: low voltage detect interrupt priority bit
0: low priority
1: high priority
TMR3IP: TMR3 overflow interrupt priority bit
0: low priority
1: high priority
CCP2IP: CCP2 interrupt priority bit
0: low priority
1: high priority
Note 1. The PIC18C601/801 has only the lower four bits of this register.
2. The PIC18FXX2 does not have the CMIP bit

Figure 6.5b m The IPR2 register (reprint with permission of Microchip)

7 6 5 4 3 2 1 0

- - RC2IP | TX2IP | TMR4IP |CCP5IP | CCP4IP | CCP3IP

RC2IP: USART2 receive interrupt priority bit
0: low priority
1: high priority

TX2IP: USART2 transmit interrupt priority bit
0: low priority
1: high priority

TMR4IP: TMR4 overflow interrupt priority bit
0: low priority
1: high priority

CCPxIP: CCPx interrupt priority bit (CCP modules 3, 4, and 5)
0: low priority
1: high priority

Figure 6.5¢c m The IPR3 register (PICL8FXX20) (reprint with permission
of Microchip)
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7 6 5 4 3 2 1 0

TXB2IP/ RXB1IP/
IRXIP | WAKIP | ERRIP | TXBnIP | TXB1iP | TXBOIP |RXBniP | RXBOIP

IRXIP: Invalid message received interrupt priority bit
0: low priority
1: high priority
WAKIP: Bus activity wakeup interrupt enable bit
0: low priority
1: high priority
ERRIP: CAN bus error interrupt enable big
0: low priority
1: high priority
TXB2IP..TXBOIP: Transmit buffer 2..0 interrupt enable bit
In mode O
0: low priority
1: high priority
In mode 1 and mode 2 ‘
TXBnIP is used as the priority bit for all CAN transmit buffers
0: low priority
1: high priority
Bit 3 and 2 are forced to 0 in CAN mode 1 and mode 2.
RXB1IP..RXBOIP: Receive buffer 1..0 interrupt enable bit
In mode O
0: low priority
1: high priority
In mode 1 and 2
RXBnIP is used to enable the priority of all receive buffer
0: low priority
1: high priority .
Bit 0 is forced to 0 in CAN mode 1 and mode 2.

Figure 6.5d m The IPR3 register (devices with CAN) (reprint with permission of Microchip)

6.5 PIC18 Interrupt Operation

The PIC18 MCU can enable or disable the priority scheme. Once enabled, the priority
scheme divides all interrupt sources into high-priority and low-priority groups. They operate
differently from the nonpriority scheme. Every interrupt source has an associated priority bit.
The priority bits of interrupt sources in the core group are contained in one of the interrupt con-
trol registers (INTCON, INTCON2, and INTCONBS), whereas the priority bits of peripheral
interrupts are contained in one of the IPR registers (IPR1 . . . IPR3}.

When the priority scheme is enabled, all high-priority interrupts are under the control of
a two-level interrupt enabling mechanism, whereas all low-priority interrupts are under the
control of a three-level interrupt enabling scheme. If the priority scheme is disabled, then all
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peripheral interrupts are under the control of a three-level enabling scheme. Interrupts in the
core group are under the control of a two-level enabling scheme. The following interrupt
sources are in the core group:

= INT pin (INTO. . . INT3) interrupts. Devices with 44, 40, and 28 pins may have
only INTO and INT1 pins (devices with CAN) or INTO through INT?2 pins |(devices
without CANJ.

= TMRO overflow interrupt.
®» PORTB input pin (upper four pins only} change interrupts.

6.5.1 PIC18 Interrupt without Setting Priority

When bit 7 (IPEN bit) of the RCON register is cleared, the PIC18 MCU disables the inter-
rupt priority and works in the compatible mode {compatible with the PIC16 MCU). All inter-
rupt sources share the common interrupt vector at 0x000008.

To enable an interrupt that is under the control of the two-level enabling mechanism, one
needs to set the GIE bit of the INTCON register and its associated interrupt bit. For example,
one needs to set both the GIE bit and the TOIE bit (INTCON<5>) in order to enable the TMRO
overflow interrupt.

To enable an interrupt that is under the control of the three-level enabling mechanism,
one needs to set the GIE bit, the PEIE bit, and the interrupt enable bit associated with the inter-
rupt source. For example, one needs to set the following three bits in order to enable the A/D
conversion-complete interrupt:

1. The GIE bit (INTCON<75)
2. The PEIE bit (INTCON<6>)
3. The ADIE bit (PIE1<6>)

As long as one of these three enable bits is not set, the A/D conversion-complete interrupt
will be disabled. If the PEIE bit is cleared, then none of the peripheral interrupts will occur.

When an interrupt is responded to, the GIE bit is automatically cleared to disable any fur-
ther interrupt, the return address is pushed onto the return address stack, and the program
counter is loaded with the interrupt vector. Most interrupt flags must be cleared by the soft-
ware. This must be done in the interrupt service routine to avoid repetitive interrupts from the
same source.

The last instruction of an interrupt service routine must be the retfie instruction. The exe-
cution of this instruction will cause the top word of the hardware stack to be popped into the
program counter and the GIE bit to be set. After this, program control is returned to the inter-
rupted program, and interrupt is reenabled. This instruction has the option to restore the WREG,
the STATUS, and the BSR registers from the fast register stack if the application requires it.

6.5.2 PIC18 Interrupt with Priority Enabled

This mechanism is useful when certain interrupts need to be serviced promptly. As shown in
Figure 6.2a, the GIE bit (bit 7) is used as the global high-priority interrupt enable bit (GIEH),
whereas the PEIE bit (bit 6} is used as the global low-priority interrupt enable (GIEL) bit when the
priority scheme is enabled. The GIEH bit must also be set in order to enable low-priority interrupts.

All unmasked interrupts are enabled by setting the GIEH bit, and all unmasked low-priority
interrupts are enabled by setting the GIEL bit. By default, all interrupts are placed in high-priority
level after reset. High-priority interrupts can interrupt a low-priority interrupt under service. A
high-priority interrupt will be enabled when both the GIEH bit and its associated enable bit are
set to 1. To enable a low-priority interrupt, the user needs to set the GIEH bit, the GIEL bit, and
its associated enable bit.
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To place an interrupt source at the low-priority level, clear its corresponding priority bit in
one of the IPR registers. All low-priority interrupts share the same interrupt vector at 0x000018,
whereas all high-priority interrupts share the same interrupt vector at 0x000008.

The pending interrupts in the high-priority group will always be serviced before the pend-
ing interrupts in the low-priority group. When the retfie instruction is executed and the prior-
ity scheme is functioning, then either the GIEH or the GIEL bit will be set to reenable the
interrupt. Interrupt flags must be cleared in the software to avoid recursive interrupts. In addi-
tion, it is a good practice to clear the interrupt flag bit before enabling any interrupt.

6.5.3 INT Pin Interrupts

AL INT pin interrupts (INTO . . . INT3) are edge triggered. The edge-select bits are contained
in the INTCON?2 register. When an edge-select bit is set to 1, the corresponding INT pin interrupt
is requested on the rising edge. Otherwise, the INT pin interrupt is requested on the falling edge.

6